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1 Introduction

Purpose of the User Manual
The User Manual provides you with instructions and information to run the ÄKTA™
avant system. It also includes relevant guidance for practical handling and mainte-
nance of instrument components.

In this chapter

Section See page

1.1 Important user information 7

1.2 ÄKTA avant overview 9

1.3 Associated Documentation 11

1 Introduction
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1.1 Important user information

Read this before operating the
product

All users must read the entire Operating Instructions before installing, oper-
ating or maintaining the product.

Always keep the Operating Instructions at hand when operating the product.

Do not install, operate, or perform maintenance on the product in any other way than
described in the user documentation. If you do, you may be exposed or expose others
to hazards that can lead to personal injury and you may cause damage to the equip-
ment.

Intended use of the product
ÄKTA avant is a liquid chromatography system intended for method and process
development in purification of biomolecules. The system can be used to screen for
optimal choice of columns, media and running parameters to purify selected proteins.

The ÄKTA avant system is intended for research use only, and shall not be used in any
clinical procedures, or for diagnostic procedures.

Prerequisites
In order to follow this manual and use the system in the manner it is intended, it is
important that:

• You have a general understanding of how the computer and Microsoft® Windows®
work.

• You understand the concepts of liquid chromatography.

• You have read and understood the Safety instructions chapter in ÄKTA avant
Operating Instructions.

• A user account has been created according to the UNICORN™ Administration and
Technical Manual.

Definitions
This user documentation contains safety notices (WARNING, CAUTION, and NOTICE)
concerning the safe use of the product. See definitions below.

1 Introduction
1.1 Important user information
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WARNING

WARNING indicates a hazardous situation which, if not avoided,
could result in death or serious injury. It is important not to proceed
until all stated conditions are met and clearly understood.

CAUTION

CAUTION indicates a hazardous situation which, if not avoided,
could result in minor or moderate injury. It is important not to
proceed until all stated conditions are met and clearly understood.

NOTICE

NOTICE indicates instructions that must be followed to avoid
damage to the product or other equipment.

Notes and tips
Note: A note is used to indicate information that is important for trouble-free and

optimal use of the product.

Tip: A tip contains useful information that can improve or optimize your proce-
dures.

1 Introduction
1.1 Important user information
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1.2 ÄKTA avant overview

Introduction
ÄKTA avant is a preparative liquid chromatography system intended for purification of
proteins as well as other bio-molecules and used for method and process develop-
ment. The system is equipped with valves, detectors and fraction collector, integrated
in the flow path, needed for automated control and optimal performance. The system
can be used to screen for columns, media, and running parameters to purify selected
proteins

This section gives an overview of the ÄKTA avant instrument and UNICORN software.
For detailed information about UNICORN, see the UNICORN manuals listed in User
documentation on the CD, on page 11. For detailed information about the instrument,
see Chapter 2 The ÄKTA avant instrument, on page 13.

Main features
The main features of ÄKTA avant are listed below.

• The ÄKTA avant is a complete system including all modules needed for normal
method and process development.

• The ÄKTA avant system can be easily extended with additional modules, e.g. for
extra samples, buffers, outlets, columns and integration of optional components.

• The ÄKTA avant instrument is compact with a built-in fraction collector.

• Cooling of the built-in fraction collector enables secure storage of the purified
samples and unattended runs over night.

• The built-in Instrument display shows instrument status and method state.

• ÄKTA avant is controlled by the UNICORN software: a complete package for control,
experimental planning, supervision and evaluation of chromatography instruments
and purification runs.

- Purification and maintenance methods are easily created using predefined
methods and method phases. Method phases are displayed graphically in a
method outline and phase properties, which makes methods and phases easy to
handle and edit.

- Run statistics history for individual columns can be saved (e.g., total number of
runs and number of runs since last cleaning procedure).

- BufferPro (automatic buffer preparation) facilitates screening for optimal buffer
compositions as well as preparation of single buffers.

- Design of Experiments (DoE) is an integrated part of UNICORN that provides an
organized approach that connects experiments in a rational manner.

UNICORN modules overview
UNICORN consists of four modules: Administration, Method Editor, System
Control and Evaluation. The main functions of each module are described in the
following table.

1 Introduction
1.2  ÄKTA avant overview
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Module Main functions

Administration Perform user and system setup, system log and data-
base administration.

Method Editor Create and edit methods using one or a combination of:

• Predefined methods with built-in application support

• Drag-and-drop function to build methods with rele-
vant steps

• Line-by-line text editing

The interface provides easy viewing and editing of run
properties.

System Control Start, monitor and control runs. The current flow path is
illustrated in the Process Picture, which allows manual
interactions with the system and provides feedback on
run parameters.

Evaluation Open results, evaluate runs and create reports.

The default Evaluation module includes a user interface
optimized for workflows like quick evaluation, compare
results and work with peaks and fractions.

To perform operations like Design of Experiments, users
can easily switch to Evaluation Classic.

When working with the modules Administration, Method Editor, System Control
and Evaluation it is possible to access descriptions of the active window by pressing
the F1 key. This can be especially helpful when editing methods

1 Introduction
1.2  ÄKTA avant overview
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1.3 Associated Documentation

Introduction
This section describes the user documentation that is delivered with ÄKTA avant.

User documentation on the CD
The user documentation listed in the table below is available in printed or PDF format.
The complete documentation is also available on the User Documentation CD.

Document Main contents

ÄKTA avant Unpacking Instructions

(29101559)

Instructions for unpacking the instrument,
and how to lift the instrument onto a bench.

ÄKTA avant Operating Instructions

(29101556)

Instructions needed to install, operate and
maintain the system in a safe way.

ÄKTA avant User Manual

(29035184)

Instructions for handling the system.
Descriptions of components. Information
about how to run and maintain the system.

ÄKTA avant 25 Product
Documentation

(28991000) OR

ÄKTA avant 150 Product
Documentation (28984249)1

System specification and declaration of
material conformity.

1 The instrument is delivered with the relevant document.

UNICORN user documentation
The user documentation listed in the following table is available from the Help menu in
UNICORN or from the UNICORN Online Help and Documentation software
accessed by pressing the F1 key in any UNICORN module.

Documentation Main contents

UNICORN Help Descriptions of UNICORN dialog boxes (available
from the Help menu).

Getting started with
Evaluation

Note:

Available in UNICORN 7.0
and later.

• Video clips showing common workflows in the
Evaluation module.

• Overview of features of the Evaluation module.

1 Introduction
1.3 Associated Documentation
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Documentation Main contents

UNICORN Method Manual 1 • Overview and detailed descriptions of the
method creation features in UNICORN.

• Workflow descriptions for common operations.

UNICORN Administration
and Technical Manual 1

• Overview and detailed description of network
setup and complete software installation.

• Administration of UNICORN and the UNICORN
database.

UNICORN Evaluation
Manual 1

• Overview and detailed descriptions of the
Evaluation Classic module in UNICORN.

• Description of the evaluation algorithms used in
UNICORN.

UNICORN System Control
Manual 1

• Overview and detailed description of the system
control features in UNICORN.

• Includes general operation, system settings and
instructions on how to perform a run.

1 Current UNICORN version is added to the title of the manual.

Data files, application notes and user
documentation on the web

To order or download data files, application notes or user documentation, see the
instruction below.

Step Action

1 Go to cytiva.com.

2 Click Product support.

3 Click Related Documents.

4 Select to download the chosen literature.

Additional literature
For practical tips on chromatography, refer to ÄKTA Laboratory-scale: Chromatog-
raphy Systems Instrument Management Handbook (product code 29010831).

1 Introduction
1.3 Associated Documentation
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2 The ÄKTA avant instrument

About this chapter
This chapter provides an overview of the ÄKTA avant instrument and the standard and
optional instrument modules.

In this chapter

Section See page

2.1 Overview illustrations 14

2.2 Runs in a cold environment 28

2.3 Removing the foldable door and pump cover 29

2.4 Liquid flow path 34

2.5 Instrument display 36

2.6 Accessories 42
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2.1 Overview illustrations

Introduction
This section provides an overview of the system and its available modules.

Instrument configurations
ÄKTA avant is available with two standard module configurations, one for flow rates up
to 25 ml/min and one for flow rates up to 150 ml/min. In this manual they are referred to
as ÄKTA avant 25 (25 ml/min) and ÄKTA avant 150 (150 ml/min).

Illustration of the main parts of the
instrument

The following illustration shows the location of the main parts of the instrument.

Part Function Part Function

1 Fraction collector 2 Buffer tray

3 Instrument display 4 Wet side

5 Foldable door 6 Pump cover

7 Holder rails 8 Swivel foot lock/unlock knob

9 Swivel foot 10 Swing out toolbox

11 Power switch

2 The ÄKTA avant instrument
2.1 Overview illustrations
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Illustration of the wet side modules of
the instrument

The following illustration shows the modules of the wet side of the instrument.

Part Function Part Function

1 Injection valve 2 Flow restrictor

3 pH valve 4 Column valve

5 UV monitor 6 Conductivity monitor

7 Inlet valve B 8 Quaternary valve

9 System pump B 10 Pressure monitor of system
pumps

11 System pump flow restrictor 12 Inlet valve A

13 System pump A 14 Mixer

15 Sample pump flow restrictor 16 Pressure monitor of sample
pump

17 Sample pump 18 Pump rinsing solution tube

19 Sample inlet valve 20 Outlet valve

21 Holder rails

2 The ÄKTA avant instrument
2.1 Overview illustrations
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Standard modules
ÄKTA avant is delivered with the modules listed in the following table.

Module Label in

ÄKTA avant 25 ÄKTA avant 150

System pump A P9 A P9H A

System pump B P9 B P9H B

Sample pump P9-S P9H S

Pressure monitor R9 R9

Mixer M9 M9

Injection valve V9-Inj V9H-Inj

Quarternary valve Q9 Q9

Inlet valve A V9-IA V9H-IA

Inlet valve B V9-IB V9H-IB

Sample inlet valve V9-IS V9H-IS

Column valve V9-C V9H-C

pH valve V9-pH V9H-pH

Outlet valve V9-O V9H-O

UV monitor U9-M U9-M

Conductivity monitor C9 C9

Built-in fraction collector NA NA

Optional modules
One or more of the modules in the following table may be added to the flow path of
ÄKTA avant.

Module Label in

ÄKTA avant 25 ÄKTA avant 150

Second Inlet valve A V9-A2 V9H-A2

Second Inlet valve B V9-B2 V9H-B2

Extra Inlet valve X1 V9-IX V9H-IX

Extra Inlet valve X2 V9-IX V9H-IX

2 The ÄKTA avant instrument
2.1 Overview illustrations
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Module Label in

ÄKTA avant 25 ÄKTA avant 150

Second Sample inlet
valve

V9-S2 V9H-S2

Versatile valve V9-V V9H-V

Loop valve V9-L V9H-L

Second Column valve V9-C2 V9H-C2

Second Outlet valve V9-O2 V9H-O2

Third Outlet valve V9-O3 V9H-O3

External air sensor L9-1.5 L9-1.5 L9-1.5

External air sensor L9-1.2 L9-1.2 L9-1.2

I/O-box E9 E9

Second UV monitor U9-L U9-L

Second Conductivity
monitor

C9 C9

Second Fraction
collector

F9-R F9-R

Illustration convention
In the valve illustrations below, the following convention is used to point out the loca-
tion of the ports on the valve head. Loop valve V9-L is used as an example.

 

• Ports located on the valve head rim are indicated
outside the black ring (e.g., 1E, 2E, etc.).

• Ports located on the pivot part of the valve head are
indicated on the inside of the black ring (e.g., 3E and 3F).

• Ports located on the valve head front are indicated by
an arrow (e.g., E and F).

Description of standard modules
The following modules are installed in the instrument when delivered.

2 The ÄKTA avant instrument
2.1 Overview illustrations
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Module Description

System pump A P9 A or P9H A A high precision pump, which delivers buffer in
purification runs.

For further information, refer to Section 3.1
Pumps, on page 55.

System pump B P9 B or P9H B A high precision pump, which delivers buffer in
purification runs.

For further information, refer to Section 3.1
Pumps, on page 55.

Sample pump P9-S or P9H S A high precision pump which delivers sample or
buffer in purification runs.

For further information, refer to Section 3.1
Pumps, on page 55.

2 The ÄKTA avant instrument
2.1 Overview illustrations
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Module Description

Pressure monitor R9 Pressure monitor which reads the system pres-
sure after System Pump A and System Pump B.

For further information, refer to Section 3.8 Pres-
sure monitors, on page 75.

Pump flow restrictor Prevents the system from siphoning when the
flow path after the pump is open. Gives a small
back pressure to the pump in extreme low pres-
sure applications.

For further information, refer to Section 3.8 Pres-
sure monitors, on page 75.

2 The ÄKTA avant instrument
2.1 Overview illustrations
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Module Description

Mixer M9 Mixes the buffers delivered from the system
pumps to a homogeneous buffer composition.

Three mixer chambers are available for ÄKTA
avant 25. Available volumes are: 0.6 ml, 1.4 ml
(mounted at delivery) and 5 ml.

Three mixer chambers are available for ÄKTA
avant 150. Available volumes are: 1.4 ml, 5 ml
(mounted at delivery), and 15 ml.

CAUTION

Risk of explosion. Do not
use Mixer chamber 15 ml
with an ÄKTA avant 25
system configuration. The
maximum pressure for
Mixer chamber 15 ml is 5
MPa (50 bar).

For further information, refer to Section 3.2
Mixer, on page 59.

Inlet valve A V9-IA or V9H-IA

V9-IA

Q

A1

A2A3

A4

A7A6
A5

Out

Inlet valve for System Pump A with seven inlet
ports and integrated air sensor.

For further information, refer to Section 3.4 Inlet
valves, on page 62.

2 The ÄKTA avant instrument
2.1 Overview illustrations
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Module Description

Inlet valve B V9-IB or V9H-IB

V9-IB

B5

B4

B3B2
B1

B6

B7
Q

Out

Inlet valve for System Pump B with seven inlet
ports and integrated air sensor.

For further information, refer to Section 3.4 Inlet
valves, on page 62.

Quaternary valve Q9 Valve which allows automatic mixing of four
different solutions.

For further information, refer to Section 3.4 Inlet
valves, on page 62.

Sample inlet valve V9-IS or
V9H-IS

V9-IS

S5

S4

S3S2

S1

S6

S7
Buff

Out

Inlet valve for sample solution, with eight inlet
ports (seven sample inlets and one buffer inlet)
and integrated air sensor.

For further information, refer to Section 3.4 Inlet
valves, on page 62.

2 The ÄKTA avant instrument
2.1 Overview illustrations
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Module Description

Injection valve V9-Inj or V9H-
Inj

LoopE 
 

 
 

    LoopF

Sy
r 

 

 
 

  
 

    W
1  

 

 
 

 
 

PaS  
 

 

2
W 

 

V9-Inj

Valve which directs sample onto the column.

For further information, refer to Section 3.5
Injection valve, on page 67.

Column valve V9-C or V9H-C Column valve which connects up to five columns
to the instrument, and directs the flow to one
column at a time. The column valve features two
integrated pressure sensors.

Allows the user to choose flow direction through
the column, or to bypass the column.

For further information, refer to Section 3.6
Column valve, on page 70.

pH valve V9-pH or V9H-pH Valve which enables the pH electrode to be
included in the flow path or by-passed during a
run. The pH electrode may be calibrated when
installed in the pH Valve. It also enables the flow
restrictor to be included in the flow path (default
position) or by-passed during a run.

For further information, refer to Section 3.9 pH
valve and pH monitor, on page 77.

2 The ÄKTA avant instrument
2.1 Overview illustrations
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Module Description

Outlet valve V9-O or V9H-O

V9-O

O
ut2

Out1Frac
Ou

t1
0

In

Ou
t4

W

Out6

O
ut3O

ut
9

Out5Out7

O
ut8

Valve which directs the flow to the fraction
collector, any of the ten outlet ports or waste.

For further information, refer to Section 3.7
Outlet valve, on page 73.

UV monitor U9-M Monitor which measures the UV/Vis absorbance
at up to three wavelengths simultaneously in the
range 190 to 700 nm.

For further information, refer to Section 3.11 UV
monitor, on page 92.

Conductivity monitor C9 Monitor which continuously measures the
conductivity of buffers and sample solutions.

For further information, refer to Section 3.12
Conductivity monitor, on page 94.

Built-in fraction collector Built-in fraction collector. A cooling function
protects the fractions from heat degradation.

For further information, refer to Section 3.10
Built-in fraction collector, on page 80.

2 The ÄKTA avant instrument
2.1 Overview illustrations
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Description of optional modules
The following modules may be added to the flow path.

Module Description

Second Inlet valve A V9-
A2 or V9H-A2

Second inlet valves for System pump A, to extend the
number of inlets up to 14.

For further information, refer to Section 4.3 Extra inlet
valves, on page 104.

Second Inlet valve B V9-
B2 or V9H-B2

Second inlet valves for System pump B, to extend the
number of inlets up to 14.

For further information, refer to Section 4.3 Extra inlet
valves, on page 104.

Inlet valve X1 and Inlet
valve X2 V9-IX or V9H-IX

V9-IX

5

4
32

1

6

7
8

Out

Inlet valve with eight inlet ports. No integrated air
sensor.

For further information, refer to Section 4.3 Extra inlet
valves, on page 104.

Second Sample inlet
valve V9-S2 or V9H-S2

Second inlet valve for Sample pump to extend the
number of sample inlets up to 14.

For further information, refer to Section 4.3 Extra inlet
valves, on page 104.

Versatile valve V9-V or
V9H-V

V9-V 1

4

2

3

A 4-port, 4-position valve, which can be used to
customize the flow path.

For further information, refer to Section 4.8 Versatile
valve, on page 122.
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Module Description

Loop valve V9-L or V9H-
L

Valve which enables automatic sample application
from up to five sample loops, or to collect intermediate
fractions in automated two-step purification.

For further information, refer to Section 4.7 Loop valve,
on page 118.

Second Column valve
V9-C2 or V9H-C2

Valve which connects five additional columns to the
instrument, extending the number of columns up to
10. The valve allows the user to choose flow direction
through the column, or to by-pass the column.

For further information, refer to Section 4.4 Second
Column valve, on page 108.

Second Outlet valve V9-
O2 or V9H-O2

Valve which adds 12 outlet ports to the system, giving
a total of 21 outlets.

For further information, refer to Section 4.5 Extra
Outlet valves, on page 111.

Third Outlet valve V9-O3
or V9H-O3

Valve which adds 12 outlet ports to the system, giving
a total of 32 outlets

For further information, refer to Section 4.5 Extra
Outlet valves, on page 111.
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Module Description

External air sensor
L9-1.5 or L9-1.2

Sensor which prevents air from being introduced into
the flow path.

For further information, refer to Section 4.6 External
air sensors, on page 114.

I/O-box E9 Module which receives analog or digital signals from,
or transfers analog or digital signals to, external equip-
ment that has been incorporated in the system.

For further information, refer to Section 4.12 I/O-box,
on page 135.

Second UV monitor U9-L Monitor which measures the UV absorbance at a fixed
wavelength of 280 nm.

For further information, refer to Section 4.11 Second
UV monitor, on page 132.
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Module Description

Second Conductivity
monitor C9

Monitor which measures the conductivity of buffers
and sample solutions.

For further information, refer to Section 4.10 Second
Conductivity monitor, on page 131.

Second Fraction
collector F9-R

Round fraction collector that can collect up to 175
fractions.

For further information, refer to Section 4.9 Fraction
collector F9-R, on page 124.
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2.2 Runs in a cold environment

Introduction
The instrument can be placed and run in a cold cabinet or room. When running the
instrument in a cold environment make sure to take the precautions listed in this
chapter.

Precautions concerning runs in a cold
cabinet

NOTICE

• Avoid condensation. If ÄKTA avant is kept in a cold room, cold
cabinet or similar, keep it switched on in order to avoid conden-
sation.

• Avoid overheating. If ÄKTA avant is kept in a cold cabinet and
the cold cabinet is switched off, make sure to switch off ÄKTA
avant and keep the cold cabinet open to avoid overheating.

• Place the computer in room temperature. If the ÄKTA avant
instrument is placed in a cold room, use a cold room compatible
computer or place the computer outside the cold room and use
the Ethernet cable delivered with the instrument to connect to
the computer.

Note: When the instrument is kept in a cold cabinet or room, it is important to
tighten all tubing connectors, also the inlet manifold connectors. Otherwise
air might get into the flow path.

Tip: When runs are performed in a cold cabinet, make sure to adjust the target
temperature of the built-in fraction collector temperature control function.
The target temperature is 20°C by default. Settings for the temperature
control function can be edited in the System Settings dialog box of
System Control, or in the Text Instructions pane in Method Editor.
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2.3 Removing the foldable door and pump cover

Introduction
The foldable door and pump cover can be removed from the instrument, for example to
fit the ÄKTA avant instrument in a cold cabinet. When using the instrument in a cold
room or cold cabinet, make sure to follow the precautions listed below.

Remove the foldable door
While holding on to the foldable door, unscrew the four screws marked in the following
illustration. The door can then be removed.

Remove the pump cover

Follow the instruction to remove the pump cover.

Step Action

1 Open the pump cover.

2 The ÄKTA avant instrument
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Step Action

2 Lift off the tray.

3 Unscrew the two countersinked screws marked in the illustration.
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Step Action

4 Pull out the two shafts.

5 Lift off the pump cover.

6 Unscrew the three screws holding the hinge to the pump cover and remove
the hinge.

2 The ÄKTA avant instrument
2.3 Removing the foldable door and pump cover

ÄKTA avant User Manual 29035184 AF 31



Step Action

7 Screw the three screws back to the pump cover and put the pump cover in a
safe place.

8 Put the inner shaft back through the hinge and damper, and push the hinge
into place.
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Step Action

9 Put the outer shaft back into place, and screw the two countersinked screws
back.
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2.4 Liquid flow path

Illustration of the flow path
The following illustration shows an overview of the standard flow path.

6

7

8

9 10 11

12

13 14 15 16 17

19

20

W1 W2

W

3

21

18

4

5

Part Description

1 Pressure monitor

2 Sample pump

3 Sample inlet valve

4 Quaternary valve

5 Inlet valve A

6 Inlet valve B
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Part Description

7 System pump B

8 System pump A

9 Pressure monitor

10 Mixer

11 Injection valve

12 Sample loop or Superloop™

13 Column valve

14 Column

15 UV monitor

16 Conductivity monitor

17 Flow restrictor

18 pH valve with pH monitor

19 Outlet valve

20 Fraction collector
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2.5 Instrument display

Introduction
The Instrument display is located on the front of the ÄKTA avant instrument. The
Instrument display shows the current state of the system. The Instrument display can
also be used to view detailed information about an ongoing method run and to view
network settings. The Pause and Continue buttons of the Instrument display can be
used to control an ongoing method run.

This section describes the location and function of the Instrument display.

Location and illustration
The following illustration shows the location and a detailed view of the instrument
display.

Part Description

1 System name

2 Information area. This example shows the State window.

3 Continue button. Tap to continue the run after, for example, a pause.

4 Pause button. Tap to pause a run.

5 The name of the current system state. The state is shown even if another
message or view is shown in the information area.

6 Lock/Unlock indicator. Indicates if the Pause and Continue buttons are
locked or unlocked. Locking is set in UNICORN in System Control.
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Part Description

7 Settings button. Tap to display the Settings window with system
parameters.

8 Details button. Tap to display the Details window with parameters and
data for the ongoing run.

9 State button. Tap to display the State window with the current system
state, both in text and color.

Function of the instrument display
Three different types of information can be displayed:

• State of the system

• Details of the run

• Network settings

State window
Tap State to view the State window. The State window displays the current state of
the system. Information about the built-in fraction collector is displayed in the lower
left frame for each state.

The table below describes the different states that can be displayed.

State Display Description

Not connected The instrument has no
communication with the
Instrument server.

Connecting The system is starting
up.

Ready The instrument is ready
to use.
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State Display Description

Run A run is ongoing.

Idle is displayed when
the built-in fraction
collector is not in use.

Deselected is displayed
when the built-in frac-
tion collector is not
selected in the instru-
ment configuration.

Run

with fractionation
ongoing

A run, and fractionation,
is ongoing.

Do not open the Frac
drawer during fractiona-
tion.

Wash A wash instruction or a
pump synchronization is
ongoing.

Manual pause A run has been paused
by the user.

System pause A run has been paused
by UNICORN.
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State Display Description

Hold A method is put on hold
by UNICORN, or by the
user.

Alarms and errors The system is paused
due to an alarm. To
resume the run,
acknowledge the alarm
and continue the run in
UNICORN.

Details window
Tap Details to view the Details window.

The Details window shows run data for the ongoing run. This window can be conven-
ient to use when the computer is not located beside the instrument. The instrument
can for example be located in a cold room.

The Details window has two tabs. The Volumetric tab shows the flow in ml/min, and
the Linear tab shows the flow in cm/h. The other parameters are presented in the
same way in both tabs.

Settings window
Tap Settings to display the Settings window.

The System parameters tab shows the system parameters, for example network
settings. This information can be useful in contact with service or local IT support.
Default values are set on delivery. To change the values, tap Edit. For information
about network settings, see UNICORN Administration and Technical Manual.
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Note: The Edit button is enabled only when the system is in state Not
connected.

The Touchscreen tab shows an instruction on how to calibrate the touchscreen.

Buttons and indicators
The Instrument display includes the following buttons and indicators:

Indicator/Button Description

Indicates if the Instrument display buttons are unlocked
or locked. The buttons can be locked from UNICORN
System Control.

Pauses the run and stops all pumps.

Resumes instrument operation from the following
states:

• Wash

• Pause

• Hold

Lock/Unlock function

Follow the instruction to lock or unlock the Pause and Continue buttons of the Instru-
ment display from UNICORN.

Step Action

1 In System Control, on the System menu, click Settings.

Result:

The System Settings dialog box box opens.
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Step Action

2 In the System Settings dialog box:

• Select Advanced →Instrument display.

• Click Locked or Unlocked.

• Click OK.
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2.6 Accessories

About this section
A number of holders are available for attaching columns, bottles and tubing to the
ÄKTA avant instrument. The holders are attached to the instrument using the holder
rails on the front and wet side of the instrument.

Optional modules can be installed on the instrument outside the system chassis when
using an Extension box.

This section describes the available holders, other accessories and the Extension box.

In this section

Section See page

2.6.1 Column holders 43

2.6.2 Tubing holders and other accessories 47

2.6.3 Extension box 52
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2.6.1 Column holders

Column holder
The Column holder has one position for medium sized columns and one position for
small sized columns. It can be used for columns with outer diameter between 10 and 50
mm.The Column holder can also be used for bottles. Use two holders to attach long
columns.

1 2 3

4

Part Description

1 Position for a medium sized column or bottle

2 Position for a small sized column

3 Tab

4 Snap-in to holder rails

Column clamp
The column clamp can be used to attach small sized columns with outer diameters
between 10 and 21 mm. Use two clamps to attach long columns.
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1

2

Part Description

1 Position for a column

2 Inner end tabs

Column holder rod
The Column holder rod can be used to attach several HiTrap™ columns. The holder has
threaded ports for HiTrap columns and tubing connectors. Push the button of the
holder to attach the holder to a holder rail.

1

2 3

Part Description

1 Snap-in to holder rails

2 Button

2 The ÄKTA avant instrument
2.6 Accessories

2.6.1 Column holders

44  ÄKTA avant User Manual 29035184 AF



Part Description

3 Column holder rod

Flexible column holder
The Flexible column holder can be used to attach, for example, HiScreen™ columns.

2

3

4

5

7

6

9

1

8

Part Function

1 Lower tubing

2 Lower part

3 Snap-in-strips

4 Attachment part

5 Upper tubing

6 Lever

7 Upper part
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Part Function

8 Upper connector

9 Lower connector
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2.6.2 Tubing holders and other accessories

Tubing holder spool
The Tubing holder spool is used to hold and arrange tubing. It is available in two
versions; one for small tubing (o.d. 1/8” and smaller) and one for large inlet tubing (o.d.
3/16”) for AKTA avant 150.

The following illustration shows the Tubing holder spool for small tubing.

1

2 3

Part Description

1 Positions for tubing

2 Tab

3 Snap-in to holder rails

Tubing holder comb
The Tubing holder comb is used to hold and arrange tubing.

1

2

3
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Part Description

1 Positions for tubing

2 Tab

3 Snap-in to holder rails

Bottle holder
The Bottle holder is used for holding bottles. For example, the Bottle holder can be
attached to the holder rails below the Instrument display to hold a sample bottle.

1

2

Part Description

1 Position for bottle

2 Snap-in to holder rails

Adapter for air sensor
The air sensor adapter is used to hold an external air sensor.

The air sensor with adapter is connected to the Bottle holder, see the following illustra-
tions.
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1

2
3

Part Description

1 Bottle holder

2 Air sensor

3 Adapter for air sensor
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Rail extension
The Rail extension rod can be used to attach accessories, for example column holders
or a Multi-purpose holder. The rod has extra rails on both sides. Push the button of the
rod to attach it to a holder rail.

1 2

Part Function

1 Button

2 Extension rod

Multi-purpose holder
The Multi-purpose holder can be used to attach accessories, for example a Loop holder
or a cassette. Attach the holder to a holder rail.

1 2

3 4 3
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Part Function

1 Attachment point for accessories

2 Snap-in to holder rails

3 Attachment points for tubing holders

4 Tab

Loop holder
The Loop holder can be used to attach up to five 10 ml sample loops. Use two Multi-
purpose holders to attach the holder to a holder rail.

1

2

 

 

 

Part Function

1 Upper attachment to
multi-purpose holder

2 Lower attachment to
multi-purpose holder
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2.6.3 Extension box

Description
The Extension box can be used to install extra modules on the ÄKTA avant instrument
outside the system chassis. It is possible to install up to three extension boxes with
extra modules when using ÄKTA avant.

Location
The Extension box can be mounted in two ways.

• Standing on top of or next to ÄKTA avant.

• On a Rail extension rod.

Note: The hanger of the extension box is located on the right or left side of the
box depending on where the removable extension box front (and back) is
attached.

Illustration of Extension box
This illustration shows the front and the back of the Extension box.

1

2

3
4

5

6

7

Part Function

1 Front

2 Front screw

3 Module screw hole

4 Feet

5 Back screw

6 Back
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Part Function

7 Hanger

Compatible instrument modules
The following instrument modules can be placed in the Extension box:

• Any V9 or V9H valve

• Mixer (M9)

• UV monitor (U9-L)

• Conductivity monitor (C9n)
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3 Standard instrument modules

About this section
This section describes the design and main functions of the instrument modules
installed in ÄKTA avant at delivery.

In this chapter

Section See page

3.1 Pumps 55

3.2 Mixer 59

3.3 Valves, overview 60

3.4 Inlet valves 62

3.5 Injection valve 67

3.6 Column valve 70

3.7 Outlet valve 73

3.8 Pressure monitors 75

3.9 pH valve and pH monitor 77

3.10 Built-in fraction collector 80

3.11 UV monitor 92

3.12 Conductivity monitor 94
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3.1 Pumps

Introduction
The ÄKTA avant instrument is fitted with three high precision pumps. There are two
system pumps, System pump A and System pump B, and one Sample pump. The
system pumps can be used individually, or in combination to generate isocratic or
gradient elution in purification methods. The Sample pump is dedicated for direct
loading of sample onto a column, or for filling of sample loops.

This section describes the pumps and their functions, and also the pump piston rinsing
systems.

Function of the pumps
Each pump module consists of two pump heads. The individual heads are identical but
actuated in opposite phase to each other by individual stepper motors, controlled by a
microprocessor. The two pistons and pump heads work alternately to give a contin-
uous, low pulsation, liquid delivery.

To ensure delivery of correct volume, the pumps must be free from air. The purge valve
on each of the pump heads is used to remove air. For instruction on how to purge the
pumps, see Section 5.4 Prime inlets and purge pump heads, on page 157.

The following table contains the operating limits and labels of the system pumps of
ÄKTA avant 25 and ÄKTA avant 150, respectively.

Configuration Label Pump
type

Flow rate Max.
pres-
sure

ÄKTA avant 25 P9 A and P9 B P9 0.001 to 25
ml/min

Note:

When running
the Column
packing flow
instruction, the
maximum flow
rate is 50
ml/min.

20 MPa

ÄKTA avant 25 P9-S P9-S 0.01 to 50
ml/min

10 Mpa
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Configuration Label Pump
type

Flow rate Max.
pres-
sure

ÄKTA avant
150

P9H A and P9H B P9H 0.01 to 150
ml/min

Note:

When running
the Column
packing flow
instruction, the
maximum flow
rate is 300
ml/min.

5 MPa

ÄKTA avant
150

P9H S P9H 0.01 to 150
ml/min

5 MPa

Location and illustration of pumps
The illustration below shows the location of the Sample pump, System pump A, and
System pump B. An enlargement of one of the System pumps is also shown.

Part Description

1 Purge valve: Used to remove air from the pump

2 Check valve: Non-return check valves at the outlet port

3 Connections to pump piston rinsing system: Tubing is connected
between the pumps and the Pump piston rinsing system tubes (9)
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Part Description

4 Check valve: Non-return check valves at the inlet port

5 Pump head: Encapsulates the inner parts of the pump

6 System pump B

7 System pump A

8 Sample pump

9 Pump piston rinsing system tubes

The pump piston rinsing system
A seal prevents leakage between the pump chamber and the drive mechanism. The
seal is continuously lubricated by the presence of eluent. The pump piston rinsing
system continuously flushes the low pressure chamber behind the piston with a low
flow of 20% ethanol prepared in deionized water or equivalent. This prevents any depo-
sition of salts from aqueous buffers on the pistons and prolongs the working life of the
seals.

The pump piston rinsing system tubing is connected to the rearmost holes on the
pump heads.

For instructions on how to fill the rinsing systems, see Section 7.3.1 Change pump
rinsing solution, on page 259.

Illustration of the pump piston
rinsing systems

Part Description

1 Inlet tubing to the sample pump piston rinsing system

2 Outlet tubing from the sample pump piston rinsing system
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Part Description

3 Inlet tubing to the system pump piston rinsing system

4 Outlet tubing from the system pump piston rinsing system
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3.2 Mixer

Introduction
The Mixer is located after System pump A and System pump B and before the Injection
valve. The purpose of the Mixer is to make sure that the buffers from the System pumps
are mixed to give a homogenous buffer composition. The Mixer has a built-in filter that
prevents impurities from reaching the column. For instructions on how to replace the
filter, see Section 7.8.7 Replace the inlet filters, on page 333.

NOTICE

Do not run the system with the mixer attached to the instrument if
no tubing is connected to the mixer. Running the mixer without
liquid in the mixer chamber causes excessive wear of the magnet in
the mixer chamber.

Location and illustration of the Mixer
The following illustration shows the location of the Mixer, and also an enlargement of
the Mixer. In both ÄKTA avant 25 and ÄKTA avant 150 the Mixer is labelled M9.

Part Description

1 Outlet

2 Mixer chamber

3 Inlet
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3.3 Valves, overview

Introduction
The valves of the ÄKTA avant system allow flexibility in the liquid flow path.

This section provides an overview of the valves included in a standard equipped ÄKTA
avant system.

General design and function of rotary
valves

All valves on the ÄKTA avant instrument, except for the Quaternary valve, are rotary
valves. The motorized rotary valve consists of a valve connection block with a number
of defined bores with channels to the inlet and outlet ports of the valve. The rotary disc,
mounted on the motor, has a number of defined channels. The pattern of channels of
the Rotary disc together with the pattern and location of the ports of the valve connec-
tion block, define the flow path and function of each type of valve. When the rotary disc
turns, the flow path in the valve changes.
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Illustration of inlet valve components
The following illustration shows the components of a disassembled Inlet valve A or a
disassembled Inlet valve B.

Part Description

1 Valve connection block

2 Rotary disc

3 Defined channel(s) in the rotary disc

4 Defined bores in the valve connection block

Note: Inlet and outlet ports are not visible in the picture. They are located on the
opposite side of the Valve connection block.
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3.4 Inlet valves

Introduction
The inlet valves are used to select which buffers or samples to use in a run.

Inlet valve A is located before System pump A, Inlet valve B is located before System
pump B, and the Sample inlet valve is located before the Sample pump. Inlet valve A
and Inlet valve B are connected to the Quaternary valve. The Quaternary valve is used
for automatic buffer preparation in BufferPro, and for formation of quaternary gradi-
ents.

The number of inlets can be increased by installing extra inlet valves. For information
on how to install extra valves, please refer to Section 4.1 System extension overview, on
page 96.

This section describes the location and function of the inlet valves.

Location and illustration of inlet
valves

The following illustration shows the location of the inlet valves and also enlargements
of Inlet valve A and the Quaternary valve.

Par
t

Description Label in

ÄKTA avant 25 ÄKTA avant
150

1 Sample inlet valve V9-IS V9H-IS

2 Inlet valve A V9-IA V9H-IA

3 Quaternary valve Q9 Q9
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Par
t

Description Label in

ÄKTA avant 25 ÄKTA avant
150

4 Inlet valve B V9-IB V9H-IB

5 Integrated air sensor (behind the
plug)

NA NA

6 Inlet ports of Inlet valve A A1 to A7 A1 to A7

7 Inlet ports Q1-Q4 of Quaternary
valve

Q1 to Q4 Q1 to Q4

8 Outlet ports from Quaternary valve
to Inlet valve A and Inlet valve B

A and B A and B

Function of Inlet valve A and Inlet
valve B

Inlet valve A and Inlet valve B enable automatic changing between different buffers and
wash solutions, and can be used to generate gradients by mixing buffer from Inlet valve
A and buffer from Inlet valve B.

The air sensors integrated in Inlet valve A and Inlet valve B can be used to prevent intro-
duction of air into the pumps and columns. For information on how to change settings
and parameters for the use of air sensors, see Chapter 5 Operation, on page 147.

The Run Data for air sensors shows the status of the air sensor. If an alarm is triggered
and then acknowledged, the Run Data will be reset to No Air even if there still is air in
the sensor. When the flow starts another alarm will go off if air is still present.

Air sensor sensitivity
The air sensor sensitivity can be set to two values. Normal is used to detect when a
buffer or sample vessel is empty. High is used to detect small air bubbles.

Parameter Air volume detected Usage

ÄKTA avant 25 ÄKTA avant 150

Normal (default) 30 μl 100 μl Detect empty
buffer/sample
vessels

High 10 μl 30 μl Detect even small
air bubbles

Ports of Inlet valve A and Inlet valve B
The following illustration shows the ports of Inlet valve A and Inlet valve B.
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Port Description Port Description

A1-A7 Buffer inlets of Inlet valve A Q Inlet from Quaternary valve

B1-B7 Buffer inlets of Inlet valve B Out To the System pumps

Function of Quaternary valve
The Quaternary valve is used for automatic mixing of four different solutions. The
Quaternary valve opens one inlet port at a time, and the different solutions are mixed in
the Mixer to form the desired buffer. The opening time in the switching valve is
controlled by the system.

The volume for each inlet port opening increases stepwise when the flow increases. To
obtain a homogeneous buffer composition, make sure to use a mixer chamber volume
suitable for the flow rate of the method. For further information, see Select Mixer
chamber, on page 149.

Current mixing percentage for Q1-Q4 are shown in Process Picture in System
Control. The curves for Q1-Q4 can be shown in a chromatogram and stored in the
result data for documentation and for further studies in Evaluation.

Ports of Quaternary valve
The following illustration shows the ports of the Quaternary valve.
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Port Description

Q1-
Q4

Buffer inlets

A Outlet to System pump A via Inlet valve A

B Outlet to System pump B via Inlet valve B

BufferPro
The BufferPro tool allows automatic mixing of buffers during a run. Buffer preparation
can be performed using corresponding acid/base buffer systems. Buffer system,
concentration, pH and salt gradient are defined in the Method Editor.

Note: In ÄKTA avant 25 BufferPro can be run at flow rates up to 25 ml/min. In
ÄKTA avant 150 BufferPro can be run at flow rates up to 40 ml/min.

When using BufferPro, immerse the Q inlets in the solutions according to the
following table.

Inlet Solution Inlet Solution

Q1 Buffer stock solution Q3 Water

Q2 Acid or base Q4 Gradient salt stock solution

Quaternary gradients
The Quaternary valve can be used to create a gradient using four different solutions
simultaneously in any combination. The percentage of each solution is controlled by
instructions in the method. It is possible to form gradients that changes the
percentage of two, three or four solutions linearly over time. This is useful when
advanced methods are developed.

Note: In ÄKTA avant 25 Quaternary gradients can be created at flow rates up to 25
ml/min. In ÄKTA avant 150 Quaternary gradients can be created at flow
rates up to 40 ml/min.
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Function of Sample inlet valve
The Sample inlet valve enables automatic loading of different samples when using the
Sample pump to inject sample directly onto the column or to fill a sample loop.

The Sample inlet valve has an inlet dedicated for buffer. This Buff inlet is used in
methods to fill the Sample pump with solution before sample is introduced. The Buff
inlet is also used to wash the Sample pump with buffer between runs.

The air sensor integrated in the Sample inlet valve is used when sample is applied from
a vessel onto a column by selecting Inject all sample using air sensor in the Sample
application phase of a method. This function uses the Buff inlet to finalize sample
injection and to remove air from the Sample pump.

Ports of Sample inlet valve
The following illustration shows the ports of the Sample inlet valve.

Port Description

S1-S7 Sample inlets

Buff Buffer inlet

Out To Sample pump
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3.5 Injection valve

Function of the Injection valve
The Injection valve is used to direct sample onto the column. The valve enables usage
of a number of different sample application techniques.

The Injection valve is labeled V9-Inj for ÄKTA avant 25 and V9H-Inj for ÄKTA avant
150.

A sample loop or a Superloop can be connected to the Injection valve and filled either
automatically using the Sample pump or manually using a syringe. The sample can also
be injected directly onto the column using the Sample pump.

For instructions on how to connect and use sample loops, see Section 5.7 Sample appli-
cation, on page 181.

Location and illustration of Injection
valve

The following illustration shows the location, together with a detailed view of Injection
valve V9-Inj.

Ports and flow paths of the Injection
valve

The illustration and tables below describe the ports of and different flow paths through
the Injection valve.

The Injection valve can be set to different positions that give different flow paths
through the valve.
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Primary flow path

Flow path for manual load 

Closed flow path

Alternative flow path

Port Description

SaP Inlet from sample pump

SyP Inlet from the System pumps via the Mixer

Syr 1 Syringe connection

Col Outlet to the Column valve.

LoopF Port for connection of a loop or a Loop valve. Used to fill a loop.

LoopE Port for connection of a loop or a Loop valve. Used to empty a loop into
the flow path.

W1 Loop and System pump waste

W2 Sample flow waste

1 For larger sample volumes connect the syringe with the help of a union Luer female to 1/16″
male (default). For smaller volumes it it recommended to use the Fill port INV-907 (18112766)
and connect a syringe with needle.
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Flow path Description

Manual load - Default
position of the valve

The system flow is directed onto the column or column
valve. Sample can be manually injected into the loop.

Excess sample leaves the valve through waste port W1.

Inject The system flow is directed through the loop and onto
the column or column valve. If the sample pump is used,
the flow entering the SaP port is directed to waste port
W2.

System pump waste The system flow is directed to waste port W1. If the
sample pump is used, the flow entering the SaP port is
directed to the column valve.

Direct inject The flow entering the SaP port is directed to the column
valve. This position is used with the sample pump. Flow
entering the SyP port is directed to waste port W1.

Sample pump load The flow entering the SaP port is directed to the loop.
This position is used with the sample pump. Excess
sample leaves the valve through waste port W1. The flow
entering the SyP port is directed to the column or the
column valve.

Sample pump waste The flow entering the SaP port is directed to waste port
W2. This position is used with the sample pump. The flow
entering the SyP port is directed to the column via the
loop.

Note: • In order to avoid sample carry-over when switching techniques for
loading samples, wash the Injection valve with buffer between the
loading of two different samples. For example, when switching from
loading sample onto the loop to loading sample directly onto the Column
with the valve in Direct inject position.

• Make sure that the SaP port is plugged with a stop plug if the Sample
Pump is not connected.
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3.6 Column valve

Introduction
The Column valve is used for connection of columns to the system, and to direct the
flow onto the column. Up to five columns can be connected to the Column valve simul-
taneously. The valve also has a built-in by-pass function that enables by-passing of
connected columns.

Pressure monitors that measure the actual pressure over a column are integrated into
the inlet and outlet ports of the Column valve. For further information on the pressure
monitors, see Section 3.8 Pressure monitors, on page 75.

The number of column positions can be increased by installing an extra Column valve.
For information on how to install extra valves, please refer to Section 4.1 System exten-
sion overview, on page 96.

Location and illustration of the
Column valve

The following illustration shows the location of the Column valve and also an enlarge-
ment of the Column valve with connected columns. In ÄKTA avant 25, the Column valve
is labelled V9-C. In ÄKTA avant 150, the Column valve is labelled V9H-C.

Part Function

1 Inlet port with built-in pressure sensor

2 Column valve

3 Outlet port with built-in pressure sensor

4 HiTrap column connected to ports 2A and 2B

5 HiPrep™ column connected to ports 1A and 1B
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Ports and flow paths of the Column
valve

The following illustration and tables describe the ports of and flow paths through
Column valves V9-C and V9H-C.

By-pass

Port Description

In Inlet from Injection valve via a built-in pressure monitor.

1A-5A Ports for connection to the top of columns.

1B-5B Ports for connection to the bottom of columns.

Out Outlet to UV monitor via a built-in pressure monitor.

Flow path Description

By-pass The flow by-passes the column(s). By-pass is the default flow path.

Down flow The flow direction is from the top of the column to the bottom of the
column. Down flow is the default flow direction.
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Flow path Description

Up flow The flow direction is from the bottom of the column to the top of the
column.

Connect a column to the Column
valve

Both top and bottom of each column shall be connected to the Column valve. The top
of the column shall be connected to an A port (e.g., 1A), and the bottom of the column
shall be connected to the corresponding B port (e.g., 1B). The flow direction can be set
either from the top of the column to the bottom of the column, Down flow, or from the
bottom of the column to the top of the column, Up flow. In the default flow path of the
valve the column is by-passed.
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3.7 Outlet valve

Function of the Outlet valve
The Outlet valve is used to direct the flow to the fraction collector, to an outlet port, or
to waste. The Outlet valve enables collection of fractions. Fractions can be collected by
using a fraction collector connected to the Outlet valve, or by using the 10 outlet ports.
Usage of the outlet ports can be convenient when, for example, a limited number of
large fractions is to be collected. If no fraction collection is needed, the Outlet valve can
be set to direct the flow to waste.

Location and illustration of Outlet
valve

The following illustration shows the location of the Outlet valve and also an enlarge-
ment of the valve. In ÄKTA avant 25, the Outlet valve is labelled V9-O. In ÄKTA avant
150, the Outlet valve is labelled V9H-O.

Ports of the Outlet valve
The following illustration shows the ports of the Outlet valve.
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Port Description

In Inlet port

Frac Port to fraction collector

Out1 - Out10 Outlet ports 1 - 10

W Waste port
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3.8 Pressure monitors

Introduction
Four pressure monitors are included in the ÄKTA avant system. Two pressure monitors
are integrated in the Column valve, and two pressure monitors are connected to the
pumps.

This section describes the location and function of the pressure monitors.

Location and illustration of the
pressure monitors

The following illustration shows the location of the pressure monitors on the instru-
ment, as well as a detailed view of the pressure monitors of the pumps. In both ÄKTA
avant 25 and ÄKTA avant 150 the pressure monitors for the System pumps and Sample
pump are labelled R9.

Part Description

1 Column valve with built-in pre-column pressure monitor and post-
column pressure monitor

2 Sample pump pressure monitor

3 System pump pressure monitor
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Function of system and sample pump
pressure monitors

The pressure monitor of the System pumps measures the system pressure after these
pumps, called System pressure in UNICORN. The pressure monitor of the Sample
pump measures the system pressure after this pump, called Sample pressure in
UNICORN.

For instructions on how to calibrate the pressure monitors, see Section 7.7.2 Calibrate
the pressure monitors, on page 308.

Function of pressure monitors
integrated in the Column valve

The pressure monitors integrated in the inlet and outlet ports
of the Column valves V9-C and V9H-C measure the pressure
just before the column, pre-column pressure (A), and the pres-
sure just after the column, post-column pressure (B).

The delta-column pressure (C), which is the pressure drop
over the column, is calculated as the difference between the
pre-column pressure and the post-column pressure.

Pressure alarms can be set for both the pre-column pressure
and the delta-column pressure. Pressure control of the flow
may be based on either the pre-column pressure or the delta-
column pressure.

For instructions on how to calibrate the pressure monitors,
see Section 7.7.2 Calibrate the pressure monitors, on page
308.

PreC
P

PostC
P

A

C
(= A-B)

B
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3.9 pH valve and pH monitor

Function of the pH valve
The pH valve is used to direct the flow to a pH electrode installed in the integrated flow
cell when inline monitoring of pH is desired during a run. The pH valve is labeled V9-pH
for ÄKTA avant 25 and V9H-pH for ÄKTA avant 150. The Flow restrictor is also
mounted on the pH valve. The Flow restrictor gives a small back pressure which
prevents air bubble formation in the detector flow cells. It is recommended to have it
selected inline.

The valve directs the flow to the pH electrode and to the Flow restrictor, or by-passes
one or both.

Location and illustration of pH valve
The following illustration shows the location of the pH valve, and also an enlargement
of the valve. In ÄKTA avant 25, the pH valve is labelled V9-pH. In ÄKTA avant 150, the
pH valve is labelled V9H-pH.

1

2

3

4

Part Description Part Description

1 pH valve 2 pH electrode

3 pH flow cell 4 Flow restrictor
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Ports and flow paths of the pH valve
The illustration and table below describe the different ports of and flow paths through
the pH valve, in this example labeled V9-pH.

By-pass

Primary flow path

Flow path for calibrations

Closed flow path

Port Description

In From Conductivity monitor

ToR To Flow restrictor

FrR From Flow restrictor

Out To Outlet valve

Cal Calibration port

W3 To Waste

 

Flow path Description

By-pass Both pH electrode and flow restrictor are by-passed.

Restricto
r

Flow restrictor is in use and pH electrode is by-passed.

Restricto
r and pH

Both pH electrode and Flow restrictor are in use.

3 Standard instrument modules
3.9 pH valve and pH monitor

78  ÄKTA avant User Manual 29035184 AF



Flow path Description

pH pH electrode is in use and Flow restrictor is by-passed.

Calibra-
tion

Flow path used when calibrating the pH monitor and when filling the
pH flow cell with storage solution. The Cal port is used to inject solu-
tion into the flow cell using a syringe.

Excess solution leaves the valve through port W3.

pH monitor
The pH monitor continuously measures the pH of the buffer and eluted proteins when
the pH electrode is in-line. When pH monitoring is used, the pH monitor should be cali-
brated every day.

The pH monitor can be calibrated with the pH electrode installed in the pH valve. For
instruction on how to calibrate the pH monitor, please refer to Section 7.7.2 Calibrate
the pressure monitors, on page 308.

The following illustration shows the location of the pH flow cell and a pH electrode
installed in the pH valve.

 

 

 

Pa
rt

Function

1 pH flow cell

2 pH electrode
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3.10 Built-in fraction collector

About this section
This section describes the design and function of the built-in fraction collector.

In this section

Section See page

3.10.1 Function 81

3.10.2 Illustrations of the built-in fraction collector 83

3.10.3 Cassettes, cassette tray and racks 86
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3.10.1 Function

Introduction
ÄKTA avant has a built-in fraction collector for safe and clean handling of fractions. A
cooling function protects the fractions from heat degradation.

Fractions can be collected in deep well plates and in tubes or bottles of different sizes.
Up to six cassettes for deep well plates and tubes can be used. The cassettes can be
used in any combination. Scanner functions identifies the types of cassettes and deep
well plates that are used.

Tubes and deep well plates are placed in cassettes which in turn are placed on the
cassette tray. The cassette tray is placed on the tray support. When the fraction
collector drawer is closed the cassette tray is inserted into the fraction collector
chamber. A height exclusion bar ensures that the tubes and deep well plates are
correctly positioned and cannot damage the dispenser head.

Temperature control
The built-in fraction collector has a temperature control function that provides an
option to set a desired fraction collector chamber temperature. The target tempera-
ture can be set to any whole value between 6°C and 20°C. The default value is 20°C.
Settings for the temperature control function can be edited in the System Settings
dialog box in System Control, or in the Text Instructions pane in Method Editor.

Note: If the difference between the ambient temperature and the target tempera-
ture is too big, it might not be possible to reach the target temperature.

Note: If the temperature control function is turned off, the temperature in the
fraction collector chamber will increase to a temperature higher than the
ambient temperature.

Note: If the cooling unit is turned on for longer periods of time at higher humidity,
there might be a buildup of ice inside the cooling unit. At higher humidity it is
recommended to turn off the cooling off between runs and have the drawer
open for ventilation.

Tip: The temperature in the fraction collector chamber can be viewed as a curve
in the chromatogram.

Scanning of cassettes
When the fraction collector drawer is closed automatic scanning is performed. There
are two types of scanning procedures:

• Full scan: Scanning of cassette type codes to identify which cassette types are
used, and scanning of rows and columns in deep well plates to identify which plate
types are used (24, 48, or 96 wells). Full scan is performed only when the system is in
state Ready.

• Quick scan: Scanning of cassette type codes to identify which cassette types are
used. Quick scan is performed during the run to ensure that correct cassettes are
placed in the fraction collector.
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Fractionation modes to avoid spillage
Two fractionation modes are available which avoid spillage between wells or tubes
during fractionation:

• Accumulator: The accumulator is used to collect liquid during movement between
wells, tubes or bottles. The liquid is then dispensed in the next well or tube. Fractio-
nation with accumulator can be used at all flow rates.

• DropSync: When using DropSync the sensors in the dispenser head detect when a
drop is released from the nozzle. The dispenser head moves to the next well or tube
just after a drop is released. Fractionation with DropSync can be used at flow rates
up to 2 ml/min. Solutions with low surface tension may require a lower flow.

Note: DropSync is used in ÄKTA avant 25 only.

Note: If using the accumulator with buffers with high salt concentration, it is
recommended to regularly use Accumulator Wash between or in
methods.

Fractionation arm positions

• Home position: The home position is used when the fraction collector is idle. The
fractionation arm is positioned in the front of the interior of the fraction collector
and the dispenser head is positioned over the waste funnel. This position is called
Waste (Frac) in UNICORN.

• Frac cleaning position: The fraction collector cleaning position is used for
convenient cleaning of the dispenser head. The fractionation arm is positioned in
the front of the interior of the fractionation collector and the dispenser head is
moved to the center of the fractionation arm.
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3.10.2 Illustrations of the built-in fraction collector

Illustration of the built-in fraction
collector exterior

The illustration below shows the main parts of the built-in fraction collector. A cassette
tray with cassettes is placed in the fraction collector drawer.

Part Description

1 Fractionation drawer

2 Fractionation window

3 Cassette tray with cassettes

4 Height exclusion bar

5 Fractionation drawer handle
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Illustration of the built-in fraction
collector interior

The illustration below shows the main parts of the fractionation chamber inside the
fraction collector.

Part Description

1 Fractionation arm main rail

2 Button cover

3 Fractionation arm

4 Dispenser head

5 Lamp (1 of 2)

6 Tubing from the Outlet valve

7 Cooling unit including circulation fan

8 Waste funnel

9 Tray aligning pins

10 Cassette tray positioning discs (2 of 3)

11 Fractionation arm guide rail
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Illustration of the dispenser head
The illustration below shows the dispenser head of the fraction collector.

Part Description

1 Dispenser head

2 Dispenser head cover

3 Nozzle

4 Accumulator (back part of Dispenser head)

5 DropSync sensor (only in ÄKTA avant 25)

6 Type code reader
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3.10.3 Cassettes, cassette tray and racks

Introduction
Fractions can be collected in deep well plates and in tubes of different sizes. A number
of cassettes and racks for different tubes and deep well plates are available. The
cassettes are placed on a rack with six cassette positions. The cassette type codes are
scanned by the cassette code reader to identify the cassette type.

Available cassettes, trays and racks
The following cassettes and racks are available:

• Cassette 3 ml tubes (for 40 tubes)

• Cassette 5 ml tubes (for 40 tubes)

• Cassette 8 ml tubes (for 24 tubes)

• Cassette 15 ml tubes (for 15 tubes)

• Cassette 50 ml tubes (for 6 tubes)

• Cassette for deep well plate (24, 48, 96 wells)

• Cassette tray (for six cassettes)

• Rack for 50 ml tubes (for 55 tubes)

• Rack for 250 ml bottles (for 18 bottles)

For information on dimension requirements for tubes and deep well plates to be used
in the fraction collector, see Fraction collector tubes and bottles, on page 89 and Deep
well plates, on page 90 respectively.

Illustrations of built-in fraction
collector tray and racks

The illustrations below show the Cassette tray (for six cassettes), the Rack for 50 ml
tubes and the Rack for 250 ml bottles.

The fronts of the tray and the racks are marked with the Cytiva monogram.

In the cassette tray, the cassette positions are marked 1 to 6.

Cassette tray Rack for 50 ml tubes Rack for 250 ml bottles
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Note: The tray and racks are inserted into the fraction collector with the Cytiva
monogram facing outwards.

Note: Do not use the cassette tray when a rack for tubes or bottles is placed in the
fraction collector.

Illustration of cassettes on the
cassette tray

The illustration below shows cassettes placed on the cassette tray.

Part Description

1 Cassette tray

2 Cassette position number

3 Cassette

4 Cassette type code

5 Tubes or deep well plates placed in a cassette

QuickRelease function

The cassettes for the smaller tube sizes (3, 5, 8, and 15 ml) have a built-in QuickRelease
function. The QuickRelease function enables easy handling of tubes in the cassettes.
With the QuickRelease device in lock position the tubes are fastened in the cassette
and can easily be emptied. With the QuickRelease function in release position, the
cassette can easily be loaded with tubes and used tubes can easily be discarded.
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Step Action

1 Load the cassette with tubes before fractionation:

• Pull the QuickRelease device to the release position.

• Load the cassette with tubes, and press the QuickRelease device to the
locked position.

Release position Locked position

2 After fractionation, pull the QuickRelease device to the release position and
remove the tubes containing the fractions you want.
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Step Action

3 Empty and discard the remaining tubes:

• Press the QuickRelease device to the lock position, and empty the
remaining tubes.

• Pull the QuickRelease device to the release position, and discard the
tubes.

Empty the tubes

Discard the tubes

Fraction collector tubes and bottles
The tubes and bottles used in the built-in fraction collector must fulfill the require-
ments listed in the following table. Examples of manufacturers are also listed in the
table.
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Tube or
bottle size
(ml)

Diameter (mm) Height (mm) Examples of
manufacturers

Min. Max. Min. Max.

3 10.5 11.5 50 56 NUNC™

5 10.5 12 70 76 VWR™

8 12 13.3 96 102 BD™ Biosciences,
VWR

15 16 17 114 120 BD Biosciences

50 28 30 110 116 BD Biosciences

250 ml bottle L: 55
W: 551

L: 64.5
W: 641

- 121 Nalgene™ ,
Kautex™

1 Length and width of the rectangular bottle base

Maximum flow rate
Fraction collection can be performed at different maximum flow rates depending on
the size of the tubes and bottles that are used. The following table lists the maximum
flow rates for the fraction collector tubes and bottles.

Tube or bottle size
(ml)

Maximum flow rate (ml/min)

3 15

5 15

8 25

15 40

50 150

250 ml bottle 150

Deep well plates

Requirements
The deep well plates used in the Fraction collector of ÄKTA avant must fulfill the
requirements listed in the table below.
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Property Specification

No. of wells 24, 48, or 96

Shape of wells Square, not cylindrical

Well volume 10, 5, or 2 ml

Approved deep well plates
The plates listed in the table below are tested and approved by Cytiva to be used with
ÄKTA avant.

Plate type Manufacturer Part no.

96 deep well plate Cytiva 7701-5200 (Whatman™)

BD Biosciences 353966

Greiner Bio-One 780270

Porvair Sciences 219009

Seahorse Bioscience S30009

Eppendorf™ 951033405/ 0030
501.306

48 deep well plate Cytiva 7701-5500 (Whatman)

Seahorse Bioscience S30004

24 deep well plate Cytiva 7701-5102 (Whatman)

Seahorse Bioscience S30024

Maximum flow rate
Fraction collection can be performed at different maximum flow rates depending on
what type of deep well plates that are used. The table below lists the maximum flow
rates for the different plate types.

Plate type Maximum flow rate (ml/min)

96 deep well plate 10

48 deep well plate 15

24 deep well plate 25
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3.11 UV monitor

Introduction
This section describes the design and function of UV monitor U9-M. The module
includes a monitor unit and a detector with a UV flow cell.

Function of the UV monitor
UV monitor U9-M measures the UV absorbance at a wavelength range of 190 to 700
nm.

The UV monitor is automatically calibrated every time the instrument is switched on.

A flip-mode enables measuring of UV/Vis absorbance at three wavelengths simultane-
ously during a run. The second and third wavelength can be turned off or on in method
phase properties, by manual instructions or in system settings.

Note: The resolution is decreased when more than one wavelength is used simul-
taneously due to lower sampling frequency per wavelength. Do not use
more wavelengths than necessary.

Location and illustration of UV
monitor

The following illustration shows the location of the UV monitor and also an enlarge-
ment of the monitor unit and detector. In both ÄKTA avant 25 and ÄKTA avant 150 the
monitor unit is labelled U9-M and the detector U9-D.

Part Description Part Description

1 Inlet 3 UV detector

2 UV flow cell 4 Outlet
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UV flow cells

NOTICE

UV and conductivity flow cells on the high pressure side.
When placing UV and/or conductivity flow cells on the high pres-
sure side of the column, the UV flow cell has a maximum pressure
limit of 2 MPa (20 bar) and the conductivity flow cell has a
maximum pressure limit of 5 MPa (50 bar).

UV flow cells are available with three different path lengths; 0.5 mm, 2 mm (default) and
10 mm.

Flow cells with shorter path lengths are suitable to use for high protein concentrations.
Flow cells with longer path lengths are suitable to use for low protein concentrations.

Note: If the UV flow cell with 10 mm path length is used, do not run at flow rates
higher than 50 ml/min as this flow cell increases the back pressure and may
result in a pressure higher than 2 MPa (20 bar).

The real cell path length of the UV cell is automatically recognized by the monitor when
a cell is fitted. The UV data is normalized to the nominal path length. This allows UV
data from runs made with different UV flow cells (but with the same nominal path
length) to be directly compared.

The UV monitor U9-M is automatically calibrated every time the instrument is switched
on. The path lengths of the flow cells are factory calibrated and no further calibration is
needed.
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3.12 Conductivity monitor

Function of the Conductivity monitor
The Conductivity monitor continuously measures the conductivity of buffers and
eluted proteins.

The Conductivity flow cell has two electrodes positioned in the flow path of the cell. An
alternating voltage is applied between the electrodes and the resulting current is
measured and used to calculate the conductivity of the eluent.

The conductivity is automatically calculated by multiplying the measured conductance
by the cell constant of the flow cell. The cell constant is factory-calibrated on delivery
but can be re-calibrated if needed, see Section 7.7.3 Calibrate the Conductivity Monitor,
on page 312.

As variation in temperature influences conductivity readings, the conductivity flow cell
is fitted with a temperature sensor that measures the temperature of the eluent. A
temperature compensation factor can be set in System settings and is used to report
the conductivity in relation to a set reference temperature.

Location and illustration of
Conductivity monitor

The following illustration shows the location of the Conductivity monitor and also an
enlargement of the monitor. In both ÄKTA avant 25 and ÄKTA avant 150 the monitor is
labelled C9.

Part Description Part Description

1 Inlet 2 Conductivity flow cell

3 Conductivity monitor 4 Conductivity monitor cable

5 Outlet

3 Standard instrument modules
3.12 Conductivity monitor
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4 Optional instrument modules

About this chapter
This chapter contains detailed instructions on the optional instrument modules that
can be connected to the ÄKTA avant instrument. A brief description of how to install
the modules is also provided.

In this chapter

Section See page

4.1 System extension overview 96

4.2 Installation of optional modules 97

4.3 Extra inlet valves 104

4.4 Second Column valve 108

4.5 Extra Outlet valves 111

4.6 External air sensors 114

4.7 Loop valve 118

4.8 Versatile valve 122

4.9 Fraction collector F9-R 124

4.10 Second Conductivity monitor 131

4.11 Second UV monitor 132

4.12 I/O-box 135

4.13 General system settings 145

4 Optional instrument modules
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4.1 System extension overview

Introduction
The ÄKTA avant instrument can easily be extended with additional valves, detectors
and a second fraction collector. There are a large number of different hardware
modules to choose from in order to customize the number of columns, inlets, outlets,
detectors and ways to apply and collect samples. For a list of optional modules see 
Description of optional modules, on page 24.

 

System extension stages
Extension of the system consists of four main stages:

Stage Description

1 Select modules and positions

2 Install the module(s)

3 Edit system properties

4 Edit system settings

4 Optional instrument modules
4.1 System extension overview
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4.2 Installation of optional modules

Introduction
Up to six extra modules can be installed in the system: three modules can be installed
on the system wet side using the free module positions (module panels are installed in
these positions at delivery), and three modules can be connected to the back of the
instrument.

Note: Do not remove any module panels and then leave the position empty. It will
affect instrument function.

To obtain an optional flow path, it is also possible to move the standard valves to other
positions. The illustration below shows the free module positions, marked in orange.

The Extension box can be used to hold modules connected to the back of the instru-
ment. See Section 2.6.3 Extension box, on page 52 for more information.

Node ID
Most of the available optional modules are preconfigured to give the desired function.
However, the function of a module or valve can be changed by changing its Node ID.
Node ID is also used by the instrument to distinguish between several units of the same
type.

Refer to Section 9.15 Check and change the Node ID of a module, on page 496 for
instructions on how to check and change the Node ID of a module.

Install a module in the instrument

The instruction below describes how to install the module hardware in the instrument.

4 Optional instrument modules
4.2 Installation of optional modules
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Note: The illustrations show the principle how to install an optional module. The
position of the module on the instrument and the used type of module will
depend on the module being installed.

CAUTION

Disconnect power. Always switch off power to the ÄKTA avant
instrument before replacing any of its components, unless stated
otherwise in the user documentation.

Step Action

1 Disconnect power from the instrument by switching off the instrument
power switch.

2 Loosen the connectors and remove the tubing from the existing module.

Note:

This step does not apply for a Module Panel.

3 Loosen the module with a Torx T20 screwdriver.

4 Remove the module.

4 Optional instrument modules
4.2 Installation of optional modules
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Step Action

5 Disconnect the cable and secure it in the slit.

6 Connect the cable to the module to be installed.

7 Insert the module.

4 Optional instrument modules
4.2 Installation of optional modules
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Step Action

8 Fasten it with a Torx T20 screwdriver.

Note: A warning message is displayed at start up if a module has been installed in
the instrument but not added to the System Properties dialog box in
UNICORN.

ÄKTA avant connector plate
Modules not installed in the instrument cabinet are connected via a UniNet-9 cable at
the back of the system. It is possible to connect up to three external modules.

The following illustration shows the connector plate with the UniNet-9 connectors
located on the back of the ÄKTA avant instrument.

4 Optional instrument modules
4.2 Installation of optional modules
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Part Function

1 UniNet-9 connectors (one connector is occupied by the Conductivity
monitor)

2 Network connector (Ethernet)

3 Test point for service.

4 Power input connector

NOTICE

Do not connect any module to the connector Test on the ÄKTA
avant instrument.

Note: Plug all unused UniNet-9 ports on the ÄKTA avant instrument with jumpers.

Note: The connector Test should be protected by a plastic lid. Do not plug the
connector with a jumper.

Constraints on optional modules
The table below indicates usage constraints for the different external modules.

External module Constraints

I/O-box E9 I/O-box E9 has no constraints.

I/O-box E9, 2nd I/O-box E9, 2nd requires I/O-box E9.

Fraction collector 2 Fraction collector 2 requires Fraction collector and
can not be installed at the same time as Outlet valve
2nd or 3rd.

External air sensor External air sensor has no constraints

Optional module mounted
in Extension box

See respective section for each module.

Note: To optimize signal quality, the total cable length connecting all external
modules to the ÄKTA avant instrument should not exceed 10 m.

Edit System Properties

When a new module has been installed, the system properties have to be updated in
UNICORN. The system will restart automatically when the configuration has been
changed in the System Properties dialog box and then the system can be recon-
nected.

There are four main types of modules (named components in UNICORN) to select from:

4 Optional instrument modules
4.2 Installation of optional modules
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• Valves and pumps

• Monitors and sensors

• Fraction collectors

• Other (e.g., I/O-box)

More than one component of the same type is only available if the first has been
selected. The selection made is reflected in which instructions and phase properties
that are available.

The following instruction gives a general description of how to update the system
properties in UNICORN.

Step Action

1 • In the Administration module. On the Tools menu, click System Prop-
erties or click the System Properties button to open the dialog box.

Result:

The System Properties dialog box is displayed.

• Select the system of interest in the System Properties dialog box.

• Click Edit.

Note:

Only active systems can be edited.

Result:

The Edit dialog box is displayed.

4 Optional instrument modules
4.2 Installation of optional modules
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Step Action

2 Select the component type of interest from the Component types list.

Result:

All available components are shown in the Component selection list.

• Select the checkbox to select the added component.

• When applicable, choose the appropriate Property.

Note:

Instrument modules are referred to as Components in UNICORN.

3 Click the OK button to apply the changes.

Edit system settings
It may be necessary to edit the System Settings when the configuration of the system
is changed. For example, if the change in configuration affects the delay volume
following the UV monitor (or other monitor connected via the I/O-box) the appropriate
system settings for Delay volumes have to be updated. This is to ensure that the frac-
tions marked in the chromatogram corresponds to the actual collected fractions.

Other system settings might also need to be edited for some optional modules.

All system settings available for ÄKTA avant are found in Section 9.7 System settings,
on page 439.

4 Optional instrument modules
4.2 Installation of optional modules
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4.3 Extra inlet valves

Introduction
In the ÄKTA avant standard configuration, 7 inlets are available for each inlet valve. To
increase the number of inlets, a second inlet valve can be installed that increases the
number of inlets to 14 for one of the valves. This optional configuration can be conven-
ient for example when a larger number of samples will be used.

There are also general inlet valves which can be used to increase the number of inlets
to for example the Quaternary valve.

Note: The general inlet valves are delivered without built-in air sensors.

Location of ÄKTA avant inlet valves
Second Inlet valves (V9-A2, V9-B2 or V9H-A2, V9H-B2) or second Sample inlet valve
(V9-S2 or V9H-S2) can be installed in the lower free position as illustrated below. To
obtain an optional flow path, it is also possible to move the standard valves to other
positions.

Flow paths in ÄKTA avant
Second Sample inlet valve

The illustration below shows an optional flow path when a second Sample inlet valve is
installed. The flow is directed from the Out port of the second Sample inlet valve (V9-
S2 or V9H-S2) to the buffer port BUFF of the Sample inlet valve (V9-IS or V9H-IS) and
leaves the valve through the Out port to the Sample pump. In the software, 14 sample
inlets can now be selected.

4 Optional instrument modules
4.3 Extra inlet valves
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S11

S12
S13S14
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Second Inlet valve

The illustration below shows an optional flow path when a second Inlet valve is
installed, connected to Inlet valve A. The flow is directed from the Out port of the
Second Inlet valve (V9-A2 or V9H-A2) to port A7 of the Inlet valve (V9-IA or V9H-IA)
and leaves the valve through the Out port to the System pump A. In the software, 14 A
inlets can now be selected.

Out Out

V9-A2 V9-IA

A1
A2A3

A4

A5
A6 A7

Q

7
8 9

10

11
1213

14
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Connect tubing

• Connect tubing from port 7 of one of the standard inlet valves (Inlet valve A or Inlet
valve B) to port Out of the second Inlet valve..

and/or

• Connect tubing from port BUFF of the standard Sample inlet valve to port Out of
the second Sample inlet valve.

The table below shows recommended tubing and connectors. For an illustration of
tubing labels see Tubing labels, on page 413.

Connection
between the
extra Inlet valve
and...

Tubing
label

Tubing Connector Tubing
length
(mm)

Inlet valve A InA2 For ÄKTA avant
25: FEP, o.d. 1/8",
inner diameter
(i.d.) 1.6 mm

For ÄKTA avant
150: FEP, o.d.
3/16", i.d. 2.9 mm

For ÄKTA avant
25: Tubing
connector,
5/16" with
Ferrule (yellow),
1/8"

For ÄKTA avant
150: Tubing
connector,
5/16" + Ferrule
(blue), 3/16"

250

Inlet valve B InB2 350

Sample inlet
valve

InS2 200

Note: For runs with small volumes of sample, the sample inlet tubing can be
changed to narrow inlet tubing, ETFE, o.d. 1/16", i.d. 0.75 mm (28957217).

Inlet valves X1 and X2
Inlet valve X1 and Inlet valve X2 are inlet valves that can be used to create different flow
paths. They can be combined with any of the other inlet valves or be used on their own.
The valves can be placed anywhere, depending on the desired purpose.

Note: To create methods with the use of the valves, Text Instruction mode has to
be selected in the Method Editor. The valves will be visible in the Instruc-
tion Box for Flow path.

ÄKTA avant 25

product name

ÄKTA avant 25

instrument label

ÄKTA avant 150
product name

ÄKTA avant 150
instrument label

Inlet valve V9-X1 V9-IX Inlet valve V9H-
X1

V9H-IX

Inlet valve V9-X2 V9-IX Inlet valve V9H-
X2

V9H-IX

4 Optional instrument modules
4.3 Extra inlet valves
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The Inlet valves X1 and X2 can for example be used to increase the number of inlets to
the Quaternary valve.

For ÄKTA avant 25, the recommended tubing is FEP, o.d. 1/8", i.d. 1.6 mm with Tubing
connector, 5/16" with Ferrule (yellow), 1/8".

For ÄKTA avant 150: the recommended tubing is FEP, o.d. 3/16", i.d. 2.9 mm with Tubing
connector, 5/16" + Ferrule (blue), 3/16".

Tubing length depends on location.

System properties

Follow the instruction to update the system properties.

Step Action

1 Open the system properties Edit dialog box.

2 In the Component types list, click Valves and pumps

3 In the Component selection list, select the check boxes corresponding to
the installed modules. Then click OK.

System settings
There are no system settings available for the inlet valves.

4 Optional instrument modules
4.3 Extra inlet valves
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4.4 Second Column valve

Introduction
When using the ÄKTA avant standard configuration with one column valve, 5 column
positions are available. To increase the number of column positions to 10, an additional
column valve can be installed in the instrument. One application is for evaluation of a
number of different columns during method optimization.

Location and illustration
A recommended flow path is to move the Column valve (V9-C or V9H-C) to the free
upper position (Fig A) and to install the second Column valve (V9-C2 or V9H-C2) in the
previous position of Column valve V9-C or V9H-C (Fig B).

Flow path
The second Column valve (V9-C2 or V9H-C2) is connected after the standard Column
valve (V9-C or V9H-C). Port Out of the standard Column valve is connected with port
In of the second Column valve. Ten columns can now be selected in UNICORN.

4 Optional instrument modules
4.4 Second Column valve
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Note: The standard Column valve (V9-C or V9H-C) must be connected before the
second Column valve (V9-C2 or V9H-C2). Otherwise, the pressure monitors
will not function correctly.

Connect tubing

For an illustration of standard tubing labels see Tubing labels, on page 413.

Step Action

1 Remove the piece of standard tubing between the Injection valve (V9-Inj or
V9H-Inj) and the standard Column valve (V9-C or V9H-C).

2 Connect tubing between the Injection valve, column valves and the UV
monitor according to the following table.

Connection

between...

Tubing
label

Tubing Connector Tubing
length
(mm)

Injection valve and
Column valve

5C1 1 For ÄKTA avant
25: PEEK, o.d.
1/16", i.d. 0.50
mm

For ÄKTA avant
150: PEEK, o.d.
1/16", i.d. 1.0
mm

For ÄKTA avant
25: Fingertight
connector, 1/16"

For ÄKTA avant
150: Fingertight
connector, 1/16"

100

standard Column
valve and second
Column valve

5C2 1 100

second Column
valve and UV
monitor

6 2 160

1 Cut the spare piece of tubing delivered with the system to correct length.
2 The original connection between the standard Column valve and the UV monitor can be used.

System properties

Follow the instruction to update the system properties.

Step Action

1 Open the system properties Edit dialog box.

2 In the Component types list, click Valves and pumps.

3 Select the Column valve 2nd (V9-C2) or Column valve 2nd (V9H-C2)
check box in the Component selection list. Then click OK.

4 Optional instrument modules
4.4 Second Column valve
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System settings

The built-in pressure sensors for Column valves V9-C and V9H-C have to be re-cali-
brated after installation. See Section 7.7.2 Calibrate the pressure monitors, on page
308.

A pre-column pressure alarm shall always be set to protect the column. See Section 5.6
Set pressure alarms, on page 179 for how to protect columns.

4 Optional instrument modules
4.4 Second Column valve
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4.5 Extra Outlet valves

Introduction
When using the standard configuration with one Outlet valve, 10 outlet positions are
available. To increase the number of outlets, one or two extra Outlet valves can be
connected, adding up to a total of 21 or 32 outlet positions. This optional configuration
is convenient when collecting a number of large fractions outside the fraction
collector.

Locations and illustrations
It is recommended to install the extra outlet valves in the middle and in the lower posi-
tion. The illustration below shows the recommended positions.

Flow path
The tubing from the pH monitor is connected to the In port of the Outlet valve (V9-O or
V9H-O). The Out 10 port of the Outlet valve (V9-O or V9H-O) is connected to the In
port of the second Outlet valve (V9-O2 or V9H-O2). The Out 21 port of the second
Outlet valve is connected to the In port of the third Outlet valve.

The following illustration shows the flow path with two extra Outlet valves installed on
ÄKTA avant 25.

4 Optional instrument modules
4.5 Extra Outlet valves
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V9-pH

Note: The second or third Outlet valve can not be installed together with the
second Fraction collector F9-R.

Connect tubing
The table below shows recommended connectors and tubing. For an illustration of
standard tubing labels see Tubing labels, on page 413.

Connection
between...

Tubing
label

Tubing Connector Tubing
length
(mm)

standard Outlet
valve and second
Outlet valve

10 1 For ÄKTA avant
25: PEEK, o.d.
1/16", i.d. 0.50
mm

For ÄKTA avant
150: PEEK, o.d.
1/16", i.d. 1 mm

For ÄKTA avant
25: Fingertight
connector,
1/16"

For ÄKTA avant
150: Fingertight
connector,
1/16"

220

second Outlet
valve and third
Outlet valve

11 1 220

1 Cut the spare piece of tubing delivered with the system to correct length.

System properties

Follow the instruction to update the system properties.

4 Optional instrument modules
4.5 Extra Outlet valves
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Step Action

1 Open the system properties Edit dialog box.

2 In the Component types list, click Valves and pumps.

3 In the Component selection list, select the check boxes corresponding to
the installed modules. Then click OK.

System settings
If the valve is placed in the flow path between the UV monitor and the outlet valve, the
delay volume must be set. See Check or set delay volumes, on page 145.

Note: It is recommended not to alter the default values for restrictor and pH cell
delay volumes when standard modules and standard tubing for flow
restrictor are used.

4 Optional instrument modules
4.5 Extra Outlet valves
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4.6 External air sensors

Introduction
Two external air sensors are available as options. The difference is their size and where
they can be installed. ÄKTA avant supports installation of one external air sensor at a
time.

L9-1.5 external air sensor
L9-1.5 has a inner diameter (i.d.) of 1.5 mm and is designed for 1.6 mm i.d. tubing at the
low pressure side before the pumps. It is installed before the Sample inlet valve and is
used to prevent air from entering the Sample inlet valve.

L9-1.2 external air sensor
L9-1.2 has a 1.2 mm i.d. and is designed for 1/16" tubing outer diameter at the high
pressure side before the column. It is installed after the Injection valve and is used to
prevent air from entering the Column valve.

The air sensors can be attached to the instrument using the rails. No module panels
need to be removed.

The Run Data for air sensors shows the status of the air sensor. If an alarm is triggered
and then acknowledged, the Run Data will be reset to No Air even if there still is air in
the sensor. When the flow starts another alarm will go off if air is still present.

4 Optional instrument modules
4.6 External air sensors
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Location and illustration
The following illustration shows the recommended positions for the external air
sensors.

1

2

Part Function

1 L9-1.5 external air sensor before Sample inlet valve

2 L9-1.2 external air sensor after Injection valve

Note: Only one external air sensor can be installed at a time.

Connect tubing

L9-1.5

Connection

between...

Tubing
label

Tubing Connector Tubing
length
(mm)

L9-1.5 and V9-IS
or V9H-IS

L FEP, o.d. 1/8", i.d.
1.6 mm

Tubing
connector,
5/16" + Ferrule
(yellow), 1/8"

200

4 Optional instrument modules
4.6 External air sensors
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L9-1.2

Connection

between...

Tubin
g
label

Tubing Connector Tubin
g
lengt
h
(mm)

V9-Inj or V9H-Inj
and L9-1.2

5L1 1 For ÄKTA avant
25: PEEK, o.d.
1/16", i.d. 0.50
mm

For ÄKTA avant
150 : PEEK, o.d.
1/16", i.d. 1 mm

For ÄKTA avant
25: Fingertight
connector, 1/16"

 

For ÄKTA avant
150: Fingertight
connector, 1/16"

100

L9-1.2 and V9-C or
V9H-C

5L2 1 For ÄKTA avant
25: PEEK, o.d.
1/16", i.d. 0.50
mm

For ÄKTA avant
150: PEEK, o.d.
1/16", i.d. 1 mm

For ÄKTA avant
25: Fingertight
connector, 1/16"

 

For ÄKTA avant
150: Fingertight
connector, 1/16"

100

1 Cut the spare piece of tubing delivered with the system to correct length.

System properties

Follow the instruction to update the system properties.

Step Action

1 Open the system properties Edit dialog box.

2 In the Component types list, click Monitors and sensors.

3 Select the External air sensor (L9) check box in the Component selec-
tion list.

4 In the Property list, click Before sample inlet or After injection valve
depending on where the air sensor is placed.

Note:

The available properties are the same, regardless of which type of air sensor
that is used, L9-1.2 or L9-1.5.

5 Click OK.

4 Optional instrument modules
4.6 External air sensors
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System settings
The sensitivity of the external air sensor can be set.

Parameter Air volume detected Usage

ÄKTA avant 25 ÄKTA avant 150

Normal (default) 30 μl 100 μl Detect empty
buffer/sample
vessels

High 10 μl 30 μl Detect even small
air bubbles

Note: The sensitivity should be set to Normal when the air sensor is located
before the Sample pump (Before sample pump). Due to higher pressure
and risk of small air bubbles, the sensitivity should be set to High when the
air sensor is located after the Injection valve (After injection valve).

4 Optional instrument modules
4.6 External air sensors
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4.7 Loop valve

Function of the Loop valve
The Loop valve allows the user to connect several loops simultaneously to the instru-
ment. It can for example be used for storing intermediate fractions in multi-step purifi-
cations, for storing samples to be used in scouting runs, or for storing eluents needed
in low volumes. The valve also has a built-in by-pass function that enables by-passing
all loops. The Loop valve is labeled V9-L or V9H-L.

Location and illustration of Loop
valve

The illustration below shows the recommended location, together with a detailed view
of Loop valve V9-L.

4 Optional instrument modules
4.7 Loop valve
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Ports and flow paths of the Loop valve
The illustration and tables below describe the ports and different flow paths through
the Loop valve. In the Position 4 example, the loop is connected to loop position 4 and
the loop is being emptied.

Port Description

F Port connected to the LoopF port of the Injection valve.

1F and 1E to
5F and 5E

Ports for connection of loop 1 to loop 5.

E Port connected to the LoopE port of the Injection valve.

Note: Ports denoted by the letter F are used for filling the loop and ports denoted
by the letter E are used for emptying the loop.

Flow path Description

Position 1-5 The flow direction depends on the Injection valve position.

By-pass The flow by-passes the loop(s). By-pass is the default flow path.

Connect tubing
The table below shows recommended tubing and connectors. For an illustration of
tubing labels see Tubing labels, on page 413.

4 Optional instrument modules
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Tubi
ng

labe
l

Connection Tubing Connector Tubing
length
(mm)ÄKTA avant

25
ÄKTA avant
150

L1 Injection valve
position LoopF to

Loop valve posi-
tion F

PEEK,

o.d. 1/16",

i.d. 0.50 mm

PEEK,

o.d. 1/16",

i.d. 1.0 mm

Fingertight connector,
1/16"

160

L2 Injection valve
position LoopE to

Loop valve posi-
tion E

PEEK,

o.d. 1/16",

i.d. 0.50 mm

PEEK,

o.d. 1/16",

i.d. 1.0 mm

Fingertight connector,
1/16"

160

Connect a Loop valve

The Loop valve is connected to the Injection valve instead of a loop, as described below.

Step Action

1 Connect port E on the Loop valve to port LoopE on the Injection valve.

2 Connect port F on the Loop valve to port LoopF on the Injection valve.

3 Connect one or many loops to the Loop valve. See Section 5.7 Sample appli-
cation, on page 181.

Note:

Always use the the first positions of the valve for the connected loops (e.g., if
three loops will be used, use port 1F-3F and the corresponding ports 1E-3E)
to avoid cross-contamination.

Note: It is possible to place the Loop valve in other positions in the flow path than
the one described above. However, the volume used for washes will then be
incorrect, just as the system configuration shown in the process picture.

System properties

Follow the instruction to update the system properties.

Step Action

1 Open the system properties Edit dialog box.

2 In the Component types list, click Valves and pumps

4 Optional instrument modules
4.7 Loop valve
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Step Action

3 Select the Loop valve (V9-L) or Loop valve (V9H-L) check box in the
Component selection list. Then click OK.

System settings
The flow rate for Loop wash can be set.

Instruction name Description

Loop wash settings Sets the flow rate used during Loop wash.

Note:

The flow rate should not exceed 10 ml/min if narrow
inlet tubing (i.d. 0.75 mm) is used.

4 Optional instrument modules
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4.8 Versatile valve

Function of the Versatile valve
The Versatile valve is a 4-port, 4-position valve, which can be used to add extra features
to the flow path. For example, the valve can be used to connect external equipment to
the flow path during parts of a run. The versatile valve is labeled V9-V or V9H-V.

It is possible to install up to four versatile valves simultaneously in ÄKTA avant. The
configuration is defined by the module's Node ID. The Node ID is set by positioning the
arrows of the two rotating switches at the back of the valve, see Section 9.15 Check and
change the Node ID of a module, on page 496.

The valve can be installed in any free module position. It is also possible to install the
valve in an Extension box. See Section 2.6.3 Extension box, on page 52.

Ports and flow paths of the Versatile
valve

The following illustration and table describe the different ports of and flow paths
through the Versatile valve. The valve has four ports (1-4).

The Versatile valve has four available sets of flow paths; two where a single flow
channel is used and two where the flow can be directed through two different channels
simultaneously.

Flow path Description

1-3 A single flow channel where the flow is directed between port 1 and
port 3.

2-4 A single flow channel where the flow is directed between port 2 and
port 4.

1-4 and
2-3

Two simultaneously used flow channels where the flow is directed
between port 1 and port 4 and between port 2 and port 3.

1-2 and
3-4

Two simultaneously used flow channels where the flow is directed
between port 1 and port 2 and between port 3 and port 4.

4 Optional instrument modules
4.8 Versatile valve
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System properties

Follow the instruction to update the system properties.

Step Action

1 Open the system properties Edit dialog box.

2 In the Component types list, click Valves and pumps.

3 In the Component selection list, select the check boxes corresponding to
the installed modules. Then click OK.

System settings
If the valve is placed in the flow path between the UV monitor and the outlet valve, the
delay volume must be set. See Check or set delay volumes, on page 145.

4 Optional instrument modules
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4.9 Fraction collector F9-R

Introduction
The external Fraction collector F9-R is installed as the second fraction collector in the
ÄKTA avant system. It is used to expand the fractionation capabilities of the ÄKTA
avant or used to fractionate volatile solutions for example in reversed phase separa-
tions.

Set Node ID
The Node ID of the external Fraction collector F9-R must be set to 1 in order to be used
in the in the ÄKTA avant system. The Node ID is set by positioning the arrow of the
rotating switch at the back of the fraction collector. See Connector panel illustration, on
page 126 and Section 9.15 Check and change the Node ID of a module, on page 496.

Function
The external fraction collector can be used for:

• Fixed volume fractionation

• Peak fractionation

• Combined fixed volume fractionation and peak fractionation

• Collecting fractions in reversed phase separations using organic solvents

Fraction collector F9-R has the following function for reducing sample spill during frac-
tionation:

• DropSync

Front view illustration
The following illustration shows the main parts of the Fraction collector.

4 Optional instrument modules
4.9 Fraction collector F9-R
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Part Function

1 Lock knob

2 Stationary part of delivery arm

3 Delivery arm

4 Tubing connector

5 Tube sensor

6 Collection tubes

7 Tube rack

8 Base unit

4 Optional instrument modules
4.9 Fraction collector F9-R
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Connector panel illustration
The illustration below shows the main parts of the connector panel on the fraction
collector.

1 22

Part Function

1 Node ID switch

2 UniNet-9 F-type connector (for communication and power supply)

Available tubes
For Fraction collector F9-R the fractions are collected in tubes of different sizes.

Tubes with the following diameter can be used with Fraction collector F9-R:

• 12 mm

• 18 mm

• 30 mm

The tubes can have a tube length between 50 to 180 mm.

4 Optional instrument modules
4.9 Fraction collector F9-R
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Illustration of the Fraction collector
F9-R tube rack

Each tube rack is made up of a combination of a Bowl, Tube support, Tube guide and
Tube holder. For more information on the assembly of the tube rack, see Assembly
instructions, on page 201. For information on which Tube rack to use, see Tube rack
inserts, on page 200.

1

2

345
6

Part Function

1 Single cutout

2 L-shaped cutout

3 Bowl

4 Tube support

5 Tube guide

6 Tube holder

Note: Note that the tube guide has both single and L-shaped cutouts, while the
tube holder only has single cutouts. See Single and L-shaped cutouts, on
page 201 for more information.

4 Optional instrument modules
4.9 Fraction collector F9-R
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Standard tubing dimensions
The table below shows recommended standard tubing dimensions to connect Fraction
collector F9-R.

System Tubing
length (mm)

Tubing diameter (mm)

ÄKTA avant 25 500 0.50

ÄKTA avant 150 500 1.00

Note: Cut the tubing according to the table above from the spare tubing delivered
with the ÄKTA avant instrument.

Connect tubing to the ÄKTA avant
instrument

Follow the instructions in the table to connect the tubing from the fraction collector to
the ÄKTA avant instrument.

Step Action

1 Lift out the tubing holder (4) from the delivery arm (1).

3

4

5

6

2 Loosen the nut of the tubing holder. Do not remove the tubing holder nut (5)
from the tubing holder.

3 Insert the tubing through the tubing holder.

4 Place the tubing holder with the tubing over the tube adjustment cavity (2) of
the delivery arm. Push the tubing down against the bottom of the tube
adjustment cavity, and then fingertighten the tubing holder nut. This
ensures the correct length of the exposed tubing end (6).

5 Re-install the tubing holder in the delivery arm.

4 Optional instrument modules
4.9 Fraction collector F9-R

128  ÄKTA avant User Manual 29035184 AF



Step Action

6 Connect the tubing from the fraction collector to port Out 10 on the Outlet
valve.

7 Adjust the delay volume setting in UNICORN to the volume of the tubing, see 
Set the delay volume in UNICORN, on page 487 for more details.

System properties

Follow the instruction to update the system properties.

Step Action

1 Open the system properties Edit dialog box.

2 In the Component types list, click Fraction collectors.

3 Select the Fraction collector 2 (F9-R) check box in the Component
selection list. Then click OK.

Note: The Fraction collector check box must be selected for the Fraction
collector 2 (F9-R) check box to be available.

Note: the Fraction collector 2 (F9-R) check box is not available if the second or
third Outlet valve is installed.

4 Optional instrument modules
4.9 Fraction collector F9-R
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System settings
If non-standard tubing is used between the outlet valve and the fraction collector, the
delay volume must be set. See Check or set delay volumes, on page 145. Fraction
settings and numbering mode can also be set.

Instruction name Description

Fractionation settings
frac 2

DropSync on or off. It is recommended to use this
setting for flow rates below 2 ml/min. Higher flow rates
can however be used, depending on the properties
(e.g. surface tension) of the liquid.

Fractionation numbering
mode frac 2

Determines whether fraction number for the fraction
collector 2 is reset at the end of a method or not.

Note:

The default setting is Reset.

Peak fractionation
parameters

Peak fractionation parameters sets the detection
parameters for peak collection, i.e. it determines when
a peak starts and ends. This information is used by the
instructions Peak fractionation, Peak fractiona-
tion frac 2 and Peak frac in outlet valve in order to
start/end the peak collection.

4 Optional instrument modules
4.9 Fraction collector F9-R
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4.10 Second Conductivity monitor

Introduction
It is possible to use two conductivity monitors. The second Conductivity monitor could
for example be placed before the column for extended gradient control or on a sample
inlet line for control of ionic strength in the sample.

Location
The recommended position of the second Conductivity monitor is dependent on
column size or where the Sample inlet valve is placed. The nearest empty module posi-
tion should be used. It is possible to install the module in an Extension box. See Section
2.6.3 Extension box, on page 52.

NOTICE

UV and conductivity flow cells on the high pressure side.
When placing UV and/or conductivity flow cells on the high pres-
sure side of the column, the UV flow cell has a maximum pressure
limit of 2 MPa (20 bar) and the conductivity flow cell has a
maximum pressure limit of 5 MPa (50 bar).

Connect tubing
When connecting a second Conductivity monitor to ÄKTA avant use the tubing dimen-
sions that are most suitable for the chosen location and application.

System properties

Follow the instruction to update the system properties.

Step Action

1 Open the system properties Edit dialog.

2 In the Component types list, click Monitors and sensors.

3 Select the Conductivity monitor 2nd (C9) check box in the Component
selection list. Then click OK.

System settings
If the monitor is placed in the flow path between the UV monitor and the outlet valve,
the delay volume must be set. See Check or set delay volumes, on page 145.

4 Optional instrument modules
4.10 Second Conductivity monitor
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4.11 Second UV monitor

Introduction
It is possible to use up to two UV monitors simultaneously, a UV monitor U9-L can be
installed alongside the standard UV monitor U9-M. The second UV monitor could for
example be used to enable the user to cover a larger dynamic range in UV absorbance
measurements by using different cell lengths. The two monitors should then be placed
as close as possible to each other. The second monitor could also be used to monitor
the absorbance of incoming feed and is then placed in the flow path just before the
column valve.

Function of UV monitor U9-L
The UV monitor U9-L continuously measures the UV absorbance at the fixed wave-
length of 280 nm.

It is not possible to vary the wavelength, or turn on or off the U9-L monitor. This is
therefore not shown in the Phase Properties pane in Method Editor. However, in a
predefined method the second UV monitor will be auto zeroed at the same time as the
U9-M monitor.

Illustration of UV monitor U9-L
The following illustration show a detailed view of the monitor and detector.

Part Description

1 Inlet

4 Optional instrument modules
4.11 Second UV monitor
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Part Description

2 UV monitor U9-L

3 UV flow cell. Two different path lengths are available:

2 mm (default) and 5 mm

4 Outlet

5 UV detector

Location of UV monitor U9-L
Depending on the application, the second UV monitor can be placed at different posi-
tions in the flow path, for example close to the first UV monitor or before the Column
valve. Use the nearest empty module position or an Extension box to hold the second
UV monitor U9-L. See Section 2.6.3 Extension box, on page 52.

The second UV monitor can be located anywhere in the flow path and is therefore
shown in the Process Picture in UNICORN as a component without a fixed place. This
means that it is possible to place the second UV monitor U9-L before the first UV
monitor in the flow path.

NOTICE

UV and conductivity flow cells on the high pressure side.
When placing UV and/or conductivity flow cells on the high pres-
sure side of the column, the UV flow cell has a maximum pressure
limit of 2 MPa (20 bar) and the conductivity flow cell has a
maximum pressure limit of 5 MPa (50 bar).

Using two UV monitors
It is possible to use two UV monitors in ÄKTA avant. UV monitor U9-M will be the first
UV monitor and UV monitor U9-L will be the second.

Note: When using two UV monitors, the signal from the first UV monitor is by
default used for peak fractionation. This can be changed by editing the text
instruction Fraction Collection →Peak fractionation parameters
→Signal source and choosing UV 2nd as Signal source.

Note: When using two UV monitors with different cell lengths to increase the UV
absorption dynamic range, the signal from UV monitor U9-L comes from the
real cell length and has to be calibrated for exact calculations. The signal
from UV monitor U9-M is automatically calibrated to nominal cell length.

System properties

Follow the instruction to update the system properties.

4 Optional instrument modules
4.11 Second UV monitor
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Step Action

1 Open the system properties Edit dialog box.

2 In the Component types list, click Monitors and sensors.

3 Select the UV monitor 2nd (U9-L) check box in the Component selection
list. Then click OK.

System settings
If the UV monitor U9-L is placed between the UV monitor U9-M and the outlet valve , or
if the UV monitor U9-L is the peak fractionation controlling UV monitor the delay
volume has to be updated. See Check or set delay volumes, on page 145.

The UV absorption signal from the UV monitor U9-L is correlated to the real cell length.
If it is important to have absorption signals correlated to the nominal cell length a cali-
bration should be done.

4 Optional instrument modules
4.11 Second UV monitor
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4.12 I/O-box

About this section
This section provides an overview of the function, connectors and signals of the I/O-
box E9.

In this section

Section See page

4.12.1 Overview of the I/O-box 136

4.12.2 Analog connector and signals 138

4.12.3 Digital connector and signals 140

4.12.4 Connect external equipment to the I/O-box 142

4 Optional instrument modules
4.12 I/O-box
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4.12.1 Overview of the I/O-box

Function of the I/O-box
The I/O-box E9 is used to interface other equipment in order to measure parameters
such as refractive index, light scattering and fluorescence. See Requirements on
connected equipment, on page 142 for information on requirements of the equipment
that can be connected to ÄKTA avant. The I/O-box can control external equipment by a
digital output signal, as well as detecting the state of them by digital inputs. It is also
possible to send out internal detector signals to external equipment.

Using two I/O-boxes
It is possible to install up to two I/O-boxes when using ÄKTA avant. If two I/O-boxes are
to be used, the second I/O-box has to be configured as I/O-box E9, 2nd. The configura-
tion is defined by the Node ID of the I/O-box. The Node ID is set by positioning the arrow
of two rotating switches at the back of the I/O-box, see Connectors, on page 137 and 
Section 9.15 Check and change the Node ID of a module, on page 496.

Location
The most common placement of the I/O-box, with the adhesive feet attached, is on the
laboratory bench on the right-hand side of the instrument main wet surface, close to
the UniNet ports. It is an advantage to have the external equipment that is going to be
connected close to the I/O-box on the same side of the instrument. The I/O box can also
be placed on a Rail extension rod, see Rail extension, on page 50.

4 Optional instrument modules
4.12 I/O-box

4.12.1 Overview of the I/O-box
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Connectors

Part Description

Analog in/out Signal connector for analog input and output signals.

UniNet-9 Connector used to connect the I/O-box to the ÄKTA
avant instrument.

Status Status indicator for service purposes.

Node ID Switches used to configure I/O-box E9 as I/O-box E9
or I/O-box E9, 2nd.

Digital in/out Signal connector for digital input and output signals.

4 Optional instrument modules
4.12 I/O-box

4.12.1 Overview of the I/O-box

ÄKTA avant User Manual 29035184 AF 137



4.12.2 Analog connector and signals

Analog connector pins

12345

6789

Part Function

1 Analog in signal 1 +

2 Analog in signal 1 - (or signal ground)

3 Shield, analog in (both ports)

4 Analog in signal 2 +

5 Analog in signal 2 - (or signal ground)

6 Calibration pin for service purposes

Analog out signal (1.9 V)

Note:

Do not use for other purposes.

7 Analog out signal 1

8 Signal ground, analog out (both ports)

9 Analog out signal 2

Analog signals
All analog input and output signals are confined to the same Analog in/out connector.

4 Optional instrument modules
4.12 I/O-box

4.12.2 Analog connector and signals
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Analog input signals
There are two analog input channels from which analog input signals can be used for
peak detection, or data collection in UNICORN. It is possible to auto-zero the input
signals, which means that the current value will be displayed as 0 V in UNICORN. This
can be done individually for the two analog input channels. The auto-zero value is saved
between runs and power-offs. The auto-zero value can be reset.

Parameter Description

Input signal range -2000 to 2000 mV

Analog output signals
There are two analog output channels from which analog output signals and system
parameters, that is, UV, cond, conc B, temperature and pH, are transferred to the
external connected equipment, for example, light scattering detectors or plotters.

Parameter Description

Output
signal range

-1000 to 1000 mV

Default
output

The user defines the default output level for the selected signal.

Full scale
output

The user sets the desired output signal value of, e.g., mAU, % or mS,
which will corresponds to the full scale output voltage 1000 mV.

Negative full
scale output

The corresponding negative full scale output value is set automati-
cally. For example, if the full scale output is set to 2000 mAU, a UV
value of 500 mAU will give an output voltage of 250 mV, and -100
mAU will give -50 mV output voltage. A signal value of 0 mAU, 0% or
0 mS will always give an output voltage of 0 mV.

Fix point Zero is always a fix point. A desired output signal of, i.e., 0 mAU, 0%
or 0 mS corresponds to an output voltage of 0 mV. At power-on, an
output signal of 0 mV is transferred to the connected equipment,
until the output signal range values are set.

Note: No warning will be displayed in UNICORN if the analog output signal
exceeds the set full scale output value or is less than the set negative full
scale output value.

4 Optional instrument modules
4.12 I/O-box

4.12.2 Analog connector and signals
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4.12.3 Digital connector and signals

Digital connector pins

12345

6789

Part Function

1 Digital in signal 1

2 Digital in signal 2

3 Digital in signal 3

4 Digital in signal 4

5 Signal ground

6 Digital out signal 1

7 Digital out signal 2

8 Digital out signal 3

9 Digital out signal 4

Digital signals
All digital input and output signals will be confined to the same D-sub connector and
have a common ground. The four input signals will be scanned synchronously, and the
outputs will be set synchronously.

4 Optional instrument modules
4.12 I/O-box

4.12.3 Digital connector and signals
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Digital input signals
The digital in-signal can be used to monitor external equipment by registering, for
example, error signals or event marks. An event mark can be used as a trigger for
watches. The measured digital signals can be shown as a curve in UNICORN. The unit
will handle both open/closed circuit and TTL-type voltage signals. An open circuit is
interpreted as logical 1 and a closed circuit as logical 0.

Note: A closed circuit is always closed against signal ground.

Input connection UNICORN interpretation

Open circuit Logical 1

Applied voltage 3.5 to 5.0 V

Closed circuit Logical 0

Applied voltage 0 to 0.8 V

Digital output signals
The digital output signal can be used to control external equipment that can receive
digital signals, such as pumps or fraction collectors. The digital output signals define an
open or closed circuit, where a logical 1 will result in an open circuit and a logical 0 will
give a closed circuit. The default level, 1 or 0, is set by the user. The level can be changed
by instructions either manually, in System Settings or by a method. It is possible to
send pulses from the current level, with a pulse length of 0.1 s to 10 s.

Note: A closed circuit is always closed against signal ground.

4 Optional instrument modules
4.12 I/O-box
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4.12.4 Connect external equipment to the I/O-box

Requirements on connected
equipment

The physical requirements for the connected equipment is described in the following
tables. All connected equipment must have a common grounding.

Analog input

Parameter Value

Channels 2

Range ±2000 mV

Input impedance 1 MΩ

Accuracy ±(0.1% + 0.2 mV)

Analog output

Parameter Value

Channels 2

Range ±1000 mV

Input impedance 100 kΩ

Accuracy ±(0.3% + 1 mV)

Digital input

Parameter Value

Channels 4

Compatibility TTL, open/closed circuit

Digital output

Parameter Value

Channels 4

Compatibility Open/closed circuit

4 Optional instrument modules
4.12 I/O-box

4.12.4 Connect external equipment to the I/O-box
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Required material
The following material is required:

• Flat-blade screwdriver, 2 mm

• Shielded cable with 9 conductors, 4 to 8 mm diameter

• Wire stripping tool

Instruction

Follow the instructions to connect one or two external cables to the supplied D-sub
connectors.

Step Action

1 Open the connector housing by removing housing screw and unlatch the
housing top shell using a flat-blade screwdriver.

2 Locate the connection block mounted on the PCB board. The screw termi-
nals has numbers corresponding to the connector contacts.

54321

9876

3 Strip the signal cable.

• Strip-off 50 mm of the shield insulator.

• Strip-off 4 mm of the single conductor insulation.

4 Loosen the strain relief clamp and insert the cable with the shield under the
strain relief clamp. Fasten the strain relief clamp over the cable shield.

Tip:

The connection block can be rotated inside the housing in order to position
the screw terminals for left side or right side cable entry.

5 Insert and fasten the single conductors in the screw terminals.

6 Close the housing top shell with the latch and screw the housing together.

System properties

Follow the instruction to update the system properties.

4 Optional instrument modules
4.12 I/O-box
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Step Action

1 Open the system properties Edit dialog box.

2 In the Component types list, click Other.

3 Select the I/O-box (E9) or I/O-box 2 (E9) check box in the Component
selection list. Then click OK.

System settings
Default values for digital out ports, noise reduction and configuration of analog out
ports can be set.

Instruction name Description

Digital out X Sets the value of the signal sent out by digital port
number X to either 0 or 1. The default value is 1.

Noise reduction
analog in X

Filters the noise in the analog signal in port number X.

Alarm analog in X Enables or disables the alarm for the analog signal in
port number X. When enabled, it sets the alarm limits
for the analog signal. If the alarm is enabled and the
analog signal falls outside the set limits, an alarm will
be triggered and the method will be paused.

Alarm digital in X Enables or disables the alarm for the signal in digital
port number X. The alarm can be triggered by either of
the signal values, 0 or 1. If the alarm is enabled and the
condition set in ‘Value’ occurs, an alarm will be trig-
gered and the method will be paused.

Configure analog out X Enables the user to send one of the pre-defined signals
(UV signal, conductivity, temperature, pH or concen-
tration of eluent B) to the analog out port number X,
and also to set the range of that signal.

Note: The delay volume has to be updated if an external component is added to
the flow path.

4 Optional instrument modules
4.12 I/O-box

4.12.4 Connect external equipment to the I/O-box

144  ÄKTA avant User Manual 29035184 AF



4.13 General system settings

Check or set delay volumes

When a module has been installed after the UV monitor in the flow path, the delay
volume has to be adjusted in the System Setting dialog box in UNICORN, to make sure
that the collected fractions correspond to the fractions indicated in the chromato-
gram.

Delay volumes can be set for the options Detector-Frac, Detector-Outlet valve,
Restrictor volume, and pH cell volume. The delay volume has to be set for all
displayed options.

Delay volumes for modules and standard tubing configurations are found in Section
9.12 Delay volumes, on page 486.

Follow the instructions to check/set the delay volumes:

Step Action

1 In the System Control module, click Settings on the System menu.

Result:

The System Settings dialog box opens.

2 In the System Settings dialog box, select Fraction collection →Delay
volumes

3 Enter new values in the Detector-Frac, Detector-Outet valve, Restrictor
volume, and pH cell volume fields if necessary

Click OK.

Lock and unlock the instrument
display

Follow the instruction below to lock or unlock the Pause and Continue buttons of the
instrument display from UNICORN.

4 Optional instrument modules
4.13 General system settings
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Step Action

1 In the System Control module, click Settings on the System menu.

Result:

The System Settings dialog box opens.

2 In the System Settings dialog box:

• Select Advanced →Instrument display.

• Click Locked or Unlocked.

• Click OK.

4 Optional instrument modules
4.13 General system settings
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5 Operation

About this chapter
This chapter describes the steps involved when operating ÄKTA avant.

In this chapter

Section See page

5.1 Before you prepare the system 148

5.2 Prepare the flow path 149

5.3 Start UNICORN and connect to the system 154

5.4 Prime inlets and purge pump heads 157

5.5 Connect a column 174

5.6 Set pressure alarms 179

5.7 Sample application 181

5.8 Fractionation 192

5.9 Create a method and perform a run 214

5 Operation
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5.1 Before you prepare the system

Introduction
It is important to prepare the standard system in accordance with the settings in the
method to be run. Before preparing the system, check the settings in the Method
Editor and make sure that all accessories to be used are available.

Checklist
Make sure to prepare the system in accordance with the settings in the method to be
run. Make sure that you understand:

• which valve ports to use for inlets and outlets

• which column type to use

• which column position to use

• which buffers and samples to prepare

• which sample application technique to use

• that the pH electrode is connected and calibrated, if applicable

• which cassettes with corresponding deep well plates and/or tubes to use in the
Fraction collector, if applicable

5 Operation
5.1 Before you prepare the system
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5.2 Prepare the flow path

Introduction
This section describes the preparation of inlet tubing, outlet tubing, waste tubing and
mixer. For an illustration of the standard typical flow path, see Section 2.4 Liquid flow
path, on page 34.

Select Mixer chamber
To obtain a homogeneous buffer composition, it is important to use a Mixer chamber
suitable for the flow rate of the method. The tables below show what Mixer chambers
to use in ÄKTA avant 25 and ÄKTA avant 150 at different flow rates.

For information on how to install a Mixer chamber, refer to Section 7.8.2 Replace the
Mixer, on page 323.

Note: If the liquids are difficult to mix, use a larger Mixer chamber to achieve
optimal mixing. However, note that a larger Mixer chamber distorts and
delays the gradient.

ÄKTA avant 25
Three different Mixer chambers are delivered with ÄKTA avant 25. Their volumes are:
0.6 ml, 1.4 ml (mounted at delivery) and 5 ml.

Mixer chamber
volume (ml)

Flow rate (ml/min),

Binary gradient

Flow rate (ml/min),

Quaternary and BufferPro
gradients

0.6 0.25 to 5 1 to 2 1

1.4 0.5 to 15 1 to 6

5 2 to 25 6 to 25

1 Technically it is possible to run BufferPro and Quaternary gradients below 1 ml/min, but
gradient formation starts to become slow.

CAUTION

Risk of explosion. Do not use Mixer chamber 15 ml with an ÄKTA
avant 25 system configuration. The maximum pressure for Mixer
chamber 15 ml is 5 MPa (50 bar).

ÄKTA avant 150
Three different Mixer chambers are delivered with ÄKTA avant 150. Their volumes are:
1.4 ml, 5 ml (mounted at delivery), and 15 ml.

5 Operation
5.2 Prepare the flow path

ÄKTA avant User Manual 29035184 AF 149



Mixer chamber
volume (ml)

Flow rate (ml/min),

Binary gradient

Flow rate (ml/min),

Quaternary and BufferPro
gradients

1.4 0.5 to 15 N/A

5 2 to 25 2 to 10

15 5 to 150 10 to 40

Inlet tubing size for ÄKTA avant 150
in BufferPro and quaternary
gradients

When running BufferPro or quaternary gradients with ÄKTA avant 150 at flow rates
below 10 ml/min, it is possible to optimize performance by changing the pieces of
tubing marked InA and InB from standard tubing dimension i.d. 2.9 mm, o.d. 3/16" to
tubing dimension i.d. 1.6 mm, o.d. 1/8" (delivered with the instrument).

Note: Remember to change back to standard tubing size for higher flow rates.

Select UV flow cells
Flow cells with shorter path lengths are suitable to use for high protein concentrations.
Flow cells with longer path lengths are suitable to use for low protein concentrations.

UV flow cells for UV monitor U9-M
UV flow cells are available with three different path lengths; 0.5 mm, 2 mm (default) and
10 mm.

The real cell path length of the UV cell is automatically recognized by the monitor when
a cell is fitted. The UV data is normalized to the nominal path length. This allows UV
data from runs made with different UV flow cells (but with the same nominal path
length) to be directly compared.

UV flow cells for UV monitor U9-L
UV flow cells for UV monitor U9-L are available with two different path lengths; 2 mm
(default) and 5 mm. When replacing a UV flow cell, the path length must be set in the
System Control module if concentration calculations will be done in the Evaluation
module. Use the nominal flow cell length if the UV flow cell is replaced but not cali-
brated. See Update the cell path length, on page 319 to set the flow cell path length.

The path length of the UV flow cell might differ from the nominal length, which leads to
inexact results in the calculation of protein concentration in the eluate. To achieve
normalized absorbance, the path length of the UV flow cell must be calibrated and the
calculated flow cell path length set manually. See Calibration of the second UV monitor
flow cell length, on page 316. This allows UV data from runs made with different UV flow
cells (but with the same nominal path length) to be compared directly.

5 Operation
5.2 Prepare the flow path
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Prepare the inlet tubing
Connect inlet tubing to the inlet ports that are to be used, and place all inlet tubing that
is to be used during the method run in the correct buffers.

Note: When using high viscosity buffers or samples in combination with high flow
rates it is recommended to change to tubing with larger inner diameter or
shorten the length of the tubing.

Prepare the outlet tubing
Connect outlet tubing to the outlet ports of Outlet valve that are to be used. If the
external Fraction collector F9-R is to be used, make sure that the tubing is connected
as described in Connect tubing to the ÄKTA avant instrument, on page 128, and
prepare the fraction collector. Otherwise, place the outlet tubing in suitable tubes or
flasks.

Prepare the waste tubing
All waste tubing is found on the rear of the instrument.

1 2

Part Description

1 Waste tubing from the Injection valve, the pH valve and the Outlet valve
(W, W1, W2 and W3).

2 Waste tubing from the Fraction collector and the Buffer tray.

Instructions

The following steps describe how to prepare the waste tubing.

5 Operation
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Step Action

1 Place the four pieces of waste tubing from the Injection valve, the pH valve
and the Outlet valve (W, W1, W2 and W3) in a vessel placed below the
bench.

NOTICE

The maximum level of the waste vessel for the waste
tubing from the valves must be lower than 30 cm above
the lab bench.

2 Place the three pieces of waste tubing from the Fraction collector and the
Buffer tray in a waste vessel placed below the bench.

NOTICE

The maximum level of the waste vessel for the waste
tubing from the Fraction collector and the Buffer tray
must be lower than the bench height.

3 Cut the waste tubing from the Fraction collector and the Buffer tray to
appropriate length. It is important that the tubing is not bent and will not be
submerged in liquid during the run.

Note:

If the tubing is too short, replace it with new tubing. Do not lengthen the
tubing as this might cause obstruction of the tubing and flooding in the Frac
chamber.
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CAUTION

Make sure that the waste vessels will hold all the produced volume
of the run. For ÄKTA avant 25, a suitable waste vessel should typi-
cally have a volume of 2 to 10 liters. For ÄKTA avant 150, a waste
vessel should have a volume of 40 liters.

Plug unused valve ports
It is recommended to plug all unused valve ports with stop plugs before starting a run.
See Section 9.3 Tubing and connectors, on page 413 for information about connectors.

5 Operation
5.2 Prepare the flow path

ÄKTA avant User Manual 29035184 AF 153



5.3 Start UNICORN and connect to the system

Introduction
This section describes how to start and log on to UNICORN and how to connect the
instrument to UNICORN.

Start UNICORN and log on

Follow the instructions to start UNICORN and log on to the program. A valid e-license
must be available for the workstation. See UNICORN Administration and Technical
Manual for more information about e-licenses.

Step Action

1 Double-click the UNICORN icon on the desktop.

Result:

The Log On dialog box opens.

Note:

If there is no connection to the database it is still possible to log on to
UNICORN and control a running system. The Log On dialog box will give the
option to start System Control without a database. Click Start System
Control to proceed to the next Log On dialog box.

5 Operation
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Step Action

2 In the Log On dialog box:

• Click a user name in the User Name list

and

• enter the password in the Password field.

Note:

It is also possible to select the Use Windows Authentication check box
and enter a network ID in the User Name box.

• select which UNICORN modules to start.

• click OK.

Result:

The selected UNICORN modules open.

Connect to system

Follow the instructions to connect the instrument to UNICORN.
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Step Action

1 In the System Control module,

• Click the Connect to Systems button,

or

• click Connect to Systems on the System menu.

Result:

The Connect to Systems dialog box opens.

2 In the Connect to systems dialog box:

• Select the checkbox in front of the system name.

• To control the selected system, click Control.

• Click OK.

Note:

Instruments that are turned off or disconnected from the network appear
dimmed and cannot be connected.

Tip:

To view the users currently connected to systems, either in control or view
mode, click the Connected Users button.
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5.4 Prime inlets and purge pump heads

About this section
Before usage of a pump, it is important to:

• Prime the inlets (fill the buffer inlets with liquid).

• Purge the pump (remove air from the pump heads).

This section describes how to prime inlets and purge the pump heads of the system
pumps and the sample pump.

Note: Note that the procedures described in this section may have to be adapted if
your system configuration differs from the one described in this manual.

In this section

Section See page

5.4.1 Prime buffer inlets and purge system pumps 158

5.4.2 Prime sample inlets and purge Sample Pump 165

5.4.3 Prime Q inlets 170

5 Operation
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5.4.1 Prime buffer inlets and purge system pumps

Overview
The procedure consists of the following stages:

Stage Description

1 Prime all inlet tubing to be used during the run.

2 Validate priming of inlet tubing.

3 Purge System Pump B if pressure signal indicates air bubbles.

4 Validate purge of System Pump B.

5 Purge System Pump A if pressure signal indicates air bubbles.

6 Validate purge of System Pump A.

7 End the run.

Note: To increase life length of the pump sealing rings, make sure that the pump
rinsing system is filled with fresh rinsing solution.

Tip: The procedures for purging the pump heads and priming the inlets using the
Process Picture, are described in the following topic. It is also possible to
perform the procedures from the Manual instructions dialog box.

Prime inlet tubing

Follow the instructions to fill all A and B inlet tubing to be used in the run with appro-
priate buffer/solution.

Step Action

1 Make sure that all inlet tubing that is to be used during the method run is
placed in the correct buffer.

2 Open the System Control module.

5 Operation
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Step Action

3 In the Process Picture:

• Click the inlet valve icons. (Click both the Inlet A and Inlet B icons, one at
a time, if both inlets are to be primed.)

• Click the position of the inlet to be filled. Fill the positions in reverse
alphabetical order and start with the highest number. For example, if all
the seven inlets in Inlet Valve B are to be filled, click them in the following
order: B7, B6 . . . B1, assuming that B1 is the starting buffer.

Result:

The inlet valve switches to the selected port.

4 Connect a 25 to 30 ml syringe to the purge valve of one of the pump heads of
System Pump B. Make sure that the syringe fits tightly into the purge
connector.

5 Open the purge valve by turning it counter-clockwise about three quarters
of a turn. Draw liquid slowly into the syringe until the liquid reaches the
pump.

6 Close the purge valve by turning it clockwise. Disconnect the syringe and
discard its contents.

7 Repeat steps 3 to 6 for each piece of inlet tubing that is to be used during the
run. In the final inlet position, draw liquid into the syringe through both purge
valves.

5 Operation
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Step Action

8 Check that there is no air left in the pump by following the instructions in 
Validate prime or purge of System Pump A or B or Sample Pump, on page
164. If air bubbles are indicated, follow the instructions in Purge Sample
Pump, on page 167

Purge System Pump B

If the priming was done thoroughly and the final buffer was drawn all the way into the
syringe and the validation of the priming showed that there was no air left in the pump
it is not necessary to purge System Pump B.

However, if the pressure signal indicated air bubbles left in the pump, follow these
instructions to purge both pump heads of System Pump B:

Step Action

1 Make sure that the piece of waste tubing connected to the injection valve
port W1 is placed in a waste vessel.

2 In the Process Picture:

• Click the Injection valve icon and then click System pump waste.

Result:

The injection valve switches to waste position. This is necessary to achieve a
low back pressure during the purge procedure.
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Step Action

3 In the Process Picture:

• Click the Inlet valve B icon.

• Click the position of one of the inlets that will be used at the beginning of
the run.

Result:

The inlet valve switches to the selected port.

4 In the Process Picture:

• Click the System pumps icon.

• Set Conc % B to 100% B and click Set % B.

• Set the System flow to 1.0 ml/min for ÄKTA avant 25 or 5.0 ml/min for
ÄKTA avant 150.

• Click Set flow rate.

Result:

Only System Pump B is active, and a system flow through injection valve
waste starts.

5 Operation
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Step Action

5 Connect a 25 to 30 ml syringe to the purge valve of the left pump head of
System Pump B. Make sure that the syringe fits tightly into the purge
connector.

6 Open the purge valve by turning it counter-clockwise about three quarters
of a turn. Draw 5 to 10 ml of liquid slowly into the syringe with a rate of about
1 ml/s.

7 Close the purge valve by turning it clockwise. Disconnect the syringe and
discard its contents.

8 Connect the syringe to the purge valve on the right pump head of System
Pump B, and repeat steps 6 to 8. Keep the system flow running.

5 Operation
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Step Action

9 Check that there is no air left in the pump by following the instructions in 
Validate prime or purge of System Pump A or B or Sample Pump, on page
164.

Purge System Pump A

Purge both pump heads of System Pump A by following the same procedure as in 
Purge System Pump B, on page 160, but replace step 3 and 4 with the following:

Step Action

1 In the Process Picture:

• Click the Inlet valve A icon.

• Click the position of one of the inlets that will be used at the beginning of
the run.

Result:

The inlet valve switches to the selected port.

2 In the Process Picture:

• Click the System pumps icon.

• Set Conc % B to 0% B and click Set % B.

Result:

Only System Pump A is active.
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Validate prime or purge of System
Pump A or B or Sample Pump

Follow these instructions to check that there is no air left in the pump after performing
a prime or a purge.

Step Action

1 In the Process Picture:

• Click on the Injection valve and select Manual load.

Result:

The injection valve switches to manual load position.

2 Make sure that the pump flow is on.

3 In the Chromatogram pane:

• Check the PreC pressure curve.

• If the PreC pressure do not stabilize within a few minutes there may be
air left in the pump. Purge the pump once more then see Section 8.6 Trou-
bleshooting: Pumps, on page 380.

End the run
Click the End button in the System Control toolbar to end the run.
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5.4.2 Prime sample inlets and purge Sample Pump

Overview
The procedure consists of the following stages:

Stage Description

1 Prime all sample inlet tubing to be used during the run.

2 Validate priming of inlet tubing.

3 Purge the sample pump if pressure signal indicates air bubbles.

4 Validate purge of the samle pump.

5 End the run.

Note: To increase life length of the pump sealing rings, make sure that the pump
rinsing system is filled with fresh rinsing solution.

Prime sample inlets

Follow the instructions below to fill all sample inlet tubing, to be used in the run, with
appropriate buffer or sample solution.

Step Action

1 Make sure that all sample inlet tubing that is to be used during the method
run is immersed in the correct samples or buffer.

2 Make sure that the waste tubing connected to injection valve port W2 is
immersed in a waste vessel.

3 Open the System Control module.

5 Operation
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Step Action

4 In the Process Picture

• Click the Sample inlet valve icon.

• Select the position of the inlet to be filled. Start at the inlet position with
the highest number and end at the position with the lowest number or
the buffer position (assuming that the first sample to run is connected to
inlet 1 etc.).

Result:

The sample inlet valve switches to the selected port.

5 Connect a 25 to 30 ml syringe to one of the purge valves of the pump heads
in the sample pump. Make sure that the syringe fits tightly into the purge
connector.

6 Open the purge valve by turning it counter-clockwise about three-quarters
of a turn. Draw slowly with the syringe until the sample just passes the
Sample inlet valve.

7 Close the purge valve by turning it clockwise. Disconnect the syringe and
discard its contents.

8 Repeat steps 4 to 7 for each sample inlet that is to be used in the method
run. The final sample or the buffer from the buffer position should be drawn
all the way through both pump heads into the syringe.

5 Operation
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Step Action

9 Check that there is no air left in the pump by following the instructions in 
Validate prime or purge of System Pump A or B or Sample Pump, on page
164. If air bubbles are indicated, follow the instructions in the Purge Sample
Pump section below.

Purge Sample Pump

If the priming was done thoroughly and the final buffer was drawn all the way into the
syringe and the validation of the priming showed that there was no air left in the pump
it is not necessary to purge the sample pump.

However, if the pressure signal indicated air bubbles left in the pump, follow the
instruction below to purge both the pump heads of the sample pump.

Step Action

1 Make sure that all sample inlet tubing that is to be used during the method
run is immersed in the correct buffers.

2 Make sure that the waste tubing connected to injection valve port W2 is
immersed in a waste vessel.

3 Open the System Control module.

4 In the Process Picture:

• Click the Injection valve icon, and then click Sample pump waste.

Result:

The injection valve switches to waste position. This is necessary to achieve a
low back pressure during the purge procedure.
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Step Action

5 In the Process Picture:

• Click the Sample inlet icon, then click Buffer.

• Click the Sample pump icon: Set the Sample flow to 1.0 ml/min for
ÄKTA avant 25 or 5.0 ml/min for ÄKTA avant 150.

• Click Set flow rate.

Result:

The sample pump flow starts.

6 Connect a 25 to 30 ml syringe to the left purge valve of the sample pump.
Make sure that the syringe fits tightly into the purge connector.

7 Open the purge valve by turning it counter-clockwise about three-quarters
of a turn. Draw 5 to 10 ml of liquid slowly into the syringe with a rate of about
1 ml/s.

8 Close the purge valve by turning it clockwise. Disconnect the syringe and
discard its contents.

5 Operation
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Step Action

9 Connect the syringe to the right purge valve on the sample pump, and
repeat step 6 to 8.

10 Check that there is no air left in the pump by following the instructions in 
Validate prime or purge of System Pump A or B or Sample Pump, on page
164.

End the run
Click the End button in the System Control toolbar to end the run.
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5.4.3 Prime Q inlets

Overview
The procedure consists of the following stages:

Stage Description

1 Prime all Q inlet tubing.

2 Validate priming of Q inlet tubing.

3 Purge Quaternary Valve and the system pumps if pressure signal indi-
cates air bubbles.

4 Validate purge of Quarternary Valve and system pumps.

5 End the run.

Prime the Q inlets

Follow the instructions to prime the Q inlets.

Step Action

1 Make sure that the pieces of inlet tubing marked A1, B1 and Q1-Q4 are
immersed in the correct buffers. The A1 and B1 positions are used for pump
synchronization and these lines should already be primed.

2 In the Manual instructions dialog box:

• Select Pumps and pressures →Quaternary start concentrations.

• Set Start concentration Q1 to 100%. Make sure that the other start
concentrations are set to 0%.

• Select Pumps and pressures →System flow and set Flow rate to 0.01
ml/min.
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Step Action

3 Connect a 25 to 30 ml syringe to one of the purge valves of either of the
system pumps. Make sure that the syringe fits tightly into the purge
connector.

4 Open the purge valve by turning it counterclockwise about 3 quarters of a
turn. Draw 10 ml of liquid into the syringe. Check that the Q1 inlet is filled
with liquid.

5 Close the purge valve by turning it clockwise. Disconnect the syringe and
discard its contents.

6 Repeat steps 2 to 5 for Q2, Q3 and Q4 respectively by setting the respective
Quaternary start concentration to 100%.

Tip:

The inlet tubing that is immersed in distilled water should be the last piece of
inlet tubing to be primed.

Tip:

If you will perform a BufferPro run, end with either Q1 or Q2.

7 Check that there is no air left in the pump by following the instructions in 
Validate prime or purge of System Pump A or B or Sample Pump, on page
164. If air bubbles are indicated, follow the instructions in Purge Quaternary
Valve and the system pumps, on page 171.

Purge Quaternary Valve and the
system pumps

If the priming was done thoroughly and the final buffer was drawn all the way into the
syringe and the validation of the priming showed that there was no air left in the pump
it is not necessary to purge Quaternary Valve and the system pumps.
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5.4 Prime inlets and purge pump heads

5.4.3 Prime Q inlets

ÄKTA avant User Manual 29035184 AF 171



However, if the pressure signal indicated air bubbles left in the valve or the pump,
follow these instructions to purge Quaternary Valve, System Pump A and System Pump
B. Note that both pump heads of each system pump have to be purged.

Step Action

1 In the Manual instructions dialog box:

• Select Pumps and pressures →Pump wash, and click All in the
BufferPro / Q inlets list.

Result:

A simultaneous pump wash of all the Q inlets is started. This will remove air
from Quaternary Valve.

2 Wait until the pump wash is completed.

• Select Pumps and pressures →Quaternary start concentrations.

• Set Start concentration Q1 to 100%. Make sure that the other start
concentrations are set to 0%.

3 Select Pumps and pressures →System flow and set Flow rate to 0.01
ml/min.

4 Connect a 25 to 30 ml syringe to the left purge valve of the selected system
pump. Make sure that the syringe fits tightly into the purge connector.
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Step Action

5 Open the purge valve by turning it counterclockwise about 3 quarters of a
turn. Draw 10 ml of liquid slowly into the syringe with a rate of about 1 ml per
second.

6 Close the purge valve by turning it clockwise. Disconnect the syringe and
discard its contents.

7 Repeat steps 3 to 5 for the other three purge valves of the system pumps to
get rid of air in all pump heads. Keep the system flow running during this
procedure.

8 Check that there is no air left in the pump by following the instructions in 
Validate prime or purge of System Pump A or B or Sample Pump, on page
164.

End the run
Click the End button in the System Control toolbar to end the run.
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5.5 Connect a column

Introduction
This section describes how to connect a column to the instrument using a column
holder and without introducing air into the flow path. Several types of column holders
are available for the ÄKTA avant instrumen, see Section 2.6 Accessories, on page 42.

WARNING

Before connecting a column, read the instructions for use of the
column. To avoid exposing the column to excessive pressure, make
sure that the pressure limit is set to the specified maximum pres-
sure for the column.

Methods automatically include pressure alarms based on the specifications of the
chosen column type. However, when running manual runs you have to set the pressure
limits yourself. Also, to protect the column media, special settings are needed. See 
Section 5.6 Set pressure alarms, on page 179 for more information on pressure alarms.

Note: Do not overtighten when connecting columns. Overtightening might
rupture the connectors or squeeze the tubing and thereby result in high
back pressure.

Attach a column holder and connect a
column

Follow the instructions to connect a column to the instrument. Always use a column
holder. The column is connected to two opposite parts of the column valve, using
appropriate tubing and connectors.

Step Action

1 Attach an appropriate column holder to the rail on the instrument.
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Step Action

2 Attach the column to the column holder.

3 Connect a suitable tubing to a column valve port, for example port 1A if
column position 1 was chosen in the method to be run.

5 Operation
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Step Action

4 In the Process Picture:

• Click the Column valve icon.

• Click, e.g., Position 1 and Down flow.

• Click Set position

Result:

The column valve switches to position 1.

5 In the Process Picture:

• Click the System pumps icon.

• Enter a low System flow (e.g., 0.2 ml/min).

• Click Set flow rate.

Result:

A system flow of 0.2 ml/min starts.
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Step Action

6 When buffer leaves the tubing on port 1A (if port 1A was chosen in the
method to be run) in a continuous mode and the top part of the column is
filled with buffer, connect the tubing to the top of the column.

7 Connect a piece of tubing to the bottom of the column.

8 When buffer leaves the tubing at the bottom of the column in a continuous
mode, connect this piece of tubing to the column valve. Use the port oppo-
site to the one already connected to the column, in this example port 2B.

5 Operation
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Step Action

9 Click the End button in the System Control toolbar to end the run.

Register columns
See UNICORN Method Manual for information on how to register columns in UNICORN
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5.6 Set pressure alarms

Introduction
The columns can be protected by two different types of pressure alarms:

• The pre-column pressure alarm protects the column hardware.

• The delta-column pressure alarm protects the column media.

The column valves V9-C and V9H-C have built-in pressure sensors that automatically
measure the pre-column and delta-column pressure.

See the instructions in the next topic to set the pressure alarm for the column to be
used in the run and, if applicable, to set the parameters for the tubing dimensions.

Note: Remember to lower the system pressure alarm and sample pressure alarm
if the optional UV Monitor U9-L and/or the optional second Conductivity
Monitor C9 is used on the high pressure side in the system (before the
column[s]).

NOTICE

UV and conductivity flow cells on the high pressure side.
When placing UV and/or conductivity flow cells on the high pres-
sure side of the column, the UV flow cell has a maximum pressure
limit of 2 MPa (20 bar) and the conductivity flow cell has a
maximum pressure limit of 5 MPa (50 bar).

Pre-column pressure alarms
It is important that the pre-column pressure alarm is set during all runs where a
column is used. The pressure alarm can be set in: the method to be run, the System
Settings dialog box, or during a manual run.

Pre-column pressure alarm limits are automatically set in the method when a column
from the column list is selected in the method. Refer to UNICORN Method Manual for
more information on pressure alarms.

Set pressure alarms

Pressure alarm limits may be set manually in System Control. The example below
describes how to set the high pressure limit for the column. Other alarms are set in a
corresponding way.
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Step Action

1 In the System Control module, on the Manual menu, click Execute
Manual Instructions.

Result:

The Manual instructions dialog box opens.

2 In the Instructions box, select Alarms →Alarm pre column pressure.

3 Click Enabled in the Mode field.

4 • Enter the high pressure limit in the High alarm box.

• Click Execute.

Note:
For more information on pressure alarms, including the Low Alarm param-
eter, seeSection 9.7.4 System settings - Pumps and pressures, on page 444.
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5.7 Sample application

Introduction
This section describes the different sample application techniques that can be used
with ÄKTA avant. The table below shows the alternatives for sample application avail-
able in the Sample application phase of a method.

Sample applica-
tion

Via Compatible loops

Inject sample
directly onto
column

• Sample pump

• Sample pump and air
sensor

• Not applicable

Inject sample
from loop

• Syringe

• Sample pump

• Sample loop

• Superloop, 10 ml

• Superloop, 50 ml

• Superloop, 150 ml

Note: In order to avoid sample carry-over when switching techniques for loading
samples, wash the valve with buffer between the loading of two different
samples. For example, when switching from loading sample in the loop to
loading sample directly onto the column with the valve in Direct inject
position.

When using a pump for sample application, it is important to prime inlets and purge the
pump before using the pump to load the sample. See further instructions in Section
5.4.2 Prime sample inlets and purge Sample Pump, on page 165.

When loading sample using an external air sensor, the sensor should be installed
according to Adapter for air sensor, on page 48.

In this section

Section See page

5.7.1 Sample application using direct injection into the column 182

5.7.2 Sample application using a Superloop 184

5.7.3 Sample application using a sample loop 189
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5.7.1 Sample application using direct injection into the
column

Introduction
There are two ways to load sample directly onto a column:

• a fixed volume is loaded, or

• all the sample is loaded.

Minimize sample loss
To minimize sample loss during direct injection of sample onto the column, sample
remaining in the flow path will be pushed onto the column with buffer from the inlet
valve. This step is called Finalize sample injection in the text instructions of the
sample application phase of the method to be used. Refer to Section 5.9 Create a
method and perform a run, on page 214 for more information on methods and phases.

When preparing to
inject...

Then...

a fixed volume of
sample

• manually prime the sample inlet tubing with sample,
see Prime sample inlets, on page 165.

• in the Method editor, make the following selections
for the Sample Application phase of the method to
be run:

- select Inject sample directly onto column,

- select Inject fixed sample volume and set the
volume to be injected.

• make sure that the flow path from the sample inlet
valve up to the injection valve will be filled with an
appropriate buffer:

- make sure that the buffer inlet tubing of the inlet
valve is immersed in buffer, and

- enable the function Wash sample flow path with
buffer in the Sample application phase.
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When preparing to
inject...

Then...

all the sample • in the Method editor, make the following selections
for the Sample Application phase of the method to
be run:

- select Inject sample directly onto column, and

- select Inject all sample using air sensor.

• manually prime the sample inlet tubing with sample
or buffer, see Prime sample inlets, on page 165, and
make sure that the tubing is immersed in sample
before starting the run.

• make sure that the flow path from the sample inlet
valve up to the injection valve is filled with sample or
an appropriate buffer and that the buffer inlet tubing
is immersed in buffer.

Maximize precision and accuracy
To achieve full precision and accuracy when a volume of sample is injected directly
onto the column, make the following selections in the Sample Application phase of
the method to be run (refer to Section 5.9 Create a method and perform a run, on page
214 for more information on methods and phases):

• select Inject sample directly onto the column,

• select Inject fixed sample volume and set the volume to be injected,

• enable the function Prime sample inlet with and set the volume to be used for
priming.

Result: the step Finalize sample injection is automatically deactivated in order to
maximize precision and accuracy. See Minimize sample loss, on page 182 for more
information.

Note: If manual priming of the flow path up to the injection valve is preferred,
enable Prime sample inlet with but set the volume to 0 ml.
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5.7.2 Sample application using a Superloop

Introduction
A Superloop allows injection of large sample volumes onto the column. A Superloop
can also be used for multiple injections, for example in a scouting experiment when the
same application conditions are required. Superloop models are available in 10 ml, 50
ml and 150 ml sizes.

A superloop can be connected to either the Injection valve or the Loop valve. When
using the Loop valve, up to five loops can be connected simultaneously.

Note: After loading a Superloop, always plug the Syr port on the Injection valve
with a Stop plug. With a Superloop connected to the valve, an over-pressure
may be created during injection.

Prepare the Superloop
To avoid injecting air into the system flow path, the Superloop should be prefilled with
buffer manually, before fitting the Superloop to the system.

Note: Read the instruction for the Superloop to be used.

Connect the Superloop

The following steps describe how to connect the Superloop to the Injection valve or to
the Loop valve.

Step Action

1 Attach the Superloop to the instrument using a Column holder.

2 Connect a piece of tubing from the top of the Superloop to:

• port LoopE on the Injection valve

or

• an E port, e.g., 1E, on the Loop valve
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Step Action

3 Connect a piece of tubing from the bottom of the Superloop to:

• port LoopF on the Injection valve

or

• the F port corresponding to the connected E port, e.g., 1F, on the Loop
valve

Fill the Superloop using a syringe

Follow the instruction below to fill the Superloop using a syringe.

Step Action

1 Check if the system is in state Ready.

• If yes: The Injection valve is in position Manual Load per default.
Continue to step 3.

• If no: Continue to step 2 to position the valve.
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Step Action

2 In the Process Picture:

• Click the Injection valve and select Manual Load.

Result:

The Injection valve switches to Manual Load position.

3 If the loop is connected to:

• the Injection valve, continue to step 5.

• the Loop valve, continue to step 4.

4 In the Process Picture:

• Click the Loop valve.

• Select the position the loop is connected to, for example Position 1.

Result:

The Loop valve switches to the selected position.
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Step Action

5 Fill a syringe with sample.

6 Connect the syringe to Injection valve port Syr.

7 Load sample into the Superloop by emptying the syringe into the Injection
valve.

8 Disconnect the syringe and plug the Syr port with a Stop plug.

Fill the Superloop using the Sample
pump

Follow the instruction below to fill the Superloop using the Sample pump.

NOTICE

Glass tube splinter. Make sure to set the sample pressure below
the max pressure of the Superloop before executing a flow in the
Manual instructions dialog box when the Superloop is connected.

Tip: The Superloop can also be filled as part of a method run, as set in the
Sample Application phase in the Method Editor. For multiple injections,
it may be more convenient to fill the Superloop once, as described in the
instruction below.

Step Action

1 In the Manual instructions dialog box:

• Select Flow path →Injection valve.

• Select Sample pump load from the Position drop-down list.

• Click Execute

Result:

The Injection valve switches to Sample pump load position.

2 Make sure that the sample inlet tubing from the sample vessel is connected
to the Sample inlet valve.

3 In the Manual instructions dialog box:

• Select Alarms: Alarm sample pressure.

• Set Mode as Enabled.

• Set a High alarm level that is below the maximum pressure of the Super-
loop.

• Click Execute
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Step Action

4 In the Manual instructions dialog box:

• Select Pumps and pressures →Sample flow.

• Set Flow rate to an appropriate value for the Superloop size, in this
example 10 ml/min.

• Click Execute

Result:

A sample flow starts, in this example of 10 ml/min.

5 When the Superloop is filled with as much volume as is needed, click the End
icon in the System Control toolbar to end the run.

6 Plug the Syr port on the Injection valve with a Stop plug.
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5.7.3 Sample application using a sample loop

Introduction
A sample loop is recommended for injection of smaller sample volumes onto the
column.

A sample loop can be connected to either the Injection valve or the Loop valve. When
using the Loop valve, up to five loops can be connected simultaneously.

Note: Sample loop is called capillary loop in UNICORN.

How to fill a sample loop

Follow the instructions to fill the sample loop with sample.

Step Action

1 Connect a suitable sample loop to Injection valve ports LoopF (fill) and
LoopE (empty).

2 Fill a syringe with sample.

3 Connect the syringe to the Injection valve port Syr.
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Step Action

4 In the Process Picture:

• Click on the Injection valve and select Manual load.

Result:

Injection valve is set to manual load.

5 If the loop is connected to:

• the Injection valve, continue to step 7.

• the Loop valve, continue to step 6.

6 In the Process Picture:

• Click the Loop valve.

• Select the position the loop is connected to, for example Position 1.

Result:

The Loop valve switches to the selected position.

7 Load sample into the sample loop. To avoid sample loss due to siphoning,
leave the syringe in the port until the sample has been injected onto the
column during the run.

Tip: It is recommended to overfill the loop to make sure that the loop is
completely filled. Excess of sample will leave the valve through port W1.
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Tip: By default a union Luer female to 1/16″ male is used for connection of the
sample syringe to the injection valve. For loading of smaller volumes with
higher precision there is an alternative accessory, Fill port INV-907
(18112766) or the complete kit Injection Valve Kit (18111089).

Fill the sample loop using the Sample
pump

Most often the sample loop is filled using a syringe. However, to fill it using the sample
pump, follow the instructions for filling the Superloop, see Section 5.7.2 Sample appli-
cation using a Superloop, on page 184.

Note: • It is not necessary to set the Alarm Sample Pressure when filling a
sample loop.

• It is recommended to overload the loop to make sure that the loop is
completely filled.

• Set Flow rate to an appropriate value for the loop size.

• After loading, plug the Syr port on the Injection valve with a Stop plug.

Empty the loop

General considerations
During the method run, the sample is automatically injected onto the column. The loop
is emptied and washed out using buffer from the system pumps. The total buffer
volume to be used for emptying and washing the loop is set in the Method Editor.

Using a sample loop connected to
Loop valve V9-L or V9H-L

For maximum reproducibility, use complete loop fill when loading the loop, that is,
overfill the loop with a sample volume of up to 3-5 times the volume of the loop. For
minimum sample loss, use partial loop fill, that is, fill only up to 50% of the loop volume.
Empty the loop with 3-5 times the volume of the loop.

Volume used to empty a loop
connected to Loop valve V9-L or V9H-
L

To minimize the risk for carry over and to make sure that the complete sample volume
reaches the column, the loop should be emptied with an excess of buffer. The tubing
between the Loop valve port E and the Injection valve port LoopE holds a small volume.
If the loop is emptied with a volume equal to, or less than the loop volume this needs to
be taken into account. It is also important to use a low flow rate to ensure that the
correct volume is added to the column when injecting a small volume.

Note: Partially emptying the loops that are attached to Loop valve V9-L or V9H-L
can increase the risk for carry over from one loop position to the next.
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5.8 Fractionation

Introduction
The built-in fraction collector and the optional Fraction collector F9-R collect fractions
from ÄKTA avant purification runs. The built-in fraction collector has integrated
cooling. The fraction collectors are connected to ÄKTA avant and controlled by
UNICORN. The fraction collectors can be automatically controlled in a method run or
manually controlled.

In this section

Section See page

5.8.1 Prepare the built-in fraction collector 193

5.8.2 Prepare Fraction collector F9-R 200

5.8.3 Fractionation overview 208
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5.8.1 Prepare the built-in fraction collector

Introduction
This section describes how to prepare the built-in fraction collector. For detailed infor-
mation regarding the types of deep well plates, tubes and cassettes, see Section 3.10.3
Cassettes, cassette tray and racks, on page 86.

WARNING

Fraction collector. Do not fractionate flammable liquids in the
built-in fraction collector. When running RPC methods, collect frac-
tions through the outlet valve or the optional external Fraction
collector F9-R .

Available cassettes, trays and racks
The following Cassettes and racks are available:

• Cassette 3 ml tubes (for 40 tubes)

• Cassette 5 ml tubes (for 40 tubes)

• Cassette 8 ml tubes (for 24 tubes)

• Cassette 15 ml tubes (for 15 tubes)

• Cassette 50 ml tubes (for 6 tubes)

• Cassette for deep well plate (24, 48, 96 wells)

• Cassette tray (for six cassettes)

• Rack for 50 ml tubes (for 55 tubes)

• Rack for 250 ml bottles (for 18 bottles)

Workflow for preparing the built-in
fraction collector

Before starting to prepare the built-in fraction collector, check the fractionation
settings in the method to be run. Perform the steps described below according to the
settings in the method.

Step Operator actions Reference to instructions

1 Insert the cassette tray or a rack for
tubes or bottles.

See Prepare and insert the cassette
tray below.
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Step Operator actions Reference to instructions

2 Change the System Settings in
UNICORN to set the fractionation
mode and other settings for frac-
tion collection.

See UNICORN System Control
Manual.

Available System Settings are
described in Section 9.7.7 System
settings - Fraction collection, on
page 448.

Prepare cassettes and insert the
cassette tray

Follow the instructions to prepare the fraction collector before a run.

Step Action

1 If you are to use cassettes with the QuickRelease function, first open the
cassettes.
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Step Action

2 Place the tubes and deep well plates in the cassettes. Make sure that the
deep well plates are rotated so that the well marked A1 is positioned above
the A1 marking on the cassette.

3 Close the cassettes that have the QuickRelease function.
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Step Action

4 Place the cassettes on the cassette tray. Make sure that the cassette type
code (see the illustration) faces the front of the tray marked with the Cytiva
monogram.

5 Open the fraction collector drawer by pressing the handle upwards, and
pulling out the drawer.

6 Place the cassette tray on the tray support of the fraction collector drawer.
Make sure that the front of the tray (marked with the Cytiva monogram)
faces the front of the drawer and is hooked onto the two pins.
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Step Action

7 Close the drawer. Make sure that it snaps into closed position.

Result:

After the door has been closed, the fraction collector performs a Full scan of
the cassette type code of each cassette to identify the cassette types, see 
Cassette and tray identification, on page 198.

Prepare a rack for 50 ml tubes or 250
ml bottles

Step Action

1 Place 50 ml tubes or 250 ml bottles in the corresponding rack (rack with 50
ml tubes shown in illustration).

2 Open the fraction collector drawer by pressing the handle upwards, and
pulling out the drawer.
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Step Action

3 Place the rack on the tray support of the fraction collector drawer. Make sure
that the front of the rack (marked with the Cytiva monogram) faces the front
of the drawer and is hooked onto the two pins.

4 Close the drawer. Make sure that it snaps into closed position.

Cassette and tray identification
When the door of the fraction collector is closed automatic scanning is performed.
There are two types of scanning procedures:

• Full scan: Scanning of cassette type codes to determine which types of cassettes
are used, and scanning of rows and columns in deep well plates to identify which
types of plates are used (24, 48, or 96 wells). Full scan is performed only when the
system is in state Ready.

• Quick scan: Scanning of cassette type codes to determine which type of cassettes
are used. Quick scan is performed during the run to ensure that correct cassettes
are placed in the fraction collector.

WARNING

Moving parts in fraction collector. Do not open the fraction
collector drawer when the fraction collector is active. If you need to
access the fraction collector, press Pause, and make sure that the
movement has stopped before opening the drawer.

View fraction collector content
To view the content of the Fraction collector, open the System control module. On the
View menu, click Fraction Collector Content.
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5.8.2 Prepare Fraction collector F9-R

Introduction
This subsection describes how to prepare and assemble Fraction collector F9-R before
a run.

Fraction collector F9-R can be connected to ÄKTA avant and controlled by UNICORN.
The fraction collector can be automatically controlled in a method run or manually
controlled.

Prepare the fraction collector
Before starting to prepare the Fraction collector F9-R, check the fractionation settings
in the method to be run. Perform the steps described below according to the settings in
the method.

• Assemble the Tube rack

• Insert collection tubes

• Adjust the Delivery arm

• Update System Settings in UNICORN

Illustration of the tube rack

1

2

345
6

Part Function

1 Single cutout

2 L-shaped cutout

3 Bowl

4 Tube support

5 Tube guide

6 Tube holder

Note: Note that the tube guide has both single and L-shaped cutouts, while the
tube holder only has single cutouts.

Tube rack inserts
The Fraction collector F9-R is delivered with the 18 mm tube rack mounted. Each tube
rack is made up of a combination of a bowl, tube support, tube guide and tube holder.
Change the tube holder and the tube guide to collect fractions in 12 mm tubes or 30
mm tubes. The 12 mm tube rack is delivered with Fraction collector F9-R and the 30
mm tube rack is available as an accessory. The table below describes inserts and corre-
sponding fraction collection tubes.
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Inserts Maximum number of
tubes

Tube diameter Tube length

12 mm Tube holder

12 mm Tube guide

175 12 mm 50 to 180 mm

18 mm Tube holder

18 mm Tube guide

95 18 mm 50 to 180 mm

30 mm Tube holder

30 mm Tube guide

40 30 mm 50 to 180 mm

Single and L-shaped cutouts
When assembling a tube rack, different cutouts are used for the various inserts
depending on the length of the collection tubes. Which cutouts to use are summarized
in the tables below.

 

12 mm and 18 mm tube rack inserts

Inserts 50 to 85 mm tubes 85 to 180 mm tubes

Tube support L-shaped cutout Not required

Tube guide Single cutout L-shaped cutout

Tube holder Single cutout Single cutout

 

30 mm tube rack inserts

Inserts 30 to 50 mm
tubes1

50 to 85 mm
tubes

85 to 180 mm
tubes

Tube support Single cutout L-shaped cutout Not required

Tube guide Single cutout Single cutout L-shaped cutout

Tube holder Single cutout Single cutout Single cutout

1 For 30 to 50 mm tubes, first insert the tube guide from the 18 mm rack using the single cutout,
before inserting the tube support for the 30 mm rack.

Assembly instructions

Follow the instructions to assemble the tube rack.
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Step Action

1 Insert the tube support (4), if required, into the bowl (3). The circular marks
on the tube support should face down.

1

2

345
6

Note:

When assembling a tube rack, single cutouts (1) and L-shaped cutouts (2),
are used for various inserts depending on the length of the collection tubes.
See Single and L-shaped cutouts, on page 201 for detailed information.

2 Insert the tube guide (5) with the tube position numbers upwards. The tube
guide should rest about 1 cm above the tube support.

3 Insert the tube holder (6) with the tube position numbers upwards:

Check that tube position 1 (7) is directly above tube position 1 (7) of the tube
guide.

7
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Step Action

4 • Push the flexible bowl out at each rib and snap the tube holder under the
top lip of the rib (8).

8

Note:

Do not force the tube holder into place as this may damage the lip.

• Check that the surface of the tube holder is level.

5 Gently move the delivery arm (10) out to the outer stop.
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Step Action

6 Place the tube rack (9) over the central spindle (11) and pull the spring
loaded drive sleeve (12) out so the tube rack comes to rest.

9

10
12

11

Insert collection tubes
Insert a sufficient number of collection tubes in to the tube rack, starting at position 1,
pushing each one down as far as they will go. All the tubes must be of the same length
and diameter and there should be no spaces in the sequence.

Adjust the delivery arm

Follow the instructions to adjust the height of the delivery arm.

NOTICE

Never lift Fraction collector F9-R by the delivery arm. This may
damage the fraction collector.
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Step Action

1 Lift and then lower the delivery arm (1), and allow it to move in so the tube
sensor (2) touches the collection tubes of the outer track.

1

2

2 Loosen the lock knob (3)

3
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Step Action

3 • Adjust the height so that the horizontal mark (5) on the tube sensor (6) is
at the same level as the top of the flat collection tubes and approximately
2 mm over the top of the flanged collection tubes (4).

4

5

6

• Lock the delivery arm at this height with the lock knob.

4 Check that the tube sensor (9) is in the correct position for the tubes used
(10). The eluent tubing (7) should be above the center of the collection tube.

7

8

9

10

5 Use the sensor control (8) to position the tube holder over the center of the
collection tube.

Connect tubing
Make sure that the tubing to the fraction collector is properly connected. See Connect
tubing to the ÄKTA avant instrument, on page 128.
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Sensor control
The sensor control can be switched between the two positions "small tubes" and "large
tubes", indicated in the illustration below.

The position for large tubes is used for tubes of approximately 18 mm i.d. and larger.
The position for small tubes is used for tubes smaller than 18 mm i.d. Note that this is a
rough approximation. Always check that the eluent tubing is centered above the
collection tube.
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5.8.3 Fractionation overview

Fractionation types
The following table lists the types of fractionation that the fraction collectors can be
used for.

Type Description

Fixed volume
fractionation

During fixed volume fractionation the fraction collector
continuously switches tubes according to the set volume
throughout the entire fractionation. This type of fractionation
is also known as straight fractionation.

Peak fractiona-
tion

Peak fractionation can be used to further increase the purity
of the collected protein peaks and minimize the number of
tubes used. The monitor signal is used to determine when to
switch the tubes. See Section 9.7.8 System settings - Watch
parameters, on page 450 for information about different
watch options.

Combined fixed
volume fractiona-
tion and peak
fractionation

The two fractionation types listed above can be used in
combination. Combination of fixed volume and peak fractio-
nation allows fractions collected by fixed volume fractiona-
tion and fractions collected by peak fractionation to be
directed to different collection tubes.

To be able to analyze different parts of the peak, the fraction size during elution is
usually set to a value smaller than the expected peak volume.
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Illustration
The following illustration show examples of fractionation using fixed volume fractiona-
tion and fractionation using peak fractionation.

A) Straight/fixed fractionation

B) Peak fractionation

Volume

Ab
so

rb
an

ce
Ab

so
rb

an
ce

Volume

Delay volume
The delay volume settings are used to make sure that the fractions collected during
fractionation, using the outlet valve or the fraction collector, correspond to the frac-
tions indicated in the chromatogram. The delay volume is the volume between the UV
monitor, and the fraction collector or outlet that is used, see the following illustration.

UV/Vis

pH

Valve

The time when a peak is detected 
by the UV/Vis detector is called T0

The peak reaches the fraction 
collector at time T1

Fraction collectorConductivity

Delay volume
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As the delay volume is affected by the length and diameter of the tubing, it should be
set according to the tubing and modules used, see Section 9.12 Delay volumes, on page
486.

 

Illustration of fraction marking using
fixed volume fractionation with
Fraction collector F9-R

The illustration below shows the fractions collected, and the numerical marking of frac-
tions, when fixed volume (straight) fractionation is used with Fraction collector F9-R.

Volume

Ab
so

rb
an

ce

 2  3  4  6  7  8  95  10  11  12  13  14  15  16  17  18  19 Fractionation marks shown in chromatogram

When fixed volume fractionation is used the delay volume is collected at the beginning
of fractionation.

Fraction collector F9-R saves the delay volume in the first tube (fraction 1), see the
previous example illustration. Delay volumes are not indicated with a numerical frac-
tion mark on the chromatogram.

Note: The built-in fraction collector does not save the delay volume, instead the
delay volume is disposed of in the waste funnel.

Note: The fractions collected by Fraction collector F9-R, are indicated by the
prefix 2: (i.e. fractions, 2 →2, 2 →3 etc.).
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Illustration of fractions and fraction
marking using peak fractionation
with Fraction collector F9-R

The following illustration shows the fractions collected, and the numerical marking of
fractions, when peak fractionation is used with Fraction collector F9-R.

Volume (ml)
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ce

Volume

2 3 4 6 7 9 10 11 Fractionation marks shown in chromatogram

When peak fractionation is used, Fraction collector F9-R collects the delay volumes in
the fractions preceeding each peak. In the chromatogram above, delay volumes are
collected in tubes corresponding to fraction 1, 5 and 8. The numerical fraction marks
for the delay volume fractions are not indicated on the chromatogram.

Note: The built-in fraction collector does not save the delay volume, instead the
delay volume is disposed of in the waste funnel.

Note: The fractions collected by Fraction collector F9-R, are indicated by the
prefix 2: (i.e. fractions, 2 →2, 2 →3 etc.).

Fractionation modes for built-in
fraction collector

There are three fractionation modes for the built-in Fraction collector, Automatic,
Accumulator and DropSync. Spillage between collection vessels during a run is
avoided with all three fractionation modes.

• Automatic: The fraction collector uses the DropSync mode for flow rates up to 2
ml/min and automatically switches to Accumulator mode for higher flow rates.

• Accumulator: Liquid is collected during movement between tubes or wells. The
liquid is then dispensed in the next well or tube. Fractionation with accumulator can
be used at all flow rates.

• DropSync: When using DropSync , the sensors in the Dispenser head detect when a
drop is released from the nozzle. The dispenser head moves to the next well or tube
just after a drop is released. Fractionation with DropSync can be used at flow rates
up to 2 ml/min. Solutions with low surface tension may require a lower flow.

Fractionation settings for Fraction
collector F9-R

There are two fractionation settings for Fraction collector F9-R, DropSync off or
DropSync on .
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Dropsync off: No synchronization of collection.

DropSync on: When using DropSync the sensors in the tube sensor detect when a
drop is released. The tube rack moves and positions the next tube under the tube
sensor just after a drop is released. Fractionation with DropSync can be used at flow
rates up to 2 ml/min. For water and solutions with higher surface tension, a higher flow
rate can be used. Volatile solutions and solutions with low surface tension may require
a lower flow.

Missing tubes or plates in built-in
fraction collector

When automatic cassette configuration is selected in the system settings the fraction
collector automatically detects which types of cassettes and plates that are present.
The fraction collector will however not detect if tubes or bottles are missing in the
cassettes. Make sure that the cassettes to be used are occupied by appropriate types
and numbers of tubes or bottles before starting a run.

It is not possible to change the cassette configuration during a run. When the system
state is set to Pause it is possible to take out cassettes or plates from the fraction
collector only if they are replaced by cassettes or plates of the same type and are
placed in the same positions.

The action of the system when the last tube in the fraction collector is filled is set in the
instruction Last tube filled in the system settings. The flow can be directed to waste
or to any of the outlets or the run can be paused. If the action is set to Pause, the
system automatically pauses when the last tube is filled and prompts the user to
replace the filled tubes.

Missing tubes in Fraction collector
F9-R

If a tube is missing, Fraction collector F9-R will continue the fractionation on the tube
row located closer to the center of the fraction collector. The fractionation marks in the
chromatogram will then not reflect the tubes in which the sample is collected.

If the fraction collector runs out of tubes, the delivery arm moves to the fraction
collector center position while ÄKTA avant pauses and displays an error message.

Peak broadening
The width of peaks at the fraction collector is influenced by the properties of the
column and the dimensions of tubing connecting the components and the compo-
nents themselves. Initial sample volume affects the peak width in gel filtration (GF)
chromatography. A sample zone is broadened during passage through a GF column so
that the sample is diluted and the resolution decreases with increasing sample volume.
Sample volume does not however affect the resolution in adsorption chromatography
techniques such as affinity chromatography (AC), ion exchange chromatography (IEX),
and hydrophobic interaction chromatography (HIC). The effect of peak broadening in
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the system from sample injection to peak detection (including dilution on the column)
is apparent in the chromatogram from the UV monitor, but broadening from the UV
monitor to fraction collection is not visible in the chromatogram. With small analytical
columns the peak broadening between the UV monitor and the fraction collector will
be obvious.
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5.9 Create a method and perform a run

About this section
This section provides an overview of how to create a method in UNICORN and how to
perform manual and method runs on ÄKTA avant.

It also contains advice on things to be considered during and after a run.

In this section

Section See page

5.9.1 Create a method 215

5.9.2 Perform a run 219

5.9.3 Monitor the run 222

5.9.4 After run procedures 224
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5.9.1 Create a method

Introduction
The predefined methods are built up using phases, where each phase corresponds to a
step in a chromatography run with a number of properties associated with that phase.

See UNICORN Method Manual for more information about method structure, defini-
tions and concepts of methods in UNICORN.

Note: UNICORN methods are always created specifically for a designated system
and thus also for a specific system type. However, it is often useful to convert
a method that was originally created for a system of one type, for use with a
system of another type. For example it is possible to convert a method
created for ÄKTA avant 25 to ÄKTA avant 150. See UNICORN Method
Manual.

Predefined methods
There are several predefined methods to choose from. All the predefined methods are
listed in the following topics.

The predefined methods available for each system are defined by the Instrument
Configuration. See Section 9.6 Predefined methods and phases, on page 429 for more
information about each method.

Purification methods

• Affinity Chromatography (AC)

• Anion Exchange Chromatography (AIEX)

• Cation Exchange Chromatography (CIEX)

• Chromatofocusing (CF)

• Desalting

• Gel filtration (GF)

• Hydrophobic Interaction Chromatography (HIC)

• Manual Loop Fill

• Reversed Phase Chromatography (RPC)

Maintenance methods

• Column CIP

• Column Performance Test

• Column Preparation

• Intelligent Packing (ÄKTA avant 150 only)

• System CIP

• System Preparation

5 Operation
5.9 Create a method and perform a run

5.9.1 Create a method

ÄKTA avant User Manual 29035184 AF 215



Main steps when defining a new
method

The main steps when defining a method are:

1. Create/open a method

• Create a Predefined method (including a set of phases that may be edited)

or

• Open an existing method that can be edited and saved with a new name or over-
written

2. Build/edit the Method Outline and/or edit the Phase Properties for the appro-
priate phases

3. Save the method

Create a new method

Follow the instructions to create a chromatographic method based on a predefined
method.

Step Action

1 Open the Method Editor module and click the New Method button.

Result:

The New Method dialog box opens.

5 Operation
5.9 Create a method and perform a run

5.9.1 Create a method

216  ÄKTA avant User Manual 29035184 AF



Step Action

2 In the System list, select your system. Click Predefined Method and in the
Predefined Method list select your predefined method. Click OK.

Result:

The phases included in the chosen method is shown in the Method Outline
pane, and the default settings for each of the phases is shown in the Phase
Properties pane.

See UNICORN Method Manual for more information about methods and method crea-
tion in UNICORN.

Note: Sample loop is called capillary loop in UNICORN.

Text Instruction mode
In most cases methods can be edited using the Phase Properties pane in the Method
Editor module. However, modules without a recommended position are not supported
by Phase Properties and have to be edited in the Text Instruction mode.

5 Operation
5.9 Create a method and perform a run

5.9.1 Create a method

ÄKTA avant User Manual 29035184 AF 217



The following modules require that the method is created using the Text Instruction
mode:

• Inlet valve IX

Note: It is necessary to use instructions for both Inlet valve IX (V9-IX or V9H-
IX) and the other inlet valve.

• Versatile valve V9-V or V9H-V

• I/O-box E9

• UV monitor U9-L, 2nd

Note: The UV monitor U9-L, 2nd is auto zeroed at the same time as UV monitor
U9-M in predefined methods. All other UV monitor U9-L, 2nd instruc-
tions need to be edited in the Text Instruction mode.
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5.9.2 Perform a run

Checklist
Make sure that the system is correctly prepared. Check that:

• The system is prepared according to Section 5.1 Before you prepare the system, on
page 148.

• A suitable column has been selected for the application. Consider target protein
and pressure range.

• The buffer inlet tubing is immersed in correct buffer vessels. Consider solution iden-
tity and volume.

Note: Inlet A1 and B1 must always be immersed in buffer or water. When the
System pumps are synchronized, the Inlet valves are positioned to A1
and B1 for a short moment. If the Sample pump is to be used, inlet Buff
must be immersed in buffer or water.

• The waste tubing is immersed into appropriate waste vessels. Consider vessel size
and vessel material.

• No tubing is twisted and the flow path is free from leakage.

• Check the pump piston rinsing system. Check that liquid is coming out of the outlet
tubing and that each tube contains at least 25 ml. If not, add liquid. Evaporation can
decrease volumes. To fill and prime the system, see Section 7.3.1 Change pump
rinsing solution, on page 259.

CAUTION

Close doors. To minimize the risk of exposure to hazardous chem-
icals and pressurized liquids, always close the foldable door and the
pump cover before starting a run.

WARNING

High pressure. The product operates under high pressure. Wear
protective glasses and other required Personal Protective Equip-
ment (PPE) at all times.

Choose and start a method

The following instruction describes how to open a method and start a run.
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Step Action

1 Open the System Control module and click the Open Method Navigator
button.

Result:

The Method Navigator pane opens.

2 Select the method to run, and click the Run button.

Result:

The Start Protocol dialog box opens.

3 Step through the displayed pages in the Start Protocol, add requested
input and make appropriate changes if necessary. Click Next.

4 Click Start on the last page of the Start Protocol.

Result:

• If column logging was chosen during installation of UNICORN and a
column type was selected when the method was created, the Select
Columns dialog box opens. For further information on column handling,
please refer to UNICORN Method Manual and UNICORN System Control
Manual.

• If column logging was not chosen during installation of UNICORN and/or
no column type was selected when the method was created, the run
starts directly.

Perform a manual run

Manual runs can be convenient for procedures such as filling tubing with buffer or
packing a column with media.

Step Action

1 On the Manual menu, click Execute Manual Instructions.
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Step Action

2 Select instruction group and instruction.

3 Select or enter parameter values.

4 Click Insert to have several instructions performed at the same breakpoint.

Note:

Manual runs are only stored temporarily. However, you can choose to store
them permanently in a selected directory. To save results in a chosen direc-
tory, click Browse before the run is started.

Note:

If a method run is started during a manual run, the results from the manual
run are not stored.

5 To perform the instructions, click Execute.

Tip: Manual runs can also be controlled from the Process Picture.
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5.9.3 Monitor the run

Introduction
You may follow the on-going method run in the System Control module. The current
system status is shown in the System state panel in the Run Data pane. For example,
it may state Run, Wash or Hold. The same information is also shown in the instrument
display.

• Selected curves are shown in the Chromatogram pane.

• All registered actions during the run are displayed in the Run Log pane.

• The current flow path is shown in the Process Picture pane.

For details on the System Control interface, see UNICORN System Control Manual.

Monitor the run
To interrupt a method during a run you may click the Hold, Pause or End buttons in
System Control. A held or paused method run can be resumed by clicking the
Continue button. See the following table.

If you want to... then...

temporarily hold the method, with current flow
rate and valve positions sustained click the  button.

temporarily pause the method, and stop all
pumps click the  button.

resume, for example, a held or paused method
run. click the  button.

Note:

An ended method cannot be
resumed.

permanently end the run

click the  button.

Note: When ending a method run in advance, it is possible to save the partial
result.

Process Picture
The Process Picture displays the current flow path, run parameters and real-time
data from monitors during a run. It also allows manual interactions with the system.

Tubing colors indicate flow path states, as shown in the following illustration and
described in the following table.
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Modules without a fixed place in the system are shown in a panel below the process
picture (modules are called components in the process picture).

Color Indication

Green Open flow path with flow.

Grey Closed flow path or an open path without flow.

Blue Syringe port in loop open for manual injection.

Actions in the Process Picture pane
It is possible to interact with the Process Picture pane.

• To open a related instruction, click the component icon. The example below shows
the pop-up toolbar for the Injection valve icon. Instructions can be given from the
pop-up toolbar of each component icon.

• To display a detailed picture with explanations, for example for a valve, right-click
the component icon and click Detailed picture.
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5.9.4 After run procedures

Introduction
This section describes how to clean the instrument and columns after a chromato-
graphic run, and how to prepare the system for storage.

The instrument and the columns should be cleaned between the runs. This will prevent,
for example, sample contamination, protein precipitation and column clogging. If the
instrument is not going to be used for a couple of days or longer, the instrument,
columns and the pH flow cell should be filled with storage solution. For further informa-
tion about cleaning and maintenance procedures, see Chapter 7 Maintenance, on page
249.

Tip: To clean and fill the instrument and columns with storage solution, use the
System CIP and Column CIP methods. Either as separate, predefined
methods or as phases included in a chromatographic method.

WARNING

Corrosive chemicals during maintenance. If the system or
column is cleaned with a strong base or acid, flush with water after-
wards and wash with a weak neutral buffer solution in the last step
or phase.

System cleaning
After a method run is completed, perform the following:

• Rinse the instrument with one or several cleaning solution(s) (e.g., NaOH, buffer
solution or distilled water) using the System CIP method.

• If applicable, empty the fraction collector.

• Clean all spills on the instrument and on the bench using a moist tissue.

• Empty the waste vessel.

• Clean the manual injection port of the injection valve, see Clean the manual injec-
tion port of the injection valve, on page 280 for detailed instructions.

• If applicable, clean the pH electrode manually and make sure to leave it in an appro-
priate buffer. See Section 7.6.6 Storage of the pH electrode, on page 291 for detailed
instructions.

System storage
If the instrument is not going to be used for a couple of days or longer, also perform the
following:

• Fill the system and inlets with storage solution (e.g., 20% ethanol) using the System
CIP method.
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Column cleaning
After a method run is completed, perform the following:

• Clean the column with one or several cleaning solution(s) using the Column CIP
method.

Column storage
If the column is not going to be used for a couple of days or longer, also perform the
following:

• Fill the column with storage solution (e.g., 20% ethanol) using the Column CIP
method.

pH electrode storage
If pH monitoring will not be used for a week or longer, perform one of the following
actions:

• Inject new storage solution into the pH flow cell.

• Replace the pH electrode with the dummy electrode that is installed in the pH valve
on delivery.

In the following situations, in order to increase the lifetime of the pH electrode, use the
By-pass position and store the electrode in storage solution inside the pH flow cell:

• pH monitoring is not needed during the run.

• Organic solutions are used.

• Extremely acidic or extremely basic solutions are used.

For further information on how to prepare the pH electrode for storage, refer to Section
7.6.6 Storage of the pH electrode, on page 291.

Log off or exit UNICORN
Follow the instructions to log off or exit UNICORN. This can be performed from any of
the UNICORN modules.
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If you want to... then...

log off UNICORN on the File menu, click Log off.

Result: All open UNICORN modules close and the Log On
dialog box opens.

exit UNICORN on the File menu, click Exit UNICORN.

Result: All open UNICORN modules close.

Note: If an edited method or result is open and not saved when you try to exit or
log off UNICORN, you will see a warning. Click Yes to save, No to exit without
saving, or Cancel to stay logged on.

Shut down the instrument
Switch off the instrument by pressing the Power switch to the O position.
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6 Performance tests

About this chapter
Performance tests should be run after installation to check the function of the ÄKTA
avant system. Performance tests can also be used at any time to check the condition of
the system, for example, after a prolonged stop. This chapter describes how to prepare,
run, and evaluate the available performance tests.

In this chapter

Section See page

6.1 General performance test actions 228

6.2 Air sensor tests 231

6.3 Built-in Fraction collector test 232

6.4 Fraction collector F9-R test 237

6.5 Quaternary valve test 240

6.6 System test 243

6.7 UV monitor U9-L test 247
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6.1 General performance test actions

Introduction
Some actions are identical for all performance tests. These actions are described in
this section.

Start the performance tests

Follow the instructions to start a performance test.

Step Action

1 In the System Control module, on the System menu, click Performance
Test and Report.

Result:

The System Performance Test and Report dialog box opens.

2 In the System Performance Test and Report dialog box, click one of the
following tests:

Test

Air sensors test

Fraction Collector test, Built in frac

Fraction Collector test, F9-R

Quaternary valve test

System test

UV test, U9-L

3 Click Run Performance Method.

Result:

The Start Protocol of the selected test opens.

4 Click Next in the Start Protocol dialog box to open the next dialog box. The
dialog boxes are described in the table Overview of the Start Protocol dialog,
on page 229.

5 In the last dialog box of the Start Protocol:Result name and location,
click Start.

Result:

The selected test starts.
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Overview of the Start Protocol dialog
The following table describes the pages of the Start Protocol.

Page Description

Notes Displays the Method Notes of the method. The Method
Notes contains a method description and instructions
on how to run the method. This dialog box also allows the
user to enter Start Notes.

Evaluation Proce-
dures

Allows the user to select to save the report to file
(recommended) and/or to print the report.

Result Name and
Location

Allows the user to change result name and result loca-
tion.

During the run
A Message dialog box opens during the run. Read the messages in the dialog, and
make sure that necessary preparations have been performed.

• Click Confirm and Continue in the Message dialog box to change system state
from System Pause to Run and proceed with the test.

• Alternatively, click Confirm in the Message dialog box and click the Continue
button on the Instrument display.

Automatic evaluation
The system automatically generates a report when the test is finished. The report can
be printed in two ways:
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• It is recommended to select Save the report to file in the Evaluation Procedures
page of the Start Protocol dialog box when starting the test. The report is saved in
the folder Temp in your UNICORN installation folder. For example
C:\Program Files\GE Healthcare\UNICORN\UNICORN 7.0\Temp.

• If the option Print report was selected in the Evaluation Procedures page of the
Start Protocol dialog box when starting the test, the report is also automatically
printed on the system printer. Refer to UNICORN Administration and Technical
Manual for information on how to install a printer.

Print the report and check the status of the tests. For each of the tests the report
states" The test passed" or "The test failed".

Note: The fraction collector test is evaluated manually and no report is generated.
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6.2 Air sensor tests

Method description
The Air sensors A, B, and S are integrated in Inlet valve A, Inlet valve B, and Sample inlet
valve. The Air sensors test checks if the air sensors detect air. The method run takes
approximately 5 minutes.

Required material
The following material is required:

• Syringe, 25 ml

• Distilled water

Prepare the Air sensors test

Follow the instruction to prepare the system before method start.

Step Action

1 Immerse the pieces of inlet tubing marked A1, B1, and the piece of sample
inlet tubing marked Buff in distilled water.

2 Prime the inlets A1, B1, and the sample inlet Buff, and purge the pumps. See 
Section 5.4.1 Prime buffer inlets and purge system pumps, on page 158 and 
Section 5.4.2 Prime sample inlets and purge Sample Pump, on page 165.

3 Disconnect the inlet tubing connected to the inlet valve positions A4, B4
and S4. During the test method air is introduced into the inlet valves through
these inlet ports to test the function of the air sensors.

Run and evaluate the test
Follow the instructions described in Section 6.1 General performance test actions, on
page 228 to start, run and automatically evaluate the performance test.

Possible causes of a failed test
The following table describes possible causes of a failed test. When possible sources of
error have been checked and taken care of, run the test once again.

Cause Action

Faulty air sensor For further information, see Inlet valves, on page 366.

Incorrect preparation
of tubing

Make sure that the tubing was correctly prepared, see 
Prepare the Air sensors test, on page 231.
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6.3 Built-in Fraction collector test

Method description
The Fraction collector test checks the functionality of the Fraction collector. For ÄKTA
avant 25, fractionation of 2 ml is performed in three sequential wells in each of two 96
deep well plates. For ÄKTA avant 150, fractionation of 20 ml is performed in three
sequential tubes placed in each of two Cassettes for 50 ml tubes.

The method run takes approximately 10 minutes.

Note: The fraction collector test is evaluated manually and no report is generated.

Required material
The following materials are required:

• Distilled water

• Syringe, 25 to 30 ml

• For ÄKTA avant 25:

- Two Cassettes for deep well plates

- Two 96 deep well plates

• For ÄKTA avant 150:

- Two Racks for 50 ml tubes

- Twelve 50 ml tubes

Prepare the Fraction collector test

Follow the instruction to prepare the system before method start.

Step Action

1 Immerse the piece of inlet tubing marked A1 in distilled water.

2 Prime inlet A1 and purge System pump A. See Section 5.4.1 Prime buffer
inlets and purge system pumps, on page 158.

3 Place the deep well plates or tubes in the Cassettes. Make sure that the deep
well plates are rotated so that the well marked A1 is positioned above the
A1 marking on the Cassette.
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Step Action

4 Place the Cassettes on the Cassette tray, one on Cassette position 1 and one
on Cassette position 6. Make sure that the Cassette type codes (see illustra-
tion below) faces the front of the tray marked with the Cytiva logo. No other
Cassetes must be present in the Fraction collector during the run.

5 Open the Frac drawer by pressing the handle upwards, and pulling out the
drawer.
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Step Action

6 Place the Cassette tray on the Tray support of the Frac drawer. Make sure
that the front of the tray (marked with the Cytiva logo) faces the front of the
drawer.

7 Close the Frac drawer. Make sure that it snaps into closed position.

8 In the System Control module, on the View menu, click Fraction collec-
tion content. In the Fraction collector content dialog box, check that the
automatic scanning procedures have been performed to show correct tube
and cassette positions.

9 In the System Control module, on the System menu, click Settings.

Result:

The System Settings dialog box opens.

10 In the System Settings dialog box:

• Select Fraction collector →Fractionation settings.

• For ÄKTA avant 25: In the Fractionation mode drop-down list, click
Accumulator.

• In the Fractionation order drop-down list, click Row-by-row.

• Click OK.

Run the test
Follow the instructions described in Section 6.1 General performance test actions, on
page 228 to start and run the performance test.
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During the test run
Visually check that the fraction collector wash is performed.

Evaluate the test
To evaluate the result, do the following:

• Check that the fractionation marks in the chromatogram correspond to the filled
wells and tubes and that there is minimal spillage. For further information on delay
volumes and fractionation marks, see Delay volume, on page 209.

ÄKTA avant 25

• Check that correct volumes, 2 ml per well, are collected in wells 1A1 to 1A4 and
6A1 to 6A4.

ÄKTA avant 150

• Check that correct volumes, 20 ml per tube, are collected in tubes 1A1 to 1A4 and
6A1 to 6A4.
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Possible causes of a failed test
The following table describes possible causes of a failed test. When possible sources of
error have been checked and taken care of, run the test once again.

Cause Action

Wrong volumes
collected in the wells or
tubes, and distur-
bances on the system
pressure curves:

- Air trapped in System
pump A

- Faulty System pump A

Air in pumps: Make sure to prime inlet tubing A1 and
purge System pump A before method start, see Section
5.4.1 Prime buffer inlets and purge system pumps, on
page 158.

Faulty pump: See Section 8.6 Troubleshooting: Pumps, on
page 380.

Liquid is collected in
the wrong wells or
tubes:

- Incorrect fractiona-
tion settings

Check the fractionation settings in the System
Settings dialog box.

Liquid is collected in
wrong Cassette:

- Incorrect preparation
of the Fraction
collector

Make sure that only two Cassettes are placed on the
Cassette tray, and that the Cassettes are positioned on
the cassette positions 1 and 6.

Fractionation inter-
rupted:

- Impurities on the
Dispenser head of the
Fraction collector

Clean the Fraction collector. See Section 7.6.4 Clean
built-in fraction collector, on page 287.

Incorrect preparation
of buffer and tubing

Make sure that the system was correctly prepared, see 
Prepare the Fraction collector test, on page 232.
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6.4 Fraction collector F9-R test

Method description
The Fraction collector F9-R test checks the functionality of Fraction collector F9-R.

The method run takes approximately 3 minutes.

Note: The fraction collector test is evaluated manually and no report is generated.

Required configuration
A correctly installed Outlet valve, and a correctly installed Fraction collector F9-R are
required to run the test.

Required material
The following materials are required:

• Distilled water

• Syringe, 25 to 30 ml

• 7 tubes, 2 ml or larger, for collecting the fractions.

Prepare the Fraction collector F9-R
test

Follow the instructions to prepare the system before method start.

Step Action

1 Make sure that the Fraction collector F9-R is connected to port Out 10 on
Outlet valve V9-O or V9H-O

2 Direct outlet tubing W to a waste container.

3 Place inlet tubing A1 into distilled water.

4 Prime inlet A1 and purge System pump A. See Section 5.4.1 Prime buffer
inlets and purge system pumps, on page 158.

5 Place 7 tubes in the Fraction collector, in positions 1 to 7.

6 In the System Control module, on the System menu, click Settings

Result:

The System Settings dialog box opens.
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Step Action

7 In the System Settings dialog box:

• Select Fraction collection →Fractionation settings frac 2.

• In the Drop sync field, click On.

• Click OK.

Run and evaluate the test
Follow the instructions described in Section 6.1 General performance test actions, on
page 228 to start and run the performance test. See the following topic for instructions
on how to evaluate the fraction collector test.

Evaluate the result
Check that the correct volumes have been collected in the tubes. The tubes should
contain the following:

• Tube 1: The delay volume

• Tube 2, 3 and 4: 2 ml

• Tube 5 and 6: 1 ml

Also, check that the fractionation marks in the chromatogram correspond to the filled
tubes and that spillage is kept to a minimum.

For further information on delay volumes and fractionation marks, see Delay volume,
on page 209.
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Possible causes of a failed test
The table below describes possible causes of a failed test. When possible sources of
error have been checked and corrected, repeat the test.

Cause Action

Incorrect volumes
collected in the tubes,
and disturbances of
system pressure
curves:

• Air trapped in
System pump A

• Faulty System pump
A

Air in pumps: Make sure to prime inlet tubing A1 and
purge System pump A before method start, see Section
5.4.1 Prime buffer inlets and purge system pumps, on
page 158.

Faulty pump: See Section 8.6 Troubleshooting: Pumps, on
page 380.

Liquid collected in
wrong tubes:

Make sure the fraction collector delivery arm is posi-
tioned above tube number 1 before starting the test.

Incorrect preparation
of buffer and tubing

Make sure that the system was correctly prepared, see 
Prepare the Fraction collector F9-R test, on page 237.
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6.5 Quaternary valve test

Method description
The Q valve test checks the functionality of the Quaternary valve. Correct gradient
formation is tested by producing a series of gradient steps. The method run takes
approximately 30 minutes for ÄKTA avant 25 and 70 minutes for ÄKTA avant 150.

Required material
The following material is required:

• 1% acetone in distilled water

• Distilled water

• Capillary loop Ref 1

• Syringe, 25 to 30 ml

• For ÄKTA avant 25: Mixer, 1.4 ml

• For ÄKTA avant 150: Mixer, 5 ml

Prepare the Q valve test

Follow the instructions to prepare the system before method start.

Step Action

1 Immerse the pieces of inlet tubing marked Q1 and Q3 in 1% acetone in
distilled water.

2 Immerse the pieces of inlet tubing marked Q2 and Q4 in distilled water.

3 Connect the capillary loop marked Ref 1 between Column valve ports 1A
and 1B to generate a back pressure.

4 For ÄKTA avant 25: Make sure that the Mixer with a chamber volume of 1.4
ml is installed.

For ÄKTA avant 150: Make sure that the Mixer with a chamber volume of 5 ml
is installed.

For information on how to change Mixer, see Section 7.8.2 Replace the Mixer,
on page 323.

5 Prime all Q inlets and purge the System pumps. See Section 5.4.3 Prime Q
inlets, on page 170.

Run and evaluate the test
Follow the instructions described in Section 6.1 General performance test actions, on
page 228 to start, run and automatically evaluate the performance test.
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Illustration of chromatogram
The illustration below shows a chromatogram from a Quaternary valve test. The
gradient steps are marked in the illustration.

100% UV0% UV 5% Q1 (UV),
95% Q2

5% Q3 (UV),
95% Q4

95% Q1 (UV),
5% Q2

95% Q3 (UV),
5% Q4

50% UV

Note: The illustration shows a chromatogram from a Q valve test on ÄKTA avant
25. A chromatogram from a Q valve test on ÄKTA avant 150 has a similar
appearance, but a different scale on the y-axis.

Possible causes of a failed test
The table below describes possible causes of a failed test. When possible sources of
error have been checked and taken care of, run the test once again.

Cause Action

Disturbances caused
by air trapped in
Quaternary valve or
any of the System
pumps

Make sure to prime all Q inlets and purge the System
pumps before method start, see Section 5.4.3 Prime Q
inlets, on page 170.
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Cause Action

Disturbances caused
by damaged pump
piston seals.

Replace piston seals. See ÄKTA avant Operating
Instructions, Maintenance chapter.

Unstable or incorrect
UV signal, or drifting
base line - faulty UV
monitor

See UV monitor U9-M and UV detector unit, on page 348

Wrong mixer chamber
size or faulty mixer

Change mixer chamber or replace the Mixer. See Section
7.8.2 Replace the Mixer, on page 323.

Faulty Quaternary
valve

See Quaternary valve, on page 367

Faulty System pumps See Section 8.6 Troubleshooting: Pumps, on page 380

Incorrect preparation
of buffer and tubing

Make sure that the system was correctly prepared, see 
Prepare the Q valve test, on page 240.
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6.6 System test

Method description
The System test checks the solvent delivery, the functionality of the UV and conduc-
tivity monitoring systems, and the valve functionality of the standard system.

The method run takes approximately 30 minutes.

Required material
The following material is required:

• Distilled water

• 1% acetone and 1 M NaCl in distilled water

• Capillary loop Ref 1

• Syringe, 25 to 30 ml

• For ÄKTA avant 25: Mixer, 1.4 ml

• For ÄKTA avant 150: Mixer, 5 ml

Prepare the test

Follow the instructions to prepare the system before method start.

Step Action

1 Immerse the piece of inlet tubing marked A1 in distilled water.

2 Immerse the piece of inlet tubing marked B1 in 1% acetone and 1 M NaCl in
distilled water.

3 Immerse the piece of inlet tubing marked Buff in 1% acetone and 1 M NaCl
in distilled water.

4 Connect the capillary loop marked Ref 1 between Column valve ports 1A
and 1B to generate a back pressure.

5 For ÄKTA avant 25: Make sure that the Mixer with a chamber volume of
1.4 ml is installed.

For ÄKTA avant 150: Make sure that the Mixer with a chamber volume of 5 ml
is installed.

For information on how to change Mixer, see Section 7.8.2 Replace the Mixer,
on page 323.

6 Prime the buffer inlets and purge System pump A and System pump B. See 
Section 5.4.1 Prime buffer inlets and purge system pumps, on page 158.
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Run and evaluate the test
Follow the instructions described in Section 6.1 General performance test actions, on
page 228 to start, run and automatically evaluate the performance test.

Possible causes of a failed test
The following tables describe possible causes of a failed test. When possible sources of
error have been checked and corrected, repeat the test.

Faulty Gradient Test Result

Cause Action

Disturbances caused
by air trapped in any of
the pumps

Make sure to prime the buffer inlets and to purge the
System pumps and the Sample pump before method
start. See Section 5.4.1 Prime buffer inlets and purge
system pumps, on page 158 and Section 5.4.2 Prime
sample inlets and purge Sample Pump, on page 165.

Disturbances caused
by damaged pump
piston seals.

Replace piston seals. See ÄKTA avant Operating
Instructions, Maintenance chapter.

Unstable or incorrect
UV signal, or drifting
base line - faulty UV
monitor

See UV monitor U9-M and UV detector unit, on page 348

Wrong mixer chamber
size or faulty Mixer

Change mixer chamber or replace the Mixer. See Section
7.8.2 Replace the Mixer, on page 323.

Faulty Step Response Result

Cause Action

If all values are faulty -
air in the pump or a
faulty pump

Air in pumps: Make sure to prime the buffer inlets and to
purge the System pumps and the Sample pump before
method start. See Section 5.4.1 Prime buffer inlets and
purge system pumps, on page 158 and Section 5.4.2
Prime sample inlets and purge Sample Pump, on page
165.

Faulty pump. See Section 8.6 Troubleshooting: Pumps, on
page 380.

Faulty values at 5% -
damaged pump piston
seal in System pump B

Replace piston seals. See ÄKTA avant Operating
Instructions, Maintenance chapter.
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Cause Action

Faulty values at 95% -
damaged pump piston
seal in System pump A

Replace piston seals. See ÄKTA avant Operating
Instructions, Maintenance chapter.

Faulty UV Absorbance Test

Cause Action

Incorrectly prepared
acetone solution

Make sure that the acetone solution is 1% and that no
solution has evaporated.

Faulty Pulsation Test

Cause Action

Air trapped in the
pumps

Make sure to prime and purge the system pumps before
starting the test, see Section 5.4.1 Prime buffer inlets
and purge system pumps, on page 158.

Faulty Conductivity Test Result

Cause Action

Incorrectly prepared
NaCl solution

Make sure that the NaCl solution is 1.00 M.

The value set for the
Cond temp compensa-
tion factor is not
optimal

If the test is performed at cold room temperature, open
the System Settings dialog box, select Conductivity
→Cond temp compensation and set the Compensa-
tion factor to 2.1

Faulty UV Noise Test

Cause Action

Air or dirt in the UV flow
cell

Flush or clean the UV cell, see Section 7.5.1 Clean the UV
flow cell, on page 269.

Impure buffer Check buffers for impurities.
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Faulty Pressure Check Test

Cause Action

Folded, twisted or
blocked tubing

Check the tubing.

Dirt in inline filter Replace the inline filter, see Section 7.3.2 Replace the
inline filter, on page 261.

System pressure
monitor not calibrated

Calibrate the pressure monitor, see Section 7.7.2 Cali-
brate the pressure monitors, on page 308.
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6.7 UV monitor U9-L test

Method description
UV U9-L test checks the functionality of the UV monitor U9-L.

The method run takes approximately 10 minutes.

Required configuration
A correctly installed UV monitor U9-L is required to run the test.

Required material
The following materials are required:

• Distilled water

• 1% acetone in distilled water

• Ref 1 tubing, see Reference tubing, on page 419

• Syringe, 25 to 30 ml

• Mixer, 1.4 ml

Prepare the UV U9-L test

Follow the instructions to prepare the system before method start.

Step Action

1 Direct outlet tubing W and W1 to a waste container.

2 Place inlet tubing A1 into distilled water.

3 Place inlet tubing B1 into a solution of 1% acetone in distilled water.

4 Connect the Ref 1 tubing on the Column valve position 1, to generate a back
pressure.

5 Make sure that the Mixer with a chamber volume of 1.4 ml is installed.

For information on how to change Mixer, see Section 7.8.2 Replace the Mixer,
on page 323.

6 Prime the buffer inlets and purge System pump A and System pump B. See 
Section 5.4.1 Prime buffer inlets and purge system pumps, on page 158.

Run and evaluate the test
Follow the instructions described in Section 6.1 General performance test actions, on
page 228 to start, run and automatically evaluate the performance test.
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Illustration of chromatogram
The illustration below shows a chromatogram from a function test with UV monitor
U9-L.

Possible causes of a failed test
The following tables describe possible causes of a failed test. When possible sources of
error have been checked and corrected, repeat the test.

Faulty UV Absorbance Test

Cause Action

Incorrectly prepared
acetone solution

Make sure that the acetone solution is 1% and that no
solution has evaporated.

Wrong UV cell path
length set in UNICORN

See, Calibration of the second UV monitor flow cell
length, on page 316.

6 Performance tests
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7 Maintenance

About this chapter
This chapter describes the maintenance program for ÄKTA avant and provides instruc-
tions for maintenance and replacement of spare parts.

In this chapter

Section See page

7.1 Maintenance Manager 250

7.2 Maintenance program 255

7.3 Weekly maintenance 258

7.4 Monthly maintenance 264

7.5 Semiannual maintenance 268

7.6 Maintenance when required 273

7.7 Calibration procedures 305

7.8 Replacement procedures 320

7 Maintenance
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7.1 Maintenance Manager

Introduction
Maintenance Manager allows the user to display general information about the
system and its modules, and also operational statistics of the modules. Notifications
for maintenance actions of the system and its modules are predefined. The user can
add automated maintenance notifications for the system. Maintenance notifications
are based on calender periods of system use, and for some modules also on opera-
tional statistics.

Open Maintenance Manager
In the System Control module, on the System menu, click Maintenance Manager to
open the Maintenance Manager dialog box.

7 Maintenance
7.1  Maintenance Manager
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View general information and
statistics

In the left side of the Maintenance Manager dialog box, select the system of interest
to view general information of the selected system. When modules are selected,
operational statistics are also displayed.

View maintenance notifications
Click the plus symbol (+) of the system of interest to expand the list of related mainte-
nance notifications. Select a notification to view notification details.

Note: Modules with no plus symbol (+) have no related maintenance notifications.

Edit a maintenance notification

Follow the instruction to edit a maintenance notification.

7 Maintenance
7.1  Maintenance Manager
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Step Action

1 In the left side field of the Maintenance Manager dialog box, select a main-
tenance notification.

Result:

Details of the selected maintenance notification are displayed in the dialog
box.

2 Edit the maintenance notification as desired:

• Select the Enable Event checkbox to activate the notification. If the box
is unchecked, the notification will not be issued.

• Enter a new interval after which the new notification will be issued.

• Click Restart to reset the counter and add a complete interval before the
next notification.

• Edit the message that will be shown in the maintenance notification.

• Click Default to restore the default settings for maintenance notifica-
tions.

3 Click Apply to save the changes.

Add a new system notification

The user can add new system notifications to the list of system events.

Follow the instructions to add a new system notification.

7 Maintenance
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Step Action

1 In the Maintenance Manager dialog box, click New System Notification.

Result:

The NewNotification field appears in the Maintenance Manager dialog
box.

2 In the NewNotification field:

• Enter a name for the new notification.

• Select a time interval after which the new notification will be issued.

• If desired, write a message that will be shown for the maintenance notifi-
cation.

3 Click Apply to save the changes and apply the notification settings.

Delete a user defined system
notification

To delete a user defined system notification, select the notification in the Mainte-
nance Manager dialog box and click Delete.

Note: Module notifications are predefined and cannot be deleted. If desired, they
can be disabled.

7 Maintenance
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Handle a maintenance notification
Each maintenance notification has a time interval after which the notification is issued.
When this time interval has been reached, a Maintenance Notification message
appears.

Follow the instruction to handle the notification.

Click... to...

reset the counter for a new maintenance notification
period.

Note:

Make sure that the maintenance action is performed as
instructed after the notification is acknowledged, other-
wise the system performance may deteriorate.

close the message without action.

Note:

The Maintenance Notification will be displayed each
time the System Control module is opened until the
notification is acknowledged.

7 Maintenance
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7.2 Maintenance program

Introduction
This section lists the periodic maintenance activities that should be performed by the
user of ÄKTA avant, as well as maintenance activities that should be performed when
required.

Maintenance is divided into:

• Daily maintenance

• Weekly maintenance

• Monthly maintenance

• Semiannual maintenance

• Maintenance when required

WARNING

• Hazardous biological agents during run. When using
hazardous biological agents, run System CIP and Column CIP
to flush the entire pump with bacteriostatic solution (e.g. 1M
NaOH) followed by a neutral buffer and finally distilled water,
before service and maintenance.

• Hazardous chemicals during run. When using hazardous
chemicals, run System CIP and Column CIP to flush the entire
system tubing with distilled water, before service and mainte-
nance.

• Always use appropriate Personal Protective Equipment (PPE)
during operation and maintenance of this product.

Periodic maintenance program
The following periodic maintenance should be performed by the user of ÄKTA avant.

Interval Maintenance action See section

Daily Calibrate the pH monitor Section 7.7.1 Calibrate the pH
monitor, on page 306

Weekly Check pressure monitors, cali-
brate if needed

Section 7.7.2 Calibrate the
pressure monitors, on page
308

Weekly Change pump rinsing solution Section 7.3.1 Change pump
rinsing solution, on page 259
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Interval Maintenance action See section

Weekly Check inline filter, replace if
necessary

Section 7.3.2 Replace the inline
filter, on page 261

Weekly Clean built-in fraction collector
sensors

Section 7.3.3 Clean built-in
fraction collector sensors, on
page 262

Monthly Check the flow restrictor Section 7.4.1 Check the flow
restrictor, on page 265

Monthly Check pump flow restrictors Section 7.4.2 Check the func-
tion of the pump flow restric-
tors, on page 267

Bi-annual Clean the UV flow cell Section 7.5.1 Clean the UV flow
cell, on page 269

Bi-annual Replace pH electrode Section 7.5.2 Replace the pH
electrode, on page 272

Maintenance when required
The following maintenance should be performed by the user of ÄKTA avant when
required.

Maintenance action See section

Clean the instrument externally Section 7.6.1 Clean the instrument externally,
on page 274

Perform System CIP (system
cleaning-in-place)

Section 7.6.2 Perform System CIP, on page 275

Perform Column CIP (column
cleaning-in-place)

Section 7.6.3 Perform Column CIP, on page 283

Clean the built-in fraction
collector

Section 7.6.4 Clean built-in fraction collector,
on page 287

Clean the Fraction collector F9-R Section 7.6.5 Clean Fraction collector F9-R, on
page 290

Clean Fraction collector F9-R
DropSync sensor

Section 7.6.5 Clean Fraction collector F9-R, on
page 290

Replace tubing and connectors Section 7.8.1 Replace tubing and connectors,
on page 321

Storage of pH electrode Section 7.6.6 Storage of the pH electrode, on
page 291

7 Maintenance
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Maintenance action See section

Clean the pH electrode Section 7.6.7 Clean the pH electrode, on page
293

Regenerate dried out pH elec-
trode

Section 7.6.8 Regenerate dried out pH elec-
trode, on page 296

Clean the conductivity monitor
flow cell

Section 7.6.12 Clean the Conductivity flow cell,
on page 303

Calibrate the Conductivity
Monitor

Section 7.7.3 Calibrate the Conductivity
Monitor, on page 312

Calibrate the UV monitors Section 7.7.4 Calibrate the UV monitors, on
page 316

Replace Mixer Section 7.8.2 Replace the Mixer, on page 323

Replace O-ring in Mixer Section 7.8.3 Replace the O-ring inside the
Mixer, on page 325

Replace UV flow cell Section 7.8.4 Replace the UV monitor U9-M
flow cell, on page 327 and Section 7.8.5 Replace
UV monitor U9-L flow cell, on page 330

Replace the flow restrictor Section 7.8.6 Replace Flow restrictor, on page
332

Replace inlet filters Section 7.8.7 Replace the inlet filters, on page
333

Wipe off excess oil from the
pump head

Section 7.6.11 Wipe off excess oil from the
pump head, on page 302

Clean the check valves Section 7.6.9 Clean pump head check valves,
on page 297

Replace check valves Section 7.8.8 Replace pump head check valves,
on page 334

Replace pump piston seals See ÄKTA avant Operating Instructions

Replace pump pistons See ÄKTA avant Operating Instructions

Replace pump rinsing system
tubing

Section 7.8.9 Replace pump rinsing system
tubing, on page 337

Replace valve modules Section 7.8.10 Replace a valve module, on page
339

Clean pump flow restrictors Section 7.6.10 Clean pump flow restrictors, on
page 300
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7.2 Maintenance program

ÄKTA avant User Manual 29035184 AF 257



7.3 Weekly maintenance

About this section
This section provides instructions for weekly maintenance activities.

In this section

Section See page

7.3.1 Change pump rinsing solution 259

7.3.2 Replace the inline filter 261

7.3.3 Clean built-in fraction collector sensors 262

7 Maintenance
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7.3.1 Change pump rinsing solution

Maintenance interval
Replace the pump rinsing solution in the system pumps and the sample pump every
week to prevent bacterial growth.

Required material
The following material are required:

• 20°C ethanol

• Syringe, 25 to 30 ml

Change the rinsing solution and
prime the rinsing system

Follow the instruction below to change rinsing solution and prime the pump piston
rinsing systems. See the tubing configuration of the pump piston rinsing systems in 
Illustration of the pump piston rinsing systems, on page 57.

Step Action

1 Unscrew the rinsing system tubes from the holders and discard the used
pump rinsing solution.

2 Fill each of the rinsing system tubes with 50 ml of 20°C ethanol.

3 Screw the rinsing solution tubes back in the holders.

4 Immerse the inlet tubing to the System pump piston rinsing system in one of
the rinsing solution tubes.

Note:

Make sure that the inlet tubing reaches to the very bottom of the rinsing solu-
tion tube.

7 Maintenance
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Step Action

5 Immerse the inlet tubing to the Sample pump piston rinsing system in the
other rinsing solution tube.

Note:

Make sure that the inlet tubing reaches to the very bottom of the rinsing solu-
tion tube.

6 Connect a 25 to 30 ml syringe to the outlet tubing of the System pump
piston rinsing system. Draw liquid slowly into the syringe.

7 Disconnect the syringe and discard its contents.

8 Immerse the outlet tubing in the rinsing solution tube where the inlet tubing
of the System pump piston rinsing system is immersed.

9 Connect a 25 to 30 ml syringe to the outlet tubing from the Sample pump
piston rinsing system. Draw liquid slowly into the syringe.

10 Disconnect the syringe and discard its contents.

11 Immerse the outlet tubing in the rinsing solution tube where the inlet tubing
of the Sample pump piston rinsing system is immersed.

12 Fill the rinsing solution tubes so that each of the tubes contains 50 ml of
20°C ethanol.

7 Maintenance
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7.3.2 Replace the inline filter

Maintenance interval
Replace the inline filter that is located in the top section of the Mixer every week. When
it starts to get clogged the back pressure from the filter will increase as registered by
the system pressure sensor. An indication of a clogged inline filter is that the difference
between the system pump pressure signal and the pre-column pressure signal will
start to rise.

Required material
The following materials are required:

• Online filter kit

• Forceps

• Gloves

Instruction

Follow the instructions to replace the inline filter that is located in the top of the Mixer.

Tip: Use forceps and gloves during the replacement procedure to avoid contam-
inating the mixer components.

Step Action

1 Unscrew the top section of the Mixer.

2 Remove the old filter using forceps. Replace the support net if this is
damaged. Fit the new filter.

3 Check the O-ring of the Mixer. If the O-ring is damaged, replace it according
to Section 7.8.3 Replace the O-ring inside the Mixer, on page 325.

4 While holding the Mixer upright, screw the top section back onto the Mixer.
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7.3.3 Clean built-in fraction collector sensors

Maintenance interval
Clean the fraction collector sensors every week, or when required, for example if the
fraction collector fails to read the tray ID or does not collect fractions correctly.

Required material
The following material is required:

• Wash bottle

• Water or 20% ethanol

• Cloth

Instructions

Follow the instructions to clean the fraction collector sensors. See Illustration of the
dispenser head, on page 85 for the location of the fraction collector sensors.

Step Action

1 In the System Control module, on the Manual menu, click Execute
Manual Instructions. In the Manual Instructions dialog, select Fraction
collection →Frac cleaning position and then click Execute.

Result:

The dispenser head moves to cleaning position, and the instrument display
states System pause.

2 Wipe off the dispenser head and the DropSync and type code reader sensor
windows using a wash bottle with water or 20% ethanol and a cloth.

3 Let the dispenser head dry completely before starting a run.
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Step Action

4 Close the fraction collector door.

Result:

Automatic scanning is performed.

5 In the System Control module, press the End button in the toolbar.

Result:

The dispenser head moves to home position, and the instrument display
states Ready.
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7.4 Monthly maintenance

Introduction
This section provides instructions for monthly maintenance.

In this section

Section See page

7.4.1 Check the flow restrictor 265

7.4.2 Check the function of the pump flow restrictors 267

7 Maintenance
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7.4.1 Check the flow restrictor

Maintenance interval
Check the back pressure for the flow restrictor every month.

Instruction

Follow the instruction to check the back pressure of Flow restrictor FR-902.

Step Action

1 Immerse the piece of inlet tubing marked A1 in distilled water, and immerse
the piece of tubing from Outlet valve port W in a waste container.

2 In the System Control module, on the Manual menu, click Execute
Manual Instructions.

Result:

The Manual instructions dialog opens.

3 In the Manual instructions dialog:

• Select Flowpath →Injection valve, and select Manual Load. Click
Insert.

• Select Flowpath →Column valve, and select By-pass. Click Insert.

• Select Flowpath →pH valve, and set the pH electrode to Off-line and
the Restrictor to In-line. Click Insert.

• Select Flowpath →Outlet valve, and select Out-Waste. Click Insert.

• Select Pumps and Pressures →System flow and set the Flow rate to
3.0 ml/min. Click Insert.

• Click Execute.

Result:

A system flow of 3.0 ml/min starts.

4 Note the PreC pressure displayed in the Run Data pane.

Tip:

If PreC pressure is not showing, click the Customize icon. In the
Customize dialog, under the Run Data Groups tab, select to view PreC
pressure.

5 In the Manual instructions dialog:

• Select Flowpath →pH valve, and set the pH electrode to Off-line and
the Restrictor to Off-line.

• Click Execute.
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Step Action

6 Note the PreC pressure displayed in the Run Data pane.

7 Calculate the difference between the two pressure values noted in step 4
and step 6.

8 Check that the pressure difference is within the range 0.2 ± 0.05 MPa.

If this is not the case, the Flow restrictor should be replaced, see Section
7.8.6 Replace Flow restrictor, on page 332.

7 Maintenance
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7.4.2 Check the function of the pump flow restrictors

Maintenance interval
Check the function of the pump flow restrictors every month.

Instruction

Follow the instruction to check the function of the pump flow restrictors.

Step Action

1 Make sure that inlet line A1 and B1 are primed with water or buffer and the
bottles should be standing on the buffer tray. The flow shall be off, no
method or manual run running.

2 Loosen the pieces of tubing marked 2A and 2B in their upper position, where
they connect to the pressure monitor.

3 Check if there are siphoning. If the pump flow restrictors are working there
should not be any siphoning.

4 If there are siphoning, the pump flow restrictors must be replaced at the
next service occasion by a Cytiva representative.

5 The piece of tubing marked 2A is connected to pump flow restrictor A, the
piece of tubing marked 2B is connected to pump flow restrictor B.

6 Check the sample pump flow restrictor in the same way, loosen the piece of
tubing marked 2S in its upper position, where it connects to the pressure
monitor.
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7.5 Semiannual maintenance

Introduction
This section provides instructions for semiannual (once every six months) mainte-
nance activities.

In this section

Section See page

7.5.1 Clean the UV flow cell 269

7.5.2 Replace the pH electrode 272

7 Maintenance
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7.5.1 Clean the UV flow cell

Maintenance interval
Clean the UV flow cell every six months, or when required.

NOTICE

Keep UV flow cell clean. Do not allow solutions containing
dissolved salts, proteins or other solid solutes to dry out in the flow
cell. Do not allow particles to enter the flow cell, as damage to the
flow cell may occur.

Required material
The following materials are required:

• Luer connector

• Waste container

• Syringe, 25 to 30 ml

• 10% surfactant detergent solution (e.g., Decon™ 90, Deconex 11, or RBS 25)

• Distilled water

Instruction

Follow the instructions below to clean the UV flow cell of UV Monitor U9-M or UV
Monitor U9-L. The illustrations show UV Monitor U9-M, UV Monitor U9-L is cleaned in
the same way. The UV flow cell can be mounted or not mounted on the instrument
during the cleaning procedure.

Step Action

1 Disconnect the tubing from the top of the UV flow cell, and replace the
fingertight connector with a Luer connector.
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Step Action

2 Disconnect the tubing from the bottom of the UV flow cell, and connect a
piece of waste tubing to the UV flow cell. Insert the waste tubing into a waste
container.

3 Fill a syringe with distilled water, and connect the syringe to the Luer
connector.

4 Squirt the distilled water through the UV flow cell in small amounts. Discon-
nect the syringe.

5 Fill a syringe with a 10% surfactant detergent solution, such as Decon 90,
Deconex 11, RBS 25 or equivalent, and connect the syringe to the Luer
connector.

Tip:

Heat the 10% surfactant detergent solution to 40°C to increase the cleaning
effect.

6 Squirt the detergent solution through the UV flow cell about five times.

7 Leave the detergent solution in the flow cell for at least 20 minutes.

8 Inject the detergent solution remaining in the syringe into the flow cell.
Disconnect the syringe.

9 Fill a syringe with distilled water. Connect the syringe to the Luer connector.

10 Inject the distilled water into the UV flow cell to rinse the flow cell. Discon-
nect the syringe.

11 Disconnect the Luer connector from the top of the UV flow cell. Reconnect
the piece of tubing from the Column valve to the top of the UV flow cell.
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Step Action

12 Disconnect the waste tubing from the bottom of the UV flow cell. Reconnect
the piece of tubing from the Conductivity monitor to the bottom of the UV
flow cell.
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7.5.2 Replace the pH electrode

Maintenance interval
Replace the pH electrode every six months, or when required.

Required material
The following materials are required: pH electrode, deionized water and standard
buffer pH 4.

Instruction

CAUTION

pH electrode. Handle the pH electrode with care. The glass tip
may break and cause injury.

Follow the instructions below to replace the pH electrode.

Step Action

1 Disconnect the pH electrode cable of the used pH electrode from the
connection on the front of the pH valve.

2 Unscrew the nut of the pH electrode by hand, and pull the used electrode
away.

3 Unpack the new pH electrode. Remove the cover from the tip of the new pH
electrode. Make sure that the electrode is not broken or dry.

4 Prior to first use of the electrode, immerse the glass bulb in deionized water
for 30 minutes and then in a standard buffer, pH 4, for 30 minutes.

5 Carefully insert the new pH electrode into the pH flow cell. Tighten the nut by
hand to secure the electrode.

6 Connect the pH electrode cable of the new electrode to the connection on
the front of the pH valve.

7 Calibrate the new pH electrode, see Section 7.7.1 Calibrate the pH monitor,
on page 306.
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7.6 Maintenance when required

Introduction
This section gives instructions for maintenance activities to be performed when
required.

In this section

Section See page

7.6.1 Clean the instrument externally 274

7.6.2 Perform System CIP 275

7.6.3 Perform Column CIP 283

7.6.4 Clean built-in fraction collector 287

7.6.5 Clean Fraction collector F9-R 290

7.6.6 Storage of the pH electrode 291

7.6.7 Clean the pH electrode 293

7.6.8 Regenerate dried out pH electrode 296

7.6.9 Clean pump head check valves 297

7.6.10 Clean pump flow restrictors 300

7.6.11 Wipe off excess oil from the pump head 302

7.6.12 Clean the Conductivity flow cell 303

7 Maintenance
7.6 Maintenance when required

ÄKTA avant User Manual 29035184 AF 273



7.6.1 Clean the instrument externally

Maintenance interval
Clean the the instrument externally when required. Do not allow spilled liquid to dry on
the instrument.

Required material
The following materials are required:

• Cloth

• Mild cleaning agent or 20% ethanol

Instruction

Follow the instructions to clean the instrument externally.

Step Action

1 Check that no run is in progress.

2 Switch off the instrument.

3 Wipe the surface with a damp cloth. Wipe off stains using a mild cleaning
agent or 20% ethanol. Wipe off any excess.

4 Let the instrument dry completely before using it.
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7.6.2 Perform System CIP

Introduction
The System CIP method is used to fill the instrument and the selected inlets and
outlets with cleaning solution.

WARNING

• Hazardous substances. When using hazardous chemicals,
take all suitable protective measures, such as wearing protec-
tive clothing, glasses and gloves resistant to the substances
used. Follow local and/or national regulations for safe operation
and maintenance of the product.

• Hazardous chemicals during run. When using hazardous
chemicals, run System CIP and Column CIP to flush the entire
system tubing with distilled water, before service and mainte-
nance.

Tip: If hazardous chemicals are used for system or column cleaning, wash the
system or columns with a neutral solution in the last phase or step.

Maintenance interval
Perform a System cleaning in place (System CIP) when required, for example between
runs where different samples and buffers are used. This is important to prevent cross-
contamination and bacterial growth in the instrument.

Required material
The following materials are required:

• Appropriate cleaning solutions (e.g., 1 M NaOH, buffer solution or distilled water).

• Syringe, 25 ml

Create a System CIP method

Follow the instruction to create a System CIP method.
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Step Action

1 In the Method Editor module,

• click the New Method button 

or

• on the File menu, click New Method.

Result:

The New Method dialog opens.
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Step Action

2 In the New Method dialog.

• In the System list select the name of the system.

• Click Predefined Method, then in the Predefined Method list, click
System CIP.

• Click OK.

Result:

One Method Settings phase and three System CIP phases show in the
Method Outline pane. Each System CIP phase uses one cleaning solution.

3 If desired, add additional System CIP phases to the method using the
Phase Library.
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Step Action

4 In the Phase Properties tab of each of the System CIP phases:

• Enter a note for the first solution (optional).

• Enter values for Flow rate, Volume per position and Incubation time.

• Define the extent of cleaning by selecting the check boxes.

Note:

For complete cleaning of the Injection valve, select at least one of the sample
inlets and clean the manual injection port using a syringe (see Create a
System CIP method, on page 275).

Note:

The pH electrode is not included in System CIP, but the flow restrictor is in
line. Refer to Section 7.6.7 Clean the pH electrode, on page 293 for instruc-
tions on how to clean the pH electrode.
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Step Action

5 In the Method Editor module,

• click the Save the method button 

or

• on the File menu, click Save As

Result:

The Save As dialog opens.

6 In the Save As dialog:

• Select a target folder to enable the Save button.

• Type a Name for the method.

• Select a System from the list.

• Click Save.

Result:

The created method is saved in the selected folder.

Run a System CIP method

Follow the instructions to run a System CIP method.

Step Action

1 In the Method Editor module, create a System CIP method according to
the previous instructions.

2 Connect by-pass tubing to all selected column positions and loop positions if
a loop valve is used.

3 Prepare cleaning solutions and immerse the selected inlet tubing in the
solutions.

Note:

Note that each phase uses one solution. All inlets selected in one phase
should be immersed in the same cleaning solution.

4 In the System Control module, select the created method and start the
run.

5 For complete cleaning of the flow path, clean the manual injection port of
the Injection valve and the pH valve manually, see the instructions below.
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Clean the manual injection port of the
injection valve

Follow the instructions to manually clean the manual load position of the Injection
valve.

Step Action

1 In the System Control module, on the Manual menu, click Execute
Manual Instructions.

Result:

The Manual instructions dialog opens.

2 In the Manual instructions dialog, select Flowpath →Injection valve, and
click Manual Load. Click Execute.

3 Connect a suitable sample loop to Injection valve ports LoopF (fill) and
LoopE (empty).

Note:

Do not use a Superloop when cleaning the Injection valve.

4 Connect tubing to Injection valve port W1, and direct this tubing to a waste
container.
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Step Action

5 Fill a syringe with approximately 10 ml of an appropriate cleaning solution
(e.g., 1M NaOH). Connect the syringe to Injection valve port Syr, and inject
the cleaning solution. Leave the cleaning solution in place for 20 minutes.

6 Fill a syringe with distilled water. Connect the syringe to Injection valve port
Syr, and inject the distilled water.

Clean the pH valve

Follow the instructions to clean the pH valve. The calibration function is used to switch
the valve position. However, no calibration is performed.

Step Action

1 Connect tubing to pH valve port W3, and direct the other end of this tubing
to a waste container.

2 Unscrew the pH electrode from the pH valve, and replace it with the dummy
electrode.
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Step Action

3 Open the System Control module, on the System menu, click Calibrate.

Result:

The Calibration dialog opens.

4 In the Calibration dialog, in the Monitor to calibrate list, click pH.

5 Click Prepare for calibration.

Result:

The pH valve switches to the calibration position.

6 Fill a syringe with approximately 10 ml of 1 M NaOH. Connect the syringe to
the pH valve port Cal, and inject the solution. Leave the cleaning solution in
place for 20 minutes.

7 Fill a syringe with distilled water. Connect the syringe to the pH valve port
Cal, and inject the distilled water.

8 Click Close.

Result:

The pH valve switches back to the default position and the Calibration
dialog closes. No calibration is performed.
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7.6.3 Perform Column CIP

Introduction
The Column CIP method is used to clean the column after purification runs, to remove
non-specifically bound proteins and to minimize the risk for carry-over between
different purification runs.

WARNING

• Hazardous substances. When using hazardous chemicals,
take all suitable protective measures, such as wearing protec-
tive clothing, glasses and gloves resistant to the substances
used. Follow local and/or national regulations for safe operation
and maintenance of the product.

• Hazardous chemicals during run. When using hazardous
chemicals, run System CIP and Column CIP to flush the entire
system tubing with distilled water, before service and mainte-
nance.

Tip: If hazardous chemicals are used for system or column cleaning, wash the
system or columns with a neutral solution in the last phase or step.

Maintenance interval
Perform a Column cleaning in place (Column CIP) when required, for example between
runs where different samples are used.

Required material
The following materials are required:

• Appropriate cleaning solutions. Please refer to the instructions for use of the
column.

Create a Column CIP method

Follow the instructions to create a Column CIP method.
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Step Action

1 In the Method Editor module,

• click the New Method button 

or

• on the File menu, click New Method.

Result:

The New Method dialog opens.

2 In the New Method dialog.

In the System list select the name of the system. Click Predefined
Method. In the Predefined Method list, click Column CIP. Click OK.

Result:

One Method Settings phase and one Column CIP phase will be displayed
in the Method Outline pane.

3 In the Phase Properties tab of the Method Settings phase, select
Column type and Column position.
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Step Action

4 In the Phase Properties tab of the Column CIP phase:

• Click Add Step to add a step.

• Select the step and click Remove Step to remove a step.

• To enter a value, select the cell and enter or select a new value.

5 In the Phase Properties tab of the Column CIP phase, click the Get
Suggested Steps button to get a suggested procedure for the selected
column type. Note that this function is not available for all column types.

Result:

Suggested cleaning steps for the selected column type are displayed.

6 If several cleaning solutions are used, change settings for Inlet A and/or
Inlet B. Select one inlet for each solution. If Inlet B is used, remember to edit
the values in the %B column.
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Step Action

7 In the Method Editor module,

• click the Save the method button 

or

• on the File menu, click Save As

Result:

The Save As dialog opens.

8 In the Save As dialog:

• Select a target folder to enable the Save button.

• Type a Name for the method.

• Select a System from the list.

• Click Save.

Result:

The created method is saved in the selected folder.

Run a Column CIP method

Follow the instructions below to run a Column CIP method.

Step Action

1 In the Method Editor module, create a Column CIP method according to
the previous instruction.

2 Prepare cleaning solutions and immerse the selected inlets in the solutions.

3 Connect the column to the selected column position.

4 In the System Control module, select the created method and start the
run.
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7.6.4 Clean built-in fraction collector

Maintenance interval
Clean the Fraction collector when required, for example if liquid has been spilled in the
Fraction collector chamber. The internal tubing of the fraction collector may need to be
replaced for maintenance or for process purposes. Information on how and when to
replace the internal tubing can be found in Section 7.8.1 Replace tubing and connec-
tors, on page 321

Required material
The following materials are required:

• Wash bottle

• Water or 20% ethanol

• Cloth

Instruction

Follow the instruction below to clean the interior of the fraction collector. See the loca-
tions of the components of the fraction collector in Section 3.10.2 Illustrations of the
built-in fraction collector, on page 83.

Step Action

1 In System Control module, on the Manual menu, click Execute Manual
Instructions.

Result:

The Manual instructions dialog opens.
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Step Action

2 In the Manual instructions dialog:

Select Fraction collection →Frac cleaning position.

Click Execute.

Result:

The dispenser head moves to cleaning position, and the instrument display
states System pause.

3 Open the fraction collector drawer and lift off the cassette tray.

4 Wash the cassettes and the cassette tray with water and a mild cleaning
agent.

5 Lift off the waste funnel and wash it with water and a mild cleaning agent.
Refit the waste funnel.

6 In ÄKTA avant 150 only: Remove the dispenser head cover and wash it with
water and a mild cleaning agent. Refit the dispenser head cover.

7 Wipe off the fraction collector chamber interior using a damp cloth. Wipe off
stains using a mild cleaning agent or 20% ethanol.

Note:

Be careful not to damage the fractionation arm flat cable.

Tip:

The fraction collector arm can easily be moved to facilitate cleaning of the
fraction collector.

Tip:

The cassette tray positioning discs can easily be removed to facilitate
cleaning of the fraction collector. Make sure to refit the discs before the
cassette tray is inserted in the fraction collector chamber. In ÄKTA avant 25,
all three discs are identical. In ÄKTA avant 150, the disc that is higher and has
a smaller diameter shall be placed in the rearmost disc position.
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Step Action

8 Wipe off the dispenser head and its diode windows using a wash bottle with
water or 20% ethanol and a cloth. ÄKTA avant 25 has four diode windows
and ÄKTA avant 150 has two diode windows (see the following illustrations).

Dispenser head in ÄKTA avant 25 Dispenser head in ÄKTA avant 150.

Note:

Be careful not to scratch the diode windows.

9 Let the fraction collector dry completely before starting a run.

10 Close the fraction collector drawer.

Result:

Automatic scanning is performed.

11 In the System Control module, click the End button in the toolbar.

Result:

The dispenser head moves to home position, and the instrument display
states Ready.
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7.6.5 Clean Fraction collector F9-R

Maintenance interval
Clean the Fraction collector when required, for example in case of liquid spill.

Required material
The following materials are required:

• Water or 20% ethanol

• Cloth

Clean the instrument

Follow the instructions below to clean the instrument externally.

Step Action

1 Check that no run is in progress.

2 Switch off the instrument.

3 Wipe the surface with a damp cloth. Wipe off stains using a mild cleaning
agent or 20% ethanol. Wipe off any excess.

4 Let the Fraction collector F9-R dry completely before restart.

Clean DropSync sensor
Clean the drop sensor photocell located above the tube sensor (see Front view illustra-
tion, on page 124) with a damp cloth.
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7.6.6 Storage of the pH electrode

Maintenance interval
When pH monitoring is not used, the pH electrode can be stored in storage solution
inside the pH flow cell. If pH monitoring is not used for a week or longer, inject new
storage solution into the pH flow cell or replace the pH electrode with the dummy elec-
trode that was installed in the pH valve on delivery.

Required material
The following materials are required:

• Syringe, 25 to 30 ml

• Storage solution (1:1 mixture of standard buffer, pH 4, and 1 M KNO3)

Instruction

Follow the instructions below to fill the pH flow cell with storage solution. The calibra-
tion function is used to switch the position of the pH valve. However, no calibration is
performed.

Step Action

1 In the System Control module, on the System menu click Calibrate.

Result:

The Calibration dialog opens.

2 In the Calibration dialog, click pH on the Monitor to calibrate drop-down
list.

3 Click Prepare for Calculation.

Result:

The pH valve switches to the calibration position.
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Step Action

4 Prepare at least 10 ml storage solution by mixing equal volumes of a
standard buffer, pH 4, and a 1 M Potassium Nitrate (KNO3) solution.

5 Fill a syringe with approximately 10 ml of the storage solution. Connect the
syringe to the pH valve port Cal, and inject the storage solution.

6 Click Close.

Result:

The pH valve switches back to the default position and the Calibration
dialog closes. No calibration is performed.
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7.6.7 Clean the pH electrode

Maintenance interval
Clean the pH electrode when required. The pH electrode can be cleaned either when it
is installed in the pH valve or when it has been removed. The pH electrode has a limited
longevity and should be replaced every six months or when the response time is slow,
see Section 7.5.2 Replace the pH electrode, on page 272. After cleaning has been
performed, re-calibrate the pH monitor, see Section 7.7.1 Calibrate the pH monitor, on
page 306.

Required material
The following materials are required:

• Syringe, 25-30 ml

• Distilled water

• 0.1 M HCl and 0.1 M NaOH

or

• Liquid detergent

or

• 1% pepsin solution in 0.1 M HCl

or

• 1 M KNO3

Cleaning agents

Clean the pH electrode using one of the following procedures:

Salt deposits
Dissolve the deposits by immersing the electrode for a five minute period in each of the
following solutions:

• 0.1 M HCl

• 0.1 M NaOH

• 0.1 M HCl

Rinse the electrode tip in distilled water between each solution.

Oil or grease films
Wash the electrode tip in liquid detergent and water. If the films are known to be
soluble in a particular organic solvent, wash with this solvent. Rinse the electrode tip in
distilled water.
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Protein deposits
Dissolve the deposit by immersing the electrode in a solution of 1% pepsin in 0.1 M HCl
for five minutes, followed by thorough rinsing with distilled water.

If these procedures fail to rejuvenate the electrode, try the following procedure.

Note: This procedure can be performed only when the pH electrode is not installed
in the pH valve.

Step Action

1 Heat a 1 M KNO3 solution to 60°C–80°C.

2 Place the electrode tip in the heated KNO3 solution.

3 Allow the electrode to cool while immersed in the KNO3 solution before re-
testing.

If these steps fail to improve the electrode, replace the electrode, see Section 7.5.2
Replace the pH electrode, on page 272.

Clean a pH electrode installed in the
pH valve

Follow the instructions below to clean a pH electrode installed in the pH valve. The cali-
bration function is used to switch the position of the pH valve. However, no calibration
is performed.

Step Action

1 Open the System Control module. On the System menu, click Calibra-
tion.

Result:

The Calibration dialog opens.

2 Set the pH monitor as the monitor to calibrate by clicking pH on the
Monitor to calibrate menu.
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Step Action

3 Click Prepare for Calibration.

Result:

The pH valve switches to the calibration position.

4 Fill a syringe with approximately 10 ml of chosen cleaning solution. Connect
the syringe to the pH valve port Cal. Inject the liquid and wait for 5 minutes.
Disconnect the syringe.

5 If several cleaning solutions are to be used, repeat step 4 with distilled water
and then with the next solution.

6 As the last step in the cleaning procedure:

• Fill a syringe with distilled water.

• Connect the syringe to the pH valve port Cal.

• Inject the water.

• Disconnect the syringe.

7 Click Close.

Result:

The pH valve switches back to the default position and the Calibration
dialog closes. No calibration is performed.
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7.6.8 Regenerate dried out pH electrode

Introduction
If the glass membrane dries out it is important to restore the hydrated glass layer.

Stage Description

1 First try Method 1.

2 If Method 1 does not help, try Method 2.

3 If the electrode continues to be slow or not function properly, replace it
with a new one.

Regeneration methods
Use one or both of the following methods to regenerate a dried out pH electrode.

Method 1
Soak the electrode in 1 M KNO3 for 5 hours or overnight.

Method 2
Soak the electrode in 0.1 M HCl overnight. Rinse it carefully with distilled water. Soak it
in 4 pH buffer for 1 hour.
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7.6.9 Clean pump head check valves

Introduction
Clean the check valves when required, for example if particles like dust or salt crystals
in the check valve cause irregular or low flow. The cleaning procedure is the same for
the system pumps and the sample pump.

Required material
The following materials are required:

• Adjustable wrench

• 100% Methanol

• Distilled water

• Ultrasonic bath

Instruction

Follow the instructions to remove and clean the pump head check valves.

Step Action

1 Before taking the check valve apart, always try to clean the check valves by
priming the pump heads first with distilled water, then with 100% Methanol
and then with distilled water again.

2 Switch off the instrument.

3 Disconnect the tubing from the pump head and disconnect the pump inlet
tubing. Disconnect the tubing of the pump rinsing system.

4 Unscrew the purge valve by turning it counter-clockwise, and lift off the
metal ring.
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Step Action

5 Unscrew the plastic nut of the upper check valve using an adjustable wrench,
and gently lift off the upper check valve.

6 Unscrew the two white plastic screws located below each pump head. Pull
the plastic connectors to the sides to release the inlet manifold.

7 Unscrew the lower check valve using an adjustable wrench.
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Step Action

8
WARNING

Hazardous substances. When using hazardous chemi-
cals, take all suitable protective measures, such as
wearing protective clothing, glasses and gloves resistant
to the substances used. Follow local and/or national
regulations for safe operation and maintenance of the
product.

Immerse the valves completely in methanol and place them in an ultrasonic
bath for a few minutes. Repeat the ultrasonic bath with deionized water.

9 Refit the check valves.

10 Tighten the nut until fully finger-tight and then use the adjustable wrench to
tighten a further 90 degrees.

11 Refit the inlet manifold and reconnect the tubing to the pump head.
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7.6.10 Clean pump flow restrictors

Introduction
Clean the pump flow restrictors when required for example if particles like dust or salt
crystals is causing blockage. The cleaning procedure is the same for the system pumps
and the sample pump.

Required material
The following materials are required:

• Stop plug, 1/16″ male

• Union, 1/16" female to 1/16" female

• Union, Luer female to 1/16" male

• Syringe, 25 ml

• Waste beaker

Instruction

Follow the instructions to clean the System pump A flow restrictor. Use the same
procedure to clean the System pump B or the Sample pump flow restrictors.

Step Action

1 Place the buffer bottles on the bench to avoid siphoning effects when
opening the flow path.

2 Disconnect the piece of tubing marked 2A from the flow restrictor block and
connect a stop plug, 1/16” male, to the restrictor block.

3 Disconnect the pieces of tubing marked 1A1 and 1A2 from the pump outlet
check valves. Place the tubing marked 1A1 in a waste beaker. Connect a
union, 1/16" female to 1/16" female, to the piece of tubing marked 1A2.
Connect a union, Luer female to 1/16" male, to the other side of the union.

4 Connect a Luer syringe filled with distilled water to the union and flush it
through the flow restrictor block. Be careful to avoid spillage if there is a salt
blockage creating back pressure. When the flow path is free continue with
next step.

5 Move the stop plug from the 2A outlet to the 1A1 inlet in the flow restrictor
block. Connect a piece of tubing from the 2A outlet to waste.

6 Refill the syringe with distilled water and press gently to flush the flow path
through the flow restrictor. Be careful to avoid spillage if there is a salt
blockage creating back pressure. The flow restrictor itself will also create
some back pressure. Continue until the flow path is free.
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Step Action

7 Reconnect the pieces of tubing marked 2A, 1A1 and 1A2 and place the
buffer bottles on top of the system again.

Note: If blockage is flushed away with water, stronger cleaning solutions can then
be used. Pump the cleaning solution through the pump in a standard
manner and out to the Injection valve waste oulet.
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7.6.11 Wipe off excess oil from the pump head

Maintenance interval
During the first months of use it is normal that excess oil leaks out of the drain hole
below the System pump. The function of the pump is not in any way affected by this.

Required material
The following materials are required:

• Cloth

• Mild cleaning agent or 20% ethanol

Instruction

Follow the instructions below to clean the System pumps externally.

Step Action

1 Check that no run is in progress.

2 Switch off the instrument.

3 Wipe off the excess oil from the pump head with a damp cloth. Wipe off
stains using a mild cleaning agent or 20% ethanol.

4 Let the pump dry completely before using the instrument.
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7.6.12 Clean the Conductivity flow cell

Maintenance interval
Clean the Conductivity flow cell when required.

Required material
The following materials are required:

• Luer connector

• Waste container

• Syringe, 25 mL

• 1 M NaOH

• Distilled water

Instruction

Follow the instruction to clean the flow cell of the Conductivity monitor. The same
procedure also applies to the second Conductivity monitor.

Step Action

1 Disconnect the Fingertight connector and the piece of tubing from the top
of the Conductivity monitor, and attach a Luer connector.

2 Disconnect the piece of tubing from the bottom of the Conductivity monitor,
and connect a piece of waste tubing to the Conductivity monitor. Place the
waste tubing in a waste container.

3 Disconnect the Conductivity monitor from the rails, or slide the Conductivity
monitor to the right on the rails.
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Step Action

4 Fill a syringe with distilled water, and connect the syringe to the Luer
connector.

5 Squirt distilled water through the conductivity flow cell in small amounts.
Disconnect the syringe.

6
WARNING

Hazardous substances. When using hazardous chemi-
cals, take all suitable protective measures, such as
wearing protective clothing, glasses and gloves resistant
to the substances used. Follow local and/or national
regulations for safe operation and maintenance of the
product.

Fill a syringe with 1 M NaOH, and connect the syringe to the Luer connector.

7 Squirt 1 M NaOH through the conductivity flow cell about five times.

8 Leave the liquid in the flow cell for at least 15 minutes.

9 Fill a syringe with distilled water. Connect the syringe to the Luer connector.

10 Inject the distilled water into the conductivity flow cell to rinse the flow cell.
Disconnect the syringe.

11 Disconnect the Luer connector from the top of the conductivity flow cell, and
reconnect the fingertight connector with tubing.

Note: If the cell was very dirty and correct absolute values are important, calibrate
the conductivity monitor after cleaning
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7.7 Calibration procedures

About this chapter
This section provides instructions for calibration procedures that can be performed
using the System Control module in UNICORN software.

In this section

Section See page

7.7.1 Calibrate the pH monitor 306

7.7.2 Calibrate the pressure monitors 308

7.7.3 Calibrate the Conductivity Monitor 312

7.7.4 Calibrate the UV monitors 316

Open the Calibration dialog box
Open the System Control module. On the System menu, click Calibrate to open the
Calibration dialog box.
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7.7.1 Calibrate the pH monitor

Maintenance interval
Calibrate the pH monitor once a day, when the pH electrode has been replaced, or if the
ambient temperature has changed by more than 5°C.

Required material
Use two pH calibration buffers with a difference of at least one pH unit. Preferably use a
pH standard buffer, pH 4 or pH 7, as the first calibration point, and a pH standard buffer
close to the lowest or highest pH you need to measure as your second point. Allow the
buffers to equilibrate to ambient temperature before use.

Instruction

CAUTION

pH electrode. Handle the pH electrode with care. The glass tip
may break and cause injury.

Follow the instructions to perform the calibration.

Step Action

1 Open the System Control module. On the System menu, click Calibra-
tion.

Result:

The Calibration dialog box opens.

2 Select pH in the Monitor to calibrate list.
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Step Action

3 Click Prepare for calibration.

Result:

The pH valve switches to the calibration position.

4 Enter the pH of the first pH standard buffer in the pH for buffer 1 box.

5 Fill a syringe with approximately 10 ml of the first pH standard buffer.
Connect the syringe to the Luer connector in pH valve port Cal, and inject
the buffer.

6 When the Current value is stable, click Calibrate.

7 Wash the pH flow cell by injecting water into pH valve port Cal using a new
syringe.

8 Enter the pH of the second pH standard buffer in the pH for buffer 2 box.

9 Repeat steps 5 to 6 using the second pH standard buffer.

Result:

Calibration date and time are displayed in the dialog box, and also values for
Calibrated electrode slope and Asymmetry potential at pH 7.

10 Is the Calibrated electrode slope ≥ 80% and the Asymmetry potential
at pH 7 inside the interval ±60 mV?

• If Yes: Click Close to switch the pH valve back to the default position, and
to close the Calibration dialog box.

• If No: Clean the pH electrode, and repeat the calibration procedure. If this
does not help, replace the electrode. For information about cleaning and
replacing the pH electrode, see Section 7.5.2 Replace the pH electrode, on
page 272.
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7.7.2 Calibrate the pressure monitors

Maintenance interval
ÄKTA avant has four pressure monitors: system pump pressure monitor, sample pump
pressure monitor, pre-column pressure monitor and post-column pressure monitor.
Check the pressure monitors every week, or when the the ambient temperature has
changed more than 5°C. Calibrate the monitor if the zero pressure reading is outside
the range ± 0.02 to MPa.

Check the monitors

Follow the instructions to check the pressure monitors. The procedure is the same for
each monitor.

Step Action

1 Disconnect the relevant tubing from the pressure monitor to obtain zero-
pressure, see table Tubing and pressures, on page 309.

2 Click the Customize button to open the Customize dialog box. In the
Customize dialog box, under the Run Data Groups tab, select the relevant
pressure to display, see table Tubing and pressures, on page 309. Click OK to
close the Customize dialog box.

3 In the Run Data pane in the System Control module, check what pressure
is displayed.

4 If the zero pressure reading is outside the range ± 0.02 MPa, calibrate the
pressure monitor according to the instruction below.

Calibrate the monitors

Follow the instructions below to calibrate any of the pressure monitors.

Step Action

1 Disconnect the relevant tubing from the pressure monitor, see table Tubing
and pressures, on page 309.

7 Maintenance
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Step Action

2 In the Calibration dialog, in the Monitor to calibrate list, select the pres-
sure monitor to calibrate.

3 Click Reset pressure.

Result:

The atmospheric pressure is defined as zero. Date and time of the most
recent calibration, and the current pressure value are displayed.

4 Reconnect the tubing to the pressure monitor.

Tubing and pressures
The following table shows the tubing to disconnect when checking and calibrating the
pressure monitors. The UNICORN names of the pressures measured by the monitors
are also shown.

7 Maintenance
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Pressure
monitor

Tubing to disconnect Pressure in
UNICORN

System pump
pressure monitor

Tubing from the System pump pressure
monitor

System pres-
sure

Sample pump
pressure monitor

Tubing from the Sample pump pressure
monitor

Sample pres-
sure
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Pressure
monitor

Tubing to disconnect Pressure in
UNICORN

Pre-column pres-
sure monitor

Tubing to Column valve V9-C or V9H-C
port In

PreC pressure

Post-column
pressure monitor

Tubing to Column valve V9-C or V9H-C
port Out

PostC pressure
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7.7.3 Calibrate the Conductivity Monitor

Introduction
Two types of calibrations can be performed:

• Conductivity monitor - factory calibration: Restores the conductivity cell
constant to the factory default value.

• Conductivity monitor - user calibration: Calibrates the conductivity cell
constant.

Maintenance interval
Recommended maintenance intervals for the two types of calibrations:

• Conductivity monitor - factory calibration: Perform calibration to override an
incorrect user calibration.

• Conductivity monitor - user calibration: The conductivity cell is factory cali-
brated, and should not require recalibration under normal usage. Perform calibra-
tion when the signal is unstable or you suspect that it is incorrect. It is also recom-
mended to recalibrate the Conductivity monitor after cleaning.

Conductivity Monitor - factory
calibration

Follow the instruction to restore the conductivity cell constant to the factory default
value.

Step Action

1 In the Calibration dialog, in the Monitor to calibrate list, click Conduc-
tivity monitor - factory calibration.

Result:

The time for the new calibration and the current value are displayed.

2 Click Restore.

Result:

The conductivity cell constant is restored to the factory default value. The
conductivity cell constant is written on the packaging of the Conductivity
monitor.

Conductivity Monitor - user
calibration

Follow the instruction to calibrate the conductivity flow cell constant.
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Step Action

1 Make sure that the instrument has been switched on for at least one hour.

2 In the System Control module, on the System menu, click Settings.

Result:

The System Settings dialog box opens.

3 In the System Settings dialog, select Conductivity →Cond temp
compensation. Set the Compensation factor to 0, and click OK.

4 In the Calibration dialog box, in the Monitor to calibrate list, click
Conductivity monitor - user calibration.

5 Prepare at least 25 ml of calibration solution. Use either a 0.1 M KCl certified
conductivity standard solution, or accurately prepare your own 1.00 M NaCl
solution.

6 Immerse a piece of sample inlet tubing, for example S1, in the calibration
solution.

7 Open the System Control module. On the Manual menu, click Execute
Manual Instructions.

Result:

The Manual instructions dialog box opens.

8 In the Manual instructions dialog box:

• Select Flow path →Injection valve, in the Position list, click Direct
inject. Click Insert.

• Select Flow path →Column position, in the Position list, click By-pass.
Click Insert.

• Select Flow path →pH valve and set the Restrictor to In-line and the
pH to Off-line. Click Insert.

• Select Flow path →Sample inlet, select a position in the Position list (in
this example S1). Click Insert.

• Select Pumps and Pressures →Sample flow and enter 1.0 to ml/min in
the Flow rate box. Click Insert.

• Click Execute.

Result:

Calibration solution is pumped through the system by the Sample pump.

9 Pump in at least 25 ml of the calibration solution, and wait until the conduc-
tivity signal is stable.

7 Maintenance
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Step Action

10 In the Run Data pane of System Control, read the current Cond temp.

Tip:

If Cond temp is not showing, click the Customize icon. In the Customize
dialog box, under the Run Data Groups tab, select to view Cond temp.

11 In the Calibration dialog box, enter the theoretical conductivity value at the
current conductivity temperature in the Enter theoretical conductivity
value input field.

• If a certified conductivity standard solution is used, use the supplied
theoretical conductivity value.

• If a manually prepared 1.00 M NaCl calibration solution is used, see the
graph for conductivity value at the current temperature Graph for
conductivity value, on page 315.

12 In the Calibration dialog box, click Calibrate.

Result:

The new conductivity cell constant is displayed in the Conductivity cell 1
constant/cm box. The new constant should normally be 40 ± 10 cm-1. The
date and time for the calibration are also displayed.

13 In the System Control toolbar, click the End icon to end the run.

14 In the System Settings dialog box, select Conductivity: Cond temp
compensation and set the Compensation factor back to desired value,
default 2.1%. Click OK.
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Graph for conductivity value
The graph below shows the conductivity value at the current temperature when 1.00 M
NaCl calibration solution is used.
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7.7.4 Calibrate the UV monitors

Automatic wavelength calibration of
the UV Monitor

The wavelength is automatically calibrated every time the instrument is switched on. If
the instrument has been switched on for a couple of days, and the ambient tempera-
ture and/or the humidity has changed, restart the instrument using the power switch
to calibrate the UV Monitor U9-M.

Calibration of the second UV monitor
flow cell length

The cell path length of the second UV Monitor U9-L might differ from the nominal
length, which leads to incorrect results in the calculation of protein concentration in
the eluate. To achive normalized absorbance, the path length of the second UV flow cell
must be calibrated.

Note: The flow cell path length must be registered or updated in UNICORN, when
the flow cell is replaced.

Equipment needed
To perform the calibration, a calibration kit containing test solutions, syringes and
accessories is needed. A specified kit is available for each cell length.

If using a UV flow cell
with the theoretical
path length...

Then use calibration kit...

2 mm UV-900 2 mm calibration kit (Product Code 18632402)

5 mm UV-900 5 mm calibration kit (Product Code 18632404)

To calculate the real path length of the UV flow cell, use the following software:

• UV-900 cell calibration Excel-file (Product Code 18632406)

Prepare for calibration

Follow the instructions to prepare for the calibration of the UV monitor U9-L.

Step Action

1 Ensure that the flow restrictor is inline in the flow path after the UV flow cell.

2 Mount the union Luer female/1/16” male, included in the test kit, in the
upper inlet of the UV flow cell.

3 Open the UV-900 cell calibration Excel-file.

7 Maintenance
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Step Action

4 The solution bottles are labelled with the concentration value and the refer-
ence absorbance value for each solution. Enter the concentrations of the
solutions in ascending order into the column UV Test kit Concentration
(mg/l). Enter the corresponding absorbance values into the column UV Test
kit Absorbance (AU/cm).

Perform the calibration

Follow the instructions to calibrate the second UV Monitor U9-L.

Step Action

1 Open the System Control module. On the Manual menu, click Execute
Manual Instructions.

Result:

The Manual instructions dialog box opens.

In the Manual Instructions dialog box:

• Select Pumps →System flow and set the Flow rate to 0.0 ml/min.

• Click Execute.

Result:

The absorbance can now be monitored.

2 Fill one of the supplied syringes with 1.5-2 ml of the first solution (0 mg/l).
Ensure that there are no air bubbles in the syringe.

7 Maintenance
7.7 Calibration procedures

7.7.4 Calibrate the UV monitors

ÄKTA avant User Manual 29035184 AF 317



Step Action

3 Fit the syringe in the union Luer connector and inject the solution. DO NOT
remove the syringe.

Note:

Air trapped in the UV cell causes inaccurate measurements. To avoid intro-
ducing air into the UV cell, gently fill the union Luer up to the edge with test
solution that is to be introduced, using the syringe. Then insert the syringe
into the union Luer.

4 Wait until the monitored absorbance value has stabilized.

5 In the Manual Instructions dialog box:

• Select Monitors →Auto zero UV 2nd

• Click Insert, then click Execute

Result:

The UV absorbance is set to zero.

6 Remove the syringe.

7 Repeat the injections with the remaining four test solutions in increasing
concentration order. Use a new syringe for each solution.

8 After each injection, wait for a stable absorbance value. Note the measured
absorbance values for each solution.

7 Maintenance
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Step Action

9 Enter the measured absorbance values into the table in the column UV-900
Absorbance (AU) in the UV-900 cell calibration Excel-file.

Note:

The values should be converted from mAU to AU.

10 When all absorbance values have been entered into the table, the real UV
flow cell path length is shown at the bottom of the table.

Note:

The regression coefficient R2 should be larger than 0.999. If this is not the
case, one or more measured values are faulty.

Update the cell path length

Follow the instructions to define the UV 2nd cell path length. The flow cell path
length should be updated when the flow cell has been replaced or calibrated.

Step Action

1 In the System Control module, on the System menu, click Calibration.

2 In the Calibration dialog box, click UV 2nd cell path length in the Monitor
to calibrate list.

3 Enter the nominal flow cell path length in the Nominal length input field
and click Set.

4 • If a calibration has been performed: enter the calculated flow cell path
length, obtained in the calibration procedure, in the Real length input
field and click Set.

• If no calibration has been performed: enter the nominal flow cell path
length in the Real length input field and click Set.

Result:

The UV flow cell path length is updated.

7 Maintenance
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7.8 Replacement procedures

About this section
This section gives instructions for the replacement procedures to be performed by the
user of ÄKTA avant.

WARNING

Disconnect power. Always disconnect power from the instru-
ment before replacing any component on the instrument, unless
stated otherwise in the user documentation.

In this section

Section See page

7.8.1 Replace tubing and connectors 321

7.8.2 Replace the Mixer 323

7.8.3 Replace the O-ring inside the Mixer 325

7.8.4 Replace the UV monitor U9-M flow cell 327

7.8.5 Replace UV monitor U9-L flow cell 330

7.8.6 Replace Flow restrictor 332

7.8.7 Replace the inlet filters 333

7.8.8 Replace pump head check valves 334

7.8.9 Replace pump rinsing system tubing 337

7.8.10 Replace a valve module 339

7.8.11 Replace pump pistons, piston seals, O-rings and rinse
membranes

342

7 Maintenance
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7.8.1 Replace tubing and connectors

Maintenance interval
Replace tubing and connectors when required, for example when a tubing has clogged
or has been bent so that the flow is stopped.

Required material
The following materials are required:

• Tubing and connectors

• Tubing cutter

• Fingertight wrench

Instruction

Follow the instruction below to replace tubing and connectors.

Step Action

1 Make sure that no run is in progress on the instrument.

2 Unscrew the connectors, and disconnect the tubing.

3 If the tubing has labels, remove the labels to be used with the new tubing
later. Discard the tubing and connectors.

7 Maintenance
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Step Action

4 Cut the new tubing to the same length as the old tubing. Use a tubing cutter
to get a straight angle cut.

CAUTION

Cut injuries. The tubing cutter is very sharp and must be
handled with care to avoid injuries.

Note:

When replacing system tubing, use the original inner diameter and length to
ensure that the correct delay volumes are maintained. Inlet and outlet tubing
may be shortened if required.

5 Put the old labels on the new tubing.

6 Mount the connectors on the tubing.

For fingertight connectors:

• Slide the connector onto the tubing.

For tubing connectors 1/8":

• Slide the connector onto the tubing.

• Slide the ferrule onto the tubing with the thick end towards the end of the
tubing.

7 Insert the tubing with connector into the port. Make sure to insert the tubing
all the way into the bottom of the port.

8 Tighten the connector fully. For areas difficult to access, use the fingertight
wrench included in the accessory kit.

7 Maintenance
7.8 Replacement procedures
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7.8.2 Replace the Mixer

Maintenance interval
Replace the Mixer when a different Mixer chamber is desired, or when the Mixer is
damaged.

Required material
The following is required:

• Mixer

Instruction

Follow the instruction to change the Mixer.

Step Action

1 Disconnect the tubing from the top and bottom of the Mixer.

2 Pull the Mixer away from the instrument.

3 Attach the new Mixer.

4 Reconnect the tubing to the top and bottom of the new Mixer.

7 Maintenance
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Step Action

5 Pump out the air inside the new mixer.

7 Maintenance
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7.8.2 Replace the Mixer

324  ÄKTA avant User Manual 29035184 AF



7.8.3 Replace the O-ring inside the Mixer

Maintenance interval
Replace the O-ring inside the Mixer if it is damaged, or if it is being replaced with an
high resistant O-ring for RPC runs.

Required material
One of the following O-rings are required:

• O-ring 13.1 x 1.6 mm (for Mixer chambers 0.6, 1.4, and 5 ml)

• O-ring 22.1 × 1.6 mm (for Mixer chamber 15 ml)

• O-ring 13,1 x 1.6 mm high resistant (product code 29011326)

Instruction

Follow the instruction to replace the O-ring inside the Mixer.

Tip: Use a forceps and gloves during the replacement procedure to avoid
contaminating the Mixer components.

Step Action

1 Loosen the top section of the Mixer.

2 Unscrew the top section of the Mixer and pull apart the Mixer in two halves.
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Step Action

3 Remove the outer locking O-ring from the top section.

4 Lift up the top section of the Mixer and pull away the old O-ring inside.

5 Wet the new O-ring with 20% ethanol and fit it in position. Make sure that
the inline filter is still in position.

6 Reassemble the Mixer components and, while holding the Mixer upright,
screw the top section back onto the Mixer.

7 Maintenance
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7.8.3 Replace the O-ring inside the Mixer
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7.8.4 Replace the UV monitor U9-M flow cell

Maintenance interval
Replace the UV flow cell when it is desired to use a flow cell with a different path length,
or if the cell is damaged. Clean the optical fiber connectors if they have accidentally
been touched.

Required material
The following materials are required:

For replacement of flow cell

• UV flow cell

For cleaning of the optical fiber
connectors

• Lens paper

• Isopropanol

Replace the flow cell

CAUTION

Hazardous chemicals or biological agents in UV flow cell.
Make sure that the entire flow cell has been flushed thoroughly
with bacteriostatic solution (e.g., NaOH) and distilled water, before
service and maintenance.

Follow the instruction to replace the UV flow cell.

Step Action

1 Switch off the instrument.

2 Disconnect the tubing from the UV flow cell.

7 Maintenance
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Step Action

3 Push the latch on the UV detector to disconnect the detector.

Note:

While the UV detector is disconnected, the UV lamp becomes inoperable so
no UV light can be emitted from the instrument.

4 Pull off the detector and the flow cell from the monochromator. Be careful
not to damage the UV flow cell.

Note:

Make sure that the flow cell does not come into contact with any liquid, and
that no liquid enters the UV detector or monochromator.

Note:

While the UV detector is disconnected, protect the fiber connectors from
dust or other impurities by mounting the rubber protective caps onto them.

Note:

Do not touch the optical fiber connectors as this will result in poor monitor
performance. If you accidentally touch the optical fiber connectors, clean
them according to Clean the optical fiber connectors, on page 329.

5 Pull off the UV flow cell from the detector.

7 Maintenance
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Step Action

6 Pull off the black protective caps from the new UV flow cell, and connect the
new UV flow cell to the detector.

7 Connect the detector, with the new flow cell connected, to the monochro-
mator. Pull the latch upwards to fasten the detector.

8 Connect the tubing to the new flow cell.

9 Switch on the instrument.

Result:

The flow cell path length is automatically recognized by the monitor when a
new flow cell is connected.

Clean the optical fiber connectors

Follow the instruction to clean the optical fiber connectors.

WARNING

Hazardous substances. When using hazardous chemicals, take
all suitable protective measures, such as wearing protective
clothing, glasses and gloves resistant to the substances used.
Follow local and/or national regulations for safe operation and
maintenance of the product.

Step Action

1 Wipe the optical fiber connectors with isopropanol on lens paper.

2 Wipe the optical fiber connectors dry with lens paper.

7 Maintenance
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7.8.5 Replace UV monitor U9-L flow cell

Maintenance interval
Replace the UV flow cell when it is desired to use a flow cell with a different path length,
or if the cell is damaged.

Required material

• UV flow cell

Replace the flow cell

CAUTION

Hazardous chemicals or biological agents in UV flow cell.
Make sure that the entire flow cell has been flushed thoroughly
with bacteriostatic solution (e.g., NaOH) and distilled water, before
service and maintenance.

Follow the instruction to replace the UV flow cell.

Step Action

1 Switch off the instrument.

2 Disconnect the tubing from the UV flow cell.

3 Unscrew the knurled wheel at the bottom of the UV monitor. Press the wheel
upwards to release the flow cell.
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Step Action

4 Pull the flow cell upwards out of the monitor. Hold the flow cell by the top
part with the O-ring: do not touch the optical surfaces of the flow cell.

Note:

Make sure that the flow cell does not come into contact with any liquid, and
that no liquid enters the monitor.

5 Insert a new flow cell into the monitor.

6 Tighten the knurled wheel firmly.

7 Connect the tubing to the new flow cell.

8 Switch on the instrument and log on to UNICORN.

9 Update the UV flow cell path length in the Calibrate dialog box, in the
System Control module.

7 Maintenance
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7.8.6 Replace Flow restrictor

Maintenance interval
Replace the Flow restrictor when required, for example when the back pressure of the
Flow restrictor is outside the range 0.2 ± 0.05 MPa.

Required material
The following material is required:

• Flow restrictor FR-902

Instruction

Follow the instruction to replace the Flow restrictor.

Step Action

1 Disconnect the tubing connected from the used Flow restrictor, and discard
the used Flow restrictor.

2 Connect the tubing to the new Flow restrictor. Make sure that the Flow
restrictor connector marked IN is connected to the pH valve port ToR (To
Restrictor), and that the Flow restrictor connector marked OUT is
connected to the pH valve port FrR (From Restrictor).

3 Check the back-pressure of the new Flow restrictor, see Section 7.4 Monthly
maintenance, on page 264.

7 Maintenance
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7.8.7 Replace the inlet filters

Maintenance interval
Replace the inlet filter when required, for example when the filters are clogged.

Required material
The following material is required:

• Inlet filter set

Instruction

Follow the instruction to replace an inlet filter and a support net.

Step Action

1 Pull off the inlet filter and the support net from the inlet filter holder.

2 Fit the new support net and inlet filter, and press the filter into position.
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7.8.8 Replace pump head check valves

Maintenance interval
Replace a check valve when required, for example if the check valve is damaged or
clogged.

Required material
The following materials are required:

• Check valve kit

• Adjustable wrench

Instruction

NOTICE

Handle the check valves with care when they have been removed
from the pump heads, to prevent loss of any internal components.

Follow the instruction to replace the check valves of a pump.

Step Action

1 Disconnect the tubing from the pump head and disconnect the pump inlet
tubing.

2 Unscrew the purge valve by turning it counter-clockwise, and lift off the
metal ring.
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7.8 Replacement procedures

7.8.8 Replace pump head check valves

334  ÄKTA avant User Manual 29035184 AF



Step Action

3 Unscrew the plastic nut of the upper check valve using an adjustable wrench,
and gently lift off the upper check valve.

4 Replace the upper check valve with a new one.

5 Tighten the nut until fully finger-tight and then use the adjustable wrench to
tighten a further 180 degrees.

6 Place the new metal ring onto the new upper check valve, and screw the new
purge valve.

7 Unscrew the two white plastic screws located below each pump head. Pull
the plastic connectors to the sides to release the inlet manifold.

7 Maintenance
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Step Action

8 Unscrew the lower check valve using an adjustable wrench.

9 Replace the lower check valve with a new one.

10 Tighten the nut until fully finger-tight and then use the adjustable wrench to
tighten a further 180 degrees.

11 Refit the inlet manifold and reconnect the tubing to the pump head.

7 Maintenance
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7.8.9 Replace pump rinsing system tubing

Maintenance interval
Replace the pump rinsing system tubing when required, for example if the tubing is
clogged or damaged.

Required material
The following material is required:

• Rinsing system tubing

Illustration of the pump piston
rinsing systems

Part Description

1 Inlet tubing to the sample pump piston rinsing system

2 Outlet tubing from the sample pump piston rinsing system

3 Inlet tubing to the system pump piston rinsing system

4 Outlet tubing from the system pump piston rinsing system

Connect new tubing

Step Action

1 Disconnect the used tubing.

2 Cut the new tubing to desired length.

3 Connect the new tubing according to the previous illustration.
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Step Action

4 Fit all pieces of tubing into the tubing holders on the pump modules.

Prime the rinsing systems
Before usage, prime the pump rinsing system tubing. Refer to

Section 7.3.1 Change pump rinsing solution, on page 259 for detailed instructions.

7 Maintenance
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7.8.10 Replace a valve module

Maintenance interval
Replace the valve modules when required, for example if a valve module is damaged.

Instruction

Follow the instruction below to replace a valve module.

WARNING

Disconnect power. Always disconnect power from the instru-
ment before replacing any component on the instrument, unless
stated otherwise in the user documentation.

Step Action

1 Disconnect power from the instrument by switching off the Power switch.
The Power switch is located on the left hand side of the instrument.

2 Loosen the module with a Torx T20 screwdriver.
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Step Action

3 Remove the valve module.

4 Disconnect the cable and secure it in the slit.

5 Connect the cable to the new valve module.
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7.8 Replacement procedures

7.8.10 Replace a valve module

340  ÄKTA avant User Manual 29035184 AF



Step Action

6 Insert the valve module.

7 Fasten it with a Torx screwdriver.
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7.8.11 Replace pump pistons, piston seals, O-rings and rinse
membranes

Introduction
Pump pistons, piston seals, O-rings and rinse membranes are pump parts that can be
replaced by the user. Replacing these parts require special attention not to damage
the pumps. See ÄKTA avant Operating Instructions for instructions on replacement
procedures.

NOTICE

• Do not disassemble the pump head unless there is good reason
to believe that there is an internal leakage. A sign of leakage is
increasing pump rinsing solution volume. Always make sure
that sufficient spare components are available before
attempting to replace a spare part.

• Replacing spare parts. Read the instructions carefully. For
example, some individual parts of the pump head can be assem-
bled incorrectly. Check the orientation of each part before
continuing with the next instruction.

7 Maintenance
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8 Troubleshooting

About this chapter
This chapter describes troubleshooting and corrective actions for ÄKTA avant.

In this chapter

Section See page

8.1 Introduction to troubleshooting 344

8.2 Troubleshooting: General Checklist 346

8.3 Troubleshooting: Monitors 348

8.4 Troubleshooting: Valves 365

8.5 Troubleshooting: Fraction collector 368
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8.1 Introduction to troubleshooting

Introduction
This section describes troubleshooting procedures for ÄKTA avant and how to
generate a System error report for service purposes. Subsequent sections in this
chapter present general troubleshooting checklists, module-specific problems and
corrective actions.

Troubleshoot the software
For software related troubleshooting, see the following table and the list of literature
below:

Problem Possible cause and action

Text in the Process
Picture pane in the
System control
module looks
strange

The operating system of the computer does not
have the text font Calibri True Type installed. For
example, Windows XP does not include this font by
default.

Install the font Calibri True Type or switch to an oper-
ating system that includes the font.

• UNICORN Method Manual,

• UNICORN Evaluation Manual and

• UNICORN Administration and Technical Manual

Troubleshooting procedure

To troubleshoot ÄKTA avant:

Step Action

1 Always start by checking the General checklist. See Section 8.2 Trouble-
shooting: General Checklist, on page 346.

2 In this document, search for solutions in the section corresponding to the
problem.

3 Make the recommended corrective actions.

4 If problems remain after corrective actions, generate a System error report
and contact your local Cytiva representative.
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Generate a System error report

A System error report can be generated during a troubleshooting case with informa-
tion about the problem and can also include methods, logs, and results. The report can
then be sent to Service for action.

To generate a System error report for information to Service:

Step Action

1 In the System Control module, on the System menu, click Create System
Error Report.

Result:

The first page of a wizard is displayed.

2 • Click Next and start to enter information about the problem, click Next.

• Choose to enclose methods, logs or result files.

• Select location for the report and click Finish to generate the report. The
filename of the zip file will be Report_YYYYMMDD.zip and the default
folder location is: C:Program Files\GE Healthcare\UNICORN.

3 E-mail the report to Cytiva Service department.
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8.2 Troubleshooting: General Checklist

Introduction
Check the items in the following topics before starting more in-depth troubleshooting
work.

System checks

• Is the correct system selected in UNICORN System Control? For more details, see 
Section 5.3 Start UNICORN and connect to the system, on page 154.

• Are the fans blowing at the back and at the right side of the system?

Monitor checks

• Is the UV monitor set to the correct wavelength? Check the wavelengths that are
used in the method. For the predefined methods the wavelengths are set in the
Method Settings phase. For more details, see UNICORN Method Manual.

• Is the air sensor sensitivity set to normal in UNICORN System Settings to avoid
unnecessary stops due to minor air bubbles? See Air sensor sensitivity, on page 63.

Instrument communication

• Have Node IDs been set correctly for all instrument modules? To check and change
Node IDs, see Section 9.15 Check and change the Node ID of a module, on page 496.

Flow path checks

• Is all tubing connected correctly? See Section 9.3 Tubing and connectors, on page
413 and Section 5.2 Prepare the flow path, on page 149.

• Is there leakage at any of the connections?

• Is any tubing folded or twisted?

• Is the inlet tubing correctly immersed in the buffer solution, beneath the liquid
surface but not too close to the flask bottom?

• Do the cassettes in the fraction collector correspond to those selected in the
method? For more details, see Section 5.8.1 Prepare the built-in fraction collector, on
page 193.

• Is there a risk that the number of wells in the deep well plate will not be sufficient for
the run? If this is the case, make sure that Last tube filled action is set to an appro-
priate action when creating the method (otherwise, the run will be paused). For
more details, see Online Help for the relevant method phase.

• Have the Fraction collector F9-R and the built-in fraction collector been correctly
prepared? For more details, see relevant sections in Section 5.8.1 Prepare the built-
in fraction collector, on page 193 and Section 4.9 Fraction collector F9-R, on page
124.
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• Are the inlet and inline filters clean or are they generating a back pressure higher
than normal? If this is the case, change the inline and inlet filters. For more details,
see Section 7.8.7 Replace the inlet filters, on page 333 and Section 7.3.2 Replace the
inline filter, on page 261.

• Does the positioning of the columns correspond to the selections made in the
method? See Section 5.5 Connect a column, on page 174.

Purification checks

• Have all columns been cleaned and prepared according to the column recommen-
dations?

• Have the samples been adjusted to binding buffer conditions?

• Have the samples been clarified by centrifugation and/or filtration prior to sample
loading?

• Are the correct buffers used for the chosen columns and proteins?

• Check buffers for precipitations. Adjust to room temperature.

• Are the chosen columns suitable for the chosen target proteins?

• Do the buffers have correct pH? The pH of some buffers changes with the tempera-
ture.

• Are the UV-wavelengths used by the method appropriate with respect to used
buffers and proteins? For more details see Cytiva Method Handbooks.
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8.3 Troubleshooting: Monitors

In this section

• UV monitor and UV detector

• Conductivity monitor

• pH monitor and pH valve

• Pressure monitors

UV monitor U9-M and UV detector
unit

Problem Possible cause and action

The UV module is not
found by the instru-
ment

• Communication problem

Contact Service.

• The cable between the UV module and the ICU is
not connected

Remove the UV module and make sure that the cable
is connected.

• Wrong Node ID

Check the module´s Node ID. If necessary, change the
Node ID. See Section 9.15 Check and change the
Node ID of a module, on page 496.

Too low UV lamp
intensity

• The detector is not correctly fitted

Check that the detector is fitted correctly. See 
Section 7.8.4 Replace the UV monitor U9-M flow cell,
on page 327 . If this error is recurrent, contact
Service.

• Unclean optical fiber connectors

Clean the connectors. See Section 7.8.4 Replace the
UV monitor U9-M flow cell, on page 327.

• Dirt on optical sensors in detector

Remove visible dirt on detector photo diodes.

Use lint free lens paper winded around a thin wood
splinter (e.g a match or toothpick). Clean the sensors
with Isopropanol through the small hole of the metal
plate which covers the sensors. Dry the sensors with
clean and dry lint free lens paper.

• Worn-out or broken lamp

Contact Service.
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Problem Possible cause and action

No light transmission
through the UV cell

• Wrong wavelength for current buffer

Change wavelength or buffer.

• Dirt in the UV flow cell

Clean the UV cell. See Section 7.5.1 Clean the UV flow
cell, on page 269.

• Unclean optical fiber connectors

Clean the connectors. See Section 7.8.4 Replace the
UV monitor U9-M flow cell, on page 327.

• Broken UV flow cell

Replace UV flow cell. See Section 7.8.4 Replace the UV
monitor U9-M flow cell, on page 327.

Autozero out of
accepted range

• Wrong wavelength for current buffer

Change wavelength or buffer.

• Unclean optical fiber connectors

Clean the connectors. See Section 7.8.4 Replace the
UV monitor U9-M flow cell, on page 327.

The internal temper-
ature of the UV
monitor is too high

• The air intake on the rear or on the left side of the
instrument is covered

Make sure that none of the air intakes on the instru-
ment are covered.

• Hot surroundings

Decrease the room temperature. Maximum oper-
ating temperature is 35°C.

• Hardware error

Switch off the instrument and wait until the tempera-
ture has decreased. Restart the instrument. If this
error is recurrent, generate a System error report and
contact Service.
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Problem Possible cause and action

UV cell path length
unreadable

• No UV flow cell is attached

Attach UV cell. See Section 7.8.4 Replace the UV
monitor U9-M flow cell, on page 327.

• UV flow cell is not correctly installed.

Verify that the UV cell is correctly installed. See 
Section 7.8.4 Replace the UV monitor U9-M flow cell,
on page 327

• The UV flow cell is broken

Replace the cell. See Section 7.8.4 Replace the UV
monitor U9-M flow cell, on page 327.

Ghost peaks • Air in the UV flow cell

Use the Flow restrictor. Use the pH valve instruction
to manually set the Flow restrictor inline (Flow path
→pH valve →Restrictor in-line), or select the Flow
restrictor in the Method Settings phase of a
method.

Remove the air by flushing the cell with water or
buffer. If persistent, clean the UV cell. See Section
7.5.1 Clean the UV flow cell, on page 269.

• Air in buffers

De-gas if necessary.

• Dirt in the UV flow cell

Clean the UV cell. See Section 7.5.1 Clean the UV flow
cell, on page 269.

• Dirt in the flow path

Clean the system in accordance to Section 7.6.2
Perform System CIP, on page 275. Clean the column
in accordance to Section 7.6.3 Perform Column CIP,
on page 283.
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Problem Possible cause and action

Baseline drift or
noisy signal

• Flow restrictor in off-line position

Use the Flow restrictor. Use the pH valve instruction
to manually set the Flow restrictor inline (Flow path
→pH valve →Restrictor in-line), or select the Flow
restrictor in the Method Setting s phase of a
method.

• Air in the UV flow cell

Use the Flow restrictor.

Remove the air by flushing the cell with water or
buffer.

If persistent, clean the UV cell. See Section 7.5.1 Clean
the UV flow cell, on page 269.

• Air in buffers

De-gas if necessary.

• Make sure that both the instrument and the buffers
have reached the ambient temperature.

• Impure buffers

Check if the signal is noisy with water.

• Unclean optical fiber connectors

Clean the connectors. See Section 7.8.4 Replace the
UV monitor U9-M flow cell, on page 327.

• Dirt in the UV flow cell

Perform a System CIP. See Section 7.6.2 Perform
System CIP, on page 275.

If necessary, manually clean the UV cell. See Section
7.5.1 Clean the UV flow cell, on page 269.

• Wrong type of UV cell is used

If a UV cell with 2 mm path length is to be used, use
only cells marked U9-2.
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Problem Possible cause and action

Unstable signal • Bad pump function

Check that the pump is operating properly. See 
Examples of pump pressure curves, on page 383 for
example of pump pressure curves.

• Poor mixing function

Check the mixer chamber size and change the
chamber if necessary. See Select Mixer chamber, on
page 149.

Check the function of the mixer. Place a stirrer bar in
the palm of your hand. Hold the hand above the mixer.
The stirrer should move when the mixer is activated.

Check that the mixer chamber is free from solids. To
open the mixer, see Section 7.3.2 Replace the inline
filter, on page 261.

The UV curve shows a
gradient that is
inverted compared
to the expected
gradient

• Large difference in refractive index between
buffer A and buffer B

Due to light spreading effects in the UV cell, the buffer
with the highest UV absorption shows the lowest UV
absorption in the chromatogram, and the buffer with
the lowest UV absorption shows the highest UV
absorption. This can occur if there is a large differ-
ence in refractive index between buffer A and buffer B
and the UV is run at high sensitivity.

UV monitor U9-L

Problem Possible cause and action

Autozero out of
accepted range

• Wrong UV flow cell for current buffer

Change to a shorter UV flow cell or change buffer.

• The UV flow cell is not correctly installed

Check that the UV flow cell is fitted correctly, see 
Section 7.8.5 Replace UV monitor U9-L flow cell, on
page 330.

• Broken UV flow cell

Replace the cell, see Section 7.8.5 Replace UV monitor
U9-L flow cell, on page 330.
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Problem Possible cause and action

The internal temper-
ature of the UV
monitor is too high

• The air intake on the rear or on the right side of
the instrument is covered

Make sure that none of the air intakes on the instru-
ment are covered.

• Hot surroundings

Decrease the room temperature. Maximum oper-
ating temperature is 35°C.

• Hardware error

Switch off the instrument and wait until the tempera-
ture has decreased. Restart the instrument. If this
error is recurrent, generate a System error report and
contact Service.

Maximum absorb-
ance that can be
measured by the
detector is reached

• Wrong UV flow cell for current buffer

Change to a shorter UV flow cell or change buffer.

• The UV flow cell is not correctly installed

Check that the UV flow cell is fitted correctly, see 
Section 7.8.5 Replace UV monitor U9-L flow cell, on
page 330.

• Dirt in the UV flow cell

Clean the UV flow cell, see Section 7.5.1 Clean the UV
flow cell, on page 269.

• Broken UV flow cell

Replace the cell, see Section 7.8.5 Replace UV monitor
U9-L flow cell, on page 330.

The UV cell is not
correctly installed

• Check that the UV flow cell is fitted correctly, see 
Section 7.8.5 Replace UV monitor U9-L flow cell, on
page 330.
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Problem Possible cause and action

Ghost peaks • Air in the UV flow cell

Use the Flow restrictor. Use the pH valve instruction
to manually set the Flow restrictor inline (Flow path
→pH valve →Restrictor in-line), or select the Flow
restrictor in the Method Settings phase of a
method.

Remove the air by flushing the cell with water or
buffer. If persistent, clean the UV cell. See Section
7.5.1 Clean the UV flow cell, on page 269.

• Air in buffers

De-gas if necessary.

• Dirt in the UV flow cell

Clean the UV cell. See Section 7.5.1 Clean the UV flow
cell, on page 269.

• Dirt in the flow path

Clean the system in accordance to Section 7.6.2
Perform System CIP, on page 275. Clean the column
in accordance to Section 7.6.3 Perform Column CIP,
on page 283.

The UV lamp is
broken or worn out

• Contact Service
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Problem Possible cause and action

Distorted protein
peaks in IEX gradi-
ents (for example
step gradients).

• Rapid changes of the refractive index

The refractive index of the buffer changes rapidly in
quick IEX gradients. The rapid change may cause light
spreading effects and disturb the shape of the protein
peaks in the U9-L 2 mm flow cell.

Run with reversed flow direction through the 2 mm
cell: connect the inlet tubing at the bottom and the
outlet tubing at the top of the flow cell.

Note:

The standard tubing (7) between the UV monitor and
the conductivity monitor is too short (170 mm) for
mounting the monitor for reversed flow direction.
Perform the following actions:

1. Replace the standard tubing with a tubing that is
210 mm long.

2. Update the total delay volume. The increase in
volume depends on the inner diameter (i.d.) of the
tubing:

- inner diameter (i.d.) 0.25 mm : 2 µl

- i.d. 0.50 mm : 8 µl

- i.d. 0.75 mm: 18 µl

- i.d. 1.0 mm: 32 µl

8 Troubleshooting
8.3 Troubleshooting: Monitors

ÄKTA avant User Manual 29035184 AF 355



Conductivity monitor

Problem Possible cause and action

The Conductivity
monitor is not found
by the instrument

• The Conductivity monitor cable has come loose

Switch off the instrument.

Reconnect the Conductivity monitor cable (the black
cable in the illustration below).

Restart the instrument.

The cell constant
measurement has
been aborted

• Internal errors

See error log. Restart instrument and retry. If this
problem recurs, generate a System error report and
contact Service.

Unstable conduc-
tivity

• Air in the Conductivity flow cell

Flush the Conductivity flow cell with water.

• Solids in the Conductivity flow cell

Clean the Conductivity cell. See Section 7.6.12 Clean
the Conductivity flow cell, on page 303.

Temperature out of
range for calibration

• This error can only occur when the temperature
compensation is turned on. The error will occur
when the temperature is outside the range 2°C
to 40°C.

Make sure the temperature of the calibration solution
is within 2°C and 40°C.
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Problem Possible cause and action

Baseline drift of
noisy signal

• Air in the Conductivity flow cell

Use the Flow restrictor.

Remove the air by flushing the flow cell with water or
buffer.

• Leaking tubing connections

Tighten the connectors. If necessary, replace the
connectors.

• Unclean Conductivity flow cell

Clean the Conductivity flow cell. See Section 7.6.12
Clean the Conductivity flow cell, on page 303.

• Poor mixing function

Check the Mixer chamber size and change chamber if
necessary. See Section 7.8.2 Replace the Mixer, on
page 323.

Check the motor operation of the Mixer. Place a
magnet close to the Mixer chamber during run. The
magnet should vibrate.

Check that the Mixer chamber is free from solids. To
replace the inline filter, see Section 7.3.2 Replace the
inline filter, on page 261.

Conductivity meas-
urement with the
same buffer appears
to decrease/increase
over time.

• Unclean conductivity flow cell

Clean the Conductivity cell. See Section 7.6.12 Clean
the Conductivity flow cell, on page 303.

• The ambient temperature may have decreased/
increased

Use a temperature compensation factor. The
temperature compensation factor is found in
System Control →System Settings →Conduc-
tivity. Instruction regarding the factor is also found
in Section 7.7.3 Calibrate the Conductivity Monitor, on
page 312.

• The Conductivity monitor needs to be calibrated

Check calibration with a solution with known conduc-
tivity.

Calibrate the Conductivity monitor. See Section 7.7.3
Calibrate the Conductivity Monitor, on page 312.
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Problem Possible cause and action

Waves on the
gradient

• Bad pump function

Check that the pump is operating properly. See 
Examples of pump pressure curves, on page 383 for
example of pump pressure curves.

• Air in the flow path

Purge the pumps. See Section 5.4.1 Prime buffer
inlets and purge system pumps, on page 158 and 
Section 5.4.3 Prime Q inlets, on page 170.

• Poor mixing function

Check that the correct Mixer chamber size is used.
See Select Mixer chamber, on page 149 for recom-
mendations. To change the Mixer, see Section 7.8.2
Replace the Mixer, on page 323.

Check the motor operation of the Mixer. Place a
magnet close to the mixer chamber during run. The
magnet should vibrate.

Check that the Mixer chamber is free from solids. To
open the mixer, see Section 7.3.2 Replace the inline
filter, on page 261.

Ghost peaks appear
in the gradient
profile

• A charged particle has been detected

Prepare the sample so that charged particles are
eliminated.

• Air bubbles are passing through the flow cell

Check for loose tubing connections.

Use the Flow restrictor.

Non-linear gradients
or slow response to
%B changes

Note:

Remember, conduc-
tivity at high salt
concentrations are
intrinsically not linear.

• Dirt in the tubing

Make sure that the tubing has been washed properly.

• Bad pump function

Make sure that the pump operates properly. See 
Examples of pump pressure curves, on page 383 for
example of pump pressure curves.

• The Mixer chamber is too large

Change to a Mixer chamber with a smaller volume.
See Select Mixer chamber, on page 149 for recom-
mendations. To change the Mixer, see Section 7.8.2
Replace the Mixer, on page 323.

8 Troubleshooting
8.3 Troubleshooting: Monitors

358  ÄKTA avant User Manual 29035184 AF



Problem Possible cause and action

Incorrect or unstable
reading

• The temperature compensation factor is not
properly set

Use a temperature compensation factor. The
temperature compensation factor is found in
System Control →System Settings →Conduc-
tivity. Instruction regarding the factor is also found
in Section 7.7.3 Calibrate the Conductivity Monitor, on
page 312.

• The column is not equilibrated

Equilibrate the column. Use the method phase Equi-
libration.

If necessary, clean the column. Use the predefined
method Column CIP. See Section 7.6.3 Perform
Column CIP, on page 283.

• Poor mixing function

Check that the correct Mixer chamber size is used.
See Select Mixer chamber, on page 149 for recom-
mendations. To change the Mixer, see Section 7.8.2
Replace the Mixer, on page 323.

Check the motor operation of the mixer. Place a
magnet close to the Mixer chamber during run. The
magnet should vibrate.

Check that the Mixer chamber is free from solids. To
open the Mixer, see Section 7.3.2 Replace the inline
filter, on page 261.

pH monitor and pH valve

Problem Possible cause and action

The pH module is not
found by the instru-
ment

• The cable between the pH valve and the ICU is
not connected

Remove the pH valve and make sure that the cable is
connected. See Section 7.8.10 Replace a valve
module, on page 339
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Problem Possible cause and action

The internal valve
temperature is too
high

• The air intake on the rear or on the left side of the
instrument is covered

Make sure that none of the air intakes on the instru-
ment are covered.

• Hot surroundings

Decrease the room temperature. Maximum oper-
ating temperature is 35°C.

• Hardware error

Switch off the instrument and wait until the tempera-
ture has decreased. Restart the instrument. If this
error is recurrent, generate a System error report and
contact Service.
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Problem Possible cause and action

Unstable pH signal • Calibration time out

Check the connections between pH electrode and pH
monitor.

Regenerate the pH electrode. Place the electrode in
deionized water for 30 minutes followed by 30
minutes in a buffer with pH 4. If the pH electrode has
dried out, stronger regeneration may be needed see 
Section 7.5.2 Replace the pH electrode, on page 272

If persistent, replace the pH electrode. See Section
7.5.2 Replace the pH electrode, on page 272.

• Bad or dried out pH electrode

Regenerate the pH electrode. Place the electrode in
deionized water for 30 minutes followed by 30
minutes in a buffer with pH 4.

Clean the pH electrode. See Section 7.6.7 Clean the
pH electrode, on page 293.

If persistent, replace the pH electrode. See Section
7.5.2 Replace the pH electrode, on page 272.

• Wrong mixer size for the used flow rate

Use the recommended mixer size for the used flow
rate. See Select Mixer chamber, on page 149.

• Wrong tubing connected between the Inlet
valves and the System pumps

If BufferPro is run on ÄKTA avant 150 at a flow rate ≤
10 ml/min, replace the pieces of tubing marked InA
and InB with FEP tubing, o.d. 1/8", i.d. 1.6 mm. See 
Tubing labels, on page 413.

• pH reading unstable after column equilibration

A specific system wash instruction during column
equilibration is the default selection for ÄKTA avant
150 when using BufferPro. If pH readings for ÄKTA
avant 25 are unstable after column equilibration,
replace the regular system wash instruction with the
instruction System wash BufferPro. This will
increase the run time of the method.

Drift of pH signal
when the pH elec-
trode has been
removed from
storage solution

• Decreasing salt concentration in the electrode
membrane due to osmosis to buffer

Regenerate the pH electrode. Place the electrode in
deionized water for 30 minutes followed by 30
minutes in a buffer with pH 4.
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Problem Possible cause and action

Temperature reading
error

• The temperature compensation of the pH
monitor is turned off

Contact Service.

It is not possible to
inject calibration
solution

• Waste tubing is twisted or blocked

Untwist the tubing.

Perform System CIP to clean waste tubing. See 
Section 7.6.2 Perform System CIP, on page 275.

Change the tubing.

Alarm in UNICORN:
(Alarm) The pH cell
can only be run at
pressures below 0.8
MPa. Please check
the tubing or lower
the flow through the
pH cell.

Note: The pressure
limit 0.8 MPa is for the
post column pressure.

• High pressure in the pH cell

Decrease the flow rate.

By-pass the pH electrode (see Ports and flow paths of
the pH valve, on page 78) and measure pH in fractions
manually.

If ÄKTA avant 25 is used: Replace tubing between
Column valve and Outlet valve by tubing with i.d. 0.75
mm (tubing: 6, 7, 8, 9, 1R and 2R).

Pressure monitors

Problem Possible cause and action

Pressure offset • The monitors have lost their calibration

Calibrate the pressure monitors. See Section 7.7.2
Calibrate the pressure monitors, on page 308.

• The temperature has changed

Wait until the temperature has stabilized and cali-
brate the pressure monitors.

• Incorrect installation of extra Column valve

Check installation positions and tubing connections.
Refer to the installation instructions delivered
together with the extra valve.
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Problem Possible cause and action

Excessively high
pressure values

• Unclean inline filter in the Mixer

Replace the inline filter in the Mixer. See Section 7.3.2
Replace the inline filter, on page 261.

• Solids in the flow path

To use the predefined method System CIP to clean
the flow path, see.

To clean the column, see Section 7.6.2 Perform
System CIP, on page 275. If persistent, replace the
column.

The pressure moni-
tors are not found by
the instrument

• The cable between the Pressure monitors and
the ICU is not connected.

Remove the monitor and make sure that the cable is
connected.

The internal temper-
ature of the pressure
monitor is too high

• The air intake on the rear or on the left side of the
instrument is covered

Make sure that none of the air intakes on the instru-
ment are covered.

• Hot surroundings

Decrease the room temperature. Maximum oper-
ating temperature is 35°C.

• Hardware error

Switch off the instrument and wait until the tempera-
ture has decreased. Restart the instrument. If this
error is recurrent, generate a System error report and
contact Service.
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Problem Possible cause and action

Irregular pressure
curves

• Air bubbles are passing through or are trapped in
the pump

Check that there is a sufficient volume of buffer
present in the flasks.

Check all connections and tubing for leaks and
constrictions.

Check pump pressure curves. See Section 8.6 Trou-
bleshooting: Pumps, on page 380 for example of
pump pressure curves.

Purge the pumps, see Section 5.4.1 Prime buffer inlets
and purge system pumps, on page 158

• The check valve does not function correctly

Remove any solids in the valves by cleaning the check
valves according to the instructions in Section 7.6.9
Clean pump head check valves, on page 297.

• Piston seal is leaking

Replace the piston seal according to the instructions
in ÄKTA avant Operating Instructions. A sign of
leakage is that the pump rinsing solution volume
starts to increase.

• Blockage of flow path

Use the predefined method Prepare System to flush
through to clear blockage.

If necessary, replace tubing. See Section 7.8.1 Replace
tubing and connectors, on page 321.

Check the mixer inline filter. It can be clogged if unfil-
tered buffers or samples are applied. See Section
7.3.2 Replace the inline filter, on page 261 for instruc-
tions how to replace the mixer inline filter.

Check the inlet filters. They can be clogged if unfil-
tered buffers or samples are applied. To replace the
filters, see Section 7.8.7 Replace the inlet filters, on
page 333.

Check the column. It can be clogged if unfiltered
buffers or samples are applied. To clean a column, see 
Section 7.6.3 Perform Column CIP, on page 283.
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8.4 Troubleshooting: Valves

General
The following table lists the general problems that may occur for the different valves.

Problem Possible cause and action

The valve is not found
by the instrument

• The cable between the valve and the ICU is not
connected

Remove the valve and make sure that the cable is
connected. See Section 4.2 Installation of optional
modules, on page 97.

• Wrong Node ID

Check the valve Node ID. If necessary, change the
Node ID. See Section 9.15 Check and change the
Node ID of a module, on page 496.

The internal valve
temperature is too
high

• The air intake on the rear or on the left side of the
instrument is covered

Make sure that none of the air intakes on the instru-
ment are covered.

• Hot surroundings

Decrease the room temperature. Maximum oper-
ating temperature is 35°C.

• Hardware error

Switch off the instrument and wait until the tempera-
ture has decreased. Restart the instrument. If this
error is recurrent, generate a System error report and
contact Service.

The valve is not
switching or is
switching to wrong
position

• Hardware error

Generate a System error report and contact Service.

External leakage • Hardware error

Generate a System error report and contact Service.

Internal leakage • Broken valve

Replace the valve. See Section 4.2 Installation of
optional modules, on page 97.
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Inlet valves

Problem Possible cause and action

Faulty air sensor in
the valve

• Hardware error

Restart the instrument with the power switch. If this
error is recurrent, generate a System error report and
contact Service.

pH valve

Problem Possible cause and action

Leaking pH valve • The dummy electrode was dry when it was
installed in the valve.

1. Remove the dummy electrode.

2. Wet the dummy electrode properly with distilled
water.

3. Insert the dummy electrode into the pH valve.

4. Rotate the dummy electrode before securing it
with the nut.

Module Panel

Problem Possible cause and action

The instrument is
unable to find some
of the modules

• A Module Panel is missing and the position is left
empty

Install the missing Module Panel.

• The cable between the Module Panel and the ICU
is not connected

Remove the Module Panel and make sure that the
cable is connected.
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Quaternary valve

Problem Possible cause and action

Wrong mixing ratio
for Quaternary valve

• The sum of the flow from inlet Q1-Q4 is not equal
to 100% of the total flow

Make sure that the sum of the flow from inlet Q1-Q4
is equal to 100% of the total flow.

Unexpected values
for e.g., pH curve or
conductivity curve
using a quaternary
flow

• The switch valve is not opened and closed
correctly

Perform Performance test according to ÄKTA avant
Unpacking Instructions. Check result and, if neces-
sary, generate a System error report and contact
Service.
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8.5 Troubleshooting: Fraction collector

In this section

• Built-in Fraction collector

• Fraction collector F9-R

Built-in fraction collector
Note: Only ÄKTA avant 25 has DropSync sensors.

Problem Possible cause and action

The Fraction
collector cannot be
found by the instru-
ment

• The cable between the Fraction collector and
the ICU is not connected

Generate a System error report and contact Service.

• A fuse in the instrument ICU is broken

The ICU needs to be changed. Generate a System
error report and contact Service.

• Wrong Node ID

• Check the module's Node ID. If necessary, change the
Node ID. See Section 9.15 Check and change the
Node ID of a module, on page 496.

Fraction collector
arm is blocked or
internal fault in the
Fraction collector

• Obstruction inside the Fraction collector

Switch off the instrument and check for obstruction
inside the Fraction collector. Try to move the Frac
arm by hand. Switch on the instrument. If this error is
recurrent, generate a System error report and
contact Service.

The accumulator is
jammed or there is an
internal error in the
instrument

• Salt crystals or protein residuals block the accu-
mulator

Restart the instrument and perform an accumulator
wash.

• Mechanical error

If this error is recurrent, generate a System error
report and contact Service.

Fraction collection
tube or well is over-
filled and fractiona-
tion movements are
lost.

• Too many commands are pending in the Fraction
collector

The reason could be that too many Fraction collector
instructions have been sent. Wait for a while and try
again.
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Problem Possible cause and action

The Fraction
collector failed to
detect the code on
the Cassette

• Unclean Cassette type code reader

Clean the dispenser head and its four diode windows
using a cloth and a mild cleaning agent or 20%
ethanol. See Section 7.6.4 Clean built-in fraction
collector, on page 287 for more information.

• Unclean Cassette type codes

Clean the Cassette type codes. See Section 7.6.4
Clean built-in fraction collector, on page 287 for more
information.

If this error is recurrent, set the Fraction collector
configuration manually in UNICORN. In System
Control, select System →Settings. Navigate
toFraction collector →Cassette configuration
and select Manual.

The Cassette tray is
loose in the Fraction
collector

• The Cassette tray positioning discs in the Frac
chamber are missing

Replace the Cassette tray positioning discs in the
Frac chamber. See Section 7.6.4 Clean built-in frac-
tion collector, on page 287.

Calibration of the
DropSync sensor
failed

• Unclean Drop sync sensor diode windows

Clean the Drop sync sensor diode windows. See 
Section 7.6.4 Clean built-in fraction collector, on page
287 for location of the Drop sync sensor diode
windows and cleaning instructions.

If this error is recurrent, generate a System error
report and contact Service.
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Problem Possible cause and action

The Dispenser head
failed to detect a
drop

• Air in the flow path

Check the flow path for air. Fill system and purge
pumps according to Section 5.4 Prime inlets and
purge pump heads, on page 157.

If this error is recurrent, generate a System error
report and contact Service.

• Unclean DropSync sensor diode windows

Clean the DropSync sensor diode windows. See 
Section 7.6.4 Clean built-in fraction collector, on page
287. If this error is recurrent, generate a System error
report and contact Service.

• Too high flow rate

Decrease the flow rate.

The Dispenser head
failed to detect the
flow properly and has
switched to tube
change with reduced
accumulator func-
tionality

• Air in the flow path

Check the flow path for air. Fill system and purge
pumps according to Section 5.4 Prime inlets and
purge pump heads, on page 157.

If this error is recurrent, generate a System error
report and contact Service.

• Unclean DropSync sensor diode windows

Clean the DropSync sensor diode windows. See 
Section 7.6.4 Clean built-in fraction collector, on page
287. If this error is recurrent, generate a System error
report and contact Service.

The Dispenser head
failed to detect a
drop and has
switched to tube
change without
DropSync

• Too high flow rate

Decrease the flow rate.

• Air in the flow path

Check the flow path for air. Fill system and purge
pumps according to Section 5.4 Prime inlets and
purge pump heads, on page 157.

If this error is recurrent, generate a System error
report and contact Service.

• Unclean DropSync sensor diode windows

Clean the DropSync sensor diode windows. See 
Section 7.6.4 Clean built-in fraction collector, on page
287. If this error is recurrent, generate a System error
report and contact Service.
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Problem Possible cause and action

The internal temper-
ature of the Fraction
collector is too high

• High ambient temperature

If the ambient temperature is too high the target
temperature in the Frac chamber cannot be reached.
Decrease the room temperature.

• The temperature control function is turned off

In the System Settings dialog box, check the
settings for the temperature control function (Frac-
tion collector →Temperature).

• Hardware error

Switch off the instrument and wait until the tempera-
ture has decreased. Restart the instrument. If this
error is recurrent, generate a System error report and
contact Service.

The hot side of the
cooling element in
the Fraction
collector is over-
heated

• The fan on the back side of the instrument is
blocked

Switch off the instrument. Remove the obstruction.
Restart the instrument when the temperature has
decreased.

• Mechanical error

Switch off the instrument until the temperature has
decreased. If this error is recurrent, generate a
System error report and contact Service.

Tubes do not fit in the
Cassette

• Wrong tube dimensions are used

Check that the used tubes have the right dimensions.
See Section 3.10.3 Cassettes, cassette tray and racks,
on page 86 for information about tubes and
Cassettes.

• QuickRelease function is worn out

Order a new Cassette. See Built-in fraction collector,
on page 506 for ordering information.

Deep well plate does
not fit in the
Cassette

• Unsupported deep well plate model

Check that the deep well plates are supported. See 
Section 3.10.3 Cassettes, cassette tray and racks, on
page 86.
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Problem Possible cause and action

The Cassette does
not fit the Cassette
tray

• The Cassette is turned in the wrong direction

See Section 5.8.1 Prepare the built-in fraction
collector, on page 193 for information of how to place
the Cassettes.

• Objects or dirt under the Cassette

Remove the object or dirt.

Cassette tray in
wrong position

• The Cassette tray positioning discs in the Frac
chamber are missing

Replace the Cassette tray positioning discs in the
Frac chamber. See Section 7.6.4 Clean built-in frac-
tion collector, on page 287.

• Incorrect positioning of the Cassette tray in the
Frac drawer

Make sure that the front of the tray (marked with the
Cytiva logo) is facing the front of the Frac drawer. See 
Section 5.8.1 Prepare the built-in fraction collector, on
page 193.

Dirt under the Cassette tray

Remove the dirt.

The loaded Cassette
tray cannot be
inserted into the Frac
chamber

• Some of the tubes or plates are incorrectly
placed in the Cassettes

Check that all tubes and plates are correctly inserted
in the Cassettes. See Section 5.8.1 Prepare the built-in
fraction collector, on page 193.

• Some of the tubes or plates have the wrong
dimensions

Check that the deep well plates and the tubes used
are of the right type. See Section 3.10.3 Cassettes,
cassette tray and racks, on page 86 for information
about supported tubes and plates.
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Problem Possible cause and action

Quick scan or Full
scan does not work

• Cassette tray positioning discs are missing

Replace the Cassette tray positioning discs. See 
Section 7.6.4 Clean built-in fraction collector, on page
287.

• The Cassette type codes are unclean

Clean the the Cassette type codes.

• The QuickRelease of a Cassette is in open posi-
tion

Close the Cassette. See Section 5.8.1 Prepare the
built-in fraction collector, on page 193.

• The Cassette code reader diode window is
unclean

Clean the Cassette code reader diode window. See 
Section 7.6.4 Clean built-in fraction collector, on page
287.

• The automatic scanning is turned off in
UNICORN

Make sure that the automatic scanning is turned on
in UNICORN software. In System Control, select
System:Settings. Navigate toFraction collector
→Cassette configuration and select Automatic.

• Wells in deep well plates are prefilled to a volume
above 25% of the total well volume

Full scan will not work with prefilled wells during
these conditions.

• Hardware error

Generate a System error report and contact Service.

The Frac chamber is
dark

• The light has been turned off in UNICORN

Turn on the light in UNICORN. In System Control,
select System:Settings. Navigate to Fraction
collector →Fraction collector lamp and select
Lamps On.

• The lamp is broken

Contact Service.
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Problem Possible cause and action

The Frac waste is
flooded

• The Frac waste tubing is positioned so that the
flow is obstructed

Untwist the waste tubing.

• The waste container is placed in a position
higher than the waste outlet

Place the waste container in a position lower than the
waste outlet.

• Waste tubing is blocked.

Clean or replace the waste tubing.

The liquid leaving the
nozzle does not
strike the waste
funnel

• Check the position of the waste funnel

Refit the waste funnel.

The Frac capillary is
blocked

• Salt residuals in the capillary

Perform an Accumulator wash.

If persistent, contact Service.

The fraction volume
found in the tubes or
wells are smaller
than expected

• Leakage on the wet side of the instrument

Localize the leakage and take care of the leakage, for
example by tightening connectors.

• Air in pumps

Purge pumps. See Section 5.4.1 Prime buffer inlets
and purge system pumps, on page 158 .

• Bad pump function

See troubleshooting of pumps in Section 8.6 Trouble-
shooting: Pumps, on page 380.

• Leakage inside the Frac chamber

Contact Service.

Liquid on the floor to
the right of the
Cassette tray

• Leakage in the Frac arm

Contact service.
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Problem Possible cause and action

Spillage by the Frac-
tion collector during
fractionation

• Unclean DropSync sensor diode windows or
unclean nozzle

Clean the DropSync diode windows and the nozzle.
See Section 7.6.4 Clean built-in fraction collector, on
page 287. Use the Fraction collector cleaning posi-
tion.

• Too high flow rate during usage of DropSync

Use a flow rate below 2 ml/min.

• One or more Cassettes have empty positions

Make sure that all Cassette positions contain tubes
or plates.

• The tubes are flooded

Make sure that the fraction volume is adapted to the
tube volume.

Fraction tubes have not been replaced by empty
tubes when the Fraction collector was opened.

It is not possible to
fractionate

• The Frac drawer is not properly closed

Close the Frac drawer.

Hard to pull out the
Frac drawer and
Cassette tray

• The arm flat cable is stuck under the Cassette
tray

Carefully try to remove the Cassette tray.

If persistent, contact Service.

The Frac arm is
blocked

• The arm flat cable has locked the Frac arm

Contact Service.
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Problem Possible cause and action

The Fraction
collector fraction-
ates in the wrong
well or tube

• Quick scan has not detected the correct
Cassette

Clean the Cassette type code of the Cassette. See 
Section 7.6.4 Clean built-in fraction collector, on page
287.

• Unsupported deep well plate is used.

Make sure that approved deep well plates are used.
See Section 3.10.3 Cassettes, cassette tray and racks,
on page 86.

• Wells in deep well plates are prefilled to a volume
above 25% of the total well volume

Full scan will not work with prefilled wells during
these conditions.

• The deep well plate is not correctly positioned in
the Cassette

See Section 5.8.1 Prepare the built-in fraction
collector, on page 193 for information of how to place
the deep well plate

• Dirt on the nozzle or DropSync sensor diode
windows. Dirt may effect where the drops fall.

Clean nozzle and DropSync sensor diode windows.
See Section 7.6.4 Clean built-in fraction collector, on
page 287.

Error message when
the Frac drawer is
opened during a run

• Some parts in a method require that the Frac
drawer is closed.

Do not open the Frac drawer when the symbol indi-
cating ongoing fractionation is displayed on the
Instrument display (see Buttons and indicators, on
page 40).

The instrument does
not fractionate via
the Outlet valve
ports

• The Detector - Outlet valve delay volume has
been set to zero.

1. In System Control, select System →Settings
→Fraction collections →Delay volumes.

2. Correct the Detector - Outlet valve delay volume.
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Problem Possible cause and action

When starting a
method run during a
manual run, the Frac-
tion collector gener-
ates an error
message indicating
that the wrong
Cassettes are in
place, even though
the correct
Cassettes are
present in the Frac-
tion collector.

Action: End a manual run before starting a method run.

High pressure alarm
when collecting frac-
tions with the Frac-
tion collector

Action:

• Decrease the flow rate or use Outlet valve fractiona-
tion,

or

• (only if ÄKTA avant 25 is used) replace tubing
according to instructions below.

Replace the tubing between Column valve and Outlet
valve by tubing with i.d. 0.75 mm (tubing: 6, 7, 8, 9, 1R
and 2R).

Note:

Delay volumes in System Settings have to be
changed to:

Detector - Frac: 635 μl

Detector - Outlet valve: 260 μl

Restrictor volume: 85 μl

To change the Fraction collector capillary from i.d. 0.5
to i.d. 0.75 mm, contact Cytiva Service.

Note:

If the Fraction collector capillary is also changed, the
delay volume, Detector - Frac, has to be changed to
950 μl.

Spillage in Fraction
collector when the
Frac arm is moving
from Cassette placed
in position 1 and 2 to
waste

Action: If possible, place the Cassettes close to waste,
i.e., position 5 or 6 during fractionation.
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Problem Possible cause and action

The fractionation
starts in the first row
again

• The Frac drawer has been opened between two
runs. When the instrument is in state Ready and
the drawer is opened and closed, the Fraction
collector content is reset.

If fractionation will continue after the last fraction of
the first run, do not open the Frac drawer between
two runs.

Spillage between
fractions

• The combination of high flow rates and liquids
with low surface tension might lead to spillage in
the Fraction collector.

If possible use Cassette positions 5 and 6. Lower the
flow rate when using liquids with low surface tension.

The circulation fan in
the Fraction
collector is blowing
even though the
Fraction collector is
not in use

• The fan controlling the temperature in the Frac-
tion collector is not automatically turned off if
the Fraction collector is deselected as compo-
nent.

Before deselecting the Fraction collector as component
(performed in System properties in the Administra-
tion module), follow the instruction below to turn off
temperature control:

1. In the System Control module, select System
→Settings.

2. Select Fraction collection →Fraction collector
temperature.

3. Select Mode Off.

4. Confirm the selection.

Fraction Collector F9-R

Problem Possible cause and action

The fraction
collector cannot be
found by the instru-
ment

• The cable between the fraction collector and the
ÄKTA avant instrument is not connected

Make sure that the cable is connected.

• Wrong node ID

Check the Node ID of the fraction collector. If neces-
sary, change the Node ID. See Section 9.15 Check and
change the Node ID of a module, on page 496.
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Problem Possible cause and action

The internal temper-
ature of the fraction
collector is too high

• Hot surroundings

Decrease the room temperature. Maximum oper-
ating temperature is 35°C.

• Hardware error

Switch off the instrument and wait until the tempera-
ture has decreased. Restart the instrument. If this
error is recurrent, generate a System error report and
contact service.

The fraction
collector failed to
detect a drop and has
changed tube
without DropSync.

• To high flow rate for DropSync

Decrease the flow rate or disable DropSync.

• Air in the flow path

Check the flow path for air. Fill system and purge
pumps. If this error is recurrent, generate a System
error report and contact service.

• Unclean DropSync sensor

Clean the drop sensor photocell located above the
tube sensor with a damp cloth.

• The tubing is not correctly mounted in the
tubing holder nut

Check that the tubing is correctly mounted, see 
Connect tubing to the ÄKTA avant instrument, on
page 128.

The tube sensor has
not detected a new
tube.

• The fraction collector movement is blocked

Make sure that the fraction collector can move and is
free from obstructions.

The delay queue is
full or there is a tube
change overload.

• The flow rate is too high

Reduce the flow rate.

• The fraction volume is too small

Collect larger fractions.

• Too many fraction collector instructions have
been sent

Wait for a while and try again.

Fraction numbering
does not start at 1
when the fractiona-
tion is restared after
a No tube error

Fraction numbering continues from where it was at
the time of the No tube error

Manually reset the fraction number in the System
settings menu.
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8.6 Troubleshooting: Pumps

In this section

• Troubleshooting for System pumps and Sample pumps

• Example of pump pressure curves

• Remove persistent air bubbles

Pumps

Problem Possible cause and action

Liquid is leaking
between the pump
head and the side
panel

• Piston seal or rinsing membrane incorrectly
fitted or worn

Replace or reinstall the seal or the membrane. See
ÄKTA avant Operating Instructions.

Low eluent flow and
noise

• Air in pumps

Purge the pumps. See Section 5.4.1 Prime buffer
inlets and purge system pumps, on page 158.

• Bad piston spring

Disassemble the pump head and examine the piston
spring. If the spring is corroded, check piston seal and
rinse membrane. Make sure that the pump piston
rinsing system is always used when working with
aqueous buffers containing salt.

• Bad pump piston

If the piston is damaged, replace it according to ÄKTA
avant Operating Instructions.

• Bad pump piston seal

Replace the piston seal and rinse membrane
according to ÄKTA avant Operating Instructions.

• Blocked pump flow restrictors

See Section 7.6.10 Clean pump flow restrictors, on
page 300.

Leakage around a
connector

• Leaking connection and/or crystallized material
around a connector

Unscrew the connector and check if it is worn or
incorrectly fitted. If so, replace the connector. Gently
finger tighten the connector.
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Problem Possible cause and action

Erratic pump pres-
sure

• Air trapped in the pump heads

• Partially blocked solvent filters

• Leaking connections

• Piston seal leakage

• Check valve malfunction

• Piston damaged

See Examples of pump pressure curves, on page 383
for examples of pump pressure curves.

The pump is not
found by the instru-
ment

• The cable between the pump and the ICU is not
connected.

Contact Service.

• A fuse in the instrument ICU is broken.

Contact Service.

The internal temper-
ature of the pump is
too high

• The air intake on the rear or on the left side of the
instrument is covered

Make sure that none of the air intakes on the instru-
ment are covered.

• Hot surroundings

Decrease the room temperature. Maximum oper-
ating temperature is 35°C.

• Hardware error

Switch off the instrument and wait until the tempera-
ture has decreased. Restart the instrument. If this
error is recurrent, generate a System error report and
contact Service.

High pressure alarm • The pressure has increased due to increased
viscosity

The viscosity increases in cold room. Lower the flow
when performing runs in a cold room.
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Problem Possible cause and action

High pressure alarm
when pressure
control is activated

• The parameter selected for pressure control is
not the most appropriate one

The pressure control is based on either the Pre
column pressure or the Delta column pressure. To
change the parameter for pressure control, select
Pre column pressure or Delta column pressure
from the Pressure control drop-down list in the
Instruction box of the instruction of interest.

• The flow is too high

Lower the flow.

Abnormal difference
in system pressure
compared to pre
column pressure

• Clogged inline filter

Replace the inline filter, see Section 7.3.2 Replace the
inline filter, on page 261.

Internal pump error
combined with high
pressure

• The flow path is blocked

Remove obstructions in the flow path. For example,
remove stop plugs and replace constricted tubing.

Internal pump error
at normal pressure

• Blocked pump restrictor

Contact Service.

Too slow pressure
build up when pres-
sure control is active

• Too low I factor in the Pressure control parameters
instruction

In the Manual Instructions dialog box, increase the I
factor of the Pressure control parameters
instruction.

Too slow pressure
build up when using
constant pressure
flow

• Too low I factor in the Constant pressure flow
parameters instruction

In the Manual Instructions dialog box, increase the I
factor of the Constant pressure flow parameters
instruction.

Pressure overshoot
or oscillating pres-
sure when pressure
control is active

• Too high I factor in the Pressure control parame-
ters instruction

In the Manual Instructions dialog box, decrease the
I factor of the Pressure control parameters
instruction.
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Problem Possible cause and action

Pressure overshoot
or oscillating pres-
sure when using
constant pressure
flow

• Too high I factor in the Constant pressure flow
parameters instruction

In the Manual Instructions dialog box, decrease the
I factor of the Constant pressure flow parame-
ters instruction.

Examples of pump pressure curves
The table below shows some examples of pump system pressure curves obtained
when errors have occurred. The examples can be useful in troubleshooting of the
system pumps and the sample pump. The system pressure monitor R9 has higher
resolution than the other pressure monitors, and is therefore recommended for trou-
bleshooting purposes.

Incident: 30 μl of air enters pump. One pump head is working normally, the other
fails to deliver buffer.

Action: Purge pump. See Section 5.4.1 Prime buffer inlets and purge system pumps,
on page 158. If the problem is persistent, see Remove persistent air bubbles, on
page 386.
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Incident: A large volume of air enters pump. Both pump heads fails to deliver
buffer.

Action: Purge pump. See Section 5.4.1 Prime buffer inlets and purge system pumps,
on page 158.

Incident: Blocked outlet check valve

Action: Clean the check valve, See Section 7.6.9 Clean pump head check valves, on
page 297.

Incident: Inlet check valve is loose.

Action: Tighten the check valve. See Section 7.8.8 Replace pump head check valves,
on page 334.
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Incident: Internal leaking inlet check valve.

Action: Action: Try first to clean the check valve, see Section 7.6.9 Clean pump head
check valves, on page 297. If that does not help replace the check valve, see Section
7.8.8 Replace pump head check valves, on page 334.

Incident: Internal leaking outlet check valve.

Action: Action: Try first to clean the check valve, see Section 7.6.9 Clean pump head
check valves, on page 297. If that does not help replace the check valve, see Section
7.8.8 Replace pump head check valves, on page 334.

Incident: One inlet is blocked,

Action: Try first to clean the check valve, see Section 7.6.9 Clean pump head check
valves, on page 297.Try also cleaning of the inlet tubing manifold . For example,
perform a System CIP.
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Air segment test
As shown in the previous pressure curves, very often malfunction in inlet or outlet
check valves gives the same increased pressure curve pulsation. Sometimes the "air
segment test" can help determine if the problem is on the inlet side or the outlet side.

• Introduce an air segment in the inlet tubing while the pump is working.

• Check how the segment moves towards the pump. If the inlet check valves are
working properly the air segment will not show any backward movement. If it does,
the problem is on the inlet check valve side.

Remove persistent air bubbles
After purging the pump (see Section 5.4.1 Prime buffer inlets and purge system pumps,
on page 158), check that all air bubbles have been removed by analyzing the precolumn
pressure curve (see examples above). If the pressure curve indicates that there are still
air bubbles present, repeat the purging process. If the problem persists, follow the
instructions below to purge the pump with methanol (see Section 5.4.1 Prime buffer
inlets and purge system pumps, on page 158 for detailed instructions for the purge
procedure).

1. Make sure that the pump contains water.

2. Use a syringe to draw 100% methanol into the pump (see Section 5.4.1 Prime buffer
inlets and purge system pumps, on page 158 for details).

3. Set the pump flow to 2.5 ml/min for ÄKTA avant 25 or 10 ml/min for ÄKTA avant 150.

4. Let the flow run until the disturbances in the pressure curve disappear.

5. Remove the methanol:

• Stop the pump and move the inlet tubing to water. Make sure that no air is intro-
duced into the system.

• Set the pump flow to 1 ml/min for ÄKTA avant 25 or 5 ml/min for ÄKTA avant 150.

• Run for 5 minutes.

6. Purge the pump again using an appropriate buffer.

8 Troubleshooting
8.6 Troubleshooting: Pumps

386  ÄKTA avant User Manual 29035184 AF



8.7 Troubleshooting: Other components

In this section

• General Hardware: All modules

• Mixer

• Superloop

• Cabinet

• Power and ICU

• External air sensors

• I/O-box E9

• Instrument display

General hardware: All modules

Problem Possible cause and action

Siphoning occurs
through the system
in column and flow
restrictor by-pass

• The internal pump flow restrictor needs to be
replaced, see Section 7.4.2 Check the function of the
pump flow restrictors, on page 267.

Modules cannot be
found by the instru-
ment

• The cable between a module and the ICU is not
connected

Remove the module and make sure that the cable is
connected.

• Two similar modules have been added to the
instrument, for example two Inlet valve A

Remove one of the modules with the same Node ID.

• The Node ID for one or more of the modules is
incorrect, for example an Inlet valve A2 has the
same Node ID as Inlet valve A. The instrument
then considers them to have the same identity.

Remove Inlet valve A2 and change the Node ID
according to Section 9.15 Check and change the
Node ID of a module, on page 496.

An unknown instru-
ment module is
connected to the
system

• The Node ID for one or more of the modules is
incorrect

Check Node ID and change the Node ID according to 
Section 9.15 Check and change the Node ID of a
module, on page 496.
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Mixer

Problem Possible cause and action

Leakage • Leaking tubing connections

Check the tubing connections. Tighten or replace if
necessary.

Check the O-ring. Replace it if it is damaged. See 
Section 7.8.3 Replace the O-ring inside the Mixer, on
page 325.

Check the Mixer chamber. Replace it if the liquid has
penetrated the Mixer chamber walls and sealings.
See Section 7.8.2 Replace the Mixer, on page 323.

See Mixer, on page 503.

Unstable gradients
and/or noisy UV
signal

• Bad mixing of eluents

Check the function of the Mixer. Place a stirrer bar in
the palm of your hand. Hold the hand above the Mixer.
The stirrer should move when the Mixer is activated.

Check the Mixer chamber size and change chamber if
necessary. See Section 7.8.2 Replace the Mixer, on
page 323.

The Mixer chamber
was not recognized

• The Mixer chamber is not correctly installed

Verify that the Mixer chamber is correctly installed.
See Section 7.8.2 Replace the Mixer, on page 323. If
the error is recurrent, replace the Mixer chamber. See 
Mixer, on page 503.

The internal Mixer
temperature is too
high

• The air intake on the rear or on the left side of the
instrument is covered

Make sure that none of the air intakes on the instru-
ment are covered.

• Hot surroundings

Decrease the room temperature. Maximum oper-
ating temperature is 35°C.

• Hardware error

Switch off the instrument and wait until the tempera-
ture has decreased. Restart the instrument. If this
error is recurrent, generate a System error report and
contact Service.
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Superloop

Problem Possible cause and action

Overpressure during
filling

• The Superloop is filled to the max . Pressure is
not released anywhere.

Manually turn Injection valve to Manual load posi-
tion.

Cabinet

Problem Possible cause and action

The instrument is not
locked on the chosen
swirl foot position

• The lock/unlock knob is in the unlock position

Turn the lock/unlock knob to the lock position.

• The rubber behind the lock/unlock knob is
unclean

Clean the swirl foot.

• The rubber behind the lock/unlock knob is worn
out

The rubber needs to be changed. Call service.

The second section
of the foldable door
cannot be opened

• Wrong procedure

Pull the second section of the foldable door upwards
before opening it.

The temperature of
the instrument or an
instrument compo-
nent is too high

• The air intake on the back or on the left side of
the instrument is covered

Make sure that none of the air intakes on the instru-
ment are covered.

• Broken fans

Contact Service.

• Hot surroundings

Decrease the room temperature. Maximum oper-
ating temperature is 35°C.

The Pump cover is
falling down

• The gas spring is worn-out

Contact Service.

Liquid from the
Buffer tray is flowing
onto the table

• The waste tubing from the Buffer tray is loose

Contact Service.
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Power and ICU

Problem Possible cause and action

The instrument
cannot be turned on

• The power cord is not connected

Connect the power cord to the wall outlet and to the
electrical inlet on the instrument. Make sure that the
cord is attached using the clip, thereby preventing
the cord from coming loose.

• No electric current in the wall outlet

Make sure that there is electric current in the wall
outlet.

• A fuse in the instrument ICU is broken

Contact Service.

• The instrument is overheated

Switch off the instrument and wait until the tempera-
ture has decreased. Restart the instrument. If this
error is recurrent, generate a System error report and
contact Service.

One or more modules
are automatically
turned off

• One or some of the minor modules use too much
current. Minor modules include all modules
except the Fraction collector, the UV monitor
and the pumps.

The current is cut off by a temperature sensitive
component. The instrument can be restarted when
the temperature has decreased. If persistent,
generate a System error report and contact Service.

The instrument
cannot be seen in
UNICORN

• The network cable is not connected

Connect the cable, see UNICORN Administration and
Technical Manual.
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Problem Possible cause and action

One or more modules
are not found by the
instrument

• The cable between a module and the ICU is not
connected.

Remove valves and check that cables are connected.

• One or more jumpers are loose or missing.

Check the connections on the back of the instrument.
Empty positions must have connected jumpers. See
the illustration below.

The internal instru-
ment temperature is
too high

• The air intake at the rear or on the right side of
the instrument is covered

Make sure that none of the air intakes on the instru-
ment are covered.

• Hot surroundings

Decrease the room temperature. Maximum oper-
ating temperature is 35°C.

• Hardware error

Switch off the instrument and wait until the tempera-
ture has decreased. Restart the instrument. If this
error is recurrent, generate a System error report and
contact Service.
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External air sensors

Problem Possible cause and action

The external air
sensor is not found
by the instrument

• The cable between the external air sensor and
the ICU is not connected

Check the back of the instrument and make sure that
the cable is connected. See illustration below.

• The external air sensor has not been selected in
UNICORN

Select the external air sensor in UNICORN. Refer to
the installation instructions delivered together with
the external air sensor.

Air is introduced into
the flow path

• One of the connections is not tight enough

Tighten the connectors.

Liquid is leaking from
the external air
sensor

• One of the connections is not tight enough

Tighten the connectors.

The internal temper-
ature of the air
sensor is too high

• Hot surroundings

Decrease the room temperature. Maximum oper-
ating temperature is 35°C.

Hardware error

Switch off the instrument and wait until the tempera-
ture has decreased. Restart the instrument. If this
error is recurrent, generate a System error report and
contact Service.
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I/O-box

Problem Possible cause and action

The internal temper-
ature of the I/O-box
is too high

• Hot surroundings

Decrease the room temperature. Maximum oper-
ating temperature is 35 C.

• Hardware error

The I/O-box is not
detected by the
system

• Wrong Node ID

Make sure that the Node ID is (00) for the primary box,
and (01) for a potential secondary box.

The system does not
detect Digital signals
correctly

• Cables incorrectly connected

Make sure that the cables are connected correctly,
earth to earth etc.

Digital In always ”0”,
regardless of input
signals

• Digital Out connections switched

Check that the digital Out cables are correctly
connected, earth to earth etc.

External digital
equipment does not
respond to set
changes in Digital
Out

• Cables incorrectly connected

Make sure that the cables are connected correctly,
earth to earth etc.

To isolate the problem:

1. Connect Digital Out (e.g. pin 6) to Digital In (pin 1,2,3,
or 4).

2. Change the Digital Out 1 signal between ”1” and ”0”.
Verify that Digital out follows.

3. If not: contact Service.

If it does: the problem probably lies within the
connected equipment.

Analog In does not
measure expected
voltage

• Auto-zero on the wrong level

Reset Auto-zero.

• Digital Out connection error

Make sure that Digital Out is connected correctly,
earth to earth etc.
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Problem Possible cause and action

Noisy analog signal • Too long cable between the external equipment
and E9

Use as short cable as possible. Use shielded cable.
Connect the cable shield to the D-sub connector’s
shield.

Analog In does not
measure expected
voltage

• Analog In is not calibrated

Contact Service.

Analog Out does not
generate expected
voltage

• Analog Out is not calibrated

Contact Service.

Instrument display

Problem Possible cause and action

Absence of or incor-
rect colors

• Display is broken

Generate a System error report and contact Service.

Weak light • Display is worn out

Generate a System error report and contact Service.

The internal temper-
ature of the instru-
ment display is too
high

• The main board for the display is overheated

Switch off the instrument and wait until the tempera-
ture has decreased. If this error is recurrent, generate
a System error report and contact Service.

The cursor on the
display touch screen
does not move

• Touch screen is damaged

Generate a System error report and contact Service.

The cursor on the
display touch screen
does not follow the
finger

• Touch screen is not calibrated

Calibrate touch screen. See Section 2.5 Instrument
display, on page 36.

The display is black • No power

Make sure that the power cord is connected.

Make sure that the instrument is on.

• Display is broken

Generate a System error report and contact Service.
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8.8 Troubleshooting: Instrument communication

Scenario Possible cause and action

Error message in
UNICORN: (Error) The
first conductivity
monitor has been
reported lost by the
instrument...

Cause: Conductivity monitor cable is not connected.

Action:

1. Switch off the instrument.

2. Connect the cable.

3. Switch on the instrument.

4. In the displayed dialog box in UNICORN, select the
option Restart the system only and click OK.

Multiple error
messages in UNICORN:
Lost modules.

Cause: A cable to a module (including module panels) is
not connected.

Action:

1. Switch off the instrument.

2. Check all modules and connections.

3. Switch on the instrument.

4. In the displayed dialog box in UNICORN, select the
option Restart the system only and click OK.

UNICORN has lost
communication with
the instrument server

• The UNICORN client has lost connection to the
instrument server during a temporary overload
of the processor

Restart the UNICORN client to regain control. The run
continues and no data will be lost.

Warning message in
UNICORN: Instrument
module is missing.

Cause: The module is not functioning properly.

Action:

1. In the displayed dialog box in UNICORN, select the
option Restart the system only and click OK.

2. If the problem still remains, replace the module or
contact Service.
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Scenario Possible cause and action

Warning messages in
UNICORN: (Warning)
Two instrument
modules have the
same Node ID.

Cause: Two or several modules have the same Node ID.

Action:

1. Switch off the instrument.

2. Check the Node ID for all modules, see Section 9.15
Check and change the Node ID of a module, on page
496.

3. Switch on the instrument.

4. In the displayed dialog box in UNICORN, select the
option Restart the system only and click OK.

Warning messages in
UNICORN: (Warning)
Gate (12) →Internal
instrument error.

Cause: One module has an incorrect Node ID.

Action:

1. Switch off the instrument.

2. Check the Node ID for all modules, see Section 9.15
Check and change the Node ID of a module, on page
496.

3. Switch on the instrument.

4. In the displayed dialog box in UNICORN, select the
option Restart the system only and click OK.
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8.9 Error codes

Introduction
This section describes the error codes that can appear for the different modules,
together with corrective actions.

All modules

Error
code

Description Action

0 - 19 Internal instrument error Restart the instrument. If recurrent
please contact Service.

Instrument control unit

Error
code

Description Action

21 - 69 Internal instrument error Restart the instrument. If recurrent
please contact Service.

Valve

Error
code

Description Action

20, 24 Internal instrument error Restart the instrument. If recurrent
please contact Service.

22 Valve not finding position Restart the instrument. If recurrent
please contact Service.

23 Faulty air sensor Restart the instrument. If recurrent
please contact Service.

25 High temperature See Section 8.4 Troubleshooting: Valves,
on page 365
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Pressure monitor

Error
code

Description Action

20, 21,
24-27

Internal instrument error Restart the instrument. If recurrent
please contact Service.

23 High temperature See Pressure monitors, on page 362.

Air sensor

Error
code

Description Action

20 High temperature See External air sensors, on page 392.

Mixer

Error
code

Description Action

25 Mixer motor error Restart the instrument. If recurrent
please contact Service.

26 Internal instrument error Restart the instrument. If recurrent
please contact Service.

27 High temperature See Mixer, on page 388

pH monitor

Error
code

Description Action

20, 21 Internal instrument error Restart the instrument. If recurrent
please contact Service.

25 No factory calibration Contact Service

26 High temperature See pH monitor and pH valve, on page
359.
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Conductivity monitor

Error
code

Description Action

20-27 Internal instrument error Restart the instrument. If recurrent
please contact Service.

28 High temperature See Conductivity monitor, on page 356

29 Temperature data error Restart the instrument. If recurrent
please contact Service.

32-34 No factory calibration Contact Service

Pump

Error
code

Description Action

51-53 Internal pump error Check that there is no blockage of the
pump outlet. Restart the instrument. If
recurrent please contact Service.

54 High temperature See Section 8.6 Troubleshooting:
Pumps, on page 380

UV Monitor U9-M

Error
code

Description Action

21, 25,
26, 31

Grating error Restart the instrument. If recurrent
please contact Service.

22, 23, 32 Block filter error Restart the instrument. If recurrent
please contact Service.

24 Internal instrument error Restart the instrument. If recurrent
please contact Service.

27 Spectrum calibration error Restart the instrument. If recurrent
please contact Service.

28, 29 Lamp error Restart the instrument. If recurrent
please contact Service.

30 High temperature See UV monitor U9-M and UV detector
unit, on page 348.
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UV Detector U9-D

Error
code

Description Action

24, 26,
28, 29,
31, 33

Internal instrument error Restart the instrument. If recurrent
please contact Service.

25 Too low light intensity Check that the detector and flow cell
are fitted correctly. If warning reap-
pears, contact Service.

27 Too high light intensity Check that the detector and flow cell
are fitted correctly. If warning reap-
pears, contact Service.

30 Too high light intensity, R
channel

Check that the detector is fitted
correctly. If warning reappears, contact
Service.

32 Too high S light intensity, S
channel

Check that the flow cell is fitted
correctly. If warning reappears, contact
Service.

34 No light detected Check optical pathway and restart the
instrument. If recurrent please contact
Service.

35 Too low light intensity, R
channel

Check that the detector is fitted
correctly. If warning reappears, contact
Service.

36 Too low light intensity, S
channel

No light through flow cell. Check solu-
tion absorption and that the cell is fitted
correctly.

UV Monitor U9-L

Error
code

Description Action

51 High temperature See UV monitor U9-L, on page 352.

52, 55 Low lamp intensity Contact Service.

54 Autozero out of range Autozero requested when AU value is
larger than 2.
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Error
code

Description Action

58 Too low light intensity, S
channel

No light through flow cell. Check solu-
tion absorption and that the cell is fitted
correctly.

59, 60 Internal instrument error Restart the instrument. If recurrent
please contact Service.

61 Measurement error Restart the instrument. If recurrent
please contact Service.

Fraction Collector F9-R

Error
code

Description Action

20 High temperature See Fraction Collector F9-R, on page
378

21 DropSync warning Clean the sensor and remove air
bubbles in the flow path.

22 Tube sensor error Check that the tube sensor is adjusted
properly.

23 Delay queue full Increase the fraction size. Fraction size
must be greater than 1/10 of the delay
volume.

24, 26 Internal instrument error Restart the instrument. If recurrent
please contact Service.

25, 28 Too fast tube change Increase the fraction size or lower the
flow rate.

27 DropSync error Clean the drop sensor

Instrument display

Error
code

Description Action

51 High temperature See Instrument display, on page 394
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I/O-box

Error
code

Description Action

20 High temperature See I/O-box, on page 393

21 Analog in signal below -2V Check the external equipment
connected to the I/O-box.

22 Analog in signal above 2V Check the external equipment
connected to the I/O-box.

23-28 Internal instrument error Restart the instrument. If recurrent
please contact Service.
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9 Reference information

About this chapter
This chapter lists reference details for ÄKTA avant.

Refer to ÄKTA avant 25 Product Documentation and ÄKTA avant 150 Product Docu-
mentation for detailed technical specifications.

In this chapter

Section See page

9.1 System specifications 404

9.2 Module specifications 406

9.3 Tubing and connectors 413

9.4 Chemical resistance guide 421

9.5 Wetted materials 427

9.6 Predefined methods and phases 429

9.7 System settings 439

9.8 Using Manual instructions 454

9.9 Available Run data 477

9.10 Available Curves 481

9.11 Injection volumes and peak broadening 485

9.12 Delay volumes 486

9.13 Component volumes 490

9.14 Pressure control 493

9.15 Check and change the Node ID of a module 496
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9.1 System specifications

Technical specifications

Parameter Data

System configuration Benchtop system, external computer

Control system UNICORN 6.3.2 or later version

Connection between PC and instrument Ethernet

Dimensions (Length x Depth x Height) 860 x 710 x 660 mm

Weight (excluding computer) 116 kg

Power supply 100-240 VAC, 50-60 Hz

Power consumption 800 VA

Enclosure protective class IP 21, wet side IP 22

Tubing and connectors ÄKTA avant 25:

• Inlet: FEP tubing, inner diameter (i.d.) 1.6 mm,
Tubing connector 5/16″ + Ferrule (yellow),
1/8″

• Pump to Injection valve: PEEK tubing, i.d.
0.75 mm, Fingertight connector, 1/16″

• After Injection valve: PEEK tubing, i.d.
0.50 mm, Fingertight connector, 1/16″

• Outlet and waste: ETFE tubing, i.d. 1.0 mm,
Fingertight connector, 1/16″

ÄKTA avant 150:

• Inlet: FEP tubing, i.d. 2.9 mm, Tubing
connector 5/16″ + Ferrule (blue), 3/16″

• After pumps: PEEK tubing, 1.0 mm i.d., Finger-
tight connector, 1/16″

• Outlet: FEP o.d.1/8″, i.d. 1.6 mm, Tubing
connector 5/16″ + Ferrule (yellow), 1/8″

• Waste: ETFE tubing, i.d. 1.0 mm, Fingertight
connector, 1/16″
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Enviromental requirements

Parameter Data

Storage and transport temperature
range

-25°C to 60°C

Chemical environment See Section 9.4 Chemical resistance
guide, on page 421.

Operating temperature range 4°C to 35°C

Relative humidity 20% to 95%, noncondensing

Equipment noise level

Equipment Acoustic noise
level

ÄKTA avant instrument < 70 dBA
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9.2 Module specifications

Introduction
This section specifies the operating data of the components in ÄKTA avant. For general
data for the system see Section 9.1 System specifications, on page 404.

System pumps

Parameter Data

Pump type Piston pump, metering type

Flow rate range (normal range) ÄKTA avant 25: 0.001 to 25 ml/min

ÄKTA avant 150: 0.01 to 150 ml/min

Flow rate range (column packing flow) ÄKTA avant 25: 0.01 to 50 ml/min

ÄKTA avant 150: 0.01 to 300 ml/min

Pressure range ÄKTA avant 25: 0 to 20 MPa (0 to 200 bar)

ÄKTA avant 150: 0 to 5 MPa (0 to 50 bar)

Viscosity range ÄKTA avant 25: 0.35 to 10 cP

ÄKTA avant 150: 0.35 to 5 cP

Flow rate

specifications

ÄKTA avant 25:

• Accuracy: ± 1.2%

• Precision: RSD < 0.5%

(Conditions: 0.25 to 25 ml/min, < 3 MPa, 0.8 to 2 cP)

ÄKTA avant 150:

• Accuracy: ± 1.5%

• RSD < 0.5%

(Conditions: 1.0 to 150 ml/min, < 3 MPa, 0.8 to 2 cP)
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Sample pump

Parameter Data

Pump type Piston pump, metering type

Flow rate range ÄKTA avant 25: 0.001 to 50 ml/min

ÄKTA avant 150: 0.01 to 150 ml/min

Pressure range ÄKTA avant 25:0 to 10 MPa (0 to 100 bar)

ÄKTA avant 150: 0 to 5) MPa (0 to 50 bar)

Viscosity range 0.7 to 10 cP

Flow rate

specifications

ÄKTA avant 25:

• Accuracy: ± 2%

• RSD < 0.5%

(Conditions: 0.25 to 50 ml/min, < 3 MPa, 0.8 to 3 cP)

ÄKTA avant 150:

• Accuracy: ± 2%

• RSD < 0.5%

(Conditions: 1.0 to 150 ml/min, < 3 MPa, 0.8 to 2 cP)

Mixer

Parameter Data

Mixing principle Chamber with magnetic stirrer

Mixer volume ÄKTA avant 25: 0.6, 1.4 (default) or 5 ml

ÄKTA avant 150: 1.4, 5 (default) or 15 ml

Gradient formation

Parameter Data

Gradient flow rate range ÄKTA avant 25:

• Binary: 0.25 to 25 ml/min

• Quaternary: 1 to 25 ml/min

ÄKTA avant 150:

• Binary: 1 to 150 ml/min

• Quaternary: 2 to 40 ml/min
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Parameter Data

Gradient composition accuracy • Binary: ± 0.6%

• Quaternary: ± 1%

(Conditions: 5 to 95 B. 0.5 to 25 ml/min, 0.2 to 2 MPa, 0.8 to 2
cP)

Valves

Parameter Data

Type Rotary valves

Number of valves 6 standard valves, up to 6 optional valves

Functions Inlet valve, Sample Inlet valve , Injection valve, Column
valve, pH valve, Outlet valve

Options Second Inlet valve, Second Sample Inlet valve, Loop valve,
Versatile valve, Second Column valve, Second and Third
Outlet valves, Extra Inlet valves

Quaternary valve

Parameter Data

Type 4-port solenoid actuated membrane valve

Functions Quaternary gradients or BufferPro

Number of inlets

Parameter Data

Inlet A 7, expandable to 14

Inlet B 7, expandable to 14

Sample inlet 7, expandable to 14

Quaternary inlet 4
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Pressure monitors

Parameter Data

Number of sensors 4

Placement of sensors • The System pressure monitor is located after the System
pumps.

• The Pre-column pressure monitor and the Post-column
pressure monitor are integrated in the Column valve V9-
C or V9H-C.

• The Sample pressure monitor is located after the Sample
pump.

Range ÄKTA avant 25: 0 to 20 MPa (0 to 200 bar)

ÄKTA avant 150: 0 to 5 MPa (0 to 50 bar)

Accuracy ÄKTA avant 25: ± 0.02 MPa or ± 2% whichever is greater

ÄKTA avant 150: ± 0.015 MPa or ± 1.5% whichever is greater

UV monitors

Item Description

Number of monitors Up to 2

Wavelength range U9-M: 190 to 700 nm in steps of 1 nm, up to 3 wavelengths

U9-L: 280 nm

Absorbance range -6 to 6 AU

Resolution 0.001 mAU

Linearity U9-M: within ± 2% at 0 to 2 AU

U9-L: within ± 5% at 0 to 2 AU

Drift U9-M (2 mm cell at 280 nm): ≤ | 0.2 mAU | AU/h

U9-L (2 mm cell): ≤ | 0.2 mAU | AU/h

Noise U9-M: < 0.08 mAU

U9-L: < 0.1 mAU

Operating pressure 0 to 2 MPa

Lamp operating time U9-M: > 5000 h

U9-L: > 10000 h
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Item Description

Flow cells: U9-M Standard:

Optical path length 2 mm

Cell volume 2 µl

Total volume: 11 µl

Option:

Optical path length 10 mm

Cell volume 8 µl

Total volume 12 µl

Optical path length 0.5 mm

Cell volume 1 µl

Total volume 10 µl

Flow cells: U9-L Standard:

Optical path length 2 mm

Cell volume 2 µl

Total volume: 30 µl

Option:

Optical path length 5 mm

Cell volume 6 µl

Total volume 20 µl

Conductivity monitor

Item Description

Number of monitors Up to 2

Conductivity reading range 0.01 to 999.99 mS/cm

Accuracy ±0.01 mS/cm or ±2%, whichever is greater,

(within 0.3 to 300 mS/cm)

Operating pressure 0 to 5 MPa (0 to 50 bar)

Flow cell volume 22 µl
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Temperature monitor integrated in
Conductivity monitor

Item Description

Reading range 0°C to 99°C

Accuracy ±1.5°C within 4°C to 45°C

pH monitor

Parameter Data

pH reading range 0 to 14

Accuracy ± 0.1 pH unit

(within pH 2 to 12, temp. within 3°C from calibration temp.)

Operating pressure 0 to 0.5 MPa (0 to 5 bar)

Flow cell volume ÄKTA avant 25: 76 µl

ÄKTA avant 150: 129 µl

Outlet valve fractionation

Parameter Data

Number of outlets 10, expandable to 32

Fraction volumes ÄKTA avant 25: 0.1 to 20 000 ml

ÄKTA avant 150: 1 to 20 000 ml

Delay volume, with pH electrode and
flow restrictor off-line (UV – Outlet
valve)

ÄKTA avant 25: 142 µl

ÄKTA avant 150: 535 µl

Built-in fraction collector

Item Description

Number of fractions Up to 576

Vessel types • 3, 5, 8, 15, 50 ml tubes

• 250 ml bottles

• Deep well plates: 96 / 48 / 24
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Item Description

Vessel type selection Automatic recognition

Fraction volumes 0.1 to 250 ml

Spillage-free modes ÄKTA avant 25: Automatic, DropSync or accumulator

ÄKTA avant 150: Automatic or accumulator

Protection of fractions Covered vessels and climate control (settable 6°C to 20°C)

Organic solvents No

Delay volume, with pH electrode and
flow restrictor off-line

(UV – dispenser head)

ÄKTA avant 25: 518 µl

ÄKTA avant 150: 1807 µl

Fraction collector F9-R, 2nd

Parameter Data

Number of fractions Up to 175

Vessel types Tube outer diameter: 12, 18 or 30 mm

Tube length: 50 to 180 mm

Fraction volumes 0.1 to 50 ml

Spillage-free mode DropSync

Fractionate flammable liquids Yes

Delay volume, with pH electrode and
flow restrictor off-line

(UV – dispenser head)

ÄKTA avant 25: 240 µl

ÄKTA avant 150: 928 µl

Dimensions (W x D x H) 320 x 400 x 250 mm

Weight 5 kg

I/O box

Parameter Data

Number of ports 2 analog in, 2 analog out

4 digital in, 4 digital out

Analog range In +/- 2 V

Out +/- 1 V
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9.3 Tubing and connectors

Introduction
This section describes the tubing and connectors to use with ÄKTA avant 25 and ÄKTA
avant 150.

Tubing labels
The illustration below shows the tubing labels for for the standard system configura-
tion.

Tubing types
The table below shows the tubing types used in ÄKTA avant.
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Description Color Scope of use Volume/cm

PEEK, o.d. 1/16", i.d.
0.25 mm

Blue High pressure tubing

Reference capillary 1

0.5 μl

PEEK, o.d. 1/16", i.d.
0.50 mm

Orange High pressure tubing 2.0 μl

PEEK, o.d. 1/16", i.d.
0.75 mm

Green High pressure tubing 4.4 μl

PEEK, o.d. 1/16", i.d. 1.0
mm

Beige High pressure tubing 7.8 μl

FEP, o.d. 1/8", i.d. 1.6
mm

Trans-
parent

Inlet tubing 20.0 μl

FEP, o.d. 3/16", i.d. 2.9
mm

Trans-
parent

Inlet tubing for high
flow rate and high
viscosity

66.0 μl

ETFE, o.d. 1/16", i.d.
0.75 mm

Trans-
parent

Narrow inlet tubing
(optional)

4.4 μl

ETFE, o.d. 1/16", i.d. 1.0
mm

Trans-
parent

Outlet and waste
tubing

7.8 μl

Silicone, o.d. 4.1 mm,
i.d. 2.1 mm

Trans-
parent

Pump rinse solution
tubing

35.0 μl

Silicone, o.d. 12 mm, i.d.
8 mm

Trans-
parent

Waste tubing from
Buffer tray

0.5 ml

Note: Many different sizes/types of tubing can be connected to a chromatography
system. Tubing with a smaller inner diameter (i.d.) holds less delay volume
and will therefore generate less dilution of the protein peak. Narrow tubing,
however, increases the system pressure, especially when running at high
flow rates. The tubing used should match the application needs.

Tubing connectors
The table below shows the tubing connectors used in ÄKTA avant.

Description Use with tubing...

Fingertight connector, 1/16" PEEK and ETFE with o.d. 1/16"

Tubing connector 5/16" +

Ferrule (blue), 1/16"

ETFE, o.d. 1/16", i.d. 0.75 mm
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Description Use with tubing...

Tubing connector 5/16" +
ferrule (blue) 3/16"

FEP o.d. 3/16" i.d. 2.9 mm

Tubing connector 5/16" +

Ferrule (yellow), 1/8"

FEP, o.d. 1/8", i.d. 1.6 mm

Other connectors
The table below shows other connectors used in ÄKTA avant.

Description Scope of use

Stop plug 1/16" male Stop plug for valve ports

Luer female to 1/16" male Syringe connector for pH valve and Injection
valve

Inlet tubing
The table below shows the labels, standard diameters, and standard lengths of the inlet
tubing.

Label Description Tubing Lengt
h
(mm)

Volume (ml)

ÄKTA
avant 25

ÄKTA
avant 150

ÄKTA
avant 25

ÄKTA
avant 150

A1 to
A7

Inlets to Inlet
valve A

FEP, o.d.
1/8", i.d. 1.6
mm

FEP, o.d.
3/16", i.d.
2.9 mm

1500 3.0 9.9

B1 to
B7

Inlets to Inlet
valve B

FEP, o.d.
1/8", i.d. 1.6
mm

FEP, o.d.
3/16", i.d.
2.9 mm

1500 3.0 9.9

InA Inlet valve A to
System pump A

FEP, o.d.
1/8", i.d. 1.6
mm

FEP, o.d.
3/16", i.d.
2.9 mm

300 0.6 2.0

InB Inlet valve B to
System pump B

FEP, o.d.
1/8", i.d. 1.6
mm

FEP, o.d.
3/16", i.d.
2.9 mm

300 0.6 2.0

S1 to
S7 1

Inlets to Sample
inlet valve

FEP, o.d.
1/8", i.d. 1.6
mm

FEP, o.d.
3/16", i.d.
2.9 mm

1000 2.0 6.6
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Label Description Tubing Lengt
h
(mm)

Volume (ml)

ÄKTA
avant 25

ÄKTA
avant 150

ÄKTA
avant 25

ÄKTA
avant 150

Q1 to
Q4

Inlets to Quate-
nary valve

FEP, o.d.
1/8", i.d. 1.6
mm

FEP, o.d.
1/8", i.d. 1.6
mm

1500 3.0 9.9

InQA Quatenary valve
to Inlet valve A

FEP, o.d.
1/8", i.d. 1.6
mm

FEP, o.d.
1/8", i.d. 1.6
mm

1500 3.0 9.9

InQB Quatenary valve
to Inlet valve B

FEP, o.d.
1/8", i.d. 1.6
mm

FEP, o.d.
1/8", i.d. 1.6
mm

1500 3.0 9.9

Buff Inlet to Sample
inlet valve

FEP, o.d.
1/8", i.d. 1.6
mm

FEP, o.d.
3/16", i.d.
2.9 mm

1000 2.0 6.6

InS Sample inlet
valve to Sample
pump

FEP, o.d.
1/8", i.d. 1.6
mm

FEP, o.d.
3/16", i.d.
2.9 mm

580 1.2 3.8

1 Narrow inlet tubing, ETFE, o.d. 1/16", i.d. 0.75 mm (28957217), is available for S1-S7.

High pressure tubing
The tables below shows the labels, standard diameters, and standard lengths of the
standard high pressure tubing and the optional high pressure tubing.

 

Standard high pressure tubing

Label Description Tubing Lengt
h
(mm)

Volume (μl)

ÄKTA
avant 25

ÄKTA
avant 150

ÄKTA
avant 25

ÄKTA
avant 150

1A1 System pump A
left to Restrictor
A

PEEK, o.d.
1/16", i.d.
0.75 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

340 150 270

1A2 System pump A
right to
Restrictor A

PEEK, o.d.
1/16", i.d.
0.75 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

340 150 270

2A Restrictor A to
Pressure monitor

PEEK, o.d.
1/16", i.d.
0.75 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

115 50 90
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Label Description Tubing Lengt
h
(mm)

Volume (μl)

ÄKTA
avant 25

ÄKTA
avant 150

ÄKTA
avant 25

ÄKTA
avant 150

1B1 System pump B
left to Restrictor
B

PEEK, o.d.
1/16", i.d.
0.75 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

340 150 270

1B2 System pump B
right to
Restrictor B

PEEK, o.d.
1/16", i.d.
0.75 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

340 150 270

2B Restrictor B to
Pressure monitor

PEEK, o.d.
1/16", i.d.
0.75 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

115 50 90

1S1 Sample pump left
to Restrictor S

PEEK, o.d.
1/16", i.d.
0.75 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

340 150 270

1S2 Sample pump
right to
Restrictor S

PEEK, o.d.
1/16", i.d.
0.75 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

340 150 270

2S Restrictor S to
Sample pressure
monitor

PEEK, o.d.
1/16", i.d.
0.75 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

115 50 90

3S Sample pressure
monitor to injec-
tion valve.

PEEK, o.d.
1/16", i.d.
0.75 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

530 230 420

3 Pressure monitor
to Mixer

PEEK, o.d.
1/16", i.d.
0.75 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

400 180 310

4 Mixer to Injection
valve

PEEK, o.d.
1/16", i.d.
0.75 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

200 90 160

5 Injection valve to
Column valve

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

160 30 130

6 Column valve to
UV monitor

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

160 30 130

7 UV monitor to
Conductivity
monitor

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

170 30 130
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Label Description Tubing Lengt
h
(mm)

Volume (μl)

ÄKTA
avant 25

ÄKTA
avant 150

ÄKTA
avant 25

ÄKTA
avant 150

8 Conductivity
monitor to pH
valve

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

165 30 130

1R pH valve to flow
restrictor

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

75 10 60

2R Flow restrictor to
pH valvel

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

75 10 60

9 pH valve to
Outlet valve

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

215 40 170

Frac Outlet valve to
Fraction
collector F9-R

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

500 100 400

Outlet valve to
built-in Fraction
collector

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

500 100 400

 

Optional high pressure tubing

Label Description Tubing Lengt
h
(mm)

Volume (μl)

ÄKTA
avant 25

ÄKTA
avant 150

ÄKTA
avant 25

ÄKTA
avant 150

L1 Injection valve
port LoopF to
Loop valve port F

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

160 30 130

L2 Injection valve
port LoopE to
Loop valve port E

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

160 30 130

5C1 1 Injection valve to
Column valve

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

100 20 80
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Label Description Tubing Lengt
h
(mm)

Volume (μl)

ÄKTA
avant 25

ÄKTA
avant 150

ÄKTA
avant 25

ÄKTA
avant 150

5C2 1 Column valve to
second Column
valve

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

100 20 80

10 1 Standard Outlet
valve to second
Outlet valve

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

220 40 170

11 1 Second Outlet
valve to third
Outlet valve

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

220 40 170

L External air
sensor L9-1.5 to
Sample inlet
valve

FEP, o.d.
1/8", i.d. 1.6
mm

FEP, o.d.
1/8", i.d. 1.6
mm

220 440 440

5L1 1 Injection valve to
L9-1.2

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

100 20 80

5L2 1 External Air
sensor L9-1.2 to
Column valve

PEEK, o.d.
1/16", i.d.
0.50 mm

PEEK, o.d.
1/16", i.d.
1.0 mm

100 20 80

1 Cut the spare piece of tubing delivered with the system to correct length.

Reference tubing
The table below shows the label, diameter, and standard length of the reference capil-
lary. The capillary is used during the System performance tests. The capillary is not
mounted at delivery.

Label Description Tubing Length
(mm)

Volume
(μl)

Ref 1 Reference capillary PEEK, o.d. 1/16", i.d. 0.25 mm 400 20

Outlet tubing
The table below shows the labels, diameters, and standard lengths of the outlet tubing.
The tubing is not mounted on delivery.
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Label Description Tubing Lengt
h
(mm)

Volume
(ml)

Out1 -
Out32

Outlets from Outlet valve
V9-O or V9H-O

V9-O: ETFE, o.d. 1/16", i.d. 1.0
mm

V9H-O: FEP o.d.1/8", i.d. 1.6 mm

1500 1.2

3.0

Waste tubing
The table below shows the labels, diameters, and standard lengths of the waste tubing.
The waste tubing is mounted on delivery.

Label Description Tubing Length
(mm)

Volume
(ml)

W1 System pump waste ETFE, o.d. 1/16", i.d. 1.0 mm 1500 1.2

W2 Sample pump waste ETFE, o.d. 1/16", i.d. 1.0 mm 1500 1.2

W3 pH valve waste ETFE, o.d. 1/16", i.d. 1.0 mm 1500 1.2

W System waste ETFE, o.d. 1/16", i.d. 1.0 mm 1500 1.2

N/A Top tray waste Silicone, o.d. 12 mm, i.d. 8 mm 1500 80

N/A Fraction collector F9-C
waste

Silicone, o.d. 12 mm, i.d. 8 mm 1350 70
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9.4 Chemical resistance guide

Introduction
This section provides general information about biocompatibilty and detailed informa-
tion about chemical resistance of the ÄKTA avant instrument.

In this section

Section See page

9.4.1 General information about biocompatibility and chemical
resistance

422

9.4.2 Chemical resistance specifications 423
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9.4.1 General information about biocompatibility and
chemical resistance

Biocompatibility
The ÄKTA avant instrument is designed for maximum biocompatibility, with biochemi-
cally inert flow paths constructed mainly from titanium, PEEK and highly resistant fluo-
ropolymers and fluoroelastomers. Titanium is used as far as possible to minimize
contribution of potentially deactivating metal ions such as iron, nickel and chromium.
There is no standard stainless steel in the flow path. Plastics and rubber materials are
selected to avoid leakage of monomers, plasticizers or other additives.

Cleaning chemicals
Strong cleaning works well with 2 M sodium hydroxide, 70% acetic acid or the alcohols
methanol, ethanol and isopropyl alcohol. Complete system cleaning using 1 M hydro-
chloric acid should be avoided in order to not damage the pressure sensors. If you are
cleaning separation media using 1 M hydrochloric acid, use loop injections of the acid
and make sure that the column is not mounted on the Column Valve V9-C. The Column
Valve V9-C contains a pressure sensor which can be damaged by 1 M hydrochloric
acid.

If sodium hypochlorite is used as sanitizing agent instead of 2 M sodium hydroxide, use
a concentration up to 10%.

Organic solvents
Reversed phase chromatography of proteins works well with 100% acetonitrile and
additives trifluoroacetic acid (TFA) up to 0.2% or formic acid up to 5%.

Strong organic solvents like ethyl acetate, 100% acetone or chlorinated organic
solvents should be avoided. These might cause swelling of plastic material and reduce
the pressure tolerance of PEEK tubing. For this reason, flash chromatography and
straight (“normal”) phase chromatography is generally not recommended on the
system

Assumptions made
The ratings are based on the following assumptions:

• Synergy effects of chemical mixtures have not been taken into account.

• Room temperature and limited overpressure is assumed.

Note: Chemical influences are time and pressure dependent. Unless otherwise
stated, all concentrations are 100%.
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9.4.2 Chemical resistance specifications

Introduction
This section provides detailed information about chemical resistance of the ÄKTA
avant instrument to some of the most commonly used chemicals in liquid chromatog-
raphy. Regarding exposure to solutions not covered by this information, contact your
Cytiva representative for recommendations.

Note: A user can be exposed to large volumes of chemical substances over a long
time period. Material Safety Data Sheets (MSDS) provide the user with infor-
mation regarding characteristics, human and environmental risks and
preventive measures. Make sure that you have the MSDS available from
your chemical distributor and/or databases on the internet.

Aqueous buffers
The specified aqueous buffers are suitable for continuous use.

Chemical Concentration CAS no/EC no

Aqueous buffers

pH 2-12

N/A N/A

Strong chemicals and salts for CIP
The following chemicals are suitable for up to 2 h contact time at room temperature.

Chemical Concen-
tration

CAS no/EC no

Acetic acid 70% 75-05-8/ 200-835-2

Decon 90 10% N/A

Ethanol 100% 75-08-1/ 200-837-3

Methanol 100% 67-56-1/ 200-659-6

Hydrochloric acid1 0.1 M 7647-01-0/ 231-595-7

Isopropanol 100% 67-63-0/ 200-661-7

Sodium hydroxide 2 M 1310-73-2/ 215-185-5

Sodium hydroxide/ethanol 1 M/40% N/A

Sodium chloride 4 M 7647-14-5/ 231-598-3
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Chemical Concen-
tration

CAS no/EC no

Sodium hypochlorite 10% 7681-52-9/231-668-3

1 If hydrochloric acid, HCl, is used as a cleaning agent when columns are connected to the
system, the HCl concentration should not exceed 0.1 M in the pressure sensors. Remember
that the ÄKTA avant system has pressure sensors in the column valve V9-C.

For other parts of the system up to 1 M HCl is acceptable for short periods of use. See Cleaning
chemicals, on page 422

Solubilization and denaturing agents
The following chemicals are suitable for continuous use, as additives in separation and
purification methods.

Chemical Concen-
tration

CAS no/EC no

Guanidinium hydrochloride 6 M 50-01-1/ 200-002-3

Sodium dodecyl sulfate
(SDS)

1% 151-21-3/ 205-788-1

Tween™ 20 1% 9005-64-5/ 500-018-3

Urea 8 M 57-13-6/ 200-315-5

Chemicals used in reversed phase
chromatography (RPC)

The following chemicals are suitable for continuous use.

Chemical Concen-
tration

CAS no/EC no

Acetonitrile/Tetrahydro-
furan1

85%/15% 109-99-9/ 203-726-8

Acetonitrile/water/
Trifluoroacetic acid (TFA)1

Max 0.2%
TFA

N/A

Ethanol 100% 75-08-1/ 200-837-3

Isopropanol 100% 67-63-0/ 200-661-7

Methanol 100% 74-93-1/ 200-659-6
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Chemical Concen-
tration

CAS no/EC no

Water/organic mobile
phase/formic acid

Max 5%
formic acid

N/A

1 Mobile phase system.

Note: It is recommended to replace the mixer sealing ring with the highly resistant
O-ring (product code 29011326) if the system is to be exposed to organic
solvents or high concentrations of organic acids, such as acetic acid and
formic acid, for a longer period of time.

Salts and additives for hydrophobic
interaction chromatography (HIC)

The following chemicals are suitable for continuous use.

Chemical Concen-
tration

CAS no/EC no

Ammonium chloride 2 M 12125-02-9/ 235-186-4

Ammonium sulfate 3 M 7783-20-2/ 231-984-1

Ethylene glycol 50% 107-21-1/ 203-473-3

Glycerol 50% 56-81-5/ 200-289-5

Reducing agents and other additives
The following chemicals are suitable for continuous use.

Chemical Concen-
tration

CAS no/EC no

Arginine 2 M 74-79-3/ 200-811-1

Benzyl alcohol 2% 100-51-6/ 202-859-9

Dithioerythritol (DTE) 100 mM 3483-12-3 / 222-468-7

Dithiothreitol (DTT) 100 mM 3483-12-3 / 222-468-7

Ethylenediaminetetraacetic
acid (EDTA)

100 mM 60-00-4/ 200-449-4

Mercaptoethanol 20 mM 37482-11-4/ 253-523-3

Potassium chloride 4 M 7447-40-7/ 231-211-8
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Other substances
The following chemicals are suitable for continuous use.

Chemical Concen-
tration

CAS no/EC no

Acetone 10% 67-64-1/ 200-662-2

Ammonia 30% 7664-41-7/ 231-635-3

Dimethyl sulphoxide
(DMSO)

5% 67-68-5/ 200-664-3

Ethanol for long-term
storage

20% 75-08-1/ 200-837-3

Phosphoric acid 0.1 M 7664-38-2/ 231-633-2
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9.5 Wetted materials

Introduction
The tables below list the materials that come into contact with process fluids in the
ÄKTA avant system.

Note: For more detailed material information, see ÄKTA avant 25 Product Docu-
mentation and ÄKTA avant 150 Product Documentation.

Primary flow path

Material Abbreviation

Ethylene ChloroTriFluoroEthylene ECTFE

Ethylene TetraFluoroEthylene ETFE

Fluorinated Ethylene Propylene FEP

Fluorinated Propylene Monomer FPM/FKM

Fully Fluorinated Propylene Monomer FFPM/FFKM

PolyChloroTriFluoroEthylene PCTFE

PolyEtherEtherKetone PEEK

PolyPropylene PP

PolyTetraFluoroEthylene PTFE

UltraHighMolecularWeightPolyEthylene UHMWPE

Aluminum oxide Alumina

Elgiloy

Hastelloy™ C-276

Quartz glass

Ruby

Sapphire

Titanium grade 2

Titanium grade 51

1 Used in pressure sensors only.
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Pump rinse system

Material Abbreviation

EthylenePropyleneDiene M-class rubber EPDM

PolyEtherEtherKetone PEEK

PolyPropylene PP

PolyPhenylene Sulfide PPS

PolyVinylidene DiFluoride PVDF

Silicone
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9.6 Predefined methods and phases

Introduction
A predefined method contains a set of phases, each phase reflecting a specific stage of
a chromatography or maintenance run. You can select additional phases from the
phase libraries and add these to an existing method, or remove phases that are not
required.

The predefined purification methods have default values with suitable running condi-
tions for the chosen column type such as flow and pressure limits. Other settings (e.g.,
sample application technique, sample volume, elution profile and fractionation) are set
on the Phase Properties pane in the appropriate phases.

Predefined purification methods
The Method Editor has predefined methods for different separation techniques. The
methods include a number of relevant phases.

The following table describes the available predefined purification methods and which
phases that are included.

Predefined purification
method

Principle Included phases

Affinity Chromatog-
raphy (AC) 

After equilibration and sample applica-
tion, the protein of interest is adsorbed
to the column ligand. After a wash to
remove unbound sample, elution is
performed either by using a buffer
containing a competitor to displace the
protein of interest, or by changing the
pH or ionic strength. After column re-
equilibration, a fraction collector accu-
mulator wash is done to minimize the
risk for salt precipitation.
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Predefined purification
method

Principle Included phases

Anion Exchange Chro-
matography (AIEX) 

After equilibration and sample applica-
tion, negatively charged proteins are
adsorbed to the column ligand. After a
wash, to remove unbound sample,
elution is performed using a gradient of
increasing salt concentration ( e.g.
NaCl). After column wash and re-equili-
bration, a fraction collector accumulator
wash is done to minimize the risk for salt
precipitation.

Cation Exchange Chro-
matography (CIEX) 

After equilibration and sample applica-
tion, positively charged proteins are
adsorbed to the column ligand. After a
wash, to remove unbound sample,
elution is performed using a gradient of
increasing salt concentration (e.g. NaCl).
After column re-equilibration, a fraction
collector accumulator wash is done to
minimize the risk for salt precipitation.
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Predefined purification
method

Principle Included phases

Chromatofocusing (CF) After equilibration and sample applica-
tion, elution is performed using a pH
gradient. The proteins separate and
elute according to their isoelectric
points. Finally, the column is re-equili-
brated.

Desalting After equilibration and sample applica-
tion, the proteins are eluted isocrati-
cally. This technique is commonly used
for buffer exchange.

Gel filtration (GF) After equilibration and sample applica-
tion, proteins separate and elute
according to their size (largest first).
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Predefined purification
method

Principle Included phases

Hydrophobic Interaction
Chromatography (HIC) 

After equilibration and sample applica-
tion (use a buffer containing a high salt
concentration, e.g, 2 M Ammonium
Sulphate) hydrophobic proteins are
adsorbed to the column ligand. After a
wash to remove unbound sample,
elution is performed using a gradient of
decreasing salt concentration. Then, the
column is washed and re-equilibrated
with start buffer. After column re-equili-
bration, a fraction collector accumulator
wash is done to minimize the risk for salt
precipitation.

Manual Loop Fill The sample application loops of the loop
valve are manually filled with samples.
The method will guide the user through
the process by pausing and displaying
on-screen instructions. Up to five loops
can be filled with different samples. The
loops are filled in descending order.
Partial or complete loop fill can be
chosen. Automatic washing of loops and
flow path are integrated in the method.

The required components for this phase
are a column valve and a loop valve.
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Predefined purification
method

Principle Included phases

Reversed Phase Chro-
matography (RPC) 

After equilibration and sample applica-
tion, hydrophobic proteins adsorb to the
column ligand. After a wash to remove
unbound sample, elution is performed
by generating a gradient of a non-polar,
organic solvent such as acetonitrile.
Finally, the column is washed and re-
equilibrated.

WARNING

Fraction collector. Do not fractionate flammable liquids in the
built-in fraction collector. When running RPC methods, collect frac-
tions through the outlet valve or the optional external Fraction
collector F9-R .

Predefined maintenance methods
A number of predefined methods for preparation and cleaning are available. These
maintenance methods are used to prepare the system, clean the system, and to fill the
system with storage solution.

The following table describes the available predefined maintenance methods.

Predefined mainte-
nance method

Principle Included phases

Column CIP The column is filled with a cleaning solu-
tion. Select inlet positions. Enter the
solution identity, volume, flow rate and
incubation time. By adding steps, several
cleaning solutions can be used. Sugges-
tions for cleaning steps are available for
a number of column types.
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Predefined mainte-
nance method

Principle Included phases

Column Performance
Test 

After equilibration of the column, sample
is injected via a loop and eluted isocrati-
cally. A non-adsorbing sample like
acetone or salt should be used. After the
run, calculate column performance in
the Evaluation module. The efficiency
of the column is determined in terms of
height equivalent to a theoretical plate
(HETP), and the peak asymmetry factor
(As). The result is logged in the column
logbook.

Column Preparation The column is filled with buffer solution.
Select inlet positions. Enter the solution
identity, volume, flow rate and incuba-
tion time. By adding steps, several prep-
aration solutions can be used.

Intelligent Packing
(only available for ÄKTA
avant 150)

Packs AxiChrom™ columns, with a
predetermined column type, by motor-
ized power or by a flow of hydraulic liquid
that pushes the adaptor down. The user
initiates the start of compression at the
exact point when the adapter reaches
the consolidated bed surface. The
adapter compresses the bed according
to the packing factor or target bed
height as selected. Two Column
Performance Test phases (upflow and/or
downflow) can be performed after the
AxiChrom column has been packed.

System CIP The system is filled with cleaning solu-
tion. Select for example inlets, outlets
and column positions to be cleaned.
Three System CIP phases are included
in the method to facilitate the use of
three different cleaning solution. Addi-
tional System CIP phases can be added
from the Phase Library if desired.
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Predefined mainte-
nance method

Principle Included phases

System Preparation The system is filled with preparation
solution. Select for example inlets,
outlets and column positions to be
prepared. Two System Preparation
phases are included in the method. Addi-
tional System Preparation phases can
be added from the Phase Library if
desired.

Predefined phases
The following table describes the predefined phases.
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Phase Name Description

Method
Settings 

The first, and mandatory, phase in any method. Defines common
parameters used in the subsequent phases.

The Method Settings phase defines:

1. Column type

Note:

The Column type list can be filtered in two steps:

• Select the chromatography technique to be used in the
list Show by technique

• Select Show only suggested columns to show the
columns that are suggested for the selected chromatog-
raphy technique.

2. Pressure limit

3. Flow rate

4. Option to control the flow to avoid overpressure

Note:

Default values for pressure limits and flow rate are given for the
selected column type.

• Column position

• Flow restrictor use

• Buffer preparation:

- Manual, or

- BufferPro (automatic buffer preparation)

• Unit selection for Method base and Flow rate

• Monitor settings:

- pH monitor

- Air sensor alarm settings

- UV monitor

Note:

The first wavelength of U9-M and the fixed wavelength for
U9-L or U9-L 2nd is always turned on. The second and third
wavelengths for UV monitor U9-M can be set on or off.

• Settings for Column Logbook

• Start Protocol

• Result name and location
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Phase Name Description

Note:

Some of these options may not be required by certain methods.

Note:

The Method Settings phase differs for systems that have the
Method settings phase and the User defined phase as the only
available predefined phases.

Column CIP Cleans the column after purification runs by rinsing the column
with a cleaning solution to remove non-specifically bound
proteins. By adding steps, several cleaning solutions can be
used sequentially.

Column
Performance
Test 

Tests the efficiency of a packed column in terms of height equiv-
alent to a theoretical plate (HETP), and the peak asymmetry
factor (As).

Column Prep-
aration 

Prepares the column before use by removing the storage solu-
tion and equilibrating the column. By adding steps, several prep-
aration solutions can be used sequentially.

Column Wash Washes out unbound sample after sample application or
removes strongly bound proteins after elution.

Elution Elutes the sample from the column. Defines parameters for the
elution and fractionation settings.

Equilibration Equilibrates the column before purification, or re-equilibrates
the column after purification.

Manual Loop
Fill 

Is used to manually fill the additional sample application loops
mounted on the loop valve. The filling options are:

• Partial loop fill

• Complete loop fill

Miscellaneous Can be added to any method at suitable places. The instructions
can help the user to better organize the graphical output of the
results or introduce a controlled delay in the method run.

Sample Appli-
cation 

Applies sample to the column. Defines the sample application
technique, the sample volume, and the handling of flowthrough.

System CIP Cleans the system after purification runs by rinsing the system
with a cleaning solution. One cleaning solution is used per
phase.
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Phase Name Description

System Prep-
aration 

Prepares the system before a run by removing storage solution
and filling the system and inlets with buffer solution. One prepa-
ration solution is used per phase.

Intelligent
Packing

A flow of hydraulic liquid pushes the adapter down. The user
initiates the start of compression at the exact point when the
adapter reaches the consolidated bed surface. The adapter
compresses the bed according to the packing factor or target
bed height as selected.

Only available for some systems and some types of AxiChrom
columns.

9 Reference information
9.6 Predefined methods and phases

438  ÄKTA avant User Manual 29035184 AF



9.7 System settings
The System Settings function is used to set the parameters for the available instruc-
tions.

The Edit dialog box in which to edit the system settings are shown below.

 

The following subsections list the system settings available for ÄKTA avant.

In this section

Section See page

9.7.1 System settings - UV 440

9.7.2 System settings - Conductivity 441

9.7.3 System settings - pH 443

9.7.4 System settings - Pumps and pressures 444

9.7.5 System settings - Air sensor 446

9.7.6 System settings - I/O-box 447

9.7.7 System settings - Fraction collection 448

9.7.8 System settings - Watch parameters 450

9.7.9 System settings - Advanced 451

9.7.10 System settings - Data collection 453
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9.7.1 System settings - UV
The following table describes the UV related system settings available for ÄKTA avant.

Instruction name Description

Alarm UV1 Enables or disables the alarm for the UV 1 signal from
UV monitor U9-M. When enabled, it sets the alarm
limits for the UV 1 signal. When the signal falls outside
the set limits, an alarm is issued and the method will be
paused.

Note:

It is not possible to set an alarm signal for the UV 2 or
UV 3 signals from UV monitor U9-M.

Alarm UV 2nd Enables or disables the alarm for the UV signal from
U9-L, 2nd. When enabled, it sets the alarm limits for
the UV signal from UV monitor U9-L, 2nd. When the
signal falls outside the set limits, an alarm will be trig-
gered and the method will be paused.

Wavelength Sets the wavelengths for UV monitor U9-M. The corre-
sponding curves in the chromatogram are marked
with the set wavelengths.

Note:

• The instruction is available when UV monitor U9-M
(variable) is selected in the component list. For best
performance, do not use more wavelengths than
necessary for the application.

• At low wavelengths, the eluent can have significant
absorbance of its own.

Noise reduction UV Filters the noise in the UV signal from U9-M or U9-L
(depending on the configuration). A column-specific
averaging time is set automatically when a column is
defined in a method run and Averaging time is set as
a variable.

Noise reduction UV
2nd

Filters the noise in the UV signal from U9-L, 2nd. A
column-specific averaging time is set automatically
when a column is defined in a method run and Aver-
aging time is set as a variable.
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9.7.2 System settings - Conductivity
The following table describes the conductivity related system settings available for
ÄKTA avant.

Instruction name Description

Alarm conductivity Enables or disables the conductivity alarm. When
enabled, it sets the alarm limits for the conductivity
signal. When the conductivity falls outside the set
limits, an alarm will be triggered and the method will
be paused.

Alarm conductivity
2nd

Enables or disables the conductivity alarm for the
second conductivity monitor. When enabled, it sets
the alarm limits for the conductivity signal. When the
conductivity falls outside the set limits, an alarm will
be triggered and the method will be paused.

Relative scale cond Facilitates monitoring of a gradient, for which the user
sets the conductivity values for 0% and 100%. The
Relative scale cond can be set in ascending manner
(0% for low and 100% for high conductivity) or in
descending manner (0% for high and 100% for low
conductivity).

Note:

The Relative scale cond in descending manner is
especially useful for conductivity visualization in RPC
and HIC, where the conductivity curve is reversed
compared to the concentration curve (i.e., high
conductivity at 0% B and low conductivity at 100% B).

Relative scale cond
2nd

Facilitates monitoring, using the second conductivity
monitor, of a gradient, for which the user sets the
conductivity values for 0% and 100%. The Relative
scale cond can be set in ascending manner (0% for
low and 100% for high conductivity) or in descending
manner (0% for high and 100% for low conductivity).

Note:

The Relative scale cond in descending manner is
especially useful for conductivity visualization in RPC
and HIC, where the conductivity curve is reversed
compared to the concentration curve (i.e., high
conductivity at 0% B and low conductivity at 100% B).
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Instruction name Description

Cond temp condensa-
tion

Is used to adjust the conductivity values to a reference
temperature in order to compare conductivity values
between runs that have been performed at different
temperatures.

Setting the compensation factor to 0% turns this func-
tion off.

Cond 2nd temp
condensation

Is used to adjust the conductivity values for the second
conductivity monitor to a reference temperature in
order to compare conductivity values between runs
that have been performed at different temperatures.

Setting the compensation factor to 0% turns this func-
tion off.
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9.7.3 System settings - pH
The table below describes the pH related system settings available for ÄKTA avant.

Instruction name Description

Alarm pH Enables or disables the pH alarm. When enabled, it
sets the alarm limits for the pH signal. When the pH
falls outside the set limits, an alarm will be triggered
and the method will be paused.
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9.7.4 System settings - Pumps and pressures
The following table describes the pressure alarm related system settings available for
ÄKTA avant.

Instruction name Description

Alarm system pressure Sets the alarm limits for the system pressure. When
enabled and the system pressure falls outside the set
pressure limits, an alarm will be triggered and the
method will be paused. Default values for the alarm
limits are set by the values in the column list when a
column is selected in the method and Alarm system
pressure is set as a variable. Low alarm is only trig-
gered if the pressure first exceeds the Low alarm limit
for ten seconds continuously and then falls below the
Low alarm limit.

Note:

Setting the Low alarm or the system flow rate to 0
deactivates the low pressure alarm.

Alarm sample pressure Sets the alarm limits for the sample pressure. When
enabled and the sample pressure falls outside the set
pressure limits, an alarm will be triggered and the
method will be paused. Default values for the alarm
limits are set by the values in the column list when a
column is selected in the method and Alarm sample
pressure is set as a variable. Low alarm is only trig-
gered if the pressure first exceeds the Low alarm limit
for ten seconds continuously and then falls below the
Low alarm limit.

Note:

Setting the Low alarm or the system flow rate to 0
deactivates the low pressure alarm.
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Instruction name Description

Alarm delta column
pressure

Sets the alarm limits for the delta column pressure
(pre-column pressure minus post-column pressure).
When enabled and the delta column pressure falls
outside the set pressure limits, an alarm will be trig-
gered and the method will be paused. Low alarm is
only triggered if the pressure first exceeds the Low
alarm limit for ten seconds continuously then falls
below the Low alarm limit.

Note:

• Setting the Low alarm to 0 deactivates the low
pressure alarm.

• Instruction Alarm delta column pressure is avail-
able only when Column valve V9-C or V9H-C (5-
columns) is selected in the component list.

Alarm pre column
pressure

Sets the alarm limits for the pre column pressure.
When enabled and the pre column pressure falls
outside the set pressure limits, an alarm is issued and
the method will be paused. Default values for the
alarm limits are set by the values in the column list
when a column is selected in the method and Alarm
pre column pressure is set as a variable. Low alarm
is only triggered if the pressure first exceeds the Low
alarm limit for ten seconds continuously then falls
below the Low alarm limit.

Note:

Setting the Low alarm to 0 deactivates the low pres-
sure alarm.
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9.7.5 System settings - Air sensor
The table below describes the air sensor related system settings available for ÄKTA
avant.

Instruction name Description

Alarm air sensors Enables or disables the air sensor alarm for the built-in
air sensor at inlet A, inlet B or the sample inlet. If an air
sensor alarm is enabled and air is detected, an alarm
will be triggered and the method will be paused.

Alarm air sensor ext Enables or disables the alarm for the optional air
sensor. If the alarm is enabled and air is detected, an
alarm will be triggered and the method will be paused.

Air sensor sensitivity Sets the sensitivity of the built-in air sensors at inlet A,
inlet B or the sample inlet.

• Normal (30 µl) is used to detect when a buffer or
sample vessel is empty.

• High (10 µl) is used to detect small air bubbles

Air sensor sensitivity
ext

Sets the sensitivity of the optional air sensor number.
The optional air sensor can be located either before
any of the inlets A or B or after the injection valve.

Normal (30 µl) is used to detect when a buffer or
sample vessel is empty. High (10 µl) is used to detect
small air bubbles

• When located before an inlet, the default sensitivity
is Normal.

• When located after the injection valve, the default
sensitivity is High and the pump currently pumping
onto the column is used for calculating the air
volume for the external air sensor.

Note:

Using an air sensor after the injection valve is only
useful when running at lower pressures. High pressure
dissolves any small air bubbles present.

9 Reference information
9.7 System settings

9.7.5 System settings - Air sensor

446  ÄKTA avant User Manual 29035184 AF



9.7.6 System settings - I/O-box
The following table describes the I/O-box related system settings available for ÄKTA
avant.

Instruction name Description

Digital out X Sets the value of the signal sent out by digital port
number X to either 0 or 1. The default value is 1.

Noise reduction
analog in X

Filters the noise in the analog signal in port number X.

Alarm analog in X Enables or disables the alarm for the analog signal in
port number X. When enabled, it sets the alarm limits
for the analog signal. If the alarm is enabled and the
analog signal falls outside the set limits, an alarm will
be triggered and the method will be paused.

Alarm digital in X Enables or disables the alarm for the signal in digital
port number X. The alarm can be triggered by either of
the signal values, 0 or 1. If the alarm is enabled and the
condition set in Value occurs, an alarm will be trig-
gered and the method will be paused.

Configure analog out X Enables the user to send one of the pre-defined signals
(UV signal, conductivity, temperature, pH or concen-
tration of eluent B) to the analog out port number X,
and also to set the range of that signal.
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9.7.7 System settings - Fraction collection
The following tables describe the fraction collection related system settings available
for ÄKTA avant.

Instruction name Description

Fractionation settings Fractionation settings comprises fractionation
mode and fractionation order.

Fractionation mode (Automatic, Accumulator or
DropSync).

Fractionation order (Row-by-row, Column-by-
column, Serpentine-row, Serpentine-column). For
fractionation mode DropSync, the Serpentine-row
and Serpentine-column options are available.

Last tube filled Action when last tube is filled (pause, direct the flow to
one of outlets or direct the flow to waste.

Cassette configura-
tion

Cassette configuration: Automatic or Manual
configuration.

If Automatic is selected, a Quick scan or a Full scan
will be performed when the door of the fraction
collector is closed to determine which type of
cassettes and plates are used. If Manual is selected,
used plates and tubes in each tray position are
entered.

Fraction collector
temperature

Sets the fraction collector chamber target tempera-
ture.

Fraction collector
lamp

Lamps in the fraction collector chamber on or off.

Fractionation settings
frac 2

DropSync synchronises tube change to drop release.
The available settings are on or off. It is recommended
to use DropSync for flow rates below 2 ml/min.
However, higher flow rates can be used depending on
the properties (for example viscosity) of the liquid.

Fractionation
numbering mode frac
2

Determines whether fraction number for the second
fraction collector is reset at the end of a method or
not.

Note:

The default setting is Reset.
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Instruction name Description

Peak fractionation
parameters

The Peak fractionation parameters set the detec-
tion parameters for peak collection, that is they decide
when a peak starts and ends. This information is used
by the instructions Fraction collection →Peak frac-
tionation and Fraction collection →Peak frac in
outlet valve in order to start/end the peak collection.

Delay volumes
The settings for system delay volumes are accessible as parameters to the Fraction
collection →Delay volumes instruction.

Parameter
for Delay
volumes

Description

Detector-
Frac

Is used to define the delay volume between the monitor and the
built-in Fraction collector. The instruction is used to make sure
that the collected fractions correspond to the fractions indicated
in the chromatogram.

Detector -
Outlet valve

Is used to define the delay volume between the monitor and the
Outlet valve. The instruction is used to make sure that the
collected fractions correspond to the fractions indicated in the
chromatogram. The delay volume must be changed when
changing tubing to another inner diameter or length, or when
removing or adding components.

Restrictor
volume

Is used to calculate the delay volume between the monitor and
the Outlet valve. The instruction is used to make sure that the
collected fractions correspond to the fractions indicated in the
chromatogram. It is recommended not to alter the default values
for restrictor and pH cell delay volumes when standard modules
and standard tubing for flow restrictor are used.

pH cell
volume

Is used to calculate the delay volume between the monitor and
the Outlet valve. The instruction is used to make sure that the
collected fractions correspond to the fractions indicated in the
chromatogram. It is recommended not to alter the default values
for restrictor and pH cell delay volumes when standard modules
and standard tubing for flow restrictor are used.

Detector -
Frac 2

Is used to define the delay volume between the monitor and the
second Fraction collector. The instruction is used to make sure
that the collected fractions correspond to the fractions indicated
in the chromatogram. The instruction is available only when the
second Fraction collector is selected in the component list.
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9.7.8 System settings - Watch parameters
The following table describes the watch parameter settings available for ÄKTA avant.

Instruction name Description

Watch UV parameters Sets the accepted signal fluctuation and Delta peak
limit of the UV signal for some of the tests in the
Watch →Watch and Watch →Hold until instruc-
tions.

Watch UV 2nd parame-
ters

Sets the accepted signal fluctuation and Delta peak
limit of the UV 2nd signal for some of the tests in the
Watch →Watch and Watch →Hold until instruc-
tions.

Watch cond parame-
ters

Sets the accepted fluctuation and Delta peak limit of
the conductivity signal for some of the tests in the
Watch →Watch and Watch →Hold until instruc-
tions.

Watch cond 2nd
parameters

Sets the accepted fluctuation and Delta peak limit of
the signal from the second conductivity monitor for
some of the tests in the Watch →Watch and Watch
→Hold until instructions.

Watch pH parameters Sets the value for the accepted fluctuation of the pH
signal used for the test Stable signal in the instruc-
tions Watch →Watch and Watch →Hold until.

Watch flow parame-
ters

Sets the value for the accepted fluctuation of the flow
rate signal used for the test Stable signal in the
instructions Watch →Watch and Watch →Hold until
with signal System flow.

Watch pressure
parameters

Sets the value for the accepted fluctuation of the pres-
sure signals used for the test Stable signal in the
instructions Watch →Watch and Watch →Hold
until.

Watch analog in
parameters

Sets the accepted signal fluctuation and Delta peak
limit of the analog signal for some of the tests in the
Watch →Watch and Watch →Hold until instruc-
tions.

9 Reference information
9.7 System settings

9.7.8 System settings - Watch parameters

450  ÄKTA avant User Manual 29035184 AF



9.7.9 System settings - Advanced
The following table describes the advanced system settings available for ÄKTA avant.

Instruction name Description

Constant pressure
flow parameters

Sets the values for the P and I factors needed to keep a
constant pressure by varying the flow rate. The signal
used for pressure control is set in the instruction
Advanced →Constant pressure flow.

Pressure control
parameters

By using Pressure control the method can be run
with the set flow rate without the risk of method stop
due to pressure alarm. Pressure control is enabled in
the instruction Pumps and Pressures →System flow
or Pumps and PressuresSample flow. Pressure
control parameters provides the P and I factors used
in the regulator and can be adjusted for different
columns.

Max flow during valve
turn

Sets the maximum flow rate used during the turning of
the injection and outlet valve in order to avoid high
pressure alarms.

Method progressing
flow

Sets which flow (Automatic, System flow or Sample
flow) to use to calculate the progress of the method.
In automatic mode, the position of the injection valve
determines if the system flow or the sample flow is
used.

Sample pump setting Enables or disables sample pump flow while the injec-
tion valve is in manual load position.

Instrument display Locks or unlocks the Pause and Continue buttons on
the instrument display.

Wash settings
The settings for system wash are accessible as parameters to the Advanced
→System and pump wash settings and Advanced →Loop wash settings instruc-
tions.
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Parameter for System
and pump wash
settings

Description

System flow rate Sets the flow rate used for the Pumps and pressures
→System wash instruction.

Note:

• The volume for system wash is set in the Pumps
and pressures:System wash instruction.

• The flow rate should not exceed 10 ml/min if narrow
inlet tubing (i.d. 0.75 mm) is used.

• Adjust the flow rate during the system wash so that
the system pressure does not exceed 2 MPa.

System pump wash
volume

Sets the wash volume used during system pump
washes.

Sample flow rate Sets the flow rate used during sample pump washes.

Note:

The flow rate should not exceed 10 ml/min if narrow
inlet tubing (i.d. 0.75 mm) is used.

Sample pump wash
volume

Sets the wash volume used during sample pump
washes.

Parameter for loop
wash settings

Description

Loop wash flow rate Sets the flow rate used during Loop wash.

Note:

• The volume for loop wash is set in the Pumps and
pressures:Loop wash instruction.

• The flow rate should not exceed 10 ml/min if narrow
inlet tubing (i.d. 0.75 mm) is used.

Loop wash high alarm Sets the maximum pressure value during Loop wash.
If the system pressure exceeds this value an alarm is
issued and the method is paused.
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9.7.10 System settings - Data collection
The following table describes the data collection related system settings available for
ÄKTA avant.

Instruction name Description

Name of given curve. E.g.,
UV1, UV2, Cond

The Maximum number of data points parameter
determine the maximum number of data points
collected for a given curve. Data reduction occurs if
the maximum number of data points is exceeded. To
avoid data reduction, set the maximum number of
data points to be collected to 180000 or insert a New
Chromatogram instruction in the method.

Note:

The default setting is 54000 data points, which corre-
sponds to 1.5 h for a signal of 10 Hz.

9 Reference information
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9.8 Using Manual instructions
It is possible to manually interact with an ongoing method using Manual instructions.

Step Action

1 In the System Control module:

• On the Manual menu. click Execute Manual Instructions

or

• use the shortcut Ctrl +M .

Result:

The Manual instructions dialog box opens.

2 In the Manual instructions dialog box:

• Click the + symbol to show the instructions for the instruction group that
you want to modify.

• Select the instruction that you want to modify.

• Enter the new values for the instruction.

3 To execute several instructions at the same breakpoint, select and edit an
instruction and click Insert. Repeat for several instructions.

4 To update parameter fields during method run, select the Auto update
checkbox.

5 To perform the instructions, click Execute.

All available manual instructions are described in the following subsections.

9 Reference information
9.8 Using Manual instructions

454  ÄKTA avant User Manual 29035184 AF



In this section

Section See page

9.8.1 Manual instructions - Pumps and pressures 456

9.8.2 Manual instructions - Flow path 459

9.8.3 Manual instructions - Monitors 461

9.8.4 Manual instructions - Fraction collection 463

9.8.5 Manual instructions - I/O-box 468

9.8.6 Manual instructions - Alarms 469

9.8.7 Manual instructions - Advanced 472

9.8.8 Manual instructions - Watch parameters 475

9.8.9 Manual instructions - Other 476

9 Reference information
9.8 Using Manual instructions

ÄKTA avant User Manual 29035184 AF 455



9.8.1 Manual instructions - Pumps and pressures
The following table describes the pump and related manual instructions available for
ÄKTA avant.

Instruction name Description

System flow Defines the system flow rate.

Flow rate can be set either as volumetric or as linear
flow. A column type must be selected before using
linear flow.

Sample flow Defines the system flow rate. Flow rate can be set
either as volumetric or as linear flow. A column type
must be selected before using linear flow.

Gradient Sets a gradient (linear or stepwise) using the system
pumps A and B.

Note:

Set gradient length value to 0 to perform a step
gradient.

Pump wash Is used to change buffers in the inlet tubing, pump and
mixer.

Note:

• Pressing End during Pump wash will terminate
both the wash and the run immediately.

Pressing Continue during Pump wash will termi-
nate the wash and the run will continue from the
point at which the Pump wash instruction was
executed.

• An instruction issued when a Pump wash is in
progress will not be executed until the wash is
completely finished and all valves have turned back
to the previous positions.

• Pump wash cannot be executed when the system
is in state HOLD.

9 Reference information
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Instruction name Description

Loop wash Is used to wash the Loop valve. It is possible to wash a
single sample application loop, all loops or only the by-
pass position.

Note:

• Pressing End during Loop wash will terminate both
the wash and the run immediately.

Pressing Continue during Loop wash will termi-
nate the wash and the run will continue from the
point at which the Loop wash instruction was
executed.

• An instruction issued when a Loop wash is in
progress will not be executed until the wash is
completely finished and the valves have turned
back to the previous positions.

• Loop wash cannot be executed when the system is
in state HOLD.

System wash Is used to fill the system with the selected buffer
composition. The flow can be directed to the waste
position of either the injection valve or the outlet valve.
The flow is directed to the end of the flow path if outlet
valve is not present.

Note:

• Pressing End during System wash will terminate
both the wash and the run immediately.

Pressing Continue during System wash will
terminate the wash and the run will continue from
the point at which the System wash instruction
was executed.

• If System wash is performed during a Gradient
operation, the current component B concentration
is maintained during the wash.

• An instruction issued during a system wash opera-
tion cannot be executed until the wash is
completely finished and all valves have turned back
to the previous positions.

• System wash cannot be executed when the
system is in state HOLD.

• Adjust the flow rate during the system wash so that
the system pressure does not exceed 2 MPa.

9 Reference information
9.8 Using Manual instructions

9.8.1 Manual instructions - Pumps and pressures

ÄKTA avant User Manual 29035184 AF 457



Instruction name Description

System wash
BufferPro

Is used to fill the system with the selected BufferPro
buffer composition and stabilize the pH before the
flow is directed to the column. The wash flow can be
directed to either the waste position of the injection
valve or the outlet valve.

Quaternary start
concentrations

Is used to set the start concentration of the quater-
nary gradient. This instruction is often used together
with the instruction Quaternary Gradient. The sum
of the start concentrations of Q1 to Q4 must be 100%.

Quaternary gradient Defines the length and end concentration of the
quaternary gradient. The start values are set by the
instruction Quaternary start concentration. The
sum of the target concentrations Q1 to Q4 must be
100%.

BufferPro pH Is used to set or change the pH when automatic buffer
preparation is active during a method run.

Column packing flow Is used to set higher isocratic flow rates. This can be
useful in column packing.

In ÄKTA avant 25 both pump A and pump B generates
flows up to 50 ml/min.

In ÄKTA avant 150 both pump A and B generate flows
up to 300 ml/min.

9 Reference information
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9.8.2 Manual instructions - Flow path
The following table describes the flow path related manual instructions available for
ÄKTA avant.

Instruction name Description

Injection valve Sets the Injection valve to the selected position. The
instruction gives an injection mark in the chromato-
gram when the inlet valve switches to Inject or Direct
Inject.

Note:

Sample pump load flow refers to the flow that enters
the injection valve via SaP port.

Column position Turns the Column valve to the position specified in the
parameter Position.

Inlet A Turns Inlet valve A to the selected position.

Inlet B Turns the Inlet valve B to the selected position.

pH valve Sets the pH cell and the 0.2 to MPa restrictor in posi-
tions inline or offline.

The pH valve also has a calibration position. This posi-
tion is only available when performing calibration of
the pH monitor (In System control select System
→Calibrate). The calibration position can also be used
to fill the pH cell with storage solution since the pH
valve is in open position.

Note:

• It is not possible to turn the pH valve during any type
of fractionation as it affects the delay volume.

• The pH valve instruction can be given during the
delay volume of the different stop fractionation
instructions, but it is executed only after the set
delay volume has been collected.

Sample inlet Turns the Sample inlet valve to the selected position.

Outlet valve Turns the Outlet valve to the selected position. The
instruction gives a mark in the chromatogram when
the valve is switched to the selected position.

Loop valve Turns the Loop valve to the selected position.

9 Reference information
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Instruction name Description

Versatile valve to
Versatile valve 4

Turns the numbered Versatile valve to the selected
position.

Note:

Four sets of positions are available. In positions 1-3
and 2-4 only a single flow channel can be used. In posi-
tions 1-4 & 2-3 and 1-2 & 3-4 the flow can be directed
through two channels simultaneously.

Valve X1 Turns the extra inlet valve to the selected position. The
extra valve is a basic 8 port valve, without air sensor, to
be used for general applications.

Valve X2 Turns the extra inlet valve to the selected position. The
extra valve is a basic 8 port valve, without air sensor, to
be used for general applications.

Injection mark Sets an injection mark in the chromatogram at the
point where this instruction is executed.

Note:

The instruction is useful when the sample is loaded
onto the column by the system pump.

9 Reference information
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9.8.3 Manual instructions - Monitors
The table below describes the monitor related manual instructions available for ÄKTA
avant.

Instruction name Description

Auto zero UV Sets the UV signals from U9-M to 0 mAU.

Auto zero UV 2nd Sets the UV signal from U9-L, 2nd to 0 mAU.

Wavelength Sets the wavelengths for UV monitor U9-M. The corre-
sponding curves in the chromatogram are marked
with the set wavelengths.

Note:

• Do not use more wavelengths than necessary for
the application.

• At low wavelengths, the eluent can have absorb-
ance of its own.

Noise reduction UV Filters the noise in the UV signal from UV monitor U9-
M. A column-specific averaging time is set automati-
cally when a column is defined in a method run and
Averaging time is set as a variable.

Noise reduction UV
2nd

Filters the noise in the UV monitor signal from U9-L,
2nd. A column-specific averaging time is set automati-
cally when a column is defined in a method run and
Averaging time is set as a variable.

Relative scale cond Facilitates monitoring using the conductivity monitor,
of a gradient, for which the user sets the conductivity
values for 0% and 100%. The Relative scale cond
instruction can be set in ascending manner (0% for low
and 100% for high conductivity) or in descending
manner (0% for high and 100% for low conductivity).

Note:

The Relative scale cond instruction in descending
manner is especially useful for conductivity visualiza-
tion in RPC and HIC, where the conductivity curve is
reversed compared to the concentration curve (i.e.,
high conductivity at 0% B and low conductivity at 100%
B).

9 Reference information
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Instruction name Description

Relative scale cond
2nd

Facilitates monitoring using a second conductivity
monitor, of a gradient, for which the user sets the
conductivity values for 0% and 100%. The Relative
scale cond instruction can be set in ascending
manner (0% for low and 100% for high conductivity) or
in descending manner (0% for high and 100% for low
conductivity).

Note:

The Relative scale cond instruction in descending
manner is especially useful for conductivity visualiza-
tion in RPC and HIC, where the conductivity curve is
reversed compared to the concentration curve (i.e.,
high conductivity at 0% B and low conductivity at 100%
B).

9 Reference information
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9.8.4 Manual instructions - Fraction collection
The following table describes the fraction collection related manual instructions avail-
able for ÄKTA avant.

Instruction name Description

Fractionation Is used when collecting fractions with a fraction
collector.

Peak fractionation Enables collection of only those peaks that fulfill the
conditions set in the Peak fractionation parame-
ters instruction.

Stop fractionation Ends the fractionation after the set delay volume
(specified in the System Settings →Fraction collec-
tion →Delay volumes instruction) has been
collected. The outlet valve is then turned to position
Waste.

Note:

If Stop fractionation is issued when both Fractiona-
tion and Peak fractionation are active, fractionation
is stopped after the set delay volume has been
collected. The outlet valve remains in position Frac and
peak fractionation continues.

Stop peak fractiona-
tion

Ends the peak fractionation after the set delay volume
(specified in the System Settings →Fraction collec-
tion →Delay volumes instruction) has been
collected. The outlet valve is then turned to position
Waste.

Last tube filled Last tube filled sets the action to perform after the
built-in fraction collector fills the last tube of the run:
pause the fractionation, direct the flow to one of the
outlet ports of the outlet valve or direct the flow to
waste.
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Instruction name Description

Feed tube Feed tube moves the fractionation arm of the built-in
fraction collector to the position specified by the
parameter Start position, after the set delay volume
has been collected. A fraction mark is given in the
chromatogram.

Fraction collector F9-R: Feed tube moves the tube
rack forward one tube after the set delay volume has
been collected and a fraction mark is set. When frac-
tionation or peak fractionation is not ongoing, Feed
tube moves the rack instantly and no fraction mark is
set.

Accumulator wash Accumulator wash is used to wash the accumulator
of built-in the fraction collector with the current solu-
tion present in the system. The wash flow rate is set in
the instruction Wash settings:Fraction collector
wash settings and the current inlet positions are
used. After the wash, the flow rate and the valve posi-
tions automatically go back to their previous settings.

Note:

Fraction collector wash cannot be executed during
any type of fractionation.

Fractionation
numbering mode

Only for Fraction collector F9-R. Fractionation
numbering mode determines whether the fraction
number is reset at the end of a method or not.

Note:

The default setting is Reset.

Reset tube type Only for Fraction collector F9. Reset tube type resets
all the tube types in the fraction collector.

Note:

It is not allowed to execute the Reset tube type
instruction during fractionation.

9 Reference information
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Instruction name Description

Frac cleaning position Only for Fraction collector F9. Frac cleaning position
enables manual cleaning of the dispenser head. The
system is paused and the fractionation arm is moved
to the middle front of the interior of the fraction
collector. It is then possible to open the door of the
fraction colelctor and manually clean the dispenser
head.

Note:

The Frac cleaning position instruction cannot be
executed during fractionation.

Fraction collector
lamp

Only for Fraction collector F9. Fraction collector
lamp turns the light in the fraction collector on or off.

Cassette configura-
tion

Only for Fraction collector F9. Cassette configura-
tion is set to either automatic or manual:

• Automatic: the fraction collector automatically
detects the cassette types present in the fraction
collector.

• Manual: The fraction collector content is manually
set.

Fractionation frac 2 Is used when collecting fractions with the second
Fraction collector.

Stop fractionation frac
2

Ends the fractionation after the set delay volume for
the second Fraction collector (specified in System
Settings →Tubing and Delay volumes) has been
collected. The outlet valve is then turned to position
Waste.

Note:

If Stop fractionation frac 2 is issued when both
Fractionation frac 2 and Peak fractionation frac 2
are active, fractionation is stopped after the set delay
volume has been collected. The Outlet valve V9-O or
V9H-O remains in position Outlet 10 / Frac 2 and
peak fractionation in the second Fraction collector
continues.

Peak fractionation frac
2

Enables collection of only those peaks that fulfill the
conditions set in the Peak fractionation parame-
ters instruction.
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Instruction name Description

Stop peak fractiona-
tion frac 2

Ends the peak fractionation in second Fraction
collector after the set delay volume (specified in
System Settings →Tubing and Delay volumes) has
been collected. The outlet valve is then turned to posi-
tion Waste.

Reset frac number frac
2

Sets fraction numbers to restart from 1 for the second
Fraction collector. The restart occurs when the
instruction is issued. The instruction overrides the
continuous numbering mode if Fractionation
numbering mode frac 2 is set to Continue in
System Settings.

Feed tube frac 2 During fractionation or peak fractionation the instruc-
tion Feed tube frac 2 moves the second Fraction
collector tube rack forward one tube after the set
delay volume has been collected and a fraction mark is
set. When fractionation or peak fractionation is not
ongoing, Feed tube frac 2 moves the rack instantly
and no fraction mark is set.

Fractionation in outlet
valve

Applicable if no fraction collector is used. Fractiona-
tion in outlet valve enables fractionation via the
outlet valve. When the set fraction size/outlet has
been collected, the outlet valve turns to the next posi-
tion. A fraction mark is set in the chromatogram for
each new outlet position.

Stop frac in outlet
valve

Applicable if no fraction collector is used. Stop frac in
outlet valve ends the fractionation in outlet valve
after the set delay volume (specified in System
Settings →Tubing and Delay volumes) has been
collected. The outlet valve is then turned to position
Waste.

Peak frac in outlet
valve

Applicable if no fraction collector is used. Peak frac in
outlet valve enables collection of only those peaks
that fulfill the conditions set in Peak fractionation
parameters. When the set fraction size/outlet has
been collected, the outlet valve turns to the next posi-
tion. A fraction mark is set in the chromatogram for
each new outlet position.
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Instruction name Description

Stop peak frac in outlet
valve

Applicable if no fraction collector is used. Stop peak
frac in outlet valve ends the peak fractionation in
outlet valve after the set delay volume (specified in
System Settings →Tubing and Delay volumes) has
been collected. The outlet valve is then turned to posi-
tion Waste.

Peak fractionation
parameters

Sets the detection parameters for peak collection, i.e.
it determines when a peak starts and ends. This infor-
mation is used by the instructions Peak fractiona-
tion, Peak fractionation frac 2 and Peak frac in
outlet valve in order to start/end the peak collection.
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9.8.5 Manual instructions - I/O-box
The following table describes the I/O-box related manual instructions available for
ÄKTA avant.

Instruction name Description

Auto zero analog in X Sets the value of the analog signal in the analog port
number X to 0 mV.

Reset auto zero analog
in X

Sets the signal in analog port number X to its current
value, i.e. the actual voltage in the analog port number
X.

Noise reduction
analog in X

Filters the noise in the analog signal in port number X.

Digital out X Sets the value of the signal sent out by digital port
number X to either 0 or 1. The default value is 1.

Pulse digital out X Generates a pulsed signal in digital port number X. The
signal changes from the initial state (0 or 1) to the
opposite state and returns to the initial state after the
defined length of time.

Configure analog out X Enables the user to send one of the pre-defined signals
(UV signal, conductivity, temperature, pH or concen-
tration of eluent B) to the analog out port number X,
and also to set the range of that signal.

9 Reference information
9.8 Using Manual instructions

9.8.5 Manual instructions - I/O-box

468  ÄKTA avant User Manual 29035184 AF



9.8.6 Manual instructions - Alarms
The following table describes the alarm related manual instructions available for ÄKTA
avant.

Instruction name Description

Alarm system pressure Sets the alarm limits for the system pressure. When
enabled and the system pressure falls outside the set
pressure limits, an alarm will be triggered and the
method will be paused. Default values for the alarm
limits are set by the values in the column list when a
column is selected in the method and Alarm system
pressure is set as a variable. Low alarm is only trig-
gered if the pressure first exceeds the Low alarm limit
for ten seconds continuously and then falls below the
Low alarm limit.

Note:

Setting the Low alarm or the system flow rate to 0
deactivates the low pressure alarm.

Alarm sample pressure Sets the alarm limits for the sample pressure. When
enabled and the pressure falls outside the set pressure
limits, an alarm will be triggered and the method will
be paused. Low alarm is only triggered if the pressure
first exceeds the Low alarm limit for ten seconds
continuously then falls below the Low alarm limit.

Note:

Setting the Low alarm to 0 deactivates the low pres-
sure alarm.

Alarm delta column
pressure

Sets the alarm limits for the delta column pressure
(pre-column pressure minus post-column pressure).
When enabled and the delta column pressure falls
outside the set pressure limits, an alarm will be trig-
gered and the method will be paused. Low alarm is
only triggered if the pressure first exceeds the Low
alarm limit for ten seconds continuously then falls
below the Low alarm limit.

Note:

• Setting the Low alarm to 0 deactivates the low
pressure alarm.

• Instruction Alarm delta column pressure is avail-
able only when Column valve V9-C or V9H-C (5-
columns) is selected in the component list.
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Instruction name Description

Alarm pre column
pressure

Sets the alarm limits for the pre column pressure.
When enabled and the pre column pressure falls
outside the set pressure limits, an alarm is issued and
the method will be paused. Default values for the
alarm limits are set by the values in the column list
when a column is selected in the method and Alarm
pre column pressure is set as a variable. Low alarm
is only triggered if the pressure first exceeds the Low
alarm limit for ten seconds continuously then falls
below the Low alarm limit.

Note:

Setting the Low alarm to 0 deactivates the low pres-
sure alarm.

Alarm UV Enables or disables the alarm for the UV signal. When
enabled, it sets the alarm limits for the UV signal from
UV monitor U9-L. When the UV signal falls outside the
set limits, an alarm will be triggered and the method
will be paused.

Alarm UV1 Enables or disables the alarm for the UV 1 signal from
UV monitor U9-M. When enabled, it sets the alarm
limits for the UV 1 signal from UV monitor U9-M. When
the UV signal falls outside the set limits, an alarm is
issued and the method will be paused.

Note:

It is not possible to set an alarm signal for the UV 2 or
UV 3 signals from UV monitor U9-M.

Alarm UV 2nd Enables or disables the alarm for the UV signal from
UV monitor U9-L, 2nd. When enabled, it sets the alarm
limits for the UV signal from U9-L, 2nd. When the UV
signal falls outside the set limits, an alarm will be trig-
gered and the method will be paused.

Alarm conductivity Enables or disables the conductivity alarm. When
enabled, it sets the alarm limits for the conductivity
signal. When the conductivity falls outside the set
limits, an alarm will be triggered and the method will
be paused.

Alarm pH Enables or disables the pH alarm. When enabled, it
sets the alarm limits for the pH signal. When the pH
falls outside the set limits, an alarm will be triggered
and the method will be paused.
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Instruction name Description

Alarm inlet A air sensor Enables or disables the air sensor alarm for the built-in
air sensor at inlet A. If the alarm is enabled and air is
detected, an alarm will be triggered and the method
will be paused.

Alarm inlet B air sensor Enables or disables the air sensor alarm for the built-in
air sensor at inlet B. If the alarm is enabled and air is
detected, an alarm will be triggered and the method
will be paused.

Alarm sample inlet air
sensor

Enables or disables the air sensor alarm for the built-in
air sensor at the sample inlet. If the alarm is enabled
and air is detected, an alarm will be triggered and the
method will be paused.

Alarm external air
sensor X

Enables or disables the alarm for the optional air
sensor number X. If the alarm is enabled and air is
detected, an alarm will be triggered and the method
will be paused.

Alarm analog in X Enables or disables the alarm for the analog signal in
port number X. When enabled, it sets the alarm limits
for the analog signal. If the alarm is enabled and the
analog signal falls outside the set limits, an alarm will
be triggered and the method will be paused.

Alarm digital in X Enables or disables the alarm for the signal in digital
port number X. The alarm can be triggered by either of
the signal values, 0 or 1. If the alarm is enabled and the
condition set in Value occurs, an alarm will be trig-
gered and the method will be paused.
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9.8.7 Manual instructions - Advanced
The following table describes the advanced manual instructions available for ÄKTA
avant.

Instruction name Description

Pressure control
parameters

By using Pressure control the method can be run
with the set flow rate without the risk of method stop
due to pressure alarm. Pressure control is enabled in
the instruction System flow or Sample flow. Pres-
sure control parameters provides the P and I factors
used in the regulator and can be adjusted for different
columns.

Pressure control min flow rate can be set either as
volumetric or as linear flow. A column type must be
selected before using linear flow.

Constant pressure
flow

Enables column packing at constant pressure. The
system pump automatically adjusts the flow rate
within the specified Minimum allowed flow rate –
Maximum allowed flow rate range. The goal is to
reach and keep the set Pressure at the selected Pres-
sure sensor using the P and I factors set in the
Constant pressure flow parameters instruction.
The total volume is continuously updated using the
actual flow rate.

Both pressure control flow rates can be set either as
volumetric or as linear flow. A column type must be
selected before using linear flow.

Note:

• When Constant pressure flow is used, the P and I
factors set in the Constant pressure flow param-
eters instruction are used to control the pressure,
instead of the P and I values set in the Pressure
control parameters instruction.

• Pressure sensor Delta column pressure is avail-
able only when column valve V9-C or V9H-C (5-
columns) is selected in the component list.

Constant pressure
flow parameters

Sets the values for the P and I factors needed to keep a
constant pressure by varying the flow rate. The signal
used for pressure control is set in the instruction
Constant pressure flow.
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Instruction name Description

Column packing flow Is used to set flow rates over 25 ml/min and 150
ml/min for ÄKTA avant 25 and ÄKTA avant 150,
respectively. Both A and B pumps are used to generate
the flow, making it possible to set flow rates up to 50
ml/min and 300 ml/min for ÄKTA avant 25 and ÄKTA
avant 150, respectively. Flow rate can be set either as
volumetric or as linear flow. A column type must be
selected before using linear flow.

Before executing the Column packing flow instruc-
tion it is important to:

• Immerse inlet tubing A1 and B1 in the same buffer

• Disconnect the column outlet tubing from the
Column valve and place the tubing in a waste vessel

Note:

When running Column packing flow only isocratic
runs can be performed, gradients cannot be gener-
ated.

Delay volume
→Monitor to outlet
valve

Is used to define the delay volume between the
monitor and the Outlet valve. The instruction is used to
make sure that the collected fractions correspond to
the fractions indicated in the chromatogram. The
delay volume must be changed when changing tubing
to another i.d. or length or when removing or adding
components.

Delay volume
→Monitor to frac

Is used to define the delay volume between the
monitor and the Fraction collector. The instruction is
used to make sure that the collected fractions corre-
spond to the fractions indicated in the chromatogram.
The instruction is available only when the Fraction
collector is selected in the component list.

Delay volume
→Monitor to frac 2

Is used to define the delay volume between the
monitor and the second Fraction collector. The
instruction is used to make sure that the collected
fractions correspond to the fractions indicated in the
chromatogram. The instruction is available only when
the second Fraction collector is selected in the
component list.

Start volume count Starts the volume counter function. The counted
volume is saved into a memory.

This instruction is best used in combination with
Watch instructions.
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Instruction name Description

Stop volume count Stops the volume counter function. The counted
volume is stored in the memory and can be recalled
with the instruction Hold counted volume. The
counted volume can also be recalled in following runs
and is stored until a new Stop volume count instruc-
tion is issued.

This instruction is best used in combination with
Watch instructions.

Hold counted volume Sets the system to Hold. The system will remain in the
state Hold until the accumulated volume reaches the
volume stored by the instructions Start volume
count / Stop volume count.

Method progressing
flow

Defines the flow from which the volume base is calcu-
lated. When set to Automatic, the position of the
injection valve determines if the system flow or the
sample flow is used.
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9.8.8 Manual instructions - Watch parameters
The following table describes the watch parameter instructions available for ÄKTA
avant.

Instruction name Description

Watch UV parameters Sets the accepted signal fluctuation and Delta peak
limit of the UV signal for some of the tests in the
Watch and Hold until instructions.

Watch UV 2nd parame-
ters

Sets the accepted signal fluctuation and Delta peak
limit of the UV 2nd signal for some of the tests in the
Watch and Hold until instructions.

Watch cond parame-
ters

Sets the accepted fluctuation and Delta peak limit of
the conductivity signal for some of the tests in the
Watch and Hold until instructions.

Watch pH parameters Sets the value for the accepted fluctuation of the pH
signal used for the test Stable signal in the instruc-
tions Watch and Hold until.

Watch flow parame-
ters

Sets the value for the accepted fluctuation of the flow
rate signal used for the test Stable signal in the
instructions Watch and Hold until with signal
System flow.

Watch pressure
parameters

Sets the value for the accepted fluctuation of the pres-
sure signals used for the test Stable signal in the
instructions Watch and Hold until.

Watch analog in
parameters

Sets the accepted signal fluctuation and Delta peak
limit of the analog signal for some of the tests in the
Watch and Hold until instructions.
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9.8.9 Manual instructions - Other
The following table describes the other manual instructions available for ÄKTA avant.

Instruction name Description

Set mark Inserts a mark into the current chromatogram with
the text entered for the parameter Mark text .

Timer Sets the system to pause or end after a set volume or
time has passed. Select base sets the base to either
accumulated time or accumulated volume. Timeout
sets the volume or time. Action sets the action to
perform (pause or end)
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9.9 Available Run data

Run data
The following table lists all available Run data for ÄKTA avant.

Run Data Range/Unit Description

System state N/A Status of connection and run.

Acc. Volume ml Total accumulated volume in
the current method or manual
run.

Block volume ml Accumulated volume in the
current block (method run only).

Acc. Time min Total accumulated time in the
current method or manual run.

Block time min Accumulated time in the
current block (method run only).

Scouting no N/A The current scouting number in
the scouting scheme.

System flow 0.001 to 50.000 ml/min
(ÄKTA avant 25)

0.01 to 300.00 ml/min (ÄKTA
avant 150)

The set flow rate of the system
pumps.

System flow
linear

cm/h The set flow velocity of the
system pumps. Only available if
a column is selected.

System pres-
sure

-1.00 to 20.00 MPa (ÄKTA
avant 25)

-1.00 to 5.00 MPa (ÄKTA
avant 150)

The system pressure signal (at
the system pumps).

Conc B 0.0 to 100.0%B The set concentration B or the
current value during a gradient.

Sample flow 0.001 to 50.000 ml/min
(ÄKTA avant 25)

0.01 to 300.00 ml/min (ÄKTA
avant 150)

The set flow rate of the sample
pump.

Sample flow
linear

cm/h The set flow velocity of the
sample pump. Only available if a
column is selected.
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Run Data Range/Unit Description

Sample pres-
sure

-1.00 to 10.00 MPa (ÄKTA
avant 25)

-1.00 to 5.00 MPa (ÄKTA
avant 150)

The sample pressure signal (at
the sample pump).

PreC pressure -1.00 to 20.00 MPa (ÄKTA
avant 25)

-1.00 to 5.00 MPa (ÄKTA
avant 150)

The pre-column pressure signal.

DeltaC pres-
sure

-1.00 to 20.00 MPa (ÄKTA
avant 25)

-1.00 to 5.00 MPa (ÄKTA
avant 150)

The delta-column pressure
signal.

PostC pres-
sure

-1.00 to 20.00 MPa (ÄKTA
avant 25)

-1.00 to 5.00 MPa (ÄKTA
avant 150)

The post-column pressure
signal.

UV 1 -6000.000 to 6000.000 mAU The first UV/Vis absorbance
signal of the U9-M monitor.

UV 2 -6000.000 to 6000.000 mAU The 2nd UV/Vis absorbance
signal of the U9-M monitor.

UV 3 -6000.000 to 6000.000 mAU The 3rd UV/Vis absorbance
signal of the U9-M monitor.

UV 2nd -6000.000 to 6000.000 mAU The UV absorbance signal of the
U9-L monitor.

pH 0.00 to 14.00 pH The pH signal.

BufferPro pH 0.00 to 14.00 pH Target BufferPro pH.

Conc Q1 0.0% to 100.0% The set concentration of Q1 or
the current value during a
quaternary or BufferPro
gradient

Conc Q2 0.0% to 100.0% The set concentration of Q2 or
the current value during a
quaternary or BufferPro
gradient
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Run Data Range/Unit Description

Conc Q3 0.0% to 100.0% The set concentration of Q3 or
the current value during a
quaternary or BufferPro
gradient

Conc Q4 0.0% to 100.0% The set concentration of Q4 or
the current value during a
quaternary or BufferPro
gradient

Cond 0.00 to 999.99 mS/cm The conductivity signal.

% Cond 0.0% to 100.0% The conductivity signal as a
percentage of a set range.

Cond temp 0.0°C to 99.0°C The temperature signal (in the
conductivity flow cell).

Inject N/A The set position of the Injection
valve.

Loop position N/A The set position of the Loop
valve.

Column posi-
tion

N/A The set position of the Column
valve.

Flow direction N/A The set flow direction position
of the Column valve V9-C and
Column valve V9H-C.

Outlet N/A The set position of the outlet
valve.

Inlet A A1 - A7 The set position of the inlet
valve A.

Inlet B B1 - B7 The set position of the inlet
valve B.

Sample inlet S1 - S7, buff The set position of the sample
inlet valve.

pH valve N/A The set position of the pH valve.

Versatile
valve

N/A The set position of the versatile
valve.

Versatile
valve 2

N/A The set position of the versatile
valve 2.
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Run Data Range/Unit Description

Versatile
valve 3

N/A The set position of the versatile
valve 3.

Versatile
valve 4

N/A The set position of the versatile
valve 4.

Valve X1 N/A The set position of the X1 valve.

Valve X2 N/A The set position of the X2 valve.

Air inlet A No air, Air The current state of the air
alarm for the integrated air
sensor in inlet valve A.

Air inlet B No air, Air The current state of the air
alarm for the integrated air
sensor in inlet valve B.

Air sample
inlet

No air, Air The current state of the air
alarm for the integrated air
sensor in inlet valve IS.

Air external No air, Air The current state of the air
alarm for the external air
sensors.

Frac position N/A The current tube position of the
fraction collector.

Frac temp N/A

Frac 2 posi-
tion

N/A The current tube position of the
fraction collector 2.

Analog in 1 to

Analog in 4

-2000.0 to 2000.0 mV The I/O-box analog input
signals.

Digital in 1 to

Digital in 8

0, 1 The I/O-box digital input signals.

Digital out 1 to

Digital out 8

0, 1 The set value of the I/O-box
digital output signals.
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9.10 Available Curves

Curves
The table lists data available in curves for ÄKTA avant.

Curve Range Sampling
frequency

Description

UV 1_280 -6000.000 to 6000.000
mAU

10 Hz The first UV/Vis
absorbance
signal of the U9-
M monitor.

UV 2_0 -6000.000 to 6000.000
mAU

2 Hz The 2nd UV/Vis
absorbance
signal of the U9-
M monitor.

UV 3_0 -6000.000 to 6000.000
mAU

2 Hz The 3rd UV/Vis
absorbance
signal of the U9-
M monitor.

Cond 0.00 to 999.99 mS/cm 5 Hz The conductivity
signal.

% Cond 0.0% to 100.0% 1 Hz The conductivity
signal as a
percentage of a
set range.

Conc B 0.0% to 100.0% 1 Hz The set concen-
tration B or the
current value
during a
gradient.

pH 0.00 14.00 1 Hz The pH signal.

System flow 0.001 to 50.000 ml/min
(ÄKTA avant 25)

0.01 to 300.00 ml/min
(ÄKTA avant 150)

1 Hz The set flow rate
of the system
pumps.
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Curve Range Sampling
frequency

Description

System flow
linear

cm/h 1 Hz The set flow
velocity of the
system pumps.
Only available if
a column is
selected.

System pres-
sure

-1.00 to 20.00 MPa (ÄKTA
avant 25)

-1.00 to 5.00 MPa (ÄKTA
avant 150)

10 Hz The system
pressure signal
(at the system
pumps).

Cond temp 0.0°C to 99.0°C 0.5 Hz The tempera-
ture signal (in
the conductivity
flow cell).

Sample flow 0.001 to 50.000 ml/min
(ÄKTA avant 25)

0.01 to 300.00 ml/min
(ÄKTA avant 150)

1 Hz The set flow rate
of the sample
pump.

Sample flow
linear

cm/h 1 Hz The set flow
velocity of the
sample pump.
Only available if
a column is
selected.

UV 2nd -6000.000 to 6000.000
mAU

10 Hz The UV absorb-
ance signal of
the U9-L
monitor.

Sample pres-
sure

-1.00 to 10.00 MPa (ÄKTA
avant 25)

-1.00 to 5.00 MPa (ÄKTA
avant 150)

10 Hz The sample
pressure signal
(at the sample
pump).

PreC pressure -1.00 to 20.00 MPa (ÄKTA
avant 25)

-1.00 to 5.00 MPa (ÄKTA
avant 150)

1 Hz The pre-column
pressure signal.
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Curve Range Sampling
frequency

Description

DeltaC pres-
sure

-1.00 to 20.00 MPa (ÄKTA
avant 25)

-1.00 to 5.00 MPa (ÄKTA
avant 150)

1 Hz The delta-
column pressure
signal.

PostC pres-
sure

-1.00 to 20.00 MPa (ÄKTA
avant 25)

-1.00 to 5.00 MPa (ÄKTA
avant 150)

1 Hz The post-
column pressure
signal.

Conc Q1 0.0% to 100.0% 0.5 Hz The set concen-
tration of Q1 or
the current
value during a
quaternary or
BufferPro
gradient

Conc Q2 0.0% to 100.0% 0.5 Hz The set concen-
tration of Q2 or
the current
value during a
quaternary or
BufferPro
gradient

Conc Q3 0.0% to 100.0% 0.5 Hz The set concen-
tration of Q3 or
the current
value during a
quaternary or
BufferPro
gradient

Conc Q4 0.0% to 100.0% 0.5 Hz The set concen-
tration of Q4 or
the current
value during a
quaternary or
BufferPro
gradient
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Curve Range Sampling
frequency

Description

Frac temp 0°C to 99.0°C 0.5 Hz The tempera-
ture inside the
built-in fraction
collector
chamber.

Analog in 1 to

Analog in 4

-2000.0 to 2000.0 mV 10 Hz The I/O-box
analog input
signals.

UV cell path
length

0.2,0.5, 1.0 cm 1 Hz The nominal cell
path length of
the U9-M
monitor.

UV cell path
length 2nd

0.2, 0.5 cm 1 Hz The nominal cell
path length of
the U9-L
monitor.

Digital in 1 to

Digital in 8

0, 1 10 Hz The I/O-box
digital input
signals.

Digital out 1
to

Digital out 8

0, 1 10 Hz The I/O-box
digital output
signals.
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9.11 Injection volumes and peak broadening

Introduction
The width of peaks at the fraction collector is influenced by the following:

• the properties of the column,

• the dimensions of the tubing,

• the dimensions of the modules in the flow path, and

• fluid dynamics.

Sample volume effects
Initial sample volume affects the peak width in gel filtration (GF) chromatography and
other isocratic techniques. A sample zone is broadened during passage through a GF
column so that the sample is diluted and the resolution decreases with increasing
sample volume. Sample volume does not however affect the resolution in adsorption
chromatography techniques such as affinity chromatography (AC), ion exchange chro-
matography (IEX), and hydrophobic interaction chromatography (HIC) if the retention
factor k is high.

Broadening from UV monitor to
fraction collection

The effect of peak broadening in the system from sample injection to peak detection
(including dilution on the column) is apparent in the chromatogram from the UV
monitor, but broadening from the UV monitor to fraction collection is not visible in the
chromatogram. This "hidden" effect is more pronounced for smaller peak volumes.

9 Reference information
9.11 Injection volumes and peak broadening

ÄKTA avant User Manual 29035184 AF 485



9.12 Delay volumes

Introduction
A number of methods, both theoretical and experimental, exist for determining the
delay volume of a system. The easiest and recommended method is to perform a theo-
retical determination. Delay volumes for standard configurations are listed in Standard
delay volumes in ÄKTA avant 25 and ÄKTA avant 150, on page 488.

Explanation of delay volume
The delay volume is the volume between the detector and the fraction collector or
outlet that is used.

The following illustration shows and example of the delay volume between the UV/Vis
monitor and the fraction collector.

UV/Vis

pH

Valve

The time when a peak is detected 
by the UV/Vis detector is called T0

The peak reaches the fraction 
collector at time T1

Fraction collectorConductivity

Delay volume

Theoretical determination of delay
volumes

A theoretical determination is performed as described in the following steps:

Step Action

1 Identify all components in the system flow path that contribute to the delay
volume of interest.

2 Determine the internal volumes of all hardware modules and tubing, see 
Section 9.13 Component volumes, on page 490 for information about theo-
retical module volumes and Section 9.3 Tubing and connectors, on page 413
for information about tubing lengths and dimensions.

3 To obtain the total delay volume, sum up half of the flow cell volume of the
monitor used (that is, the UV or UV/Vis monitor) with all volumes of tubing
and modules that are located after the monitor in the flow path.
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Note: For pH-valve V9-pH and V9H-pH always use the volume for the valve in by-
pass position. The system automatically adds the volumes for the flow
restrictor and the pH flow cell when if they are part of the system.

Set the delay volume in UNICORN

Follow the instructions to set the delay volume between the UV monitor and the Outlet
valve and between the UV monitor and the Fraction collector.

Step Action

1 In the System Control module, on the System menu, click Settings.

Result:

The System Settings dialog box opens.

2 • Click Fraction collection →Delay volumes

• Enter the delay volume between the UV monitor and the Fraction
collector in the Detector-Frac field

• Enter the delay volume between the UV monitor and the Outlet valve in
the Detector - Outlet valve field

• and click OK.

Note: The system will use the delay volume appropriate to the configuration used
and ignore other settings (e.g. the value for Detector-Outlet valve will be
ignored if you are using a fraction collector). It is however recommended to
set all delay volumes so that the volumes remain correct if you change frac-
tionation method.
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Standard delay volumes in ÄKTA
avant 25 and ÄKTA avant 150

The table below shows the delay volumes of different sections of the flow path.

Flow path Volume (μl)

UV detector to built-in fraction collector

Note:

With pH electrode and flow restrictor off-line.

ÄKTA avant 25: 518

ÄKTA avant 150: 1807

UV detector to Outlet Valve

Note:

With pH electrode and flow restrictor off-line.

ÄKTA avant 25: 142

ÄKTA avant 150: 535

UV detector to second Outlet Valve ÄKTA avant 25: 196

ÄKTA avant 150: 781

UV detector to third Outlet Valve ÄKTA avant 25: 250

ÄKTA avant 150: 1028

Flow restrictor,

including tubing 1R and 2R

ÄKTA avant 25: 48

ÄKTA avant 150: 94

pH flow cell ÄKTA avant 25: 76

ÄKTA avant 150: 129

UV detector to Fraction collector F9-R, 2nd

(With pH electrode and flow restrictor off-line.)

ÄKTA avant 25: 240

ÄKTA avant 150: 928

Delay volumes for extended systems
If modules and tubing are added to, or subtracted from, the ÄKTA avant system
between the UV monitor and the fraction collector, use the standard delay volumes
values in Standard delay volumes in ÄKTA avant 25 and ÄKTA avant 150, on page 488
and correct with tubing volumes from Section 9.3 Tubing and connectors, on page 413
and component volumes from Section 9.13 Component volumes, on page 490 to calcu-
late a new delay volume. Add this delay volume in UNICORN.

Note: For pH-valve V9-pH and V9H-pH always use the volume for the valve in by-
pass position. The system automatically adds the volumes for the flow
restrictor and the pH flow cell when if they are part of the system.
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Use of different monitors for peak
fractionation in the same method

If different monitors or detectors are used for peak fractionation in different parts of
the same method, the delay volumes have to be set as method instructions for each of
the method parts. For example, both an external fluorescence detector and the UV
monitor module can be used for peak fractionation.
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9.13 Component volumes

Introduction
This section describes the component volumes and delay volumes of the ÄKTA avant
instrument.

The table below shows the component volumes of ÄKTA avant.

Component Volume (μl)

Inlet valve V9-IA, V9-IB, V9-A2, V9-B2 88

Inlet valve V9H-IA, V9H-IB, V9H-A2, V9H-B2 212

Sample inlet valve V9-IS, V9-S2 88

Sample inlet valve V9H-IS, V9H-S2 212

Inlet valve V9-IX 88

Inlet valve V9H-IX 212

External air sensor L9-1.2 20

External air sensor L9-1.5 35

Pump P9 (P9 A, and P9 B)

(total volume for two heads including T-connector and
check valves)

549

Pump P9H (P9H A, P9H B, P9H S)

(total volume for two heads including T-connector and
check valves)

2163

System pump flow restrictor 30

Sample pump flow restrictor 30

System pump pressure monitor R9 45

Sample pump pressure monitor R9 45

Sample pump P9-S (P9-S)

(total volume for two heads including T-connector and
check valves)

1392

Mixer, 0.6 to ml 600

Mixer, 1.4 to ml 1400

Mixer, 5 ml 5000

Mixer, 15 ml 15000
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Component Volume (μl)

Loop valve V9-L 17

Loop valve V9H-L 76

Versatile valve V9-V 14

Versatile valve V9H-V 31

Injection valve V9-Inj 10

Injection valve V9H-Inj 23

Column valve V9-C,V9-C2 110

Column valve V9H-C, V9H-C2 190

UV monitor U9-M: Flow cell 0.5 mm 10

UV monitor U9-M: Flow cell 2 mm 11

UV monitor U9-M: Flow cell 10 mm 12

Second UV monitor U9-L: Flow cell 2 mm 30

Second UV monitor U9-L: Flow cell 5 mm 20

Conductivity cell 22

Flow restrictor FR-902 10

pH valve V9-pH, in By-pass position 15

pH valve V9H-pH, in By-pass position 35

pH flow cell mounted in pH valve V9-pH 76

pH flow cell mounted in pH valve V9H-pH 129

Flow restrictor FR-902 and tubing when mounted on pH
valve V9-pH

48

Flow restrictor FR-902 and tubing when mounted on pH
valve V9H-pH

94

Outlet valve V9-O, V9-O2, V9-O3 9

Outlet valve V9H-O, V9H-O2, V9H-O3 82

Built-in fraction collector internal tubing ÄKTA avant 25: 31

ÄKTA avant 150: 135

Built-in fraction collector accumulator 40
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Component Volume (μl)

Built-in fraction collector dispenser head ÄKTA avant 25: 53

ÄKTA avant 150: 68

Fraction collector F9-R tubing ÄKTA avant 25: 98

ÄKTA avant 150: 393

Note: The given values for the component volumes of the valves are average
values. Depending on the chosen flow path the actual component volume
may differ.
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9.14 Pressure control

Introduction
By using the function Pressure control to regulate the run, the method can be run
with the set flow rate without the risk of method stop due to pressure alarm. If the pres-
sure approaches the pressure limit, for example if the sample has higher viscosity than
the buffer, the flow rate is automatically lowered. Pressure control is enabled in the
manual instructions Pumps →System flow or Pumps →Sample flow. The default
setting for Pressure Control is Off. To enable the function, set what pressure signal to
use. It is recommended to use the pre-column pressure. The instruction Advanced
→Pressure control parameters provides the P and I factors used in the regulator and
can be adjusted for different columns, see information further down.

In the Method editor, pressure control is enabled by selecting Control the flow to
avoid overpressure in the predefined phase Method settings.

Pressure control parameters
The table below describes the factors used for pressure regulation.

Parameter Description

P factor Proportional component in PI pressure regulation. Reduces the
error between actual and requested target pressure, but may leave
a permanent error.

I factor Integrating component in PI pressure regulation. Eliminates the
stationary error from the P factor, but introduces a slight instability
that may lead to oscillation in the pressure and the actual flow rate.
Set I = 0 to disable the I factor. As a general guide use a small I factor
for high pressure columns and a large I factor for low pressure
columns, see Recommended pressure control parameters, on page
494 for more recommendations.

Target
value for
pressure
control

Sets the target value for the PI pressure regulation as a percentage
of the pressure limit. If the target pressure is too close to the pres-
sure limit there is a risk that a short pressure spike will trigger the
pressure alarm. The pressure limit is set in the Alarm pressure
instruction. The Alarm pressure used for pressure control
depends on the settings in the System flow instruction.

Pressure
control
min flow
rate

If the flow rate is reduced below the value set in Pressure control
min flow rate, the method is paused and the system is set to state
ALARMS AND ERRORS.

Pressure control min flow rate can be set either as volumetric or
as linear flow. A column type must be selected before using linear
flow.
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Recommended pressure control
parameters

The following table contains the recommended values for P and I parameters for
different media types.

Column/
Media

Recom-
mended P
factor

Recom-
mended I
factor

Additional information

Default 8 40 N/A

Small soft
media columns

8 40 N/A

Large soft1

media columns
8 300 - 600 A higher I value than the default

value is needed to speed up pres-
sure ramp-up times.

Small rigid2

media columns
8 15 A lower I value than the default

value is needed to avoid large
fluctuations in pressure or flow
rate. As an alternative, try
increasing P.

20 40

1 Soft media is defined as all Cytiva separation media, except silica and MonoBeads.
2 Rigid media is defined as Cytiva separation media that is based on silica and MonoBeads.

Back pressure
Using narrow tubing between components will improve resolution but will lead to
increased back pressure in the system. Narrow tubing after the column will increase
the pressure in the column at a given flow rate. Make sure that the pressure sensor
limits in the system are set so that the maximum pressure for the column used is not
exceeded.

Additional instructions for avoiding
pressure alarms

The instruction Max flow during valve turn sets the maximum flow rate used during
the turning of the Injection valve and Outlet valve in order to avoid high pressure
alarms. If the flow rate passing through the Injection valve or the Outlet valve is higher
than the set max flow rate, the valves will only turn after decreasing the flow to the
specified flow rate. After the valves have turned, the previous flow rate will be restored.
The instruction is found under Advanced in the System settings dialog box.
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Constant pressure flow
By using the text instruction Constant pressure flow it is possible to continuously
adjust the flow rate to keep a certain pressure. This could be useful for example in
column packing at constant pressure. The Advanced →Constant pressure flow
instruction is found in the Manual Instructions dialog box in the System Control
module. See Section 9.8.7 Manual instructions - Advanced, on page 472 for a descrip-
tion of parameters for the Constant pressure flow text instruction.
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9.15 Check and change the Node ID of a module

Introduction
Node ID is a unit number designation that is used by the instrument to distinguish
between several units of the same type. All standard valves and available optional
modules are pre-configured to the default function. However, the function of a valve or
module can be changed by changing the Node ID. Also, in a troubleshooting situation it
may be useful to check a valve's or module's Node ID.

Note: The function of a valve or module is defined by its Node ID, not by its physical
position.

Node ID for standard modules
The following table lists the Node ID for the standard modules.

Module Label Node ID

System Pump A P9 A or P9H A 0

System Pump B P9 B or P9H B 1

Sample Pump P9-S or P9H S 2

Pressure Monitor, system pressure R9 0

Pressure Monitor, sample pressure R9 1

Mixer M9 0

Injection Valve V9-Inj or V9H-Inj 4

Quaternary Valve Q9 0

Inlet Valve A V9-IA or V9H-IA 0

Inlet Valve B V9-IB or V9H-IB 1

Sample Inlet Valve V9-IS or V9H-IS 2

Column Valve V9-C or V9H-C 5

Precolumn pressure monitor in Column
Valve

N/A 2

Post-column pressure monitor in
Column Valve

N/A 3

pH Valve V9-pH or V9H-
pH

11
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Module Label Node ID

pH Monitor

Note:

The pH monitor is included in the pH
valve module box.

H9 0

Outlet Valve V9-O or V9H-O 8

UV Monitor U9-M 0

UV detector U9-D 0

Conductivity Monitor C9 0

Built-in fraction collector N/A Not settable by
the user.

Node ID for optional modules
The following table lists the Node ID for the optional modules.

Module Label Node ID

Second Inlet valve A V9-A2 or V9H-
A2

12

Second Inlet valve B V9-B2 or V9H-B2 13

Extra Inlet valve X1 V9-IX or V9H-IX 15

Extra Inlet valve X2 V9-IX or V9H-IX 16

Second Sample inlet valve V9-S2 or V9H-S2 14

Versatile valve V9-V or V9H-V 20

Versatile valve 2 V9-V or V9H-V 21

Versatile valve 3 V9-V or V9H-V 23

Versatile valve 4 V9-V or V9H-V 24

Loop valve V9-L or V9H-L 17

Second Column valve V9-C2 or V9H-
C2

6

Unused pre-column pressure monitor in
second Column valve

N/A 4

Unused post-column pressure monitor
in second Column valve

N/A 5
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Module Label Node ID

Second Outlet valve V9-O2 or V9H-
O2

9

Third Outlet valve V9-O3 or V9H-
O3

10

External air sensor L9-1.2 or L9-1.5 0

I/O-box E9 0

Second I/O-box E9 1

Second UV Monitor U9-L 1

Second Conductivity Monitor C9 1

Fraction collector 2 F9-R 1
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Check and change the Node ID

The Node ID of a module is set by the positions of an arrow of two rotating switches at
the back of the module. Follow the instructions to check or change the Node ID.

Step Action

1 If applicable, remove the module according to the instruction in Install a
module in the instrument, on page 97.

2 The Node ID is set by the positions of an arrow of two rotating switches at the
back of the module.

• The first rotating switch, labeled A sets the tens.

• The second switch, labeled B sets the units.

• For example for Node ID 13, the A switch is set to 1 and the B switch to 3.

A             B  

3 Check the Node ID and compare it with the listed Node IDs in the tables
above.

4 To change the Node ID, use a screwdriver to set the arrows of the switches to
the desired number.

5 Re-install the module in the instrument, if applicable.

9 Reference information
9.15 Check and change the Node ID of a module
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10 Ordering information

Introduction
This chapter lists accessories and user replaceable spare parts available for ÄKTA
avant.

Tubing

Item Code no.

Reference capillary 1 28950749

Reference capillary 2 28950750

ETFE Tubing kit 10×1.0 m, id 1.0 mm, od 1/16″

Note:

Outlet tubing for ÄKTA avant 25.

28980995

Tubing kit 10×1.5m, FEP i.d.1.6 mm, o.d. 1/8″

Note:

Inlet tubing for ÄKTA avant 25/

Outlet tubing for ÄKTA avant 150

28980984

Tubing kit 10×1.5m, FEP id 2.9 mm, o.d 3/17″

Note:

Inlet tubing for ÄKTA avant 150.

28980987

Sample tubing kit for 7 inlets i.d. 0.75 mm

Note:

Narrow inlet tubing for ÄKTA avant 25.

28957217

Rinse system tubing 28956504

Replacement tubing kit, ÄKTA avant 25 28956606

Replacement Tubing Kit, ÄKTA avant 150 28979446

BufferPro InA and InB tubing kit, FEP i.d. 1.6 mm o.d. 1/8″ 28980998

Complete tubing marking kit

Note:

Tags for all tubing in ÄKTA avant 25 and ÄKTA avant 150.

28956608

10 Ordering information
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Item Code no.

Inlet/outlet tubing tag kit, ÄKTA avant 25

Note:

Tags for all inlet and outlet tubing in ÄKTA avant 25.

28981001

Inlet/outlet tubing tag kit, ÄKTA avant 150

Note:

Tags for all inlet and outlet tubing in ÄKTA avant 150.

28981004

Union 1/16″ male/male, i.d. 0.5 mm (5-pack) 28954326

Tubing cutter 18111246

Inlet filter holder kit 11000407

Inlet filter set 11000414

Fittings and connectors

Item Product code

Fingertight connector, 1/16″ male 18111255

Tubing connector for o.d. 1/16″ tubing 18112707

Tubing connector for o.d. 1/8″ tubing 18112117

Tubing connector for o.d. 3/16″ tubing 18111249

Union, 1/16" female to 1/16" female, (5 pcs) 11000339

Union, Fingertight 1/16" female to 1/16" female, i.d. 0.3
mm (4 pcs)

11000852

Union, 1/16" male to M6 female 18111258

Union, 1/16" female to M6 male 18111257

Union, Luer female to 1/16" male 18111251

Union, 1/16" male to 1/16" male, i.d. 0.5 mm (2 pcs) 18112093

Union, 5/16" female to M6 male 18112776

Union, 5/16" female to 1/16" male 18114208

Union, M6 female to 1/16" male 18385801

Ferrule for 1/16" tubing connector, blue 18112706

Ferrule for 1/8" tubing connector, yellow 18112118
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Item Product code

Ferrule for 3/16" tubing connector, blue 18111248

Stop plug, 5/16" male 18111250

Stop plug, 1/16" male 18111252

Holders

Item Code no.

Adapter for air sensor 28956342

Bottle holder 28956327

Column clamp (for columns o.d. 10 to 21 mm) 28956319

Column holder 28956282

Column holder rod 28956270

Flexible column holder 28956295

Loop holder 29011350

Multi-purpose holder 29011349

Rail extension 29011352

Tube holder (5-pack) 28954329

Tubing holder comb 28956286

Tubing holder, spool for small tubing (o.d. 1/8” and
smaller)

28956274

Tubing holder, spool for large inlet tubing (o.d. 3/16”) for
ÄKTA avant 150

29014283

Inlet filter holder kit 11000407

Screw lid kit, GL45 11000410

Conversion kits

Item Code no.

ÄKTA avant Conversion kit, 25 to 150

Note:

Contact Service for installation.

28980168
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Item Code no.

ÄKTA avant Conversion kit, 150 to 25

Note:

Contact Service for installation.

28981861

Pump spare parts

Item Code no.

P9-S Seal kit, 65 ml 28960250

P9 Seal kit, 25 ml (seal kit, P9) 28952642

Piston kit, 100 ml (piston kit, P9-S) 18111213

P9 Piston, kit 25 ml 28952640

Check valve kit (check valves in/out for P9, P9H and P9-S) 18112866

P9H Piston kit, 150 ml 28979368

P9H Seal kit, 150 ml 28979373

Mixer

Item Code no.

Mixer chamber 0.6 ml 28956186

Mixer chamber 1.4 ml (mounted at delivery in ÄKTA avant
25)

28956225

Mixer chamber 5 ml (mounted at delivery in ÄKTA avant
150)

28956246

Mixer chamber 15 ml 28980309

O-ring 13.1 × 1.6 mm

Note:

For Mixer chamber 0.6, 1.4, and 5 ml.

28953545

O-ring 13.1 × 1.6 mm High resistance

(can be used as an alternative to 28953545)

29011326
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Item Code no.

O-ring 22.1 × 1.6 mm

Note:

For Mixer chamber 15 ml.

28981857

Online filter kit 18102711

Valves

ÄKTA avant 25

Item Code no.

Column Valve V9-C 28956506

pH Valve V9-pH 28956508

Inlet Valve V9-IA 28956510

Inlet Valve V9-IB 28962006

Inlet Valve V9-IS 28962007

Outlet Valve V9-O 28956512

Injection Valve V9-Inj 28956514

Inlet Valve V9-A2 28957221

Inlet Valve V9-B2 28957223

Inlet Valve V9-S2 28957225

Inlet Valve V9-X1 28957227

Inlet Valve V9-X2 28957234

Column Valve V9-C2 28957236

Outlet Valve V9-O2 28957238

Outlet Valve V9-O3 28957240

Versatile Valve V9-V 29011353

Loop Valve V9-L 29011358

10 Ordering information

504  ÄKTA avant User Manual 29035184 AF



ÄKTA avant 150

Item Code no.

Column Valve V9H-C 28979241

pH Valve V9H-pH 28979246

Inlet Valve V9H-IA 28979248

Inlet Valve V9H-IB 28979277

Inlet Valve V9H-IS 28979279

Outlet Valve V9H-O 28979281

Injection Valve V9H-Inj 28979283

Inlet Valve V9H-A2 28979303

Inlet Valve V9H-B2 28979315

Inlet Valve V9H-S2 28979320

Inlet Valve V9H-X1 28979326

Inlet Valve V9H-X2 28979328

Column Valve V9H-C2 28979330

Outlet Valve V9H-O2 28979332

Outlet Valve V9H-O3 28979337

Versatile Valve V9H-V 29090691

Loop Valve V9H-L 29090689

Injection valve accessories

Item Code no.

Sample loop, 10 µl 18112039

Sample loop, 100 µl 18111398

Sample loop, 500 µl (mounted at delivery) 18111399

Sample loop, 1 ml 18111401

Sample loop, 2 ml 18111402

Sample loop, FEP 10 ml 18116124

Superloop, M6 fitting, 10 ml 19758501
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Item Code no.

Superloop, 1/16" fittings (ÄKTA design), 50 ml 18111382

Superloop, M6 fitting, 150 ml 18102385

Fill port, INV-907 18112766

Injection kit, INV-907 18111089

Connector 1/16" Male/Luer Female 28985812

Built-in fraction collector

Item Code no.

Cassette tray 28954209

Cassette, for 50 ml tubes (2-pack)

Note:

For 6 tubes

28956402

Cassette, for 15 ml tubes (2-pack) 28956404

Cassette for 5 ml tubes (2-pack) 29133422

Cassette, for 8 ml tubes (2-pack) 28956425

Cassette for 3 ml tubes (2-pack) 28956427

Cassette, for deep-well plate (2-pack) 28954212

Rack, for 50 ml tubes

Note:

For 55 tubes

28980319

Rack, for 250 ml bottles 28981873

Fraction Collector F9-R

Item Code no.

Fraction Collector F9-R 29011362

Tube Rack Complete, 175 × 12 mm 19868403

Tube Rack Complete, 95 × 10–18 mm 18305003

Tube Rack Complete, 40 x 30 mm 18112467
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Item Code no.

Bowl 18305103

Tube Support 18305402

Tubing Holder 18646401

Tube Holder and Guide, 175 × 12 mm 19724202

Tube Holder and Guide, 95 × 10–18 mm 19868902

Tube Holder and Guide, 40 × 30 mm 18112468

Drive sleeve 19606702

pH monitor

Item Code no.

pH electrode 28954215

O-ring 5.3 × 2.4 mm 28956497

UV monitor

Item Code no.

UV flow cell U9-0.5, 0.5 mm for U9-M 28979386

UV flow cell U9-2, 2 mm for U9-M 28979380

UV flow cell U9-10, 10 mm for U9-M 28956378

UV Monitor U9-L (fixed wavelength) 29011360

UV flow cell 2 mm for U9-L 29011325

UV flow cell 5 mm for U9-L 18112824

Conductivity monitors

Item Code no.

Conductivity Monitor C9 (standard module) 28956495

Conductivity monitor (C9n) (optional) 29011363
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External air sensors

Item Code no.

Air Sensor L9-1.2 mm 28956502

Air Sensor L9-1.5 mm 28956500

I/O box

Item Code no.

I/O-box E9 29011361

Module components

Item Code no.

Module Panel 29011364

Dummy Module 28956493

Extension Box 29110806

Cables

Item Code no.

Jumper 1 IEC 1394 (F-type) 28956489

Jumper D-SUB (D-type) 29011365

External module cable, short (F-type) 29012474

External module cable, long (F-type) 29011366

Cable 2.5 m UniNet-9 D-type 29032425

Flow restrictor

Item Code no.

Flow Restrictor FR-902 18112135
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Barcode scanner

Item Code no.

Barcode Scanner 2-D with USB 28956452

UniTag

Item Code no.

UniTag (sheet with 108 labels) 28956491

Trays

Item Code no.

Wet side waste tray 28956487

Front side waste tray 28956485

User Documentation

Item Code no.

ÄKTA avant User Manual

Note:

Covers ÄKTA avant 25 and ÄKTA avant 150.

29035184
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Index

A

Advanced system settings, 451
Affinity chromatography, 429

predefined method, 429
Air sensor settings, 446
Air sensors, 48, 63, 114, 392, 398

air sensor adapter, 48
description, 63
error codes, 398
external air sensors, 114
troubleshooting, 392

ÄKTA avant , 13, 86, 95, 193, 249,
344

Cassettes and trays, 86
description, 13, 95
maintenance, 249
preparation, 193
troubleshooting, 344

ÄKTA avant 25 , 126
Tubes, 126

ÄKTA avant system, 9, 404
main features, 9
specifications, 404

Anion exchange, 430
predefined method, 430

C

Cassettes, 86, 87
quickrelease function, 87

Cation exchange, 430
predefined method, 430

Chromatofocusing, 431
predefined method, 431

CIP, 275, 283, 433, 434, 437
column CIP, 283
column maintenance
method, 433
column predefined phase,
437
system CIP, 275
system maintenance
method, 434
system predefined phase,
437

Cleaning, 225
column, 225

Cold cabinet, 28, 29
precautions, 28
prepare for a run, 29

Cold room, 28
Column, 43, 70, 179, 225, 283

cleaning, 225
column CIP, 283
column holder, 43
Column valve, 70
pressure alarm, 179
storage, 225

Column CIP, 433, 437
maintenance method, 433
predefined phase, 437

Column performance test, 434,
437

maintenance method, 434
predefined phase, 437

Column preparation, 434, 437
maintenance method, 434
predefined phase, 437

Column valve, 70
description, 70

Column wash, 437
predefined phase, 437

Component volumes, 490
Conductivity monitor, 94, 303,
312, 399

calibration, 312
clean the conductivity flow
cell, 303
description, 94
error codes, 399

Conductivity settings, 441
Connectors, 414

for ÄKTA avant, 414

D

Data collection settings, 453
Delay volume, 209, 486

reference information, 486
settings, 209

Delay volumes settings, 449
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Desalting, 431
predefined method, 431

Documentation, 11

E

Elution, 437
predefined phase, 437

Equilibration, 437
predefined phase, 437

Extension box, 52

F

Flow cells, 77, 94, 132
conductivity, 94
pH, 77
UV, U9-L, 132

Flow path, 149, 413, 488, 490
component volumes, 490
delay volumes, 488
illustration, 413
prepare the flow path, 149

Flow restrictor, 265, 267, 332
check function, 265, 267
replace flow restrictor, 332

Fraction collection settings, 448
Fraction collector , 81, 87, 89, 90,
200, 237, 262, 287, 290, 368, 401

cleaning, 262, 287, 290
error codes F9-R, 401
F9-R test, 237
preparation, 200
quickrelease function, 87
requirements on deep well
plates, 90
requirements on tubes, 89
temperature control, 81
troubleshooting, 368

Fraction collector F9-C, 86, 193
Cassettes and racks, 86, 193

Fraction collector F9-R, 128
connect tubing, 128

Fractionation, 127, 200, 208, 209
assemble tube rack, 127, 200
delay volume, 209
fractionation types, 208
prepare, 200

Full scan, 81

G

Gel filtration, 431
predefined method, 431

H

Hardware installation, 97
of a module, 97

Holders, 43–45, 47, 48, 50–52, 502
air sensor adapter, 48
bottle holder, 48
column clamp, 43
column holder, 43
column holder rod, 44
Extension box, 52
flexible column holder, 45
loop holder, 51
multi-purpose holder, 50
ordering information, 502
rail extension, 50
tubing holder comb, 47
tubing holder spool, 47

Hydrophobic interaction chroma-
tography (HIC), 432

predefined method, 432

I

I/O-box E9, 136, 137, 393, 402
ÄKTA avant installation, 136
connectors, 137
description, 136
error codes, 402
troubleshooting, 393

I/O-box settings, 447
Important user information, 7
Injection valve, 67

description, 67
flow paths, 67

Inlet tubing, 151, 158
prepare, 151
prime inlet tubing B, 158

Inlet valves, 62–64, 66, 366
description, 62
Inlet valve A, 63
Inlet valve B, 63
Quaternary valve, 64
Sample inlet valve, 66
troubleshooting, 366

Install of optional modules, 97
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Installation, 151
prepare waste tubing, 151

Instrument control panel, 397
error codes, 397

Instrument control panel error
codes, 401
Instrument display, 36, 37

function, 37
location, 36
states, 37

Instrument overview, 14, 125
Fraction collector F9-R, 125
Instrument configurations,
14

Intelligent Packing, 434, 438
Predefined method, 434
Predefined phase, 438

Ion exchange, 430
predefined method, 430

L

Log on, 154
UNICORN, 154

Loop valve, 118, 119
description, 118
flow paths, 119

M

Maintenance, 250, 255, 268, 274,
305, 320

calibration procedures, 305
clean the instrument, 274
Maintenance Manager, 250
maintenance program, 255
replacement procedures,
320
semiannual maintenance,
268

Maintenance manager, 251
handling maintenance notifi-
cations, 251

Maintenance methods, 433–435
column CIP, 433
column performance test,
434
column preparation, 434
system CIP, 434
system preparation, 435

Manual instructions, 454, 456,
459, 461, 463, 468, 469, 472, 475,
476

advanced, 472
alarms, 469
flow path, 459
fraction collection, 463
I/O-box, 468
monitors, 461
other, 476
pumps, 456
watch parameters, 475

Manual loop fill, 437
predefined phase, 437

Manual Loop Fill, 432
predefined method, 432

Method settings, 436
predefined phase, 436

Methods, 215, 216, 429–434
affinity chromatography, 429
anion exchange, 430
cation exchange, 430
chromatofocusing, 431
create a method, 216
create method, 215
desalting, 431
gel filtration, 431
hydrophobic interaction
chromatography (HIC), 432
Intelligent Packing, 434
maintenance methods, 215
manual loop fill, 432
predefined maintenance
methods, 433
predefined methods, 215,
429
purification methods, 215
reverse phase chromatog-
raphy (RPC), 433

Miscellaneous, 437
predefined phase, 437

Mixer, 59, 149, 261, 323, 325, 388,
398, 407

choose Mixer chamber, 149
description, 59
error codes, 398
replace mixer, 323
replace the inline filter, 261
replace the o-ring, 325
specifications, 407
troubleshooting, 388
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Modules, 55, 59, 67, 73, 77, 92, 94,
118, 122

conductivity monitor, 94
injection valve, 67
loop valve, 118
mixer, 59
outlet valve, 73
pH valve, 77
pumps, 55
UV monitor, 92
versatile valve, 122

Monitors, 92, 94, 348
conductivity, 94
troubleshooting, 348
UV, 92

N

Node ID, 97, 496, 499
change Node ID, 499
check Node ID, 499
description, 97, 496

Notes and tips, 8

O

Optional configurations, 97
install optional modules, 97

Ordering information, 500–509
cables, 508
Conductivity monitor, 507
external air sensors, 508
flow restrictor, 508
fraction collector, 506, 507
Fraction collector, 506
holders, 502
I/O-box E9, 508
mixer, 503, 504
module panel, 508
multi module front, 508
pH monitor, 507
trays, 509
tubing, 500–502
UniTag, 509
UV monitor, 505, 507
valves, 505

Outlet tubing, 151
prepare, 151

Outlet valve, 73
description, 73

P

Performance tests, 228, 237, 247
fraction collector F9-R, 237
overview, 228
UV U9-L system, 247

pH monitor, 79, 225, 272, 291, 293,
306, 359, 398

calibration, 306
clean the pH electrode, 293
description, 79
Error codes, 398
replace the pH electrode, 272
storage of the pH electrode,
225, 291
troubleshooting, 359

pH settings, 443
pH valve, 77, 78, 359

description, 77
flow paths, 78
troubleshooting, 359

Phases, 435–438
column CIP, 437
column performance test,
437
column preparation, 437
column wash, 437
elution, 437
equilibration, 437
Intelligent Packing, 438
manual loop fill, 437
method settings, 436
miscellaneous, 437
predefined phases, 435
sample application, 437
system CIP, 437
system preparation, 438

Prepare the system, 149–151, 154,
181, 193, 200

ÄKTA avant, 193
flow path, 149
fraction collector, 200
inlet tubing, 151
Mixer, 149
outlet tubing, 151
sample application, 181
Start UNICORN, 154
UV monitor U9-L, 150
UV monitor U9-M, 150

Pressure alarm, 179
set, 179
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Pressure monitor, 398
Error codes, 398

Pressure monitors, 75, 308
calibration, 308
check the pressure monitors,
308
description, 75

Prime inlet tubing B, 158
Process picture, 222
Pump and pressure settings, 444
Pumps, 55, 158, 259, 297, 334, 337,
380, 399, 406

change pump rinsing solu-
tion, 259
clean check valves, 297
description, 55
Error codes, 399
purge system pumps, 158
replace check valves, 334
replace pump rinsing system
tubing, 337
specifications, 406
troubleshooting, 380

Q

Quaternary valve, 64, 65
BufferPro, 65
function, 64
quaternary gradients, 65

Quick scan, 81
QuickRelease function, 87

R

reference information, 485
injection volumes and peak
broadening, 485

Reference information, 403, 404,
406, 421, 486, 493, 494

back pressure, 494
chemical resistance guide,
421
component specifications,
406
delay volumes, 486
pressure regulation, 493
system specifications, 404

Reverse phase chromatography
(RPC), 433

predefined method, 433

Run, 219, 220, 222, 224, 477, 481
after run procedures, 224
available curves, 481
available run data, 477
choose method, 219
monitor a run, 222
perform a run, 219
perform manual run, 220

S

Safety notices, 7
Sample application, 67, 181, 184,
189, 437

flow paths, 67
injection valve, 67
predefined phase, 437
sample loading, 181
sample loop, 189
superloop, 184

Sample loop, 189
sample loading, 189

Scanning of cassettes, 81
full scan, 81
quick scan, 81

Software overview, 9
software modules, 9

Storage, 224, 225
column, 225
pH electrode, 225
system, 224

Superloop, 184, 389
sample loading, 184
troubleshooting, 389

System CIP, 434, 437
maintenance method, 434
predefined phase, 437

System configuration, 96, 101, 103
overview, 96
system properties, 101
system settings, 103

System Control module, 222, 454
manual instructions, 454
process picture, 222

System preparation, 148, 435, 438
before preparation, 148
maintenance method, 435
predefined phase, 438

System pumps, 55
operating ranges, 55
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System settings, 440, 441, 443,
444, 446–451, 453

advanced, 451
air sensor, 446
conductivity, 441
data collection, 453
delay volumes, 449
fraction collection, 448
I/O-box, 447
pH, 443
pump and pressures, 444
UV, 440
wash settings, 451
watch parameters, 450

System storage, 224
System test, 247

UV U9-L, 247

T

Technical specifications, 404, 406
component specifications,
406
system specifications, 404

Trays, 86
Troubleshooting, 348, 368, 380,
387, 395, 397

Error codes, 397
fraction collector, 368
Fraction collector, 368
instrument communication,
395
monitors, 348
other components, 387
pumps, 380

Tube rack, 127, 200
assembly, 127, 200

Tubing, 321, 413
for for ÄKTA avant, 413
replace tubing, 321

U

UNICORN, 154, 155
connect to system, 155
Log on, 154
Start, 154

UV detector U9-D, 400
error codes, 400

UV monitor, 92, 132, 150, 269, 316,
327, 330

calibration, 92, 150, 316

clean UV flow cell, 269
description, 92
replace UV flow cell, 327, 330
second, 132

UV monitor U9-L, 132, 150, 247,
400

description, 132, 150
error codes, 400
system test, 247

UV monitor U9-M, 92, 150, 348,
399

description, 92, 150
error codes, 399
troubleshooting, 348

UV settings, 440

V

Valves, 60, 62, 64, 67, 70, 73, 77,
104, 108, 111, 118, 122, 339, 397,
408

Column valve, 70
Error codes, 397
extra Column valve, 108
extra Inlet valves, 104
extra Outlet valves, 111
injection valve, 67
Inlet valves, 62
loop valve, 118
outlet valve, 73
overview, 60
pH valve, 77
Quaternary valve, 64
replace a valve module, 339
specifications, 408
versatile valve, 122

Versatile valve, 122
description, 122
flow paths, 122

W

Wash settings, 451
Waste tubing, 151

prepare, 151
Watch parameters settings, 450
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